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How Do I?

Manage files 

Define fields for a database

Join and unjoin databases 

Work in Design

Add and edit fields in a view

Design views 

Enter and edit data 

Find and sort records 

Preview and print 

Automate work with macros 

Exchange data with other files or applications 

Customize Approach 

Share data on a network



Create OLE objects
About creating OLE objects
Create an Approach OLE object in Approach
Create an Approach OLE object from another application



Link OLE objects from other applications
About linking OLE objects from other applications
Insert a linked object
Edit a linked object
Modify a link



Embed OLE objects
About embedding an OLE object
Embed an existing OLE object
Embed a new OLE object
Edit an embedded object



Import data
About importing data
Import data into a database
Import an Approach file



Export and send data
About exporting and sending data
Export data from Approach 
Copy a PicturePlus picture to a file 
Sending E-mail from Approach 



Modify a repeating panel
About modifying a repeating panel
Select a repeating panel
Add labels to a repeating panel 
Change the basic properties of a repeating panel
Change line or color settings for a repeating panel
Resize a repeating panel
Add a field to a repeating panel
Rearrange fields in a repeating panel
Summarize data for records in a repeating panel 



Modify a report
Select a report panel
Change line or color settings for a report panel
Add a header or footer
Add a title page
Change the number of columns in a report
Keep records together
Work with whole report columns



Summarize data
About summarizing data in a report
Add a summary panel to a report
Move a summary panel
Add a calculated field to a summary panel



Use PowerClick reporting
About PowerClick reporting
Add a grand total to a report
Group records and add subtotals to a report



Work with worksheets
Select in a worksheet
Copy a selection to the Clipboard
Navigate in a worksheet
Divide a worksheet into panes
Format a worksheet for printing



Change the appearance of a worksheet
About changing the appearance of a worksheet or crosstab 
Add a database field to a worksheet or crosstab 
Remove a database field from a worksheet or crosstab 
Move worksheet or crosstab columns
Resize worksheet or crosstab columns and rows
Insert a blank or formula column in a worksheet
Change worksheet or crosstab settings
Edit column header text



Set Approach preferences
About setting Approach preferences
Set display defaults
Set a default order for records
Define a password for a file
Set dialing preferences
Set database options for a dBASE or FoxPro file
Set database options for a Paradox file
Set database options for all SQL tables
Maintain external indexes for a dBASE or FoxPro database
Create secondary indexes for a Paradox database
Set general working preferences



Customize SmartIcons and menus
About customizing SmartIcons and menus 
Customize the SmartIcon bar 
Customize menus 



Enter data in fields
About entering data in fields
Select a field
Change the insertion point or selection
Enter text in a text or memo field
Enter a value in a numeric field
Enter a value in a Boolean field
Enter a date in a date field
Enter a time in a time field
Duplicate a value from the last record modified
Select from a drop-down list
Turn on a radio button or checkbox
Fill a field with a new value



Set up a network environment
About setting up a network environment
Set file-sharing options for dBASE files
Specify a locking protocol for shared dBASE files
Set file-sharing options for Paradox files



Work on a network
About working on a network
Change the status to single user
Enter a password
Refresh the network data on the screen
Save changes to a shared record



Move to another record
About moving to another record
Move one record at a time
Move to the first or last record
Move to a specific record



Add, delete, and hide records
About adding, deleting, and hiding records
Add a new record
Duplicate a record
Delete specific records
Delete a found set of records
Hide records
Show hidden records



Put a picture in a field
About putting a picture in a field
Paste a picture
Draw lines with the pointer



Create and run macros
About macros
Define a macro
Add and remove commands in a macro
Move a command in a macro
Edit a macro
Delete a macro
Run a macro
Save a find request as part of a macro 



Attach macros
About attaching macros
Attach a macro to a button or object
Create a button and defining a macro
Attach a macro to a field
Attach a macro to a view



Sample macros
About sample macros
Create a looping macro
Switch to another view with a macro
Find a set of records with a macro
Set a value in a field with a macro 
Use an IF calculation in a macro
Define a conditional macro



Customize the Design work area
About customizing the Design work area 
Show a design grid 
Snap objects to the grid 
Show rulers 
Show data or field names 
Zoom in and out 



Add objects to the background of a view
About adding objects to the background of a view 
Draw a geometric object 
Paste a picture 
Enter text in a text object 
Add a macro button 



Select in Design
About selecting in Design 
Select objects in Design 
Select text_in_Design 



Edit objects and text
About editing objects and text 
Change the basic properties of an object 
Change line or color settings for an object 
Resize an object 
Move an object
Slide an object when you print
Change text attributes 
Cut or copy an object or text
Delete an object or text 
Apply properties from another object 



Work with named styles
About working with named styles 
Define and save a named style 
Edit or delete a named style 



Work with more than one object at a time
About working with more than one object at a time 
Group and ungroup objects
Change the stacking order of an object 
Align and distribute objects 



Edit views
About editing views 
Change the basic properties of a view 
Add a date or time to a view 
Resize page margins 
Change line or color settings for a view 
Duplicate a view 
Delete a view 



Display fields on a view
About displaying fields in a view 
Add a field as a field box 
Display a field as a drop-down list 
Display a subset of data in a drop-down list 
Display a field as a checkbox 
Display a field as radio buttons 



Format data in fields
About formatting data in fields 
Set a standard date format 
Set a special date format for periods of a year 
Set a time format 
Set a numeric format 
Set a text format 



Edit fields
About editing fields 
Change the basic properties of a field 
Change text attributes of data 
Change line or color settings for a field 
Change the wording, attributes, or position of a label 
Slide or resize a field when you print
Change the data entry order for fields 



Work with PicturePlus fields
About working with PicturePlus fields 
Add a PicturePlus field to a view 
Change the basic properties of a PicturePlus field 
Change display options for a PicturePlus field 



Add, edit, and delete database fields
About adding, editing, and deleting database fields 
Add fields to a database 
Set up a formula for a calculated field 
Edit a field 
Specify a key field for a Paradox database 
Delete a field 



Customize a field for data entry
About customizing a field for data entry 
Enter data automatically 
Verify the accuracy of entered data 
Set OLE options for a PicturePlus field 
Set data options for a variable field 



Find records

About creating a find request
Create a find request 
Find records with multiple criteria (And)
Find records with one of several criteria (Or)
Find text with wildcards
Find case-sensitive text
Find a word that sound like another
Find numbers, dates, and times
Find values in a range
Find today's date
Find radio button and checkbox settings
Find nonblank fields
Use an If statement to find data
Repeat a search
Show all records



Find special records
About finding special records
Find duplicate values
Find unique values



Sort records
About sorting records
Specify a sort order    
Change the sort order 
Show records in their original order



Create and open files
About creating and opening files
Create a new database file
Open an Approach file
Map fields in an Approach file
Open a database created in another application
Open a table created in Microsoft Access 
Create a database from a spreadsheet
Create a database from a delimited text file
Create a database from a fixed-length text file



Save, close, and delete files
About saving, closing, and deleting files
Save an Approach file
Save a copy of an Approach file and a database file
Save a copy of an Approach file only
Close an Approach file
Delete a file



Work with SQL tables
About working with SQL tables 
Connect to an Oracle server    
Connect to Oracle on your local drive 
Connect to a server in SQL Server 
Connect to an IBM DB2 server through MDI 
Connect to an IBM DB2 server through ODBC 
Create a query file in Approach 
Open a query file in Approach 
Save or export data from a query 



Work with ODBC data sources
About working with ODBC data sources 
Open a database table through ODBC 
Open a database table on a server through ODBC 
Open an ODBC data source set up on your system 
Install an ODBC driver 
Set up a data source for an ODBC driver 



Create a report
Create a standard or columnar report
Create a report with summaries
Create a repeating panel     report  



Design a form
About forms and repeating panels
Create a form
Add a repeating panel to an existing form 
Modify a repeating panel



Design a report
About reports
Create a report
Modify a report
Summarize data
Use PowerClick reporting



Design a form letter
About form letters
Create a form letter
Type text in a form letter
Add a field to a form letter
Move or delete a form letter field



Design a mailing label
About mailing labels
Create a mailing label
Create a custom mailing label format
Move or resize mailing label fields
Type on a mailing label
Set a field to slide
Change the mailing label layout
Print an envelope 



Design a worksheet
About worksheets
Create a worksheet
Work with worksheets
Change the appearance of a worksheet



Design a crosstab
About crosstabs
Create a crosstab
Add a summary column or row to a crosstab
Edit a crosstab formula
Change the appearance of a crosstab
Turn a worksheet into a crosstab



Design a chart
About charts
Create a chart using the Chart Assistant
Create an instant chart from a crosstab
Chart a different data set



Join and unjoin databases
About joining and unjoining
Join database files
Set options for a join 
Unjoin database files



Share data on a network
Set up a network environment
Work on a network



Add and edit fields on a view
Display fields on a view
Format data in fields
Edit fields
Work with PicturePlus fields



Work in Design
Customize the design work area
Add objects to the background of a view
Select in Design
Edit objects and text
Work with named styles
Work with more than one object at a time
Edit views



Manage files
Create and open files
Save, close, and delete files
Work with SQL tables
Work with ODBC data sources



Define fields for a database
Add, edit, and delete database fields
Customize a field for data entry



Design views
Design a chart
Design a crosstab
Design a form
Design a form letter
Design a mailing label
Design a report
Design a worksheet



Check spelling
About checking spelling
Run the spelling checker
Edit the user dictionary
Change to another main dictionary
Set options for checking spelling



Enter and edit data
Move to another record
Add, delete, and hide records
Enter data in fields
Put a picture in a field
Check spelling 



Find and sort records
Find records
Find special records
Sort records



Preview and print
About previewing and printing 
Specify the printer, paper, and orientation
Preview a view
Print a view



Customize Approach
Set Approach preferences
Customize SmartIcons and menus



Automate work with macros
Create and run macros
Attach macros
Sample macros
Macro commands



Exchange data with other files or applications
Import data 
Export and send data 
Create OLE objects 
Link OLE objects from other applications
Embed OLE objects



About finding records
Finding records allows you to focus on a subset of your data. You tell Approach what to search for by entering search 
criteria in one or more find requests. When you finish searching, Approach displays only the records that meet the 
search criteria; this is the found set.

Creating a find request         
A new find request is a blank copy of the view you're currently using. You enter the criteria in fields of the find request.
If the view contains a summary field, you see the summary field along with all of the other fields in the find request. 

Finding records with multiple criteria (And)        
When you enter criteria in more than one field in a find request, Approach finds the records that match all the criteria. 
This is known as an And search.

Finding records with one of several criteria (Or)        
You can specify several criteria and have Approach find the records that match at least one of the criteria. This is 
known as an Or search.

Finding text with wildcards        
Approach can find text that matches a string of characters, a word, or a phrase in a text field. You can include asterisk
(*) and question mark (?) wildcards in a text search. Asterisks match any number of characters and question marks 
match any single character. 

Finding case-sensitive text        
Whether a search is case-sensitive depends on the file type of your database. A search in a dBASE, FoxPro, or 
Paradox 4.0 database is not normally case-sensitive, but a search is case-sensitive in a Paradox 3.5 database, a 
SQL table, or a database you open through ODBC.
You can limit a specific search to be case-sensitive even in a database that is not normally case-sensitive in its 
searches.

Finding a word that sounds like another        
Approach can locate words that sound like other words. This is particularly useful when you know how a name or 
other proper noun sounds, but aren't sure how to spell it.

Finding numbers, dates, and times        
You can find a value in a numeric, Boolean, date, or time field or in a calculated field that returns a number, Boolean 
value, date, or time. 

Finding values in a range        
Approach can look for values that fall within an inclusive range in a text, numeric, date, or time field or in a calculated 
field that returns a number, date, or time.

Finding today's date        
You can find the current date in a date field or in a calculated field that returns a date.

Finding radio button and checkbox settings        
You can look for all records that have a particular combination of radio button and checkbox settings. 

Finding find or nonblank fields        
Approach can isolate records with blank values in a particular field. This can help you identify errors in data entry or 
find records that don't have complete information yet. A field is considered blank if it has a Null value or no value. 



Approach can also find fields that are not blank.

Using an If statement to find data        
An If statement is a concise and powerful tool for comparing data in two or more fields. You can use an If statement in
a find request to build complex search criteria. 
When you use an If statement for finding data, Approach returns a value of Yes or No based on the If statement for 
each record in the database. The records that return Yes are included in the found set.

Repeating a search        
Approach keeps track of your most recent search so that you can easily repeat it, as long as you are still in a view 
based on the same database and you have not used the Show All command.

Showing all records        
When you're finished working with a found set, you can go back to seeing all the records in the database. This also 
returns records to their original sort order.

See also
Find 
Saving a find request as part of a macro 



Creating a find request

A new find request is a blank copy of the view you're currently using. You enter the criteria in fields of the find request.
1. Change to the view you want to use for finding records.
2. Click the Find icon.

3. Type search criteria in the appropriate fields.
4. Click OK in the find request, click the Enter icon, or press ENTER to begin the search.

If you want to cancel a find while Approach is still searching, press ESC.

See also
Finding a set of records with a macro 



Details: Creating a find request

You can type criteria in a find request just as you type data in a regular form or report. Type criteria in as many fields 
as necessary to define the search.

Approach SmartIndex
Approach automatically creates an index the first time you find or sort on a field. This makes any subsequent finds or 
sorts on that field go faster.

Finding on a summary field
You can find on a summary field only if it summarizes a group of records sorted by a field. You can't find on a grand 
total summary field or one that summarizes by a number of records.

Using operators in a find request
You can use the following operators with search criteria. Either type an operator in the field, or click where you want 
the operator to go and then click its icon in the icon bar.

This operator Specifies
< Less than

> Greater than

<= Less than or equal to

>= Greater than or equal to

= Equal to (if alone, finds 
records with blank fields)

<> Not equal to (if alone, 
finds records with 
nonblank fields

, Or criteria within a field

& And criteria within a field

… Range of values (for 
example, A…D)

* Wildcard for zero or 
more characters

? Wildcard for one 
character

@ Comparison with the 
result of a formula (used 
with another operator, 
such as in =@Today())

! Case-sensitive text 
search

~ Sounds like

If Complex expressions



Finding records with multiple criteria (And)

When you enter criteria in more than one field in a find request, Approach finds the records that match all the criteria. 
This is known as an And search.

Type criteria in more than one field in a find request.
For example, to find all employees who work in the Finance department and live in San Francisco, enter Finance
in the Department field and San Francisco in the City field of an employee form find request.

See also
Using an If statement to find data



Finding records with one of several criteria (Or)

You can specify several criteria and have Approach find the records that match at least one of the criteria. This is 
known as an Or search.

To find records with Or criteria in one field:
Separate the criteria with a comma in that field in one find request. 

You can type a comma or click the Find Or icon.

For example, to find all employees who work in the Finance department or the Payroll department, enter 
Finance,Payroll in the Department field of an employee form find request.

To find records with Or criteria in more than one field: 
1. Type the Or criteria for the first field. 
2. For each additional field, click Find More in the find request, click the Find icon again, or choose Find More from 

the Records menu. Then type the Or criteria for the field in the new find request.
Do not click OK, click the Enter icon, or press ENTER until you're finished creating the entire set of find requests.

For example, to find all employees who work in the Finance department or live in San Francisco, enter Finance in the
Department field of one find request and San Francisco in the City field of a second find request.



Finding text with wildcards

Approach can find text that matches a string of characters, a word, or a phrase in a text field. You can include asterisk
(*) and question mark (?) wildcards in a text search.

To find text:

Type the characters in a text field.
If you want the match to be exact, precede the characters with an equal sign (click the Find Equal icon).

For example, the search text Payroll finds "Payroll," "Payroll Dept.," and any other text that begins with the search 
text. The text =Payroll finds only "Payroll."

To match any number of characters in a field:

Include an asterisk (*) in the search text.
You can type an asterisk or click the Asterisk icon.

For example, the search text *past* finds records that contain the text "past" anywhere in the search field. The text 
*san can find "San Francisco" and "Santa Rosa." The text *r* can find "red" and "green" but not "blue." The text *o 
can find "solo" and "trio" but not "dot." The text g*s can find "grants" and "goods" but not "green."

To match a single character in a field:

Include a question mark (?) in the search text. 
You can type a question mark or click the Question Mark icon.

For example, the search text to? can find "toy" and "tom" but not "today." The text ?an can find "ran" and "pan" but 
not "plan." The text to??y can find "today" and "Tommy" but not "toy" and "tom." The text ?o? can find "Tom" and 
"son" but not "today" and "Troy."



Finding case-sensitive text

You can limit a specific search to be case-sensitive even in a database that is not normally case-sensitive in its 
searches.

Precede the search text with an exclamation mark (!).
You can type an exclamation mark or click the Find Case Sensitive icon.

For example, in a database that is not case-sensitive, the search text Madrid finds text that begins with "Madrid," 
"madrid," and any other combination of uppercase and lowercase letters. The text !Madrid finds only text that begins 
with "Madrid" (with a capital M).



Finding a word that sounds like another

Approach can locate words that sound like other words. This is particularly useful when you know how a name or 
other proper noun sounds, but aren't sure how to spell it.

Precede the search text with a tilde (~).
You can type a tilde or click the Find Sounds Like icon.

For example, the search text ~Philip finds "Philip," "Filip," "Philippe," and similar-sounding words.



Finding numbers, dates, and times

You can find a value in a numeric, Boolean, date, or time field or in a calculated field that returns a number, Boolean 
value, date, or time. 

To find a number:

Type the number in a numeric or calculated field.
Do not type format characters such as currency symbols or commas with the number. If the field has a format, 
Approach provides these characters automatically.

To find a Boolean value:

Type 0 or 1 in a Boolean or calculated field.

To find a date:

Type the date as numbers in a date or calculated field. 
Separate the numbers with non-numeric characters such as slashes (/). Type a single number to find a date for 
the current month and year.
Type one, two, three, or four digits for the year. One-digit and two-digit years are assumed to mean the twentieth 
century. If you don't type a year, Approach assumes the current year (based on your system settings) and enters 
it for you.

To find a time:

Type the time as numbers in a time or calculated field. 
Separate the numbers with colons (:). Type a single number to enter only an hour.
You can use either a 12-hour or a 24-hour format. If you enter an hour less than 12 without a suffix of AM or PM, 
Approach assumes AM.



Finding values in a range

Approach can look for values that fall within an inclusive range in a text, numeric, date, or time field or in a calculated 
field that returns a number, date, or time.

Enter an ellipsis (…) between the beginning value and the ending value of the range.
You can type an ellipsis or click the Find Range icon.

For example, the search string H...J in a text field finds all text strings that begin with H, I, or J. The string 7...9 in a 
numeric field finds the values 7, 8, and 9. The string 5-1-94...5-31-94 finds all dates in the month of May 1994.



Finding today's date

You can find the current date in a date field or in a calculated field that returns a date.

Enter a comparison operator and @Today() in a date or calculated field.
The operators you can use are =, <>, <,<=, >=, and >. You can type operators or click the appropriate icons.

        

        

        

        

The Today function returns the current date on your system clock, and the at sign (@) tells Approach to compare the 
system date from the Today function with values in the records.
For example, =@Today() specifies that you want an exact match with the system date.



Finding radio button and checkbox settings

You can look for all records that have a particular combination of radio button and checkbox settings. 

Turn on the radio buttons and checkboxes in the find request to specify the combination you want to find.
If you want to specify a No value for a checkbox, such as "payment not received," click the checkbox to turn it on 
and then click it again to turn it off. A checkbox is Null until it is clicked at least once.



Finding blank or nonblank fields

Approach can isolate records with blank values in a particular field. A field is considered blank if it has a Null value or 
no value. Approach can also find fields that are not blank.

To find blank fields:

Enter an equal sign (=) by itself in a field. 
You can type an equal sign or click the Find Equal icon.

To find nonblank fields:

Enter a not-equal sign (<>) by itself in a field.
You can type a not-equal sign or click the Find Not Equal icon.



Using an If statement to find data

When you use an If statement for finding data, Approach returns a value of Yes or No based on the If statement for 
each record in the database. The records that return Yes are included in the found set.

Type an If statement in an unused field in a find request.
The statement can include field references, constants, and any of the other search operators. Enclose text, date, 
and time constants in single quotation marks. You can put the statement in any field in the request; it does not 
have to be one of the fields referred to in the statement. 
For example, this statement finds records that have a higher value in the ActualCost field than in the Budget field:
If(ActualCost>Budget)



Details: Using an If statement to find data

Field names
Enclose a field name in double quotation marks if it begins with a number, or if it contains a space, a period, a 
comma, or one of the following characters:
/, #, +, -, <, >, (, )

Joined databases
If a field reference refers to a field in a joined database, include the name of the database in the reference. The 
database name must be in all capital letters. Separate the database name and the field name with a period. For 
example,
If(ORDERS.Quantity>SUPPLY.Quantity)

Combining expressions
You can combine expressions in an If statement with the And and Or operators. This is a more concise way to specify
complex criteria than using multiple fields.
For example,
If((Department='Finance')And(City='San Francisco'))
If((Amount>200)Or(Date<'4/30/94')
If((Today()-InvoiceDate<=90)And(BalanceDue>0))
To compare If statements to a search using multiple fields, see Finding records with multiple criteria (And) and 
Finding records with one of several criteria (Or).



Repeating a search

Approach keeps track of your most recent search so that you can easily repeat it, as long as you are still in a view 
based on the same database and you have not used the Show All command.
1. Choose Find Again from the Browse menu. 

In a worksheet or crosstab, Find Again appears on the Worksheet Find or Crosstab Find submenu. 
2. Click OK in the find request, click the Enter icon, or press ENTER.



About finding special records
In addition to searching for specific information, you can also find all records that have either the same value in a field
or a unique value. With this type of find, Approach searches in the current found set (not the entire database) either 
for duplicates of any value or for each occurrence of a unique value.

Finding duplicate values        
Finding records with duplicate values can help you check for errors in data entry or remove redundant records from 
your database. You can find all duplicate records, or just the extra duplicates.

Finding unique values        
Finding records with distinct values lets you weed out duplicate values to see what your unique value set is. For 
example, when you have multiple customer records for a company that has several locations, finding distinct records 
lets you see how many unique companies are in your customer database.



Finding duplicate values

Finding records with duplicate values can help you check for errors in data entry or remove redundant records from 
your database. You can find all duplicate records, or just the extra duplicates. Approach searches for duplicate values
only in the current found set (not the entire database).
1. Find the records in which you want to look for duplicate values, or show all records in the database.
2. Choose Find Special from the Browse menu.

In a worksheet or crosstab, Find Special appears in the Worksheet Find or Crosstab Find submenu.
3. Select "Find duplicate records."
4. To find only the extra duplicate records, turn on "Exclude the first duplicate record."

If this setting is off, Approach finds all records with duplicate values.
5. Move the fields you want to check from the Database Fields list to the Fields to Search list.
6. Click OK.
If you want to cancel a find while Approach is still searching, press ESC.

See also
Finding unique values 



Details: Finding duplicate values

Joined databases
In an Approach file with joined databases, you can find duplicate records only in the current view's main database.

Moving fields to another list
To move a field to the Fields to Search list, select the field name and click Add, or double-click the field name.
To move a field back to the Database Fields list, select the field name and click Remove, or double-click the field 
name. To move all the fields back, click Clear.



Finding unique values

Finding records with unique values lets you weed out duplicate values and see what your unique value set is. 
Approach searches for unique values only in the current found set (not the entire database).
1. Find the records in which you want to look for distinct values, or show all records in the database.
2. Choose Find Special from the Browse menu.

In a worksheet or crosstab, Find Special appears in the Worksheet Find or Crosstab Find submenu.
3. Select "Find unique or distinct records."
4. Move the fields you want to check from the Database Fields list to the Fields to Search list.
5. Click OK.
If you want to cancel a find while Approach is still searching, press ESC.

See also
Finding duplicate values 



Details: Finding unique values

Joined databases
In an Approach file with joined databases, you can find distinct records only in the current view's main database.

Moving fields to another list
To move a field to the Fields to Search list, select the field name and click Add, or double-click the field name.
To move a field back to the Database Fields list, select the field name and click Remove, or double-click the field 
name. To move all the fields back, click Clear.



Showing all records

When you're finished working with a found set, you can go back to seeing all the records in the database. This also 
returns records to their original sort order.

Click the Show All icon or choose Show All from the Browse menu. 
In a worksheet or cross-tab report, Show All appears in the Worksheet or Crosstab Find submenu.



About sorting records by data in fields
You can sort a database to rearrange records according to data in a field or a set of fields. Sorting only temporarily 
changes the order of records. 

Sorting records by a field in a view        
You can quickly sort the records in the found set using the contents of any field that appears in a view. 

Specifying a sort order        
You need to tell Approach which field or fields to use for sorting and whether the sort in each field should be 
ascending or descending. A sort field can be a text, numeric, Boolean, date, time, or calculated field.

Changing the sort order        
The Sort dialog box stores the instructions you specified the last time you sorted. If you want to sort records a 
different way, you can open the dialog box again and make changes to it.

Showing records in their original order        
When you're finished working with records in a sort order, you can go back to seeing the records in their original 
order. The original order is either the order the records were created or a default sort order.

See also
Setting a default order for records 



Sorting records by a field in a view

You can quickly sort the records in the found set using the contents of any field that appears in a view. 
1. Click a field to select it.
2. Click the Ascending Sort or Descending Sort icon.

        



Specifying a sort order

You need to tell Approach which field or fields to use for sorting and whether the sort in each field should be 
ascending or descending. A sort applies only to the current found set (not the entire database).
1. Find the records you want to sort, or show all records in the database.
2. Choose Define from the Browse Sort submenu.

In a worksheet, Sort appears in the Worksheet Sort submenu.
3. Move the primary sort field from the Database Fields list to the Fields to Sort On list.
4. Select Ascending or Descending for the primary sort field.
5. If necessary, specify additional sort fields in the same way.
6. To include summary fields in the sort, click Summaries, move any summary fields you want to sort on to the 

Fields to Sort On list, select a Summarized On option (if necessary), and click OK.
7. Click OK.



Details: Specifying a sort order

Approach SmartIndex
Approach automatically creates an index the first time you find or sort on a field. This makes any subsequent finds or 
sorts on that field go faster.

Sort fields
A sort field can be a text, numeric, Boolean, date, or time field, or a calculated field that returns text or a number, 
Boolean value, date, or time. You can sort records by text fields in alphabetical order, by numeric fields in numerical 
order, by Boolean fields using Yes or No, and by date and time fields in chronological order.
The first field you specify is the primary sort field. Approach sorts the records by the contents of that field. You can 
also specify other sort fields for Approach to use in case any records have the same value in the primary field. For 
example, you might use Last Name as a primary sort field and First Name as an additional sort field.

Moving fields to another list
To move a field to the Fields to Sort On list, select the field name and click Add, or double-click the field name.
To move a field back to the Database Fields list, select the field name and click Remove, or double-click the field 
name. To move all the fields back, click Clear.
The Database Fields list shows the names of fields for the database selected in the Database Fields drop-down list 
(just above the list). If a field you want is in a different database joined to the current Approach file, select the name of
the database in the drop-down list.

Ascending or descending order
Ascending sorts text from A to Z, numbers from lowest to highest, and dates and times from earliest to latest. If a text 
field has numbers and text, the sorting is 0 to 9 and then A to Z. Leading spaces are sorted before numbers and text.
Descending sorts data in the opposite direction. If a text field has numbers and text, the sorting is Z to A and then 9 to
0. Leading spaces are sorted at the end.



Changing the sort order

The Sort dialog box stores the instructions you specified the last time you sorted. If you want to sort records a 
different way, you can open the dialog box again and make changes to it.

To add another field to the end of the sort order:

Select the field name in the Database Fields list and click Add, or double-click the field name.

To remove a field from the sort order:

Select the field name in the Fields to Sort On list and click Remove, or double-click the field name.

To remove all the fields from the sort order:

Click Clear.

To change the direction in which a field is sorted:

Select the field name and select Ascending or Descending.



Showing records in their original order

When you're finished working with records in a sort order, you can go back to seeing the records in their original 
order. The original order is either the order the records were created or a default sort order.

Click the Show All icon or choose Show All from the Browse menu. 
In a worksheet or crosstab, Show All appears in the Worksheet or Crosstab Find submenu.



Creating a find request



Repeating a search



Finding duplicate values



Finding unique values



Showing all records



Specifying a sort order



Changing the sort order



Showing records in their original order



Finding records with multiple criteria (And)



Finding records with one of several criteria (Or)



Finding text with wildcards



Finding case-sensitive text



Finding a word that sounds like another



Finding numbers, dates, and times



Finding values in a range



Finding today's date



Finding radio button and checkbox settings



Finding nonblank fields



Using an If statement to find data



Sorting records by a field in a view



Functions
Functions are predefined routines that perform specific operations. Approach provides functions for many common 
tasks you may need in your work. Rather than defining a routine yourself, you can use one of these functions to tell 
Approach what to do.
You can use a function by itself or combine it with operators, operands, and other functions to build a more complex 
formula. 
A function has a name, a pair of parentheses, and usually a set of values called parameters for the function to 
evaluate.
Click a function for more information about it:

Abs (Absolute 
value)    

Pi 

Acos (Arc cosine)    PMT (Payment) 
Asc (ASCII)    Position 
Asin (Arc sine)    Pow (Power)    
Atan (Arc tangent)    Prefix 
Atan2 (Arc tangent 
2) 

Proper 

Avg (Average)    PV (Present value)    
Blank    Radian 
Chr (Character) Random 
Combine Replace 
Cos (Cosine)    Right 
CurrTime (Current 
time)    

Round 

Date    SAverage (Summary
average)    

DateToText SCount (Summary 
count)    

Day Second 
DayName Sign 
DayOfWeek Sin (Sine)    
DayOfYear SLN (Straight-line 

depreciation)    
Degree SMax (Summary 

maximum)    
Exact SMin (Summary 

minimum) 
Exp 
(Exponentiation)    

SNPV (Summary net
present value)    

Factorial Soundslike 
Fill Span 
FV (Future value) SpanUntil 
Hour Sqrt (Square root) 
Hundredth SSTD (Summary 

standard deviation)   
If SSum (Summary 

sum) 
IsBlank STD (Standard 



deviation) 
IsLastRecord SVAR (Summary 

variance) 
Left Tan (Tangent)    
Length TextToBool (Text to 

Boolean)    
Like TextToDate    
Ln (Natural 
logarithm)    

TextToTime    

Log (Logarithm) Time 
Lower (Lowercase) Today 
Middle Translate 
Minute Trim 
Mod Trunc (Truncate)    
Month Upper (Uppercase)   
MonthName Var (Variance)    
NPeriods (Number 
of periods)    

WeekOfYear    

NumToText 
(Number to text) 

Year    

See also
Setting up a formula for a calculated field    



Abs (Absolute value) 

Returns the absolute value of a number. The absolute value is the positive equivalent of the number.
Format    Abs(number)
Examples

Abs(6.8) equals 6.8
Abs(0) equals 0
Abs(Total) equals 10, where the Total field contains -10



Acos (Arc cosine) 

Returns the trigonometric arc cosine of a number between -1 and 1. The arc cosine is expressed in radians in the 
range 0 to pi.
Format    Acos(number)
Example

Acos(0.75) equals 0.7227342478134



Asc (ASCII) 

Returns the ASCII numeric value of a character. If a string is entered as a parameter, Asc returns a value only for the 
first character in the string.
Format    Asc(character)
Examples

Asc('a') equals 97
Asc('Aqua') equals 65



Asin (Arc sine) 

Returns the trigonometric arc sine of a number between -1 and 1. The arc sine is expressed in radians in the range -
pi/2 to pi/2.
Format    Asin(number)
Example

Asin(0.5) equals 0.5235987755983



Atan (Arc tangent) 

Returns the arc tangent of a number. The arc tangent is expressed in radians in the range -pi/2 to pi/2.
Format    Atan(number)
Example

Atan(-1.25) equals -0.8960553845713



Atan2 (Arc tangent 2) 

Returns the arc tangent of number1/number2. The arc tangent is expressed in radians in the range -pi to pi.
Format    Atan2(number1,number2)
Example

Atan2(0.75,-1.25) equals 2.6011731533192



Avg (Average) 

Calculates the average of values in a number list within a record. If any fields in the number list are blank, those fields
are not included in the average.
Format    Avg(number list)
Examples

Avg(2.8,-5.6,14,5.9) equals 4.275
Avg(Score1,Score2,Score3) equals 4, where the Score1 field contains 3, Score2 contains 8, and Score3 

contains 1
Avg(Score1,Score2,Score3) equals 5.5, where the Score1 field contains 3, Score2 contains 8, and Score3 is 

blank



Blank 

Returns a value if the field is blank; otherwise, returns the value in the field.
Format    Blank(field,value)
Examples

Blank(Cost,2.75) equals 3.95, where the Cost field contains 3.95
Blank(Cost,Minimum) equals 2.5, where the Cost field is blank and Minimum contains 2.5



Chr (Character) 

Returns the ASCII character for a number.
Format    Chr(number)
Examples

Chr(97) equals a
Chr(65) equals A



Combine 

Concatenates all text strings in a list to form one text string.
Format    Combine(list)
Examples

Combine('Monthly ','Expenses') equals Monthly Expenses
Combine(FirstName,' ',LastName) equals Mary Jones, where the FirstName field contains Mary and LastName 

contains Jones (The second parameter is a space.)
Combine(City,', ',State,' ',Zip) equals San Francisco, California 94504, where the City field contains San 

Francisco, State contains California, and Zip contains 94504
Combine(Company,Chr(10),Chr(13)) equals Blue Moon followed by a return and a new line, where the Company

field contains Blue Moon



Cos (Cosine) 

Returns the trigonometric cosine of an angle. The angle must be expressed in radians. The result is always between -
1 and 1.
Format    Cos(angle)
Example

Cos(1.243) equals 0.3219574751143



CurrTime (Current time) 

Returns the current time on the system clock. This function does not use any parameters.
Format    CurrTime()
Example

CurrTime() equals 1:15:00, where the system-clock time is 1:15:00



Date 

Returns a date corresponding to numbers in the month, day, and year parameters. 
Format    Date(month,day,year)
Example

Date(10,31,1993) equals October 31, 1993



DateToText 

Converts a date to a text string, for use with formulas involving text or text-oriented functions or for display or export. 
The format of the string is determined by the format parameter.
Format    DateToText(date,format)
Example

DateToText(Date,'MMM DD, YYYY') equals Jan 11, 1994, where the Date field contains the date 1/11/94



Day 

Returns a number from 1 to 31 representing the day of the month for a date.
Format    Day(date)
Examples

Day('10/31/93') equals 31
Day(Date) equals 25, where the Date field contains the date 3/25/94



DayName 

Returns the name of the day corresponding to a number or a date. The number must be from 1 to 7, with 1 being 
Sunday.
Format    DayName(number) or DayName(date)
Examples

DayName(5) equals Thursday
DayName('1/1/94') equals Saturday
DayName(Date) equals Sunday, where the Date field contains the date 1/2/94



DayOfWeek 

Returns a number representing the day of the week in a date. The number is from 1 to 7, with 1 being Sunday.
Format    DayOfWeek(date)
Examples

DayOfWeek('1/1/94') equals 7
DayOfWeek(Date) equals 7, where the Date field contains the date 1/1/94



DayOfYear 

Returns a number representing the number of days since January 1 of the year in a date.
Format    DayOfYear(date)
Example

DayOfYear('2/1/94') equals 32



Degree

Converts a number from radians to degrees. Radians are the result of all trigonometric functions.
Format    Degree(radians)
Example

Degree(2) equals 114.5915590261646



Exact 

Performs a case-sensitve comparison of text1 and text2. If the two strings match exactly, the function returns Yes; if 
they do not match, the function returns No.
Format    Exact(text1,text2)
Examples

Exact('receipts','receipts') equals Yes
Exact ('ORDER','Order') equals No



Exp (Exponentiation) 

Calculates the constant e to the power of a number. The constant e is the base of the natural logarithm, equal to 
2.718281828545904.
Format    Exp(number)
Example

Exp(5) equals 148.413159102657660



Factorial 

Returns the factorial of a number.
Format     Factorial(number)
Example

Factorial(4) equals 4*3*2*1 equals 24



Fill 

Returns a text result containing repeated instances of text. The text is repeated the number of times specified by a 
number.
Format    Fill(text,number)
Example

Fill('Baden',2) equals BadenBaden



FV (Future value) 

Calculates the future value of an investment given a payment, a periodic interest rate, and a number of periods.
Format    FV(payment,rate,periods)
Example

To calculate the value of an investment in which you pay $50 per month for five years at 11% annual interest, the 
formula is as follows:
FV(50,.11/12,5*12) equals 3975.90 (The second parameter specifies the rate as 11% over 12 months.)



Hour 

Returns a number representing the hours in a time.
Format    Hour(time)
Examples

Hour('10:12:19') equals 10
Hour(Time) equals 9, where the Time field contains the time 9:12:19



Hundredth 

Returns a number representing the hundredths of a second in a time.
Format    Hundredth(time)
Examples

Hundredth('12:15:23.34') equals 34
Hundredth(Time) equals 14, where the Time field contains the time 8:15:30.14



If 

Evaluates a condition for true or false, and returns a true value or a false value.
You can nest an If function inside the main If function to evaluate a true value or false value.
Format    If(condition,true value,false value)
Examples

If(State='CA','Yes','No') equals No, where the State field contains the text AZ
If(Total>=1000,50,0) equals 50, where the Total field contains a value greater than or equal to 1000
If(Amount<1000,0,If(Amount<2000,50,100))

equals 0, where the Amount field contains a value less than 1000
equals 50, where the Amount field contains a value greater than 1000 and less than 2000
equals 100, where the Amount field contains a value greater than 2000

If(Amount>1000 AND Type='B',200,100)
equals 200, where the Amount field contains a value greater than 1000 and the Type field contains B
equals 100, where the Amount field contains a value less than 1000 or the Type field does not contain B



IsBlank 

Returns Yes if a field is blank; otherwise, returns No.
Format    IsBlank(field)
Examples

IsBlank(Customer) equals No, where the Customer field contains a value
If(IsBlank(Quantity),0,100) 

equals 0, where the Quantity field is blank 
equals 100, where the Quantity field contains a value



IsLastRecord 

Returns Yes if the current record is the last record in the sort order of the found set; otherwise, returns No.
Format    IsLastRecord()



Left 

Returns a text result containing the specified number of characters in text, counting from the left.
Format    Left(text,number)
Examples

Left('Mississippi',2) equals Mi
Left(State,2) equals Ca, where the State field contains California
Combine(Alpha1,Left(Alpha2,3)) equals ABCDEF, where the Alpha1 field contains ABC and the Alpha2 field 

contains DEFG



Length 

Returns the number of characters in a text string, including all spaces, numbers, and special characters.
Format    Length(text)
Examples

Length('Customer No.') equals 12
Length(SalesRep) equals 5, where the SalesRep field contains Jerry
Length(Combine(Item1,Item2)) equals 11, where the Item1 field contains Orange and the Item2 field contains 

Lemon



Like 

Performs a case-insensitive comparison of text1 and text2. If the two strings match (without considering case), the 
function returns Yes; if they do not match, the function returns No.
You can use a wildcard in text2. An asterisk (*) represents any number of characters including zero or no characters, 
and a question mark (?) represents one character.
Format    Like(text1,text2)
Examples

Like('Cola','cola') equals Yes
Like ('their','th*r') equals Yes
Like('their','th?r') equals No
Like(Color1,Color2) equals Yes, where the Color1 field contains red and Color2 contains R?D
Like(SalesRep,Combine('*',Contact,'*')) 

equals Yes, where the SalesRep field contains Jerry and Contact contains er
equals No, where the SalesRep field contains Jerry and Contact contains H

If(Like(SalesRep,Contact),'Match','No Match')
equals Match, where the SalesRep field contains Jerry and Contact contains Jerry
equals No Match, where the SalesRep field contains Jerry and Contact contains Keng



Ln (Natural logarithm) 

Returns the natural logarithm of a positive number. This is the logarithm to the base e.
Format    Ln(number)
Example

Ln(10) equals 2.302851



Log (Logarithm) 

Calculates the logarithm of a number to the base 10 (decimal logarithm). The value calculated is the power to which 
10 is raised to produce the number.
Format    Log(number)
Example

Log(1000) equals 3



Lower (Lowercase) 

Converts all letters in text to lowercase.
Format    Lower(text)
Examples

Lower('Gourmet Emporium') equals gourmet emporium
Lower(Country) equals usa, where the Country field contains USA



Middle 

Extracts characters from text, beginning at the start position and containing the number of characters specified by 
size.
Format    Middle(text,start,size)
Examples

Middle('Germany',4,3) equals man
Middle(Product,2,4) equals ppro, where the Product field contains Approach



Minute 

Returns a number representing the minutes in a time.
Format    Minute(time)
Examples

Minute('12:10:05') equals 10
Minute(Time) equals 11, where the Time field contains the time 12:11:05



Mod 

Divides number1 by number2 and returns the remainder. The result is the modulus.
Format    Mod(number1,number2)
Examples

Mod(12,5) equals 2
Mod(Order,3) equals 1, where the Order field contains 16
Mod(Order,Stock) equals 3, where the Order field contains 8 and Stock contains 5
If(Mod(Total,2)=0,'Even','Odd')

equals Even, where the Total field contains 8
equals Odd, where the Total field contains 3



Month 

Returns a number representing the month in a date.
Format    Month(date)
Examples

Month('10/20/93') equals 10
Month(Date) equals 12, where the Date field contains the date 12/05/94



MonthName 

Returns the name of the month corresponding to a number or a date. The number must be from 1 to 12, with 1 being 
January.
Format    MonthName(number) or MonthName(date)
Examples

MonthName(9) equals September
MonthName('10/20/93') equals October
MonthName(Date) equals March, where the Date field contains the date 3/29/94
Combine('Sales for ',MonthName(Date),' ',Year(Date)) equals Sales for July 1994, where the Date field contains 

the date 7/6/94



NPeriods (Number of periods) 

Calculates the number of periods necessary to pay off a principal with a periodic payment at a given periodic interest 
rate.
Format    NPeriods(rate,principal,payment)
Example

To calculate the number of $100 monthly payments required to pay off a $1000 loan with a monthly interest rate 
of 1 percent, the formula is as follows:
NPeriods(.01,1000,100) equals 11



NumToText (Number to text) 

Converts a number to a text string, for use with formulas involving text or text-oriented functions or for display or 
export. 
The format of the string is determined by the format parameter. A zero (0) in the parameter specifies a required digit, 
and a number sign (#) specifies a non-required digit.
Format    NumToText(number,format)
Examples

NumToText(200,'##0.00') equals the text string 200.00
NumToText(5694.08,'$##,##0.00') equals the text string $5,694.08



Pi 

Returns the constant 3.14159. This function does not use any parameters.
Format    Pi()
Example

Pi() 15 equals 47.124



PMT (Payment) 

Calculates the payment required to pay off a loan given a principal, a periodic interest rate, and a number of periods.
Format    PMT(principal,rate,periods)
Example

To finance $92,000 toward the purchase of office equipment at an annual interest rate of 6.9% over 48 monthly 
payments, the formula is as follows:
PMT(92000,.069/12,48) equals $2198.79 (The second parameter specifies the rate as 6.9% over 12 months.)



Position 

Beginning at the start position, scans text for the first occurrence of a search string and returns a number indicating 
where the string was found in text. If text does not contain the search string, the result is zero.
Format    Position(text,search string,start)
Examples

Position('Mississippi','iss',3) equals 5
Position(City,' ',1) equals 7, where the City field contains Mexico City (The space is the search string.)
Left(Region,Position(Region,' ',1),-1) equals West, where the Region field contains West Central



Pow (Power) 

Returns the value of number1 raised to the power of number2.
Format    Pow(number1,number2)
Examples

Pow(2,3) equals 8
Pow(30,8) equals 656,100,000,000



Prefix 

Returns Yes if all the characters in text1 match the same number of characters at the start of text2; otherwise, returns
No.
Format    Prefix(text1,text2)
Example

Prefix('quo','quantity') equals No
Prefix(Item1,Item2) equals Yes, where the Item1 field contains Aqua and the Item2 field contains Aqua Spring 

Water



Proper 

Converts the first letter of each word in text to uppercase and all other letters to lowercase.
Format    Proper(text)
Examples

Proper('SOS') equals Sos
Proper('europe') equals Europe
Proper(Region) equals Asia, where the Region field contains asia



PV (Present value) 

Calculates the present value of an ordinary annunity given a payment, a periodic interest rate, and a number of 
periods. An ordinary annunity is a series of payments to be made at equally spaced intervals. The present value is 
the value in today's dollars of the payments to be made or received later.
Format    PV(payment,rate,periods)
Example

If an annuity returns $250.50 per year for 5 years and the discount rate is 12%, the formula is as follows:
PV(250.5,0.12,5) equals 902.996438 (This means that the present value of the annuity is $903.)



Radian 

Converts a number from degrees to radians.
Format    Radian(degrees)
Examples

Radian(90) equals 1.5708
Radian(30) equals 0.5236



Random 

Returns a random number between 0 and 1. This function does not use any parameters.
Format    Random()
Examples

Random() equals a random number between 0 and 1
Trunc(Random()*10)+1 equals a random number between 1 and 10



Replace 

Beginning at the start position, substitutes the series of characters in original text with others in replacement text. The
size parameter specifies the number of characters to replace in the original text. The replacement text can be longer 
or shorter than the number specified in size, resulting in a new character string of a different length.
Format    Replace(original text,start,size,replacement text)
Example

Replace('Alan',3,1,'le') equals Allen



Right 

Returns a text result containing the specified number of characters in text, counting from the right.
Format    Right(text,number)
Examples

Right('sideview',4) equals view
Right(Region,4) equals Asia, where the Region field contains Southeast Asia
Right(Item,Length(Item) - Position(Item,' ',1)) equals Cola, where the Item field contains Diet Cola (This returns 

the text to the right of the space in Item, as specified by the Position function.)
Combine(Alpha1,Right(Alpha2,3)) equals ABCGHI, where the Alpha1 field contains ABC and the Alpha2 field 

contains DEFGHI



Round 

Rounds a number to the number of decimal places specified by precision. If the precision is zero or not specified, 
Approach rounds the number to the nearest integer.
Format    Round(number,precision)
Examples

Round(23.789) equals 24
Round(Amount,1) equals 23.8, where the Amount field contains 23.789



SAverage (Summary average) 

Returns the average of the values in a number field for a summary range of records. If the field is blank in any of the 
records, those records are not included in the average.
Format    SAverage(number field)
Example

SAverage(Amount) equals 3, where the Amount field contains 2, 3, 1, and 6 in a summary range of records
SAverage(Amount) equals 2, where the Amount field contains 2, 3, and 1 in three records and is blank in the 

fourth record in a summary range



SCount (Summary count) 

Returns the number of nonblank occurrences in a field for a summary range of records. Fields with blank values are 
not counted.
Format    SCount(field)
Example

SCount(Paid) equals 2, where the Paid field contains a value in two records in a summary range



Second 

Returns a number representing the number of seconds in a time.
Format    Second(time)
Examples

Second('10:35:18') equals 18
Second(Time) equals 20, where the Time field contains the time 8:45:20



Sign 

Returns -1, 0, or 1, representing whether a number is negative, zero, or positive.
Format    Sign(number)
Examples

Sign(21) equals 1
Sign(-21) equals -1



Sin (Sine) 

Returns the trigonometric sine of an angle. The angle must be expressed in radians.
Format    Sin(angle)
Example

Sin(1.243) equals 0.946754131



SLN (Straight-line depreciation) 

Calculates the straight-line depreciation of an asset for a single period, given a cost, salvage, and life.
Format    SLN(cost,salvage,life)
Example

SLN(7500,3000,10) equals 450



SMax (Summary maximum) 

Returns the largest number or latest date or time in a field for a summary range of records. The field can be a 
number, date, or time field.
Format    SMax(field)
Example

SMax(Amount) equals 200, where the Amount field contains 25, 40, 200, and 75 in a summary range of records



SMin (Summary minimum) 

Returns the smallest number or earliest date or time in a field for a summary range of records. The field can be a 
number, date, or time field..
Format    SMin(field)
Example

SMin(Amount) equals 25, where the Amount field contains 25, 40, 200, and 75 in a summary range of records



SNPV (Summary net present value) 

Calculates the net present value of an investment based on a series of periodic cash flows (value) and a discount 
rate. The net present value of an investment is today's value of a series of future payments (negative values) and 
income (positive values).
Format    SNPV(value,discount rate)
Example

Suppose that if you invested $12,000 one year from today, the investment would generate an annual income of 
$1500, $4000, $3500, and $4100 in the four following years. Assuming an annual discount rate of 8 percent, the 
formula is as follows:
SNPV(Payment,.08) equals -1286.78, where the Payment field contains the values -12000, 1500, 4000, 3500, 

and 4100.



Soundslike 

Returns Yes if text1 sounds phonetically like text2.
Format    Soundslike(text1,text2)
Example

Soundslike('fill','Phil') equals Yes



Span 

Returns the number of characters in text1 that also exist in text2 until a character is found that is not in text2. 
Format    Span(text1,text2)
Examples

Span('automobile','muato') equals 6
Span(OrderNo,PartNo) equals 0, where the OrderNo field contains 23241 and the PartNo field contains 413



SpanUntil 

Returns the number of characters in text1 that are not in text2 until a character is found that is also in text2.
Format    SpanUntil(text1,text2)
Example

SpanUntil('radio','eiu') equals 3



Sqrt (Square root) 

Returns the square root of a number.
Format    Sqrt(number)
Examples

Sqrt(13.69) equals 3.7
Sqrt(100) equals 10



SSTD (Summary standard deviation) 

Calculates the standard deviation of a population given the entire population as a field within a summary range of 
records. The standard deviation is a measure of how widely values are dispersed from the average value (the mean).
Format    SSTD(number field)
Example

SSTD(Score) equals 1.87, where the Score field contains 2, 3, 1, and 6 in a summary 



SSum (Summary sum) 

Returns the sum of all the values in a number field for a summary range of records.
Format    SSum(number field)
Example

SSum(Amount) equals 375, where the Amount field contains 100, 25, 50, and 200 in a summary range of 
records



STD (Standard deviation) 

Calculates the standard deviation of a population given the entire population as parameters. The standard deviation 
is a measure of how widely values are dispersed from the average value (the mean).
Format    STD(number list)
Example

STD(4,5,9,2) equals 2.549510



SVAR (Summary variance) 

Calculates the variance of a population given the entire population as a summary range of records.
Format    SVAR(number field)
Example

SVar(Score) equals 3.5, where the Score field contains 2, 3, 1, and 6 in a summary range of records



Tan (Tangent) 

Returns the trigonometric tangent of an angle. The angle must be expressed in radians.
Format    Tan(angle)
Example

Tan(1) equals 1.557407725



TextToBool (Text to Boolean) 

Returns No if the first character in text is F, f, N, n, or zero; otherwise, returns Yes.
Format    TextToBool(text)
Example

TextToBool(False) equals No



TextToDate 

Converts text to a date value, for use with formulas involving dates or date-oriented functions. 
The date string must in the format MM/DD/YY (or whatever date format is specified in the Windows International 
Control Panel).
Format    TextToDate(text)
Example

TextToDate('1/11/94') + 30 equals 2/10/94



TextToTime 

Converts text to a time value, for use with formulas involving times or time-oriented functions. 
The time string must be in the format HH:MM:SS.00 (the seconds are optional). You can also use AM or PM at the 
end of the time. (Some countries use a different separator than the colon. Use whatever time separator is specified in
the Windows International Control Panel.)
Format    TextToTime(text)
Example

TextToTime('11:30PM') equals 23:30:0.0



Time 

Returns a time corresponding to numbers in the hours, minutes, seconds, and hundredths parameters. 
Format    Time(hours,minutes,seconds,hundredths)
Example

Time(2,15,30,0) equals 2:15:30



Today 

Returns the current system date. This function does not use any parameters.
Format    Today()
Example

Today() equals 2/14/94, where the system date is February 14,1994



Translate 

Replaces all occurrences of character1 with character2 in text.
Format    Translate(text,character1,character2)
Example

Translate('grey','e','a') equals gray



Trim 

Returns a text string without its leading and trailing spaces.
Format    Trim(text)
Examples

Trim('New York      ') equals New York
Trim(City) equals Paris, where the City field contains ' Paris '



Trunc (Truncate) 

Truncates a number to the number of decimal places specified by precision. If the precision is zero or not specified, 
Approach truncates the number to an integer.
Format    Trunc(number,precision)
Examples

Trunc(13.1374,2) equals 13.13
Trunc(13.1374) equals 13



Upper (Uppercase) 

Converts all letters in text to uppercase.
Format    Upper(text)
Examples

Upper('Ca') equals CA
Upper(Country) equals KENYA, where the Country field contains Kenya



Var (Variance) 

Returns the variance of a population given the entire population as parameters.
Format    Var(number list)
Example

Var(1,4,7) equals 6



WeekOfYear 

Returns a number representing the number of weeks since January 1 of the year in a date.
Format    WeekOfYear(date)
Example

WeekOfYear('11/15/1993') equals 47



Year 

Returns a number representing the year within which a date occurs. 
Format    Year(date)
Examples

Year('10/21/93') equals 1993
Year(Date) equals 1994, where the Date field contains the date 1/1/94



alias
A "copy" of a database file, for use in special types of joins. An alias is not an actual duplicate of a database, but 
another listing of it for the purposes of joining. Most often, you use an alias to join a database to itself.



Approach file
A file that stores forms, reports, and other views. The Approach file does not store any data, but provides a "window" 
into data in associated database files. When you create a database file, Approach automatically creates an Approach 
file for it.



Approach file password
A text string a user must enter to be able to create views, join databases, or go to Design in an Approach file. You can
give your Approach files a password to keep other users from making design changes to them.



area chart
A chart that shows trends in data over time by emphasizing the area under the curve created by each data series.



arithmetic expression
An expression that performs a basic calculation on two numeric, date, or time values.



ascending order
A sort order that sorts records from A to Z for text (case-insensitive), lowest to highest for numbers, and earliest to 
latest for dates and times.



bar chart
A chart that shows individual values represented by bars.



body
The part of a report that shows data from records. A body appears between a header and footer.



Boolean field
A field that stores a value of True or False.



Browse
The environment in Approach that you use to work with information in a database. You can enter and edit data, find 
and sort records, and print views in Browse. 



calculated field
A field that stores the result of a formula. You enter the formula as part of the field's definition, and Approach 
calculates the result and displays it in the field. A calculated field is stored in an Approach file.



checkbox
A type of field object that has a Checked value and an Unchecked value. You turn the checkbox on or off in Browse to
enter the value in the field. Usually, a field has only one checkbox. 



client
A computer used to get access to files or applications on a network.



column gutter
The area near the top of worksheets and crosstabs. You drag fields into the column gutter to add them to a worksheet
or crosstab.



comparison expression
An expression that compares two values and returns a result of Yes or No.



compound document
A document that contains a linked or embedded OLE object. If you have an OLE object from another application in an
Approach file, the Approach file is a compound document.



constant
A literal value in a formula. When calculating a formula, Approach uses the constant in every record.



container application
An application that contains an OLE object. If you have an OLE object from another application in an Approach file, 
Approach is the container application.



context-sensitive menu (Browse)
A menu in Browse that changes depending on the current selection or view. This menu can be called Browse, 
PicturePlus, Worksheet, or Crosstab and provides commands appropriate for that type of element.



context-sensitive menu (Design)
A menu in Design that changes depending on the current selection or view. This menu can be called Form, Report, 
Letter, Mailing Label, Worksheet, Crosstab, Chart, Object, Text, or Panel and provides commands appropriate for that
type of element.



crosstab
A view used for organizing and summarizing data from many records into categories and groups. A crosstab shows 
summaries of underlying database records that are grouped by any database field.



current record
The active record in a view in Browse. You can enter and edit data in the current record.



data entry order
The order in which you move through the fields in a view when you press TAB. (You can also press ENTER to move 
through fields if your preferences are set this way.) Sometimes referred to as tab order in other applications.



data object
An OLE object you can create in Approach from a range of worksheet or crosstab cells.



database
A collection of data organized into fields and records.



database file
A file that stores data. The data you see and work with in an Approach file is stored in one or more database files.



database password
A text string a user must enter to be able to open an Approach file. The password grants the user read-only access or
read/write access to data associated with the file.



date field
A field that can hold a single date. You can perform finds and sorts on dates in a date field.



default style
A named style that you define to be the preset style for new views. When you create a view using an Assistant, you 
can apply the default style or one of the SmartMaster styles to the view.



descending order
A sort order that sorts records from Z to A for text (case-insensitive), highest to lowest for numbers, and latest to 
earliest for dates and times.



delimited text file
A text file that uses separators such as commas, spaces, or tabs to break up the text into discrete units. If you open a
delimited text file as a database in Approach, the units of text become fields.



Design
The environment in Approach that you use for laying out forms, reports, form letters, and mailing labels. 



design object
A graphic element that you can move, resize, and modify as a whole in Design. Fields, lines, rectangles, and macro 
buttons are examples of design objects.



detail database
A joined database that provides secondary information in a view. For example, a detail database for an invoice form 
might provide customer names and addresses. A view can have one main database and many detail databases.



drop-down list
A predefined list of values from which you select in Browse to enter data in a field. The drop-down list appears when 
you click in or tab to the field.



embed
To insert an OLE object in Approach. You can embed an object in a PicturePlus field or in the background of a view.



expression
A combination of operators, operands, and functions that yields a single result. A formula can consist of one or more 
expressions.



field
A category of information in a database. For example, in an invoice database the fields might be for invoice number, 
date, name, and amount due.



field box
An editable area in a view that holds a field value. You can type in the field box in Browse to enter data in the field.



field definition
A set of attributes that includes the field name, the type of data the field can contain, a maximum field length for some
field types, and optional data entry settings. Every field in a database must have a definition.



field label
The text used to identify a field in a view. A field label often corresponds to the field name.



field mapping
The relationship between fields in two databases (when importing data) and between fields in an Approach file and a 
database file.



field name
A name for a field stored as part of the field definition.



field reference
In a formula, a reference to another field. When calculating the formula, Approach uses the value in the referenced 
field from the current record.



field type
A specification for the type of data you can enter in a field. The possible field types are Boolean, calculated, date, 
memo, numeric, PicturePlus, text, time, and variable.



file type
A specification for the way a program stores and organizes data in files. In Approach, you can use a variety of 
database file types.



find
To search for and display a set of records based on data in one or more fields.



Find
The environment in Approach that you use to search for data in records. You specify search criteria in Find; when 
Approach finds records that match the criteria, it returns you to Browse and displays only those records. 



find request
A blank view used for entering search criteria.



fixed-length text file
A text file in which the text is broken into blocks of a specific length. If you open a fixed-length text file as a database 
in Approach, the blocks of text become fixed-length fields.



font
A set of characters in one design, size, and style.



footer
A design element that repeats at the bottom of each page in a previewed or printed report, worksheet, or crosstab.



form
A view typically used for entering data. When working with a form, you see one record at a time.



form letter
A letter view that usually combines names and addresses from a database record with typed text.



found set
A group of records that match your search criteria. When Approach finds records that match the criteria, it displays 
them as the found set.



full record locking
A method of network data-sharing in which only one user at a time can edit a record.



function
A predefined formula you can use in a calculated field. Approach provides functions for conversion, date, financial, 
logical, mathematical, statistical, summary, text, time, and trigonometric operations.



grid
A non-printing matrix of dotted lines that you can show in Design. The grid provides a background to help you lay out 
objects in a view. 



handles
Squares at the edges of a selected design object. You can drag a handle to resize the object.



header
A design element that repeats at the top of each page in a previewed or printed report, worksheet, or crosstab.



icon bar
A bar at the top of the Approach work area that has SmartIcons you can click to apply a command. Approach 
provides default icon bars, and you can create custom icon bars of your own.



index
A compilation of all the values in a field. Finds and sorts on a field go faster if the field has an index. Approach can 
compile the index as you enter data or when you first find or sort.



InfoBox
A window that stores object properties, such as lines and colors, text attributes, and macro settings. Every design 
object in a view has an InfoBox with properties. You can keep the InfoBox open as you work, and use it to edit 
objects.



join
To link two databases on a common field. When multiple databases are joined in an Approach file, the file can have 
views that use data from all the joined databases.



join field
The linked field in two joined databases. Often, a join field is an ID field created specifically for joining.



key field
A field or group of fields with a value that uniquely identifies each record    (for example, an invoice number). Paradox 
database files in Approach require a key field.



line chart
A chart that shows each value in a data series as a data point connected by a line.



link
To place a copy of an OLE object in Approach, with a connection to the original object in the source application. If the 
original object changes, the copy also changes in Approach. You can link an OLE object in a PicturePlus field or in 
the background of a view.



logical expression
An expression that compares or changes the result of comparison expressions and returns a result of Yes or No. A 
logical expression allows you to define more complex conditions than you can with comparison expressions alone.



lookup
An automatic display of data from a many-to-one or one-to-one relationship.



macro
A single command that executes a sequence of other commands. You define this sequence when you create the 
macro.



macro button
An object that you can add to a form, report, or other view. When you click a button, it executes an attached macro.



mailing label
A view that displays database fields and text you type in a mailing address format.



main database
A joined database that provides the basis for a view. For example, an invoice view would use an invoice database as 
its main database. A view shows all of the records from the main database.



many-to-many
A relationship in which two or more records in one database are related to two or more records in a joined database. 
For example, each order can include several products, and each product can appear on several orders.



many-to-one
A relationship in which two or more records in one database are related to only one record in a joined database. For 
example, several employees can be in the same department.



map
To associate fields in an Approach file with fields in a database file. You need to map fields when importing data or an 
Approach file. You may also need to map fields when opening an Approach file if you have made changes to a 
database file without saving them in the Approach file.



memo field
A field that corresponds to a memo file. Because the data is stored in a separate file, you can store much more data 
in a memo field than you can in other types of fields.



named style
A set of InfoBox properties that you name and save as a group. You can apply a named style to an object, rather than
applying individual properties to it using the InfoBox.



numeric field
A field that can hold numbers and numeric symbols (such as a decimal point and a currency sign). You can perform 
arithmetic calculations on data in a numeric field.



OLE (Object Linking and Embedding)
A method for transferring and sharing objects between applications.



OLE object
An object you embed or link in Approach through OLE. You can double-click an OLE object to edit it using the tools 
from the source application without leaving Approach. Charts, sound files, and data ranges are examples of OLE 
objects.



one-to-many
A relationship in which a record in one database is related to two or more records in a joined database. For example, 
one department can have several employees. In a form, you use a repeating panel to represent the "many" data from
a one-to-many relationship.



one-to-one
A relationship in which a record in one database is related to only one record in a joined database. For example, a 
vehicle number can be related to a license number for a single vehicle.



operand
A value to be operated on in a formula. Operands can be either constants or field references.



operator
A symbol in a formula that defines the calculation or other evaluation to be performed. A plus sign (+) and a less-than 
sign (<) are examples of operators.



optimistic record locking
A method of network data-sharing in which two users can edit a record at the same time. When the second user tries 
to enter changes, Approach warns that they will overwrite those of the first user.



page margins
When printing a view, the area between the printable part of the view and the edge of the paper.



parameter
A value to be operated on in a function. Parameters are enclosed in parentheses after the function name and can be 
either constants or field references.



PicturePlus field
A field that can contain graphics and OLE objects. You can also allow drawing in a PicturePlus field.



pie chart
A chart that shows each value in a data series as a slice of a pie.



point
A typographic unit of measure; about 1/72 inch.



Preview
The environment in Approach that shows views on the screen as they will appear when printed.



query file
A text file that contains log-on information and a Select statement for a SQL table. Query files allow you to quickly 
connect to a server and get access to specific information in a table.



radio button
A field object that can have a Clicked value. You usually use a set of two or more radio buttons for a field; you turn on 
one button in the set in Browse to enter its value in the field.



read-only access
Permission to read data in a database but not to modify it. You can assign a database password to your files to grant 
read-only permissions to users who know the password.



read/write access
Permission to read and modify data in a database. You can assign a database password to your files to grant 
read/write permissions to users who know the password.



record
One set of related information in a database. For example, in an invoice database each invoice is a record.



relational database application
A database application that lets you bring together data from more than one database in a single form, report, or 
other view. Approach is a relational database application.



repeating panel
A design element that displays the "many" side of a one-to-many relationship. You use a repeating panel in a form to 
show data from multiple records in a detail database. For example, a repeating panel in a department form might list 
all the department's employees.



report
A view used for organizing, summarizing, and presenting data from many records. A report shows all the records in 
the database or the current found set on one page (or on a series of pages).



row gutter
The area at the left side of a worksheet or crosstab that holds row headers. You drag a column header from a 
worksheet and drop it in the row gutter to convert a worksheet to a crosstab.



search criteria
A set of data to look for in a database, such as Tokyo in the City field. When Approach finds records that match the 
search criteria, it displays only those records.



server
A central computer that stores files and applications to which users have access across a network.



server application
An application used to create an OLE object.



SmartIcon
An icon in a bar at the top of the Approach work area. Each SmartIcon corresponds to a menu command; you can 
click an icon to apply the command more quickly than choosing from a menu.



SmartMaster layout
A predefined layout of fields on a view. You select a SmartMaster layout when you create a new view.



SmartMaster style
A predefined set of InfoBox properties for a view. You can select a SmartMaster style when you create a new view.



snap
To align objects automatically to increments on a grid in Design. The grid does not have to be showing for objects to 
"snap" to it.



sort
To organize records alphabetically, numerically, or chronologically by data in a field.



sort field
A text, numeric, date, or time field used for sorting records in a database.



status bar
A bar at the bottom of the Approach work area. The status bar has pop-up menus for changing the view, the 
environment, and the icon bar. It also provides information such as the number of records and the point size of text.



summary function
A function that applies to a range of records. For example, the SSum(Amount) summary function adds the values in 
the Amount field in a range of records you specify.



summary panel
An area in a report containing a calculated field that summarizes data.



summary report
A report that omits record-by-record detail and displays only summary information.



template
A predefined set of field definitions. Approach comes with templates already set up for several common business 
applications, such as a customer database and an employee database. You can use a template to create a new 
database rather than defining all of your fields from scratch.



text field
A field that can hold any characters you can type, including letters, numbers, and symbols. You can search on a text 
field using any character in the field.



time field
A field that can hold a single time. You can perform finds and sorts on times in a time field.



Tools palette
A set of tools in Design for drawing and editing design objects. You can drag the title bar of the Tools palette to move 
the palette around in the work area.



variable field
A field that temporarily stores a value used in calculations and macros. A variable field is part of an Approach file.



view
A form, report, form letter, set of mailing labels, worksheet, crosstab, or chart. Views are stored in an Approach file. 
Approach provides a standard form and worksheet in each Approach file, and you can also design as many custom 
views as you need. 



view object
An OLE object you can create in Approach from a single view or an entire Approach file. You can also include data in 
a view object.



view tabs
"Folder" tabs that appear at the top of the window for each view in the Approach file. You can click a tab to go to that 
view.



worksheet
A view used for organizing, summarizing, and presenting data from many records in a grid of columns and rows. A 
worksheet shows all the records in the database or the current found set on one page (or on a series of pages). Each
record occupies a single row in the worksheet.



x-axis
The horizontal axis in an area, bar, or line chart. An x-axis usually shows categories that represent information from 
the database, such as years or geographic areas.



y-axis
The vertical axis in an area, bar, or line chart. A y-axis defines the scale of values plotted in the chart.



zoom
To change the magnification of a view on the screen. You can zoom in for a closer look or zoom out for the big 
picture. Zooming does not affect the size of a view when you print it, only how it appears on the screen.



Keyboard shortcuts
Click one of these topics for information:
Using the keyboard 
Abbreviations 
Commands (Alphabetical) 
Direction keys 
Selection keys 



Using the keyboard

You can use the CONTROL key or ALT key, in combination with other keys, to open menus, choose commands, and 
select options presented in dialog boxes.
In a dialog box:

Press TAB to move from one group of options to another.

Press ALT with the appropriate letter keys to select options.



Abbreviations

Abbreviation Key
ALT Alt
BKSP Backspace
CTRL Control
DEL Delete
DOWN Down arrow
END End
HOME Home
INS Insert
LEFT Left arrow
PGDN Page Down
PGUP Page Up
RIGHT Right arrow
SH Shift
UP Up arrow



Commands (alphabetical)

Command Shortcut
Actual Size 
(100%)

CTRL+ 1

Alignment CTRL+ I
Browse CTRL+ B
Browse menu 
(open)

ALT + B

Chart menu 
(open)

ALT + R

Copy CTRL+ INS or 
CTRL+ C

Create menu 
(open)

ALT + C

Crosstab menu 
(open)

ALT + R

Cut SH + DEL or 
CTRL+ X

Delete Record CTRL+ DEL

Design CTRL+ D
Edit menu 
(open)

ALT + E

Fast Format CTRL+ M
File menu 
(open)

ALT + F

Find CTRL+ F
First Record CTRL+ HOME

Go To Record CTRL+ W
Group CTRL+ G
Help menu 
(open)

ALT + H

Hide Record CTRL+ H
Insert Current 
Time

CTRL+ SH + T

Insert Previous 
Value

CTRL+ SH + P

Insert Today's 
Date

CTRL+ SH + D

Last Record CTRL+ END

Letter menu 
(open)

ALT + L

Mailing Label 
menu (open)

ALT + M

New Record CTRL+ N



Next Record PGDN

Next View CTRL + PGUP

Object menu 
(open)

ALT + O

Open CTRL+ O
Paste SH + INS or 

CTRL+ V
Preview CTRL+ SH + B
Previous 
Record

PGUP

Previous View CTRL + PGDN

Print CTRL+ P
Refresh CTRL+ R
Report menu 
(open)

ALT + R

Save Approach 
File

CTRL+ S

Show All CTRL+ A
Show Drawing 
Tools

CTRL+ L

Show Ruler CTRL+ J
Snap to Grid CTRL+ Y
Sort CTRL+ T
Spell Check CTRL+ K
Style & 
Properties 
(InfoBox)

CTRL+ E

Text menu 
(open)

ALT + X

Tools menu 
(open)

ALT + T

Undo ALT + BKSP or 
CTRL+ Z

Ungroup CTRL+ U
Window menu 
(open)

ALT + W

Worksheet 
menu (open)

ALT + O



Direction keys

To Press
Move down one 
line

DOWN

Move left one 
character

LEFT

Move left one 
word

CTRL+ LEFT

Move right one 
character

RIGHT

Move right one 
word

CTRL+ RIGHT

Move to start of 
line

HOME

Move to end of 
line

END

Move to next 
record

PGUP

Move to 
previous record

PGDN

Move up one 
line

UP



Selection keys

To Press
Select down 
one line

SH-DOWN

Select left one 
character

SH-LEFT

Select left one 
word

CTRL+ SH + LEFT

Select right one 
character

SH + RIGHT

Select right one 
word

CTRL+ SH + 
RIGHT

Select up one 
line

SH + UP



Basics
Click one of these topics for information:
Files in Approach
Views of your data
Types of fields
Joined databases 
Basic steps for setting up a database
Glossary

See also
Work Area 



Approach files and database files

Approach files and database files
You work with two kinds of files in Approach: Approach files and database files.
An Approach file stores forms, reports, worksheets, and other views. You do all your work in Approach files, including 
entering and editing data, finding and sorting records, and organizing and printing information.
The data you see in an Approach file is stored behind the scenes in one or more database files. You do not work 
directly in a database file, but use the Approach file as a "window" into it. You can work with database files in a variety
of file formats in Approach.
When you create a new database file in Approach (or open an existing database file, spreadsheet, or text file from 
another application), Approach automatically creates and opens a new Approach file so that you can begin entering 
data. Then whenever you want to work with the data again, you open the Approach file for it rather than the database 
file.

Joining database files
You can work with data from more than one database file in an Approach file. To do this, you join the database files in 
the Approach file. A view can show data from any database file joined in that Approach file.

Filename extensions
Approach files have the filename extension .APR. The filename extension for dBASE and FoxPro database files 
is .DBF; for Paradox files is .DB; for Lotus Notes files is .NSF, and for Microsoft Access files is .MDB. SLQ tables do 
not have an extension.
For other extensions, see Filename extensions.

See also
File types 
Joined databases
About creating and opening files 



Views of your data

You can work with data in Approach in a variety of different views. Views are stored in an Approach file, and can use 
data from all of the databases joined in that Approach file.
Click a type of view for information about it:

Forms Mailing labels
Repeating 
panels (on a 
form)

Worksheets and 
crosstabs

Reports Charts
Form letters

When you create a new Approach file, it has a form and worksheet already set up. You can modify these views and 
add as many other views as you need.
Approach provides a rich set of predefined field layouts and color and style combinations called SmartMasters for 
creating custom views quickly and easily. You can also use Approach's design tools to modify views. In any view, you 
can put fields wherever you want them, import graphics and OLE objects, draw objects such as lines and rectangles, 
and customize the design in other ways.



Forms

A form shows data about one record at a time. You can page through the database to see other records in the form. 
Forms are usually used for entering and editing data about a record.

An example
You might use a form to maintain data about customers. Each copy of the form shows data for one customer record 
at a time:

Main and detail databases
If you're using only one database in the current Approach file, you see a copy of the form for each record from that 
database. 
If you have joined databases in the Approach file, the form must have a main database. You see a copy of the form 
for each record in the main database. The form can also have fields from detail databases for additional, related 
information.
To show data from a one-to-many join in a form, add a repeating panel to the form. The repeating panel's main 
database is one of the detail databases for the form.

See also
Repeating panels 
Main and detail databases in a view 
Creating a form 



Repeating panels

You can add a repeating panel to a form to show data from a one-to-many join.
In a one-to-many join, one record in a database is related to two or more records in a joined database. The repeating 
panel shows the "many" records that are related to the form's one main record.

An example
A department and employees have a one-to-many relationship: One department can have many employees. To list 
the employees for each department, join a department database to an employee database on a department ID field. 
Then set up a form based on the department database and give the form a repeating panel for the employees. The 
panel lists all the employees that have the same department ID as the current department.
The employees in this repeating panel each have 332 in their department ID field (the same ID the department has):

Main and detail databases
Like a form with joined data, a repeating panel must have a main database that provides the framework of records. 
Each line in a repeating panel displays a record from its main database. The panel in the example above uses the 
employee database as the main database.
A repeating panel can also have fields from detail databases for additional, related information.

See also
Forms 
Main and detail databases in a view 
Creating a form 
Adding a repeating panel to an existing form 



Reports

Reports let you organize and analyze information from multiple records in powerful ways. You can sort the records 
that are showing, calculate summary information for them using a summary function, and lay out and arrange record 
data however you need to.
Reports can show data from database fields, summary information calculated from field data, or a combination of the 
two. Database fields appear in the body of the report; you can edit the fields in Browse. Summary information 
appears in summary panels; you can view a summary in Preview (and in Design if Show Data is on), but you cannot 
edit it.
If a report uses data from joined databases, you see all the records from the main database as line items in the 
report's body.

A report with fields only
For example, you might design a report for quick data entry of sales records in a columnar format. This type of report 
shows only database fields:

A report with fields and totals
A second report might group and summarize the sales records by product, showing a combination of database 
records and totals:

A report with totals only
A third report might show only subtotals and a grand total for the same sales report:



See also
Main and detail databases in a view 
Creating a standard report 



Form letters

A form letter displays a combination of database fields and text you type in a business letter format. Approach creates
a copy of the letter for each record in the current found set, adding the name and address information from the 
records to the standard text you provide.
A typical form letter consists of database fields for the recipient's name and address plus a salutation, closing, and 
your return address. You can use all of these elements, or just select the ones that are appropriate.

An example
You might want to send a year-end letter to each customer you've done business with in the past year. Using the 
name and address stored in your customer database, you can have Approach create a personalized letter for each 
customer:

Spacing around fields
Because database fields might contain information of varying lengths, Approach automatically adjusts the spacing 
around fields to create a smooth flow between typed text and database fields. You see the adjusted spacing when 
you go to Preview, and in Design if Show Data is on.

See also
Creating a form letter 



Mailing labels

A mailing label is a collection of database fields from one record, normally with name and address information.
The number of mailing labels you see on a page depends on the label size and page layout you select when you 
create the labels. You can choose from more than 50 standard Avery mailing label formats or create other formats of 
your own.

An example
You might use a customer database to prepare a mailing label for all the customers who will receive a year-end letter.
Each label has data from one record:

Spacing around fields
Approach automatically positions the database fields to match the mailing label format and adjusts the spacing 
around fields. You see the adjusted spacing in Preview, and in Design if Show Data is on.

See also
Creating a mailing label 



Worksheets and crosstabs

Worksheets
A worksheet presents database records in a grid of columns and rows. The columns in a worksheet are database 
fields, and the rows are individual records:

Worksheets are often the most efficient and flexible type of view for displaying data.

Crosstabs
A cross-tabulation worksheet, or crosstab, expands on the worksheet model, allowing you to categorize and 
summarize database records. Instead of rows containing individual records, a crosstab shows cells that summarize 
underlying records grouped or categorized by any fields you select. 
You can create a simple crosstab that counts or summarizes data for groups of records, or you can create a more 
complex, multiple-level crosstab that summarizes data for groups of records by database fields. This crosstab 
summarizes sales by product and sales rep:

See also
Creating a worksheet 
Creating a crosstab 



Charts

A chart is a graphic representation of data. Charts can make complex data easier to understand and are often the 
best way to communicate and analyze data. You can create bar, line, area, and pie charts in Approach, in two or three
dimensions and in color.
All charts except pie charts plot data against a horizontal x-axis and a vertical y-axis. The x-axis can include a scale 
or categories such as years, geographic areas, or age ranges. The y-axis defines the scales of values plotted in the 
chart. You can show tick marks and labels for units of measure with an axis, and you can title each axis to describe 
the data plotted against it.
You can create a chart in Approach using the Chart Assistant or a data from a crosstab. If you use the Chart 
Assistant, you can specify the type of chart as you create it. If you create a chart from a crosstab, Approach uses the 
preset chart type (initially set to bar chart). After creating a chart, you can change it to one of the 20 chart types 
supported by Lotus Chart using the Chart InfoBox. You can also use the InfoBox to add, modify, or delete other 
elements in the chart.
For examples of charts and information about editing them using the Chart InfoBox, see Lotus Chart Help.

See also
Creating a chart using the Chart Assistant 
Creating an instant chart from a crosstab 



Types of fields

When you define a field, you give it a name and a type, and in some cases a formula or data entry options. A field's 
type determines what kind of data you can store in the field. The type may also affect how you can use the field for 
finding and sorting records and whether its data can be used in calculations. 
These are the field types you can use in Approach:

Text A text field can 
contain any 
characters you can 
type, including 
letters, numbers, 
and symbols. You 
can search on a text
field using any 
character in the 
field. A sort on a text
field is alphabetical 
in either ascending 
order (0 to 9, then A 
to Z) or descending 
order (Z to A, then 9 
to 0).

Numeric Numeric fields are 
for storing numeric 
data that you need 
to use in 
calculations or find 
or sort arithmetically.
You can sort records
by a numeric field in 
either ascending 
order (lowest to 
highest) or 
descending order 
(highest to lowest).

Memo Like text fields, 
memo fields can 
store any characters
you can type. You 
can perform a 
search on a memo 
field, but you cannot 
sort records by data 
in a memo field or 
use a memo field in 
a formula.

Boolean A Boolean field 
contains a value of 
Yes, No, Y, N, 1, or 
0. Define a Boolean 
field for information 
that requires a 



simple yes or no, 
such as whether a 
payment has been 
received.

Date A date field holds a 
single date. You can 
find and sort records
on a date field, and 
you can use a date 
in some 
calculations. A sort 
on a date field is in 
either ascending 
order (earliest to 
latest) or 
descending order 
(latest to earliest).

Time A time field holds a 
single time. You can 
find and sort records
on a time field, and 
you can use a time 
in some 
calculations. A sort 
on a time field is in 
either ascending 
order (earliest to 
latest) or 
descending order 
(latest to earliest).

PicturePlus A PicturePlus field 
can hold a graphic 
or an object that 
comes from a 
Windows application
that supports OLE 
(Object Linking and 
Embedding). Some 
common OLE 
objects are charts, 
sound files, and data
ranges. You paste or
import the graphic or
object into the field 
in a record.

Calculated A calculated field 
stores the result of a
formula. you set up 
the formula when 
you define the field, 
and Approach 
calculates the result 
and enters it in the 
field. The result can 
be a text string, a 
number, a date or 
time, or a Boolean 
value. You cannot 



edit a result in a 
calculated field.

Variable A variable field is a 
temporary storage 
area. Any data in a 
variable field is 
stored in memory, 
not on disk. A 
variable field is 
accessible 
whenever the 
Approach file in 
which it's defined is 
open. You usually 
use variable fields to
store data for a 
macro.

Calculated and variable fields are part of an Approach file rather than a database file because they do not contain 
stored data.

See also
About adding, editing, and deleting database fields 



Joined databases

It's often most efficient to split up data into separate, manageable database files -- such as one for orders, one for 
customer data, and one for product specifications. Even if you don't have a lot of data and complexity to begin with, 
data has a tendency to grow over time. A database design that groups data judiciously from the start can help you 
avoid problems later.
Approach is a relational database application, which means that you can bring together data from separate database 
files and use it as if it were all stored in one place. To do this, you join the databases in the Approach file that uses 
their data. The forms, reports, and other views in the Approach file can use data from any of the databases joined in 
that file.
Click one of these topics for more information:
How databases are joined
Main and detail databases in a view
One-to-many, many-to-one, and one-to-one relationships
Many-to-many relationships
Alias joins

See also
About joining and unjoining



How databases are joined

To join two databases, you establish a link between one or more fields the databases have in common. These are 
called the join fields. It's usually best to define one field in each database specifically to be a join field and then enter 
an ID value in that field in each record. 
When a record in one database has the same join value as a record in a joined database, the two records are 
"related."

An example
Suppose you want to compile a list of all the employees in each department in your company. Divide the data into two
database files, one for departments and one for employees, and give each file a department ID field. Then join the 
databases on the ID field:

Multiple join fields
If you do not have a field you can use as a join field, you can join databases on other fields they have in common. 
The fields must together uniquely identify records in one of the databases, such as first name, last name, and phone 
number.



Main and detail databases in a view

Each form, report, or other view that uses joined databases has one main database and one or more detail 
databases. The main database provides the basic information for that view; each record from the main database 
appears in it. A view is said to be "based on" its main database. The other joined databases act as detail databases, 
providing additional, related information to display in the view.
Each view in an Approach file can have a different main database.

Forms
In a form, each page of the view corresponds to one record in the main database. For example, this form is based on 
a department database and has one copy of the form for each department:

The employee database is used as a detail database in the department form.
A repeating panel in a form is always based on one of the form's detail databases. The panel shows all the records 
from the detail database that match the value in the main database's join field.

Reports
In a report, you see all the records from the main database as line items in the report's body. For example, this report 
is based on an employee database and lists every employee in the company grouped by department:



One-to-many, many-to-one, and one-to-one relationships

Most often, the relationship between records in two joined databases is one-to-many or many-to-one.

One-to-many
In a one-to-many relationship, a record in one database can be related to one or more records in the other database. 
For example, one department can have several employees -- or in other words, one record in a department database 
has the same department ID as several records in an employee database.
To show the result of a one-to-many relationship on a form, you add a repeating panel to a form that is based on the 
"one" database. The repeating panel is based on the "many" database, and each line in the panel is a record in that 
database. For more information, see Repeating panels.

Many-to-one
A many-to-one relationship is the reverse of one-to-many. For example, several employees can be in the same 
department -- or in other words, several records in an employee database have the same department ID as one 
record in a department database. 
On this employee form, the department data is the same for all employees in the many-to-one relationship:

Many-to-one relationships are often used as a lookup, to provide a convenient means of displaying data in a view. If 
you type a department ID on the employee form above, the department name and location for that ID appear 
automatically. 
For a lookup to work properly, the ID field must come from the main database for the view, and the fields with the 
lookup data must come from a detail database. On the employee form, the department ID field comes from the 
employee database, and the other department fields come from the department database.

One-to-one
In a one-to-one relationship, a record in one database is related to only one record in the other database. For 
example, a vehicle number in one database might be related to a license number for the vehicle in a joined database.
You don't normally need to use one-to-one relationships in Approach. You can store a single set of data (such as 
everything about one vehicle) together in a single record.



Many-to-many relationships

In a many-to-many relationship, many records in one database can be related to many records in the other database.
A set of orders for products is a common application of this. Each order can include many products, and each product
can appear on many orders. A many-to-many relationship is a one-to-many in both directions.

Joining two databases directly
You cannot set up a many-to-many relationship directly between two databases. For example, if you join an orders 
database and a products database directly on an order number, each product can appear on only one order (because
the order number becomes part of the product's record).
Similarly, if you join the two databases on a product number, each order can have only one product (because the 
product number becomes part of the order's record).

Joining through a third database
To set up a many-to-many relationship between two databases, you need to add an intermediate database. The other
databases each have a one-to-many relationship with this database.
For the orders and products databases, you might use a third database that stores the "many" line item data for the 
repeating panel on your order form:

The third database keeps the orders data out of the products database and the products data out of the orders 
database. Now each order can have many products, and each product can be on many orders. You can display one-
to-many data both on order views and on product views.



Alias joins

It's sometimes useful to join a database to itself. For example, suppose you want to keep track of which employees in
your company are managers and who they are responsible for. The employee database can have employee IDs to 
identify each employee uniquely and manager IDs to identify each person's manager by employee ID.
This can be an efficient way to use data because you don't need to duplicate the manager records in a separate 
database. But you do need a second database to express the join relationships properly.

Joining to an alias
To join a database to itself, you create a "copy" of the database in the Join dialog box. The copy is not an actual 
duplicate of the database, but only another listing of it called an alias. Once you've created the alias, you can set up a
join between the database and its alias as you do between any two databases.
For example, you can join the manager ID in an employee database to the employee ID in an alias "manager" 
database:

The manager database has a one-to-many relationship with the employee database. You can display the results of 
this self-join using a repeating panel on a form based on the manager database.
If you create more than one alias of a database, you can join one alias to another and even join an alias to a different 
database.

Names of aliased databases
When you alias a database, the name of the database is appended with a 1, and the alias has the same name as the 
database, plus a 2 (or a 3 and so on); for example, EMPLOYEE:1 and EMPLOYEE:2. 
These names appear only in the Approach file with the joins, and they do not affect the name of the database file 
itself or the name of the database in any other Approach file.



Basic steps for setting up a database

These are the basic steps for setting up a new database in Approach:
1. Create a new database file.

You can create an empty database file (without data) or start with an existing database, spreadsheet, or text file 
from another application. Approach automatically creates an Approach file for the database file. See About 
creating and opening files.

2. Define the fields of the new database file.
A field definition specifies a name and type for the field, and in some cases additional information such as a 
length or formula. When you create a new database file, you can select a template that has fields already 
defined. You can edit existing fields and add new fields to a database at any time. See About adding, editing, and
deleting database fields.

3. If you want to use data from other databases in your new Approach file, join the other databases to the new 
database file.
You can join two databases on any field they have in common. See About joining and unjoining.

4. If you want to use custom views, design the views for the new Approach file.
Approach supplies a standard form and worksheet for a new Approach file. You can also design custom views of 
your own. See About forms and repeating panels, About reports, About form letters, About mailing labels, About 
worksheets, or About crosstabs.

5. Enter data in the records.
Either type in data yourself or import it from another file. You can enter the data in the standard form or 
worksheet that Approach provides or in a custom view that you design. See About entering data in fields or 
About importing data.



Glossary

Click a term to see a definition of it:
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Approach file key field
Approach file 
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Work Area
Click one of these topics for information:
Elements of the Approach work area
Design
Browse
Find
Preview



Elements of the Approach work area

The Approach work area contains file windows, menu commands, SmartIcons, view tabs, and a status bar. Some of 
these elements change depending on which environment you're in (Design, Browse, Find, or Preview).

Menu commands
All of the Approach commands appear in menus along the top of the work area. To choose a command, click the 
menu name to open the menu and then click the command.
To see a brief description of a menu command, move the pointer over a command in its menu. The description 
appears in the window's title bar.
In Design and Browse, one of the menus is context-sensitive; it changes as appropriate for the current selection or 
current view. For details, see Design menus or Browse menus.

SmartIcons
The SmartIcons are a subset of the menu commands; they appear in an icon bar (initially set to appear just below the
menu bar). To apply a SmartIcon command, click the icon.

Approach comes with a default icon bar for Browse, Find, and Preview and for worksheets and crosstabs. For 
Design, Approach provides three default icon bars and a floating palette of icons. You can also prepare custom icon 
bars of your own.
To see a brief description of an icon, move the pointer over the icon. (Or if your icon options are set this way, click the 
icon with the right mouse button.) The description appears in a "bubble."
To show or hide the icon bar, choose Show SmartIcons from the View menu.
For descriptions of all the icons, see SmartIcons. For information about creating icon bars or changing the icon 
options, see Customizing the SmartIcon bar.

View tabs
The names of views in an Approach file appear in view tabs at the top of the file's window. To go another view, click its
view tab.

To rename a view while in Design, double-click its view tab and type in the tab.
To rearrange views in the work area while in Design, drag the tabs to move them.
To show or hide the view tabs, choose Show View Tabs from the View menu.

Status bar
The status bar at the bottom of the work area has pop-up menus for changing the view, the environment, and the icon
bar. The rest of the information in the status bar varies depending on which environment you're in. For details, see 
Design status bar or Browse status bar.
To show or hide the status bar, choose Show Status Bar from the View menu.

See also
Design Browse
Find Preview





Design

In Design, you edit the layout of forms, reports, form letters, and mailing labels. You do not work with actual data in 
Design, but you can see data and plan the arrangement of it.

To go to Design:

Click the Design icon, or choose Design from the View menu or from the environment pop-up menu in the 
status bar.

Icon bars and Tools palette
Approach provides three default icon bars in Design for manipulating design objects, text, and reports, and a floating 
Tools palette for drawing new objects. The Worksheet and Crosstab icon bars are also available in Design. The icon 
bar that is preset to appear depends on the type of the current view.
The Tools palette opens automatically when you go to Design. To move the palette, drag it by the title bar.
Click a topic for descriptions of icons:

Design icon bar Tools palette
Report icon bar Worksheet icon 

bar 
Text icon bar Crosstab icon 

bar 

Other window elements
Click a topic for information about other window elements in Design:

InfoBox Design status bar
Design menus

Data or field names
When you're in Design, you can show data in fields as it appears in Browse or show the names of fields and 
databases. To toggle between the two settings, choose Show Data from the View menu.
When you show data, you see data from the first record (in a form or form letter) or from the first page of records (in 
other views). If a view has any fields that summarize data from multiple records, Approach calculates the summary in 
Design and shows the results. If a view has fields or other objects that slide up or left, the fields slide into position.

See also
About customizing the Design work area 



InfoBox

Every design object has a set of properties, such as dimensions, text attributes, line and fill colors, and attached 
macros. The settings for an object are stored in an InfoBox. You can keep the InfoBox open on the screen as you 
work and use it to edit objects.
This is the top of the InfoBox. Click a part of it to see a description:

To open the InfoBox in Design:

Click the Show Info icon, choose Style & Properties from the context-sensitive menu, or double-click an 
object or in the background of a view.

If a text object is not selected, you can double-click it to open the InfoBox. But if a text object is selected, double-
clicking it puts an insertion point in the object.

Panels of settings
The InfoBox shows panels of settings for the selected object. If no object is selected, it shows settings for the current 
view.
To go to another panel of settings, click the tab for that panel in the InfoBox.

Manipulating the InfoBox
To collapse the InfoBox to its title bar and panel tabs, double-click the title bar. To return the InfoBox to full size, 
double-click the title bar again.
To move the InfoBox, drag it by the title bar.
To close the InfoBox, double-click its close box.

Named styles
You can save a set of InfoBox properties in a named style and then apply the style to objects or to a view. This allows 
you to apply properties consistently without having to set them manually again and again in the InfoBox. For more 
information, see Defining and saving a named style.



Design menus

Context-sensitive menu
In the Design menu bar, one of the menus is context-sensitive; it changes depending on the current selection or the 
current view. 

If an object is selected or if you've clicked in text, in a repeating panel, or in a summary panel, the menu is called 
Object, Text, or Panel and has commands for working with that type of element.
If you have no selection, the menu is called Form, Report, Letter, Mailing Label, Worksheet, Crosstab, or Chart and 
provides commands for working with the current type of view. 

Pop-up menu
When you're in Design, you can quickly open a pop-up menu with some of the most commonly used design 
commands. These commands are a subset of the ones in the main menus.
To choose from the pop-up menu, click an object or the border of a view with the right mouse button to open the 
menu and then drag to the command you want.



Design status bar

The status bar in Design gives information about the current view and the text and objects in it. Most parts of the 
status bar are pop-up menus or buttons you can use to change the selection or the work area.
Click a part of the status bar to see a description:

Pop-up menus and buttons
The parts of the status bar that show view name, environment name, font, font size, named style, and zoom setting 
are pop-up menus; the icon bar symbol is also a pop-up menu, with icon bars available in the current view. To choose
from a pop-up menu, click the menu name to open the menu and then drag to the item you want.
To change the text attributes of selected text or a selected text object, click the Boldface, Italic, or Underline button.

Dimensions area
The dimensions area of the status bar shows either the width and height of the selected object or the top and left 
coordinates of the selected object. If no object is selected, the dimensions area always shows the location of the 
pointer.
To toggle between showing dimensions and coordinates, click in the dimensions area.

E-mail notifier
The e-mail notifier appears when you have new mail on Lotus Notes, cc:Mail, or another VIM or MAPI mail system.



Browse

In Browse, you work with the information in a database. You can enter and edit data, add and delete records, find and
sort records, and print views. You can also create views (but you need to go to Design to modify the design of forms, 
reports, form letters, and mailing labels).

To go to Browse:

Click the Browse icon, or choose Browse from the View menu or from the environment pop-up menu in the 
status bar.

Icon bars
The default Browse icon bar has SmartIcons for many of the most commonly used commands for working with data 
and records. If the current view is a worksheet or crosstab, the Worksheet or Crosstab icon bar appears and provides
commands specific to that type of view.
Click a topic for descriptions of icons:

Browse Icon bar Crosstab icon 
bar.

Worksheet icon 
bar

Other window elements
Click a topic for information about other window elements in Design:

Browse menus Browse status 
bar



Browse menus

In the Browse menu bar, one of the menus is context-sensitive; it changes depending on the current selection or the 
current view. 

Most often, this menu is named Browse and provides standard commands for finding, sorting, and editing records. 
But if a PicturePlus field is selected or if the current view is a worksheet or crosstab, the menu is called PicturePlus, 
Worksheet, or Crosstab and has commands for working with that type of element.



Browse status bar

The status bar in Browse gives information about the current Approach file. Most parts of the status bar are pop-up 
menus or other options you can use to navigate in the file or to modify your work area. (Find and Preview also use 
this status bar; in Preview, it has an additional pop-up menu for zooming.)
Click a part of the status bar to see a description:

Pop-up menus
The parts of the status bar that show view name and environment name are pop-up menus; the icon bar symbol is 
also a pop-up menu. To choose from a pop-up menu, click the menu name to open the menu and then drag to the 
item you want.

Record number
The record number shows the position of the current record in the sort order of the found set. This number is not 
permanently associated with the record. (The numbering of records can change if you find, sort, add, or delete 
records.)
To go to the previous or next record, click the previous or next arrow in the status bar. 
To go to another record by number, click the record number in the status bar and fill in the dialog box that appears.

E-mail notifier
The e-mail notifier appears when you have new mail on Lotus Notes, cc:Mail, or other VIM or MAPI mail systems.



Find

In Find, you fill out a find request to isolate records that meet certain criteria. When you first go to Find, you see a 
new find request for the current view.

To go to Find:

Click the Find icon, or choose Find from the Browse menu or from the environment pop-up menu in the 
status bar.

Window elements
The default Find icon bar has SmartIcons you can click to insert operators in search criteria. For descriptions of the 
icons, see Find icon bar.
Under the icon bar is the Find button bar. Click a button for a description of it:

The status bar in Find is the same as it is in Browse. For details, see Browse status bar.

Search criteria
You enter search criteria in the fields you want to search on in the find request. (For example, to find all employees 
who were hired after July 1, 1994 in an employee form, type >7/1/94 in the form's Date Hired field.) 
When you finish filling out the request, Approach returns you to Browse and displays only the records that match the 
search criteria you specified. This subset of records is the found set.

See also
About finding records 



Preview

The Preview environment shows what the current view will look like when printed. This gives you a chance to correct 
errors or make design changes before committing a view to paper.

To go to Preview:

Click the Preview icon, or choose Preview from the File menu or from the environment pop-up menu in the 
status bar.

Window elements
The default Preview icon bar has SmartIcons for moving through records, finding and sorting records, and printing. 
For descriptions of the icons, see Preview icon bar.
The status bar in Preview is the same as it is in Browse, except that it also has a pop-up menu with zoom settings. 
For details, see Browse status bar.

Data, summaries, and objects
All of the data from Browse also appears in Preview. You can move through records in Preview as you can in Browse,
but you cannot click in fields or edit data.
If a view has any fields that summarize data from multiple records, Approach calculates the summary in Preview and 
shows the results. If a view has fields or other objects that slide up or left, the fields slide into position.

Zoom settings
When you first go to Preview, you see the current view reduced to 75 percent. You can change to other zoom 
settings. (The possible settings are 25, 50, 75, 100, and 200 percent.) For more information, see Previewing a view.

See also
About previewing and printing 



Close box
Click the close box to close the InfoBox.



Title bar
Drag the title bar to move the InfoBox.



Panel tabs
Click a panel tab to display another panel of settings.



Panels of settings
The InfoBox shows panels of settings for the 
selected object or current view.



View pop-up menu
Shows the name of the current view.



Environment pop-up menu
Shows the name of the current environment.



Font pop-up menu
Shows the font of selected text or the selected 
text object.



Size pop-up menu
Shows the font size of selected text or the selected 
text object.



Boldface, Italic, and Underline buttons
Click a button to change the attributes of selected 
text or the selected text object.



Named style pop-up menu
Shows the named style of the selected object or 
the current view.



Dimensions or location 
Shows the dimensions or location of the selected 
object or the location of the pointer.



Zoom setting pop-up menu
Shows the zoom setting for the current view



E-mail notifier
Appears when you have new mail.



Icon bar pop-up menu
Choose from this pop-up menu to display another 
icon bar.



Record number
Shows the number of the current record in the 
found set.



Previous Record button
Click to go to the previous record.



Next Record button
Click to go to the next record.



Number of records
Shows the number of records in the found set in 
relation to the entire database.



OK button
Begins the search.



Cancel button
Cancels the search and returns to Browse.



Clear Find button
Removes search criteria from the find request.



Find More button
Creates an additional find request (so that you can 
specify Or criteria for a field).



SmartIcons
Click a topic for information about a SmartIcon bar.
Browse icon bar
Crosstab icon bar
Design icon bar
Find icon bar
Preview icon bar
Report icon bar
Text icon bar
Worksheet icon bar
Tools palette
Other available icons



Browse icon bar

This is the default Browse icon bar (divided into sections for easier viewing). It appears in forms, reports, mailing 
labels, charts, and form letters. 
Click an icon to see a description of the action it performs.



Design icon bar

This is the default Design icon bar (divided into sections for easier viewing). It appears in forms, charts, and mailing 
labels.
Click an icon to see a description of the action it performs.



Preview icon bar

This is the default Preview icon bar (divided into sections for easier viewing). It appears in all views. 
Click an icon to see a description of the action it performs.



Find icon bar

This is the default Find icon bar (divided into sections for easier viewing). It appears when a find request is active. 
Click an icon to see a description of the action it performs.



Report icon bar

This is the default Design icon bar for reports (divided into sections for easier viewing).
Click an icon to see a description of the action it performs.



Text icon bar

This is the default Design icon bar for form letters (divided into sections for easier viewing).
Click an icon to see a description of the action it performs.



Worksheet icon bar

This is the default icon bar for worksheets for both Browse and Design (divided into sections for easier viewing). 
Click an icon to see a description of the action it performs.



Crosstab icon bar

This is the default icon bar for crosstabs for both Browse and Design (divided into sections for easier viewing). 
Click an icon to see a description of the action it performs.



Tools palette

This is the Tools palette that appears when you're in Design for forms, reports, charts, and mailing labels. 
Click an icon to see a description of the action it performs.



Other available icons

In addition to the icons that appear in the default icon bars, Approach also has additional icons that you can include in
your own custom icon bars. 
Click an icon to see a description of the action it performs.

File commands

        

        

        

        

        

Edit and text commands

        

        

       

        

View commands

        

Create commands

        

        

        

        

        

        

Browse commands



Object commands

        

        

        

        

Function icons

        

        

        

Other miscellaneous commands

        

        

        

        

        

        

        

        

        



Open File
Displays the Open File dialog box, where you can select a file to be opened.



Save File
Saves the current Approach file.



Send Mail
Sends the current view using your e-mail application.



Print
Prints the current view.



Preview
Goes to Preview.



First Record
Displays the first record in the found set.



Previous Record
Displays the previous record in the found set.



Next Record
Displays the next record in the found set.



Last Record
Displays the last record in the found set.



Design
Goes to Design.



Browse
Goes to Browse.



Find
Finds a set of records.



Show All
Displays all records in the database.



Ascending Sort
Sorts records in ascending order according to the current field.



Descending Sort
Sorts records in descending order according to the current field.



New Record
Creates a new record.



Delete Record
Deletes the current record.



Duplicate Record
Duplicates the current record.



Date
Inserts the date.



Time
Inserts the time.



Duplicate Data
Duplicates data from the previous record.



Spell Check
Checks spelling.



Enter
Performs a find or accepts the record.



Undo
Undoes the last change.



Cut
Cuts the current selection to the Clipboard.



Copy
Copies the current selection to the Clipboard.



Paste
Pastes the contents of the Clipboard.



Fast Format
Applies the format of the current selection.



Show Info
Opens the InfoBox so that you can change the style and properties of the current view or selected object.



Bring Forward
Brings the selected object forward one layer.



Send Backward
Sends the selected object back one layer.



Group
Groups the selected objects.



Ungroup
Ungroups the selected grouped object.



Show Grid
Displays drawing grid lines.



Show Ruler
Displays rulers at the top and left side of the window.



Show Tools
Displays the Tools palette.



Zoom In
Zooms in for a closer look.



Zoom Out
Zooms out so that you can see more.



Next Icon Bar
Displays the next SmartIcon bar available.



Sort
Opens the Sort dialog box so that you can specify how to sort records in the found set.



Show Data
Displays data in Design.



Chart
Charts the current crosstab data.



Add Row
Adds a summary row to the crosstab.



Add Column
Adds a summary column to the crosstab.



Sum
Calculates a total.



Average
Calculates an average.



Count
Calculates a count.



Select Column
Selects only the column (and not the header) for the current column.



Column Header
Selects only the header (and not the rest of the column) for the current column.



Add Field
Opens the Add Field dialog so that you can add a field to the view.



Insert Column
Inserts a blank column into a worksheet.



Equal
Matches items that are the same.



Not Equal
Matches items that are not the same.



Less Than
Matches items that are less than a value you enter.



Less Than or Equal
Matches items that are less than or equal to a value you enter.



Greater Than or Equal
Matches items that are greater than or equal to a value you enter.



Greater Than
Matches items that are greater than a value you enter.



And
Finds records that match either criteria.



Or
Finds records that match both criteria.



Multiple Character Wildcard
Matches any string.



Single Character Wildcard
Matches any character.



Range
Finds a range of values.



Sounds Like
Finds words that sound alike but may be spelled differently.



Case-Sensitive
Matches case in text when finding records.



Expression
Finds records based on the value returned by an If statement.



Formula
Finds records that match the result of a formula.



Left Align
Left-aligns text.



Center
Centers text.



Right Align
Right-aligns text.



Single Space
Single-spaces text.



Double Space
Double-spaces text.



Trailing Summary
Adds a trailing summary panel to a report.



Leading Summary
Adds a leading summary panel to a report.



Panel Labels
Displays labels for report panels.



Insert Field
Inserts a field you select into the form letter.



Pointer
Gives you a pointer for selecting objects.



Text
Gives you a tool for creating text.



Rectangle
Gives you a tool for drawing rectangles or squares (press SHIFT while dragging for squares).



Ellipse
Gives you a tool for drawing ovals or circles (press SHIFT while dragging for circles).



Rounded Rectangle
Gives you a tool for drawing rounded rectangles.



Line
Gives you a tool for drawing lines.



Field
Gives you a tool for drawing fields.



Checkbox
Gives you a tool for drawing checkboxes.



Radio Button
Gives you a tool for drawing radio buttons.



Macro Button
Gives you a tool for drawing macro buttons.



PicturePlus
Gives you a tool for drawing PicturePlus fields.



New File
Creates a new Approach file.



Import
Opens the Import dialog box so that you can import into Approach.



Export
Opens the Export dialog box so that you can export from Approach.



Print Form
Prints the current form.



Print Setup
Opens the Print Setup dialog box.



Exit
Exits Approach.



Bold
Makes selected text bold.



Italic
Makes selected text italic.



Justify
Justifies text.



Paste Special
Opens the Paste Special dialog box.



Style Definition
Allows you to define a text style.



Underline
Makes selected text underlined.



Column Mode
Allows you to work with entire report columns.



Show Tabs
Displays a view tab for each view.



New Chart
Opens the Chart Assistant so that you can create a new chart.



New Form
Opens the Form Assistant so that you can create a new form.



New Label
Opens the Mailing Label Assistant so that you can create a new mailing label.



New Letter
Opens the Form Letter Assistant so that you can create a new form letter.



New Report
Opens the Report Assistant so that you can create a new report.



New Worksheet
Opens the Worksheet Assistant so that you can create a new worksheet.



New Crosstab
Opens the Crosstab Assistant so that you can create a new crosstab.



Find Duplicate
Opens the Find Special dialog box so that you can find duplicate records.



Find Special
Opens the Find Special dialog box so that you can find duplicate or unique records.



Align
Aligns selected objects.



Select All
Selects all objects in a view.



Maximum
Calculates a maximum value for a range of records.



Minimum
Calculates a minimum value for a range of records.



Standard Deviation
Calculates a standard deviation.



Variance
Calculates a variance.



1-2-3
Opens Lotus 1-2-3 if it's available.



AmiPro
Opens AmiPro if it's available.



CC:Mail
Opens CC:Mail if it's available.



Freelance
Opens Freelance Graphics if it's available.



Improv
Opens Lotus Improv if it's available.



Notes
Opens Lotus Notes if it's available.



Organizer
Opens Lotus Organizer if it's available.



SmartPics
Opens Lotus SmartPics if it's available.



Page Number
Inserts a page number.



Customize SmartIcons
Opens the SmartIcons dialog box so that you customize SmartIcons.



Help
Opens the Approach online Help.



Snap Grid
Turns on the snap grid for aligning objects.



Send To Back
Sends the selected object to the back layer.



Send To Front
Sends the selected object to the front layer.



About creating and opening files
When you create a new database file, or open an existing database from another application, Approach automatically
creates and opens a new Approach file so that you can begin entering data. When you want to work with an existing 
database, you open an Approach file for it rather than the database file.

Creating a new database file        
If you're setting up a database from scratch, begin by creating a database file. You can give the file predefined fields 
from a template or define fields of your own after creating the file.

Opening an Approach file         
If you want to work with a database that already has an Approach file, open the Approach file rather than the 
database file. Approach files have the filename extension .APR. If more than one database is joined in an Approach 
file, the Approach file gives you access to all of those databases.

Mapping fields in an Approach file         
If you make structural changes to fields and do not save the Approach file, or if you make structural changes through 
another Approach file, the next time you open an Approach file you'll need to map the changed fields. This can 
happen if you have changed the name or type of a field or have deleted a field from the database file.

Opening a database created in another application         
You can open a database that was created in another application. Approach creates a new Approach file for it, and 
you can work with the database as if it had been created in Approach.

Opening a table created in Microsoft Access         
You can use Approach to open a database table created in Microsoft Access. You need to see the contents of the 
database first and then select the table you want. Approach creates and opens a new Approach file.

Creating a database from a spreadsheet         
You can open a spreadsheet in a Lotus 1-2-3 or Excel format. Approach creates an Approach file and a database file 
with a copy of the spreadsheet's data.

Creating a database from a delimited text file         
If you open an ASCII text file with delimited text, Approach creates an Approach file and a database file with a copy of
the text file's data. The delimiters mark where one field ends and the next one begins. 

Creating a database from a fixed-length text file         
If you open an ASCII text file with fixed-length text, Approach creates an Approach file and a database file with a copy
of the text file's data. The text is divided into fixed-length fields.

See also
About database files 



Creating a new database file

If you're setting up a database from scratch, begin by creating a database file. You can give the file predefined fields 
from a template or define fields of your own after creating the file.
1. Click the New File icon or choose New from the File menu. Or if the Welcome dialog box is on the screen, select 

"Create a new file," select a template if you want, and click OK.

2. Type a name for the database file in the File Name text box.
3. Select a database file type in the List Files of Type drop-down list.
4. Click OK.

See also
About defining fields for a database



Details: Creating a new database file

Templates
Approach comes with templates that provide predefined fields for common types of databases. When you create a 
database from the Welcome dialog box, you can specify one of these templates.
If you create a database using a template, the database is a copy of the template; you can modify its fields for your 
particular needs. If you create a database without using a template, the database is empty, with no fields; you define 
the fields yourself in the Field Definition dialog box.

File types
The List Files of Type drop-down list shows the file types you can use for a new database. The standard file types in 
the list are dBASE IV, dBASE III+, FoxPro 2.1, and Paradox. You do not need to have a dBASE, FoxPro, or Paradox 
application to use these file types in Approach.
If the ReadOnly line in your APPROACH.INI file is set to 0, the list also shows the types Access, Oracle, SQL Server, 
DB2, DB2-MDI, Lotus Notes, and any ODBC drivers you have installed. For more information about these types, see 
File types.

Saving the Approach file
Make sure you save your new Approach file. Approach does not automatically save an Approach file for a new 
database (though it saves any data you enter in the database file).



Opening an Approach file

If you want to work with a database that already has an Approach file, open the Approach file rather than the 
database file. Approach files have the filename extension .APR.

To open any Approach file:
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select the name of the Approach file in the File Name list.
3. To open the Approach file only for viewing, turn on Read-only.
4. Click OK.

To open one of the last five Approach files used:

Select the name of the file in the bottom of the File menu, or press ALT-F and the number (1 through 5) that 
appears for the file in the menu. Or if the Welcome dialog box is on the screen, select the name of the file in the Open
drop-down list and click OK.



Details: Opening an Approach file

Read-only setting
If you turn on this setting, you will not be able to edit data or save design changes in the Approach file. This setting 
applies only to your current session with the file and does not make it permanently read-only.

Field mapping
If the Approach file has fields that need to be mapped to fields in a database file, the Field Mapping dialog box 
appears when you try to open the file. See Mapping fields in an Approach file.

Database file passwords
If a database requires a password, Approach asks you to provide the password when you try to open an Approach file
that uses that database. A database can have a read/write password or both a read/write and a read-only password. 
The Approach file opens if you type the password correctly.



Mapping fields in an Approach file

If you make structural changes to fields and do not save the Approach file, or if you make structural changes through 
another Approach file, the next time you open an Approach file you'll need to map the changed fields.

To map fields in an Approach file:
1. Open the Approach file.
2. Click Yes in the alert box. 

The alert box appears if the file has fields that need to be mapped.
3. In the Field Mapping dialog box, map an unmapped Approach file field in the list on the left to the database field 

right across from it by clicking between the two fields. 
An arrow appears between the fields when you click. You can drag a database field up or down to move it across
from the Approach file field to map.

4. Continue mapping unmapped fields in the same manner.
5. Click OK.

To remove all the mapping in an Approach file:

Click Clear in the Field Mapping dialog box. 

To restore an Approach file to its original mapping:

Cick Automatically Line Up Fields in the Field Mapping dialog box.

See also
Opening an Approach file



Details: Mapping fields in an Approach file

Field lists in the dialog box
The fields on the left side of the Field Mapping dialog box are in the Approach file; the fields on the right side are in 
the database files. An arrow between two fields means they are mapped. Fields with the same name are mapped 
automatically (unless you have changed the type of a field).

Suggestions for mapping
Follow these suggestions for mapping a field:

If you have Do this
Changed the 
name of a field in
the database file

Map the Approach file
field to the new field 
name in the database.

Changed the 
type of the field 
in the database 
file

Map the Approach file 
field to its same name 
in the database, or 
map it to a different 
name to replace it with
a different field.

Deleted the field 
from the 
database file

Map the Approach file
field to a different field
name in the database.

Unmapped fields
If you leave any fields unmapped, they will not show data in the Approach file. In Design, the unmapped fields will 
have NO_FIELD_REFERENCE in them. In Browse, if you click in an unmapped field you get an error telling you that 
you cannot edit the field and must assign a database field to it.



Opening a database created in another application

You can open a database that was created in another application. Approach creates and opens a new Approach file, 
and you can work with the database as if it had been created in Approach.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select a database file type in the List Files of Type drop-down list.
3. Select the name of the database in the File Name list.
4. To open the new Approach file only for viewing, turn on Read-only.
5. Click OK.

See also
About working together with Lotus Notes 
About working with ODBC data sources 
Opening a table created in Microsoft Access 



Details: Opening a database created in another application

Read-only setting
If you turn on this setting, you will not be able to edit data or save design changes in the new Approach file. This 
setting applies only to your current session with the file and does not make it permanently read-only.

SQL tables
If you select Oracle, SQL Server, or DB2-MDI and are not already connected to a SQL server, a dialog box appears 
that lets you connect. See About working with SQL tables.

Key fields for a Paradox database
If you try to open a Paradox database and Approach cannot find a key field, the Choose Key Field dialog box appears
so that you can select a field to use as the key field. If the database does not have a unique field or a combination of 
fields you can use for this, click Add Key Field in the dialog box. Approach creates a copy of the database file and 
adds the new field to it, with a unique number for each record.

Saving in another file type
You can save the database file in another file type. For example, if you open a database that's on a mainframe 
computer, you may want to save a copy of the database in dBASE IV to make it more suitable for use on your own 
computer.



Opening a table created in Microsoft Access

You can use Approach to open a database table that was created in Microsoft Access. Approach creates and opens a
new Approach file.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select Access in the List Files of Type drop-down list.
The names of Access databases appear in the Directories list, with a filecard icon in front of them.

3. Double-click the name of the database in the Directories list.
The names of tables in the database appear in the File Name list.

4. Select the name of the table in the File Name list.
5. Click OK.
6. If an alert box appears, click OK to open the table.

The alert box appears if your preferences are set for displaying SQL and ODBC databases read-only.

See also
Microsoft Access 



Creating a database from a spreadsheet

You can open a spreadsheet in a Lotus 1-2-3 or Excel format. Approach creates an Approach file and a database file 
with a copy of the spreadsheet's data.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select Lotus 1-2-3 or Excel in the List Files of Type drop-down list.
3. Select the name of the spreadsheet in the File Name list and click OK.
4. To use the text in the first row of the spreadsheet as field names, turn on "First row contains field names" in the 

Select Range dialog box (for Lotus 1-2-3) or the Field Names dialog box (for Excel).
5. If you're creating a database from a Lotus 1-2-3 spreadsheet, select a sheet or named range with the data you 

want to use in the database.
6. Click OK.
7. In the Convert To dialog box, type a name for the database file in the File Name text box.
8. Select a database file type in the List Files of Type drop-down list.
9. Click OK.

See also
Opening a named range from a Lotus 1-2-3 spreadsheet 



Details: Creating a database from a spreadsheet

Fields and records
When you create a database from a spreadsheet, the rows in the spreadsheet become records in the database and 
the columns become fields.
The fields are initially named A, B, C, and so on, but you can rename them in the Field Definition dialog box. If the 
first row of the spreadsheet has text that identifies the rest of the contents (such as 1st Qtr, 2nd Qtr, and so on), you 
can use this row to provide the field names.

Data from the spreadsheet
If you create a database from an Excel spreadsheet, all of the data from the spreadsheet is copied into the database.
If you create a database from a Lotus 1-2-3 spreadsheet, you can specify a sheet or named range of data to use. 
When you select a Lotus 1-2-3 spreadsheet in the Open dialog box, the Select Range dialog box appears, showing 
the names of sheets and ranges from the spreadsheet file. The range names are in all capital letters.



Creating a database from a delimited text file

If you open an ASCII text file with delimited text, Approach creates an Approach file and a database file with a copy of
the text file's data. The delimiters mark where one field ends and the next one begins. 
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select Text - Delimited in the List Files of Type drop-down list.
3. Select the name of the text file in the File Name list and click OK.
4. In the Text File Options dialog box, select the separator used in the text file in the Separate Fields With area. 

If the separator you want does not appear in the list, select Other and type the character in the text box.
5. Select the character set used in the text file.
6. To use the text in the first row of the file as field names, turn on "First row contains field names."
7. Click OK.
8. In the Convert To dialog box, type a name for the database file in the File Name text box.
9. Select a database file type in the List Files of Type drop-down list.
10. Click OK.

See also
Creating a database from a fixed-length text file



Details: Creating a database from a delimited text file

Separators
A delimited text file uses separators such as commas, spaces, or tabs to break up the text into discrete units. When 
you create a database from delimited text, these separators mark where one field ends and the next one begins. You 
specify the delimiter used when you open the text file in Approach. A paragraph return marks where one record ends 
and the next one begins.

Field names
When you create a database from a delimited text file, the fields are initially named A, B, C, and so on, but you can 
rename them in the Field Definition dialog box. If the first row of the text file has text that identifies the rest of the file's
contents (such as Name, Address, and City), you can use this first row to provide the field names.



Creating a database from a fixed-length text file

If you open an ASCII text file with fixed-length text, Approach creates an Approach file and a database file with a copy
of the text file's data. The text is divided into fixed-length fields.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select Text - Fixed-Length in the List Files of Type drop-down list.
3. Select the name of the text file in the File Name list and click OK.
4. In the Fixed Length Text File Setup dialog box, select the character set used in the text file.
5. Type a name for the first field in the Field Name text box, or turn on "First row contains field names" to use the 

text in the first row of the file as field names.
6. Select a data type for the first field in the Data Type drop-down list.
7. Type the starting position for the first field in the Start text box.
8. Type the number of characters for the first field in the Width text box.
9. For the rest of the fields, type a field name (unless "First row contains field names" is on), select a data type, and 

type a width. 
You don't need to provide the starting position for fields after the first one.

10. Click OK.
11. In the Convert To dialog box, type a name for the database file in the File Name text box.
12. Select a database file type in the List Files of Type drop-down list.
13. Click OK.

See also
Creating a database from a delimited text file



Details: Creating a database from a fixed-length text file

How text is divided
In a fixed-length text file, the text on each line is broken into blocks of text a specific length. (If the text does not fill the
entire length, it has spaces after it until the next block begins.) When you create a database from fixed-length text, 
you need to tell Approach how long each block of text is. Approach uses fixed-length fields for the text in the 
database.
A paragraph return in the text file marks where one record ends and the next one begins. If the records do not have 
paragraph returns, the next record begins at the end of the block; you need to know the contents of the text file to 
define the blocks correctly.

Field names
You can name the fields when you create a database from a fixed-length text file. Or if the first row of the file has text 
that identifies the rest of the file's contents (such as Name, Address, and City), you can use this first row to provide 
the field names.
If you name the fields yourself, follow the restrictions on characters and the length of the name for the database file 
type. See About database files.



About saving, closing, and deleting files
Approach automatically saves changes to your data as you work and whenever you close a file. You need to save an 
Approach file manually after Approach creates the file (such as for a new database file) and whenever you make 
design changes to views or join database files.

Saving an Approach file        
The first time you save an Approach file, you give the file a name and specify a location. You should also save 
periodically when you make design or join changes to the file.

Saving a copy of an Approach file and a database file        
You can save a copy of an Approach file and its associated database file(s), either to back up a database or to 
prepare a template for other databases.

Saving a copy of an Approach file only        
You can also save a copy of an Approach file that uses the same set of data as the original file. This allows you to 
quickly set up multiple Approach files for a single set of data.

Closing an Approach file        
When you close an Approach file, Approach saves any unsaved changes to data. If you've made design or join 
changes you haven't saved, an alert box asks if you want to save those changes.

Deleting a file        
You can delete an Approach file or a database file from within Approach. When you delete a database file, all related 
files such as indexes are deleted along with it.



Saving an Approach file

The first time you save an Approach file, you give the file a name and specify a location. You should also save 
periodically when you make design or join changes to the file.

To save a new Approach file:
1. Click the Save Approach File icon or choose Save Approach File from the File menu.

2. Type a name for the file in the File Name text box.
3. To give the Approach file a password, turn on "Set Approach file password" and type the password in the text 

box.
4. Click OK.

To save changes to an existing Approach file:

Click the Save Approach File icon or choose Save Approach File from the File menu.



Details: Saving an Approach file

Approach file passwords
If you give an Approach file a password, a user must enter the password before creating views, joining databases, or 
going to Design in the file.

Saving a default view
When you open an Approach file, the file opens to the view you were using the last time you last saved. Before 
saving an Approach file, change to the view you want to appear when the file is opened or create an Open macro that
automatically changes to the view you want. For information about macros, see Defining a macro.



Saving a copy of an Approach file and a database file

You can save a copy of an Approach file and its associated database file(s), either to back up a database or to 
prepare a template for other databases.
1. Choose Save As from the File menu.
2. Type a different name or specify a different location for the copy of the Approach file.
3. To give the copy a password, turn on "Set Approach file password" and type the password in the text box.
4. Select "Exact copy" or "Blank copy" in the Databases area.
5. Click OK.
6. Type a different name or specify a different location for the copy of the database file.
7. To change the file type for the copy, select another type in the List Files of Type drop-down list.
8. Click OK.
9. For each additional database, specify a different name or location, select a file type (if necessary), and click OK. 

The Save Database As dialog box appears for each database file joined in the Approach file.

See also
Saving a copy of an Approach file only



Details: Saving a copy of an Approach file and a database file

"Exact copy" setting
"Exact copy" makes an exact copy of the database, with all of its data. Use this setting to create a backup of a 
database. The copy will be an exact duplicate of the original Approach file and database file.

"Blank copy" setting
"Blank copy" makes a copy of the database with everything except for the data. Use this setting to create a template 
for other databases. The copy will have the same field definitions, views, macros, and setup options as the original, 
but no data.

Approach file passwords
If an Approach file has a password, a user must enter the password before creating views, joining databases, or 
going to Design in the file.

Key fields for a Paradox database
If you use the Paradox file type for a database file, the Choose Key Field dialog box appears so that you can select a 
field to use as the key field. If the database does not have a unique field or a combination of fields you can use for 
this, click Add Key Field in the dialog box. Approach adds a new field to the copy of the database, with a unique 
number for each record.



Saving a copy of an Approach file only

You can also save a copy of an Approach file that uses the same set of data as the original file. This allows you to 
quickly set up multiple Approach files for a single set of data.
1. Choose Save As from the File menu.
2. Type a different name or specify a different location for the copy of the Approach file.
3. To give the copy a password, turn on "Set Approach file password" and type the password in the text box.
4. Select ".APR file only" in the Databases area. 

This specifies that you want the new Approach file to use the data associated with the original Approach file.
5. Click OK.

See also
Saving a copy of an Approach file and a database file



Closing an Approach file

When you close an Approach file, Approach saves any unsaved changes to data. If you've made design or join 
changes you haven't saved, an alert box asks if you want to save those changes.

Click the Close File icon or choose Close from the File menu.



Deleting a file

You can delete an Approach file or a database file from within Approach. When you delete a database file, all related 
files such as indexes are deleted along with it.
1. Choose Delete File from the File menu.
2. To delete a database file, select the database file type in the List Files of Type drop-down list. To delete an 

Approach file, leave the drop-down list set to Approach Files.
3. Select the name of the file you want to delete in the File Name list.
4. Click OK.
5. In each alert box that appears, click Yes to delete the file or click No to keep the file. 

Approach displays an alert box for every database file you're deleting.



Details: Deleting a file

When you delete a database file, all related files such as indexes are deleted along with it. 
When you delete an Approach file, Approach can delete the associated database files (and their related files) for you. 
If you delete an Approach file that is based on more than one database file, Approach gives you a chance to delete or
keep each joined database file.
Note: Be especially careful when deleting database files from an Approach file. Other Approach files may also be 
based on them.
You can also delete files in the Windows File Manager, but you cannot delete an Approach file and its database files 
all in one step. If you want to be sure you're deleting a set of associated files, delete the files in Approach.
Approach files and database files must be closed before you can delete them.



About working with SQL tables
Approach allows you to view and work with SQL data right at your desktop. The data can be stored in Oracle SQL, 
Microsoft/Sybase SQL Server, or IBM DB2 tables. If you have other SQL tables that can be opened through an 
ODBC driver, you also have access to those tables in Approach.
When you use Approach with SQL tables, you work in the same intuitive Approach interface you use with any other 
type of database. Rather than having to build report and query definitions in SQL, you can use Approach as a quick 
tool for all your reporting and querying.
You can be connected to more than one server at a time. 

Connecting to an Oracle server         
You can connect to an Oracle server in Approach. If you're not already connected to one when you select Oracle in a 
List Files of Type drop-down list, Approach opens a dialog box that lets you connect.

Connecting to Oracle on your local drive         
You can connect to an Oracle table on your local drive. To do this, you must be running Windows 3.1a or later in 
Standard mode.

Connecting to a server in SQL Server         
You can connect to SQL Server in Approach. If you're not already connected to a server when you select SQL Server 
in a List Files of Type drop-down list, Approach opens a dialog box that lets you connect.

Connecting to an IBM DB2 or SQL/DS server through ODBC         
You can connect to an IBM DB2 or SQL/DS server directly in Approach through ODBC or via the IBM Distributed 
Database Connection Services (DDCS).

Connecting to an IBM DB2 server through MDI         
You can connect to an IBM DB2 server in Approach through the Micro Decisionware Database Gateway (MDI). If 
you're not already connected to a DB2-MDI server when you select DB2-MDI in a List Files of Type drop-down list, 
Approach opens a dialog box that lets you connect.

Creating a query file in Approach         
If you have a SQL table open in Approach, you can create a query file for it by saving or exporting.

Opening a query file in Approach         
When you open a query file, you automatically connect to a server using the log-on information in the file. Then the 
Select statement executes a find or sort and returns data to a read-only file on your local drive.

Saving or exporting data from a query         
A query file's Select statement returns data to a temporary read-only data file on your local drive. You can keep this 
data by either saving it in a database file or exporting it to a database file.

See also
About SQL tables 
Setting database options for SQL, Access, ODBC, and Lotus Notes tables 



Connecting to an Oracle server

You can connect to an Oracle server in Approach. If you're not already connected to one when you select Oracle in a 
List Files of Type drop-down list, Approach opens a dialog box that lets you connect.
1. Open the New, Open, Save Database As, Import Data, or Export Data dialog box.
2. Select Oracle in the List Files of Type drop-down list.

If you are already connected to a server but want to connect to an additional one, click Connect after selecting 
Oracle.

3. Type a letter identifying the protocol you want in the Network text box.
If you leave this blank, Approach defaults to the Local protocol setting in your CONFIG.ORA or ORACLE.INI file. 
For example, Local=X:ORASRV automatically sets the protocol to X.

4. Type the name of the server in the Server Name text box.
If you leave this blank, Approach defaults to the Local server setting in your CONFIG.ORA or ORACLE.INI file. 
For example, Local=X:ORASRV automatically sets the server to ORASRV.

5. Type your user name in the User Name text box.
6. Type your password in the Password text box.
7. Click OK.

See also
Oracle SQL 
Troubleshooting Oracle SQL on a server 



Details: Connecting to an Oracle server

Prior Connection drop-down list
The Prior Connection drop-down list shows the last eight SQL servers you connected to. If you're connecting to one 
of these servers again, you can select the connection from the list rather than typing the protocol, server name, and 
user name.

Protocols
Check with your system administrator to find out which protocol you should use. These are some of the most 
common ones:

For this 
protocol

Type

Named Pipes P
SPX X
NetBIOS B
TCP/IP T
DECnet D
ORACLE Async A

SQL*Net drivers
Before connecting to an Oracle server, you must have SQL*Net drivers installed for the type of server and client 
you're using. For more information, see Troubleshooting Oracle SQL on a server.

Disconnecting from a SQL server
When you quit Approach, you are disconnected from any SQL servers you connected to in that session. You can also
use the Open dialog box to disconnect from a particular server. Select the connection name in the Server drop-down 
list and click Disconnect.



Connecting to Oracle on your local drive

You can connect to an Oracle table on your local drive. To do this, you must be running Windows 3.1a or later in 
Standard mode.
1. Type commands in DOS to start Oracle and Windows.

See the Details topics for the commands.
2. In Approach, open the New, Open, Save Database As, Import Data, or Export Data dialog box.
3. Select Oracle in the List Files of Type drop-down list.

If you are already connected to a server but want to connect to an additional one, click Connect after selecting 
Oracle.

4. Type your user name in the User Name text box.
5. Type your password in the Password text box.

Leave the Network and Server Name text boxes blank.
6. Click OK.

See also
Oracle SQL 
Troubleshooting Oracle SQL on your local drive 



Details: Connecting to Oracle on your local drive

Before connecting to a local Oracle table in Approach, type the following commands in DOS to start Oracle and 
Windows. Replace c with the letter of your drive that contains the Oracle table.
c:\>sqlpme (loads the Oracle memory manager)
c:\>oracle6 or c:\>oracle7 (starts the Oracle application)
c:\>sqldba (starts SQL for Oracle)
c:\>startup (starts the Oracle database)
c:\>exit (exits the SQL command mode)
c:\>win/s (starts Windows in Standard mode)



Connecting to a server in SQL Server

You can connect to SQL Server in Approach. If you're not already connected to a server when you select SQL Server 
in a List Files of Type drop-down list, Approach opens a dialog box that lets you connect.
1. Open the New, Open, Save Database As, Import Data, or Export Data dialog box.
2. Select SQL Server in the List Files of Type drop-down list.

If you are already connected to a server but want to connect to an additional one, click Connect after selecting 
SQL Server.

3. Type the name of the server in the Server Name text box.
4. Type your user name in the User Name text box.
5. Type your password in the Password text box.
6. Click OK.

See also
SQL Server 
Troubleshooting Microsoft SQL Server 
Troubleshooting Sybase SQL Server 



Details: Connecting to a server in SQL Server

Prior Connection drop-down list
The Prior Connection drop-down list shows the last eight SQL servers you connected to. If you're connecting to one 
of these servers again, you can select the connection from the list rather than typing the protocol, server name, and 
user name.

Disconnecting from a SQL server
When you quit Approach, you are disconnected from any SQL servers you connected to in that session. You can also
use the Open dialog box to disconnect from a particular server. Select the connection name in the Server drop-down 
list and click Disconnect.



Connecting to an IBM DB2 or SQL/DS server through ODBC

You can connect to an IBM DB2 or SQL/DS server directly in Approach through ODBC or via the IBM Distributed 
Database Connection Services (DDCS).
1. Open the New, Open, Save Database As, Import Data, or Export Data dialog box.
2. Select DB2 in the List Files of Type drop-down list.

The Drives drop-down list changes to Server and shows the names of DB2 servers you can connect to.
3. Select a server in the Server drop-down list.

The names of owners on the server appear in the Directories list.
4. If a Setup dialog box appears, fill it in and click OK.

The dialog box appears if your ODBC.INI file does not have setup information for DB2.
5. Double-click the name of the owner in the Directories list.

The tables in the database appear in the File Name list.
6. Select the name of the table in the File Name list.
7. Click OK.
8. If an alert box appears, click OK to open the table.

The alert box appears if your preferences are set for displaying SQL and ODBC tables read-only.

See also
IBM DB2 
Connecting to an IBM DB2 server through MDI 



Details: Connecting to an IBM DB2 or SQL/DS server through ODBC

DB2 types available through ODBC
You can open IBM DB2/2, DB2/6000, and DB2/HP-UX tables directly in Approach through ODBC support, and IBM 
DB2, DB2/400, and SQL/DS tables via IBM Distributed Database Connection Services (DDCS) through ODBC 
support.

Disconnecting from a SQL server
When you quit Approach, you are disconnected from any SQL servers you connected to in that session. You can also
use the Open dialog box to disconnect from a particular server. Select the connection name in the Server drop-down 
list and click Disconnect.



Connecting to an IBM DB2 server through MDI

You can connect to an IBM DB2 server in Approach through the Micro Decisionware Database Gateway (MDI).
1. Open the New, Open, Save Database As, Import Data, or Export Data dialog box.
2. Select DB2-MDI in the List Files of Type drop-down list.

If you are already connected to a server but want to connect to an additional one, click Connect after selecting 
DB2-MDI.

3. Type the name of the server in the Server Name text box.
4. Type your authorization ID in the Authorization ID text box.
5. Type your password in the Password text box.
6. Click OK.

See also
IBM DB2 
Troubleshooting IBM DB2-MDI 
Connecting to an IBM DB2 or SQL/DS server through ODBC 



Details: Connecting to an IBM DB2 server through MDI

Prior Connection drop-down list
The Prior Connection drop-down list shows the last eight SQL servers you connected to. If you're connecting to one 
of these servers again, you can select the connection from the list rather than typing the protocol, server name, and 
user name.

Options for DB2-MDI connections
You may need to set some table options when connecting to a DB2 server through MDI. To do this, click Options in 
Connect to DB2-MDI, type the information in the Connect Options dialog box, and click OK.
System Catalog is the ID of the account that owns the views of system tables. Normally, the tables are owned by 
SYSIBM. If you do not have access to SYSIBM, the system administrator should create a view of the tables in 
another account. Type the authorization ID for that account here.
Tablespace is the name of the database that stores new tables. Tables are normally created in the DSNDB04 
database. If you receive errors when creating or modifying tables, you may not have permission to create tables in 
DSNDB04. For more information about where to store new tables, read about the Create Table statement in the 
reference manual for your DB2 system.

Disconnecting from a SQL server
When you quit Approach, you are disconnected from any SQL servers you connected to in that session. You can also
use the Open dialog box to disconnect from a particular server. Select the connection name in the Server drop-down 
list and click Disconnect.



Creating a query file in Approach

If you have a SQL table open in Approach, you can create a query file for it by saving or exporting.

To create a query file by saving:
1. With a SQL table active, choose Save As from the File menu.
2. In the Save Approach File As dialog box, specify a name and location for the Approach file.
3. Select "Exact copy" in the Databases area and click OK.
4. In the Save Database As dialog box, select Query in the List Files of Type drop-down list.
5. Specify a name and location for the query file and click OK.

To create a query file by exporting:
1. With a SQL table active, choose Export Data from the File menu.
2. Select Query in the List Files of Type drop-down list.
3. Specify a name and location for the query file.
4. In the Database Fields list, select the fields you want returned when the Select statement is executed.

To select a field, click the field name and click Add, or double-click the name.
5. Click OK.

See also
Query files 



Details: Creating a query file in Approach

Contents of a query file
If you create a query file in Approach, the file stores the log-on information you used when you connected to the 
current table's server. And if you have executed a find or sort in the table, the search and sort conditions are stored in
the query file as the Select statement (if they can be translated into SQL).
If you create a query file using a text editor, you can specify the log-on information and Select statement. For more 
information, see Query files.

Saving vs. exporting
If you create a query file by saving, the file has an Approach file. You'll be able to open the query file by opening its 
Approach file.
If you create a query file by exporting, the exported data does not have an Approach file. You can create an Approach
file for it by using the Save As command.
When exporting data, you can specify the particular fields you want stored for the Select statement. This way, the 
query file will open faster because it won't have to find or sort every field in the table.



Opening a query file in Approach

When you open a query file, you automatically connect to a server using the log-on information in the file. Then the 
Select statement executes a find or sort and returns data to a read-only file on your local drive.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select Query in the List Files of Type drop-down list.
If the query file you want has an Approach file, you can leave this as Approach Files.

3. Select the file you want to open in the File Name list and click OK.
4. If a Connect dialog box appears, fill in the information.

The dialog box appears if you are not already connected to the appropriate SQL server.

See also
Query files 
Connecting to an Oracle server 
Connecting to a server in SQL Server 
Connecting to an IBM DB2 server through MDI 



Saving or exporting data from a query

A query file's Select statement returns data to a temporary read-only data file on your local drive. You can keep this 
data by either saving it in a database file or exporting it to a database file.

To save data from a query:
1. With the temporary data file active, choose Save As from the File menu.
2. In the Save Approach File dialog box, specify a name and location for the Approach file.
3. Select "Exact copy" in the Databases area and click OK.
4. In the Save Database As dialog box, select a database file type in the List Files of Type drop-down list.
5. Specify a name and location for the database file and click OK.

To export data from a query:
1. With the temporary data file active, choose Export Data from the File menu.
2. Specify a name and location for the database file.
3. Select a database file type in the List Files of Type drop-down list.
4. In the Database Fields list, select the fields you want to export.

To select a field, click the field name and click Add, or double-click the name.
5. Click OK.

See also
Query files 



Details: Saving or exporting data from a query

If you save data from a query in a database file, the data has an Approach file. You'll be able to view and edit the data
by opening its Approach file.
If you export data from a query to a database file, the exported data does not have an Approach file. You can create 
an Approach file for it by using the Save As command.
When exporting data, you can specify the particular fields you want stored.



About working with ODBC data sources
Approach is fully compatible with the Open Database Connectivity standard (ODBC). If you have databases in 
applications that have an ODBC driver, you can work with those databases in Approach.
An ODBC driver installed on your system appears in the List Files of Type drop-down list in the Open dialog boxes. In
most cases, the name of the driver appears just like other names in the list; for example, Access. But if the application
is also available as a PowerKey in Approach, the name is prefixed with "ODBC"; for example, ODBC:Oracle.
The procedure for opening an ODBC data source varies slightly depending on the type of the data source. Some 
sources are database files like .DBF files. In these cases, you can open the files just as you open a dBASE, Paradox,
or FoxPro file: After selecting the ODBC driver in the List Files of Type drop-down list, you find and select the file in 
the Open dialog box. For more information, see Opening a database created in another application.
ODBC data sources can also be database tables, tables in server applications, and data sources you have set up on 
your system.

Opening a database table through ODBC         
You can use ODBC to get access to data organized in database tables.You need to see the contents of the database 
first and then select the table in it you want. 

Opening a database table on a server through ODBC         
You can use ODBC to open a database table on a server. You may be prompted to connect to a server if Approach 
cannot find the server information in your ODBC.INI file. You can be connected to more than one server at a time. 

Opening an ODBC data source set up on your system         
If you have an ODBC data source already set up on your system, you can open it quickly with very little navigating 
through the Open dialog box.

Installing an ODBC driver         
If ODBC is installed on your computer, you can usually install an ODBC driver using the Windows Control Panel. 
Some vendors of ODBC drivers have a different procedure for installing. In those cases, see the documentation that 
came with the driver.

Setting up an ODBC data source         
After installing an ODBC driver, you can set up data sources for the driver. This stores information about the data's 
location in your ODBC.INI file and tells Approach where to find the data when you try to open it.

See also
ODBC data sources 
Setting database options for all SQL tables 



Opening a database table through ODBC

You can use ODBC to get access to data that is organized in database tables.You need to see the contents of the 
database first and then select the table in it you want. 
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select an ODBC driver for a database table application in the List Files of Type drop-down list.
The databases in the application appear in the Directories list with a filecard icon in front of them.

3. Double-click the name of the database in the Directories list.
4. Select the name of the table in the File Name list.
5. Click OK.
6. If an alert box appears, click OK to open the table.

The alert box appears if your preferences are set for displaying SQL and ODBC tables read-only.



Opening a database table on a server through ODBC

You can use ODBC to open a database table on a server. You may be prompted to connect to a server if Approach 
cannot find the server information in your ODBC.INI file.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select an ODBC driver for a server application in the List Files of Type drop-down list.
The Drives drop-down list changes to Server and shows the names of servers you can connect to through the 
ODBC driver.

3. Select a server in the Server drop-down list.
The names of databases, qualifiers, or owners on the server appear in the Directories list.

4. If a Setup dialog box appears, fill it in and click OK.
The dialog box appears if your ODBC.INI file does not have setup information for the driver. See the 
documentation that came with the driver for details.

5. Double-click the name of the database, qualifier, or owner in the Directories list.
The tables in the database appear in the File Name list.

6. Select the name of the table in the File Name list.
7. Click OK.
8. If an alert box appears, click OK to open the table.

The alert box appears if your preferences are set for displaying SQL and ODBC tables read-only.



Details: Opening a database table on a server through ODBC

Information in the Open dialog box
When you select an ODBC driver for a server application in the List Files of Type drop-down list, the information that 
appears in the Open dialog box varies depending on the driver: 

If an ODBC driver supports qualifiers for table names, the names of the qualifiers appear in the Directories 
list. If the driver also supports ownership, the names of owners and the names of tables appear in the File Name list 
(such as DBA.EMPLOYEE); if the driver does not support ownership, only the names of tables appear in File Name.

If an ODBC driver supports ownership but not qualifiers, the names of owners appear in the Directories list 
and the names of tables appear in the File Name list.

If an ODBC driver supports neither qualifiers nor ownership, the names of servers appear in the Directories 
list and the names of tables appear in the File Name list.

"Quick connecting" to an ODBC server
Once you specify the name of a server and database in the Open dialog box, Approach keeps track of that 
connection for your current work session. The next time you open the dialog box and select the ODBC driver, the 
name of the connection you used for it before will appear in the Server drop-down list; for example, Joann Willis @ 
Accounting.
If you select the connection name in the Server drop-down list, the File Name list shows the tables you used before 
on that server. This way, you don't need to establish a connection and select in the Directories list.

Disconnecting from an ODBC server
When you quit Approach, you are disconnected from any ODBC servers you connected to in that session. You can 
also use the Open dialog box to disconnect from a particular server. Select the connection name in the Server drop-
down list and click Disconnect.



Opening an ODBC data source set up on your system

If you have an ODBC data source already set up on your system, you can open it quickly with very little navigating 
through the Open dialog box.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select ODBC Data Sources in the List Files of Type drop-down list.
The names of the data sources you have set up appear in the Directories list.

3. Double-click the name of a data source in the Directories list.
The tables in the data source appear in the File Name list.

4. If a Setup dialog box appears, fill it in and click OK.
The dialog box appears if your ODBC.INI file does not have all of the required information about the data source 
for the driver.

5. Select the name of the table in the File Name list.
6. Click OK.
7. If an alert box appears, click OK to open the table.

The alert box appears if your preferences are set for displaying SQL and ODBC tables read-only.

See also
Setting up a data source for an ODBC driver



Installing an ODBC driver

If ODBC is installed on your computer, you can usually install an ODBC driver in the Windows Control Panel following
these instructions.
1. In the Main group in the Windows Program Manager, double-click the Control Panel icon to open the Control 

Panel.
2. Double-click the ODBC icon.
3. In the Data Sources dialog box, click Drivers.
4. In the Drivers dialog box, click Add.
5. In the Add Driver dialog box, type the name of the drive and directory for the driver in the text box, or click 

Browse to select a drive and directory name.
6. Click OK.
7. In the Install Drivers dialog box, select the driver you want to install in the Available ODBC Drivers list.
8. Click OK.

See also
Setting up a data source for an ODBC driver



Setting up a data source for an ODBC driver

After installing an ODBC driver, you can set up data sources for the driver. This stores information about the data's 
location in your ODBC.INI file and tells Approach where to find the data when you try to open it.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.

2. Select the ODBC driver for the data source in the List Files of Type drop-down list.
3. Click Setup.
4. Fill in the Setup dialog box and click OK.

The Setup dialog box varies depending on the driver. See the documentation that came with the driver for 
details.

5. Click OK.

See also
Installing an ODBC driver 



Creating a new database file



Opening an Approach file



Mapping fields in an Approach file



Opening a database created in another application 



Opening a table created in Microsoft Access



Creating a database from a spreadsheet



Creating a database from a delimited text file



Creating a database from a fixed-length text file



Saving an Approach file



Saving a copy of an Approach file and a database file



Saving a copy of an Approach file only



Closing an Approach file



Deleting a file



Connecting to an Oracle server



Connecting to Oracle on your local drive



Connecting to a server in SQL Server



Connecting to an IBM DB2 or SQL/DS server through ODBC



Connecting to an IBM DB2 server through MDI



Creating a query file in Approach



Opening a query file in Approach



Saving or exporting data from a query



Opening a database table through ODBC



Opening a server database through ODBC



Opening an ODBC data source set up on your system



Installing an ODBC driver



Setting up an ODBC data source



About adding, editing, and deleting database fields
If you create a database file using a template, the new database has fields already defined; if you create a database 
file without a template, you define the fields yourself in the Field Definition dialog box. You can also add more fields to
a database and edit and delete existing fields.

Adding fields to a database        
For each field you define, you need to assign a name, specify the type of data the field can store, and in some cases 
set a maximum length. If a field is calculated, you also need to set up a formula.
If you add fields to an existing database, they do not automatically appear in any views. You can add fields to views 
by dragging them from the Add Field dialog box or by drawing them with the Field tool.

Setting up a formula for a calculated field         
When you add a calculated field to a database, you need to set up a formula for the field. Approach calculates the 
result of the formula and displays the result in the field. The result can be a text string, a number, a date or time, or a 
Boolean value.

Setting up a formula for a summary calculated field         
If a formula applies to a range of records, you need to use a function defined specifically for summaries and specify 
the set of records to summarize. 

Editing a field         
You can edit the name, type, length, or formula of any existing field. The change applies to the field throughout the 
database -- even if the field already has data in any of the records.

Specifying a key field for a Paradox database        
A key field is a field or a combination of fields that uniquely identifies each record, such as an invoice number or a first
name and last name together. Using a key field ensures that there are no duplicate records in a database. The 
Paradox database file type requires a key field in Approach.

Deleting a field        
When you delete a field, Approach removes the field and its data from every record in the database.

See also
About creating and opening files 
About customizing a field for data entry 



Adding fields to a database

For each field you define, you need to assign a name, specify the type of data the field can store, and in some cases 
set a maximum length. If a field is calculated, you also need to set up a formula.
1. Choose Field Definition from the Create menu, or create a new database file without using a template.
2. If you created the database file without using a template and want to use predefined fields, select a template in 

the Template drop-down list.
3. For the first field you want to add, type a name for the field in the Field Name text box in an empty line. 

If necessary, first click Insert to place a new empty line above the line with the insertion point or go to the empty 
line at the bottom of the field list.

4. Select a type for the field in the Data Type drop-down list.
5. If necessary, type a length for the field in the Size text box.
6. Continue defining and adding fields in the same manner.
7. To change the order of the fields in the Field Definition dialog box, select an order in the View Fields By drop-

down list.
8. To print a copy of the field definitions, click Print and use the Print dialog box to print the list of definitions.
9. Click OK.

See also
Setting up a formula for a calculated field 
About displaying fields on a view    



Details: Adding fields to a database

Field Definition dialog box
If you create a database file without using a template, the Field Definition dialog box appears automatically so that 
you can add fields to the database. "Creating New Database" and the name of the file appear in the title bar of the 
dialog box.
You can also open the Field Definition dialog box at any time to add more fields to an existing database file.

Field names
In a dBASE or FoxPro database created in Approach, the names of fields can be up to 32 characters long. You can 
use any characters in a field name, including letters, whole numbers, spaces, commas, periods, and arithmetic signs.
In a Paradox database created in Approach, the names of text, numeric, and date fields can be up to 25 characters 
long; the names of time, memo, Boolean, and PicturePlus fields can be up to 18 characters long. These characters 
can include letters, whole numbers, spaces, commas, periods, and arithmetic signs. 
In an Access table created in Approach, the names of text, numeric, memo, and Boolean fields can be up to 32 
characters long; the names of date, time, and PicturePlus fields can be up to 26 characters long. The first character 
must be a letter, but after that, a name can have letters and whole numbers.
The field names stored in a database file may be different from the field names you use with that file through 
Approach. For details about field names, see File types.

Field types
The possible field types are Boolean, calculated, date, memo, numeric, PicturePlus, text, time, and variable. 
If you select the calculated, PicturePlus, or variable type, the bottom of the Field Definition dialog box shows a panel 
for entering a formula or for setting options.

Field lengths
You need to enter a maximum length for text fields in all types of databases and for numeric fields in some types of 
databases.
For a text field, type the number of characters you want allowed in the field. In dBASE, FoxPro, or DB2, a text field 
can have up to 254 characters; in Paradox, Access, Oracle SQL, or SQL Server, it can have up to 255 characters. (In 
Oracle SQL 7 a text field can be up to 2000 characters, but Approach treats any text field over 255 characters as a 
memo field.)
dBASE and FoxPro databases require a length for numeric fields. Type the number of digits you want to the left and 
to the right of the decimal point. You can have up to 19 digits on the left and up to 15 on the right, but the total number
of digits cannot exceed 19.

Field order
All the fields except for calculated and variable ones appear in the Field Definition dialog box in the order you add 
them. Calculated and variable fields are at the end of the list because they are part of the Approach file and not part 
of the database.
The possible field orders are Default Order, Field Name (alphabetical), Data Type (grouped by type), and Custom 
Order. If you select Custom Order, you can drag the fields up and down in the list to rearrange them.
The field order affects only how fields appear in the dialog box. In a database, fields are stored in the order they were 
created.

Key fields for a Paradox database
If you're defining fields for a new Paradox database, the Choose Key Field dialog box appears so that you can select 



a field to use as the key field. If the database does not have a unique field or a combination of fields you can use for 
this, click Add Key Field in the dialog box. Approach creates a copy of the database file and adds the new field to it, 
with a unique number for each record.

Displaying fields on a view
When you add fields to a database, they do not automatically appear on any views. You can add fields to views by 
dragging them from the Add Field dialog box or by drawing them with the Field tool.
If "Show the Add Field dialog" is on in Preferences, when you close Field Definition you go to Design and the Add 
Field dialog box opens. For more information about this setting, Setting general working preferences.



Setting up a formula for a calculated field

When you add a calculated field to a database, you need to set up a formula for the field. Approach calculates the 
result of the formula and displays the result in the field.
1. Choose Field Definition from the Create menu, or create a new database file without using a template.
2. Type the name of the calculated field and select Calculated in the Data Type drop-down list. 

The bottom part of the Field Definition dialog box shows the options for setting up a formula.
3. In the Define Formula panel, build the formula by clicking the elements you want or by typing in the Formula text 

box.
4. Click OK.

See also
Setting up a formula for a summary calculated field 
Adding fields to a database 



Details: Setting up a formula for a calculated field

Formula text box
When you select a field name, a function name, or an operator in one of the lists in the Define Formula panel, 
Approach copies it into the Formula text box. You can also type these elements directly into the text box, and you can
type constants in the box. To move the insertion point in the Formula text box, click where you want it to go or press 
the left or right arrow key.

Field names
The Fields list shows the fields defined for the database except for PicturePlus and memo fields. Calculated and 
variable fields are in italics. To see the fields in a different joined database, select the database you want in the Fields
drop-down list.
Field names with spaces or other special characters such as hyphens must be enclosed in double quotation marks. If
you click a field name in the Fields list, Approach provides the quotation marks for you.

Constants
Enclose text, date, and time constants in single quotation marks. 

Order of evaluation
To change the order of evaluation, use parentheses to enclose the expressions you want evaluated first.

Syntax flag
When a formulas syntax is complete and correct, the flag in the Define Formula panel is no longer crossed out.



Setting up a formula for a summary calculated field

If a formula applies to a range of records, you need to use a function defined specifically for summaries and specify 
the set of records to summarize. 
1. Choose Field Definition from the Create menu, or create a new database file without using a template.
2. Type the name of the summary calculated field and select Calculated in the Data Type drop-down list. 

The bottom part of the Field Definition dialog box shows the options for setting up a formula.
3. Select a summary function (such as SSum or SCount) in the Functions drop-down list and supply a field 

reference as the function's parameter.
You can supply the parameter and other parts of the formula by clicking elements in lists or by typing in the 
Formula text box.

4. Click the Define Summary tab.
5. Select which records the formula should apply to in the Summarize On drop-down list.

See the Details topic for options.
6. If you want Approach to maintain a running total for this formula in a view, turn on Make calculation a running 

summary. 
This is not available for the where-placed option.

7. Click OK.

See also
Setting up a formula for a calculated field 
Adding fields to a database 



Details: Setting up a formula for a summary calculated field

To apply a 
formula to

Select

A set of records as
defined by the 
summary panel 
with the calculated
field. 

"Summary panels 
where this field is 
placed"

Every record in the
current found set 
of a database

Summary of all 
records in 
database, where 
database is the 
name of the 
database you want
(This option 
appears for every 
database joined in 
the Approach file.)

Every record in the
current found set 
of all databases 
joined in the 
Approach file

"Summary of all 
records in all 
databases"

A set of records as
defined by a 
summary panel of 
a specific grouping

An option for a 
type of summary 
panel, such as 
"Left leading 
summaries of all 
records in 
database" (These 
options appear for 
every summary 
panel in the 
Approach file.)



Editing a field

You can edit the name, type, length, or formula of any existing field. The change applies to the field throughout the 
database, even if the field already has data in any of the records.
1. Choose Field Definition from the Create menu.
2. If you need to edit a field in a different joined database, select the name of the database in the Database drop-

down list.
3. Select the part of the definition you want to edit and make the change. 

You can type a new name or length or select a new data type. For a calculated field, you can also edit the 
formula.

4. If an alert box appears, click OK to confirm the changes. 
An alert box appears if you change a field type or decrease a length.

5. Click OK.

See also
Adding fields to a database 



Details: Editing a field

These are the effects of editing a field definition:

If you change the name of a field, the new name appears wherever the name is used. This includes field 
references in formulas.

If you change the type of a field that contains data, Approach tries to convert the data to the new type. If it 
cannot convert the data in a particular field, Approach warns you that the data will be deleted and asks if its OK to 
delete the data.

You can change a field type from numeric to text or from text to numeric (if the field does not contain any text) 
without losing data. If you change a calculated field to another type of field, you lose the fields calculated result. If
you change any other type of field, Approach warns you that data will be deleted and asks if its OK to delete the 
data.

If you decrease the length of a field that already contains data, the data is truncated after the new length.

If you change a formula, Approach recalculates the formula in all the records. If the result is used in formulas
in other fields, those formulas are also recalculated. (Some summary calculations are not updated until you preview 
or print.)



Specifying a key field for a Paradox database

When you create or save a database file in the Paradox file type, the Choose Key Field dialog box appears 
automatically so that you can specify a key field.
1. In the Choose Key Field dialog box, click Add Key Field to have Approach add a key field, or select the name of 

the field or fields you want to be the key. 
To select more than one field, CONTROL-click the fields.

2. Click OK.



Details: Specifying a key field for a Paradox database

The list in the Choose Key Field dialog box shows all the text, numeric, date, and time fields defined for the database.
If you click Add Key Field, Approach inserts a numeric field named Key Field at the beginning of each record. The key
field value is a serial number starting at 1, and it increments by 1 from one record to the next.
If you want to change the key field in an existing Paradox database, you can either export the database in the 
Paradox type or save the database as dBASE and then save it again as Paradox. The Choose Key Field dialog box 
appears when you export or save as Paradox. See Saving a copy of an Approach file and a database fileor Exporting 
data from Approach.



Deleting a field

When you delete a field, Approach removes the field and its data from every record in the database.
1. If the field you want to delete is used in a join, unjoin the field. 

Choose Join from the Create menu, select the join line, click Unjoin, close the unjoined database, and click OK.
2. Choose Field Definition from the Create menu.
3. Select the field you want to delete in the list of field definitions. 

If the field is in a different database joined in the Approach file, select the name of the database in the Database 
drop-down list.

4. Click Delete.
5. Click OK in the alert box to delete the field.



Details: Deleting a field

If you delete a field used in a formula, the formula will return a blank result. In views and in the Define Formula panel 
of the Field Definition dialog box, Approach replaces the deleted field name with NO_FIELD_REFERENCE. Edit the 
formula so that it no longer uses that field. See Setting up a formula for a calculated field.
Before deleting a field, make sure you no longer need the data it contains and that you no longer need the field in 
another Approach file. You cannot retrieve data from a deleted field.



About customizing a field for data entry
Approach provides several ways to customize the entry of data in fields.
You can set the data entry options when you create a field or anytime later. If you change an option for an existing 
field, it does not affect any data already in the field. (Approach checks data as you enter it, and not any data already 
in the fields.)

Entering data automatically         
For a text, numeric, date, time, or Boolean field, you can have Approach enter data automatically. This makes filling 
out records as quick, easy, and accurate as possible. For example, you might have Approach date revisions or 
number invoices for you.

Verifying the accuracy of entered data         
For a text, numeric, date, time, or Boolean field, you can have Approach verify that the data in a field is valid for that 
field. For example, Approach can check to see that a customer name in the current record is unique in the database 
or that a numeric value falls within a certain range.

Setting OLE options for a PicturePlus field         
For a PicturePlus field, you can specify whether to allow OLE objects and which application to use as a default OLE 
server.

Setting data options for a variable field         
For a variable field, you can specify the type of data allowed and set an initial value.

See also
About adding, editing, and deleting database fields 
About formatting data in fields 



Entering data automatically

For a text, numeric, date, time, or Boolean field, you can have Approach enter data automatically. For example, you 
might have Approach date revisions or number invoices for you.
1. Choose Field Definition from the Create menu.
2. Add a new text, numeric, date, time, or Boolean field, or select an existing one.
3. If the bottom part of the dialog box is not open, click Options.
4. Set the option for the value you want entered automatically in the current field.

See the Details topic for options.
5. Click OK.



Details: Entering data automatically

Approach can enter a date, a time, fixed data you specify, data from the previous record, a serial number that 
increases or decreases from one record to the next, or the result of a formula.

To Do this
Remove a 
previously set 
option (in any 
field)

Click Nothing.

Enter the data 
from the same 
field in the last 
record added (in 
any field)

Click "Previous 
record."

Enter the date or 
time the record 
was created (in a 
date, time, or text 
field)

Click "Creation date" 
or "Creation time."

Enter the date or 
time the record 
was last modified 
(in a date, time, or 
text field)

Click "Modification 
date" or "Modification 
time."

Enter the same 
data in the field in 
each record (in 
any field)

Click Data and type 
the data you want in 
the text box.

Enter a unique 
number in the field
in each record (in 
a numeric or text 
field)

Click "Serial number" 
and type a value for 
the first record in 
"starting at" and an 
increment value in 
"incremented by." The 
increment value can 
be positive (to 
increase the number) 
or negative (to 
decrease the number).

Enter the result of 
a formula when 
you create the 
record (in any 
field)

Click "Creation 
formula." Then click 
Formula and set up 
the formula in the 
Formula dialog box.

Enter the result of 
a formula when 
you create the 
record and update

Click "Modification 
formula." Then click 
Formula and set up 
the formula in the 



the result 
whenever you 
modify the record 
(in any field)

Formula dialog box.



Verifying the accuracy of entered data

For a text, numeric, date, time, or Boolean field, you can have Approach verify that the data in a field is valid for that 
field. For example, Approach can check that a numeric value falls within a range.
1. Choose Field Definition from the Create menu.
2. Add a new text, numeric, date, time, or Boolean field, or select an existing one.
3. If the bottom part of the dialog box is not open, click Options.
4. Click the Validation tab.
5. Set the options for verifying data in the field. 

See the Details topic for options.
6. Click OK.



Details: Verifying the accuracy of entered data

Approach can verify the accuracy of data as you enter it. If you try to enter data that Approach determines to be 
invalid, an alert box appears describing the problem.

To verify that Do this
The field in each 
record has a 
unique value.

Turn on Unique.

The value is within
an alphabetical, 
numerical, or 
chronological 
range.

Turn on From/to and 
type values for the 
beginning and end of 
the range (inclusive) 
in the text boxes.

The field contains 
a value in each 
record.

Turn on "Filled in."

The value 
matches one of 
the values in a set.

Turn on "One of." 
Then for each value 
you want in the set, 
type the value in the 
text box and click 
Add. To remove a 
value from the set, 
select it and click 
Remove.

A formula 
evaluates to True 
when the value is 
used as an 
operand.

Turn on "Formula is 
true." Then click 
Formula and set up 
the formula in the 
Formula dialog box. 
For example, the 
formula >100 accepts
only values greater 
than 100.

The value 
matches a value in
another field in 
this database or in
a database joined 
to it.

Turn on "In field" and 
select the other field 
in the list. If the other 
field is in a different 
database, select the 
database in the drop-
down list.



Setting OLE options for a PicturePlus field

For a PicturePlus field, you can specify whether to allow OLE objects and which application to use as a default OLE 
server.
1. Choose Field Definition from the Create menu.
2. Add a new PicturePlus field or select an existing one.
3. To allow OLE objects in the field, turn on "Allow OLE objects."
4. Select a default server application in the Default Object Type list.
5. Click OK.

See also
About embedding OLE objects 
About linking OLE objects from other applications 



Details: Setting OLE options for a PicturePlus field

Linking and embedding
When you link an OLE object, the object is not stored in the field, but a copy of the object appears there. The original 
object remains in its source file, and if the original object changes, the copy in the PicturePlus field is updated 
automatically to match it. When you embed an OLE object, the object is stored in the field.

Default OLE servers
If you have a default OLE server application, that application starts when you double-click an empty PicturePlus field 
or when you press the space bar with an empty PicturePlus field selected. You can then create an object, and it will 
be embedded in the field.



Setting data options for a variable field

For a variable field, you can specify the type of data allowed and set an initial value.
1. Choose Field Definition from the Create menu.
2. Add a new variable field or select an existing one.
3. Select a data type in the Field Type drop-down list. 

A variable field can store a text, numeric, date, time, or Boolean value.
4. To give the field an initial value, type the value in the Default Value text box. 

The initial value will appear in the variable field every time you open this Approach file.
5. Click OK.



Adding fields to a database



Setting up a formula for a calculated field



Setting up a formula for a summary calculated field



Editing a field



Specifying a key field for a Paradox database



Deleting a field



Entering data automatically



Verifying the accuracy of entered data



Setting OLE options for a PicturePlus field



Setting data options for a variable field



About displaying fields on a view
You can add a field to a form, report, form letter, or mailing label as a field box, a drop-down list, a checkbox, or a set 
of radio buttons. You must be in Design to add a field to a view, and the field must be defined in a database used in 
your Approach file.
If a field appears in a view as a field box, a user can type a value in the box in Browse. This gives a user the most 
flexibility in what to enter as data.
If a field appears as a drop-down list, as a checkbox, or as radio buttons, a user selects a value to enter in Browse. 
This limits the values a user can enter in the field, and it can make entering data much easier and more accurate.

Adding a field as a field box         
You can add a field as a field box using either the Add Field dialog box or the Field tool. The field box has the border 
width, text attributes, and other properties of the named style for the view.

Displaying a field as a drop-down list         
A field can appear as a drop-down list or as a combination of a drop-down list and a field box. When you set up a 
drop-down list, you can type custom values to appear in it or use values from a database field. You can also show 
values from another field as descriptions rather than as data to enter.

Displaying a subset of data in a drop-down list         
When you set up a drop-down list, you can use existing values from a database field. You can define a set of 
conditions to display only a subset of data from the field.

Displaying a field as a checkbox         
A field can appear as one or more checkboxes. A checkbox has two values: a checked value, which is entered in the 
field when the checkbox is on; and an unchecked value, which is entered when the checkbox is off. You click a 
checkbox in Browse to turn it on or off.
You can add a field to a view as a checkbox or change a field already on a view to a checkbox. Checkboxes can have
custom values you provide or values from the current database field.

Displaying a field as radio buttons         
A field can appear as a set of radio buttons. Each radio button has a value. You click a radio button in Browse to enter
its value in the field.
You can add a field to a view as radio buttons or change a field already on a view to radio buttons. Radio buttons can 
have custom values you provide or values from the current database field.

See also
About adding, editing, and deleting database fields
Adding a field to a worksheet 



Adding a field as a field box

You can add a field as a field box using either the Add Field dialog box or the Field tool. The field box has the border 
width, text attributes, and other properties of the named style for the view.

To add a field as a field box using the Add Field dialog box:
1. In Design, click the Add Field icon or choose Add Field from the Form, Report, Letter, or Mailing Label menu.

2. If you need to define a new field, click Field Definition in the Add Field dialog box and use the dialog box that 
appears.

3. If the field you want is in a different joined database, select the database in the drop-down list in Add Field.
4. Drag the database field you want from Add Field to the view.

To add a field as a field box using the Field tool:
1. In Design, click the Field icon or choose Field from the Create Drawing submenu. 

To draw more than one field, double-click the icon. It will stay selected until you select a different icon.

2. Drag diagonally to draw the field box.
3. In the Basics panel of the field's InfoBox, select the database field you want.



Details:Adding a field as a field box

Adding a field right after defining it
Normally, the Add Field dialog box shows all the fields defined for databases used in the current Approach file. But if 
your preferences are set this way, right after you define new fields the Add Field dialog box appears automatically and
you go to Design. 
When this happens, Add Field shows only the fields you just defined and has a Show All Fields button at the bottom. 
You can click Show All Fields if you want to list all the fields in the dialog box.
For information about this setting, see Setting general working preferences.

Another way to add a field to a form letter
In a form letter, you can also add a field by typing the field name where you want the field to appear. Enclose the field 
name in double angle brackets, and if the Approach file uses joined databases, include the name of the database. For
example, <<ORDERS.DATE>>.



Displaying a field as a drop-down list

When you set up a drop-down list, you can type custom values to appear in it or use values from a database field. 
You can also show values from another field as descriptions rather than as data to enter.
1. In Design, select the field you want to display as a list.
2. In the Basics panel of the field's InfoBox, select Drop-Down List Only or Field Box and List in the Data Entry Type

drop-down list.
3. To use custom values in the drop-down list, select "Type in list items" and type the values you want in the value 

list. 
If you want to put a new line between two existing values, click Insert to add a line right above the one with the 
insertion point.

4. To use values from a database field, select "Create list automatically from field data." 
Approach finds the unique values for the current field and displays them in the value list.

5. To show an arrow button with the drop-down list, turn on "Show drop-down arrow."
6. To set options for the values in the drop-down list, click Options. 

The bottom part of the dialog box opens.
7. To use values from a database field other than the current field, select the field you want in the field list on the 

left. 
If the field is in a different joined database, select the database in the drop-down list. Approach finds the unique 
values for the selected field and displays them in the value list.

8. To show values from another field as descriptions rather than as actual data to enter, turn on "Show description 
field" and select a field in the description field list.

9. Click OK.

See also
Displaying a subset of data in a drop-down list



Details: Displaying a field as a drop-down list

The values you display in a drop-down list do not have to be the data that will actually be entered in the field. You can
show data simply as "descriptions" of what to enter. 
For example, suppose a field with a drop-down list stores an employee ID. To make it easier to enter employee IDs in
the field, you could display the employees' last names in the list rather than their IDs. Then when you select a name 
in the list in Browse, the ID corresponding to that name is entered into the field. To set this up, you select the 
employee ID field in the field list on the left in the Drop-Down List dialog box, turn on "Show description field," and 
select the employee name field in the description field list.



Displaying a subset of data in a drop-down list

When you set up a drop-down list, you can use existing values from a database field. You can define a set of 
conditions to display only a subset of data from the field.
1. Display a field on a view as a drop-down list.
2. In the Define Drop-Down List dialog box, click "Create list automatically from field data."
3. Click the Options button.
4. Turn on "Filter the list based on another field."
5. Select the field or fields with the value you want to match.

In Browse, the drop-down list will show only values from records that have the same data in the match field as 
the current record.

6. Click OK.
7. Click OK in the Define Drop-Down List dialog box.

See also
Displaying a field as a drop-down list



Details: Displaying a subset of data in a drop-down list

One database
If the current Approach file uses one database file, the Define Filter dialog box shows the fields in that database. 
Select a field to be the match field.
For example, suppose a database stores information about all of your employees. If you'd like to limit a drop-down list
to only the names of employees with the same job title as the current employee record, you select the field with the 
job titles.

Joined databases
If the current Approach file uses joined database files, the Define Filter dialog box shows fields from all of the 
databases. Select a field to match between the current database on the left (with the drop-down list) and a joined 
database on the right.
For example, suppose you have three joined databases: one for orders, one for line items in orders, and one for 
product data. In a repeating panel for entering products on an order form, you might use a drop-down list of product 
names for filling out the form. If in particular countries only some of the products are available, you can add a Country
field to the product and order databases. Then in the Define Filter dialog box, select the Country field in the two 
databases.



Displaying a field as a checkbox

You can add a field to a view as a checkbox or change a field already on a view to a checkbox. Checkboxes can have
custom values you provide or values from the current database field.

To add a field to a view as a checkbox:
1. In Design, click the Checkbox icon or choose Checkbox from the Create Drawing submenu. 

To add more than one field as a checkbox, double-click the icon. It will stay selected until you select a different 
icon.

2. Drag diagonally to draw an area for the checkbox.
3. In the Define Checkbox dialog box, select a database field for the checkbox in the field list. 

If the field you want is in a different joined database, select the database in the drop-down list.
4. To use custom values for the checkbox, type a Checked value, an Unchecked value, and a checkbox label. 

If you want to put a new line between two existing checkboxes, click Insert to add a line right above the one with 
the insertion point.

5. To use values from the database field, click Create Checkboxes from Field Data. 
Approach finds all the unique values for the selected field and displays them as Checked values and labels. You 
need to provide the Unchecked values.

6. Click OK.

To change a field already on a view to a checkbox:
1. In Design, select the field you want to display as a checkbox.
2. In the Basics panel of the field's InfoBox, select Checkboxes in the Data Entry Type drop-down list.
3. To use custom values for the checkbox, type a Checked value, an Unchecked value, and a checkbox label.
4. To use values from the database field, click Create Checkboxes from Field Data. 

Approach finds all the unique values for the current field and displays them as Checked values and labels. You 
need to provide the Unchecked values.

5. Click OK.

See also
Displaying a field as radio buttons 



Details: Displaying a field as a checkbox

Because each checkbox has two values, you should typically set up only one checkbox for a field. When you click the
checkbox, you go back and forth between its Checked and Unchecked values. (If you want a set of clickable options 
in which one option is always on, use radio buttons instead of checkboxes.)
If you never click a checkbox, its value is Null. You must click a checkbox to turn it on and then click it again to turn it 
off to enter its Unchecked value.
If a field has more than one checkbox, only one checkbox can be on at a time (but it is possible for no checkbox to be
on). When you turn on a checkbox, any box already on in the set is turned off. You can turn off a checkbox to enter its
unchecked value in the field.



Displaying a field as radio buttons

You can add a field to a view as radio buttons or change a field already on a view to radio buttons. Radio buttons can 
have custom values you provide or values from the current database field.

To add a field to a view as radio buttons:
1. In Design, click the Radio Button icon or choose Radio Button from the Create Drawing submenu. 

To add more than one field as radio buttons, double-click the icon. It will stay selected until you select a different 
icon.

2. Drag diagonally to draw an area for the radio buttons.
3. In the Define Radio Button dialog box, select a database field for the radio buttons in the field list. 

If the field you want is in a different joined database, select the database in the database drop-down list.
4. To use custom values for the radio buttons, type the Clicked values and button labels. 

If you want to put a new line between two existing buttons, click Insert to add a line right above the one with the 
insertion point.

5. To use values from the database field, click Create Buttons from Field Data. 
Approach finds all the unique values for the selected field and displays them as Clicked values and button labels.

6. Click OK.

To change a field already on a view to radio buttons:
1. In Design, select the field you want to display as radio buttons.
2. In the Basics panel of the field's InfoBox, select Radio Buttons in the Data Entry Type drop-down list.
3. To use custom values, type the Clicked values and button labels.
4. To use values from the database field, click Create Buttons from Field Data. 

Approach finds all the unique values for the current field and displays them as Clicked values and button labels 
in the list.

5. Click OK.

See also
Displaying a field as a checkbox 



Details: Displaying a field as radio buttons

Entering a value with a radio button
Because each radio button has only one value, you should normally use a set of two or more radio buttons for a 
single field. You click a radio button to enter that value in the field. If you never click one of the radio buttons in a set, 
the field's value is Null.
In a set of radio buttons, only one button can be on at a time. When you turn on a radio button, any button that is 
currently on in the set is turned off.

Rearranging a set of radio buttons
A set of radio buttons is initially one grouped object. If you want to rearrange the buttons, ungroup the buttons and 
then drag the buttons to move them. When you're finished, group the buttons again. For more information, see 
Grouping and ungrouping objects.



About formatting data in fields
Approach provides predefined formats for displaying and printing date, time, numeric, and text data in a field. You 
must be in Design to set a format for a field.
When you enter data in a field with a format, you enter only the data itself. Approach automatically provides 
formatting characters, such as currency symbols or thousands separators. You see the data in its format when you 
move out of the field.
If "Show data entry format" is on for a date, time, or numeric field, formatting characters appear in the field when you 
click in it to enter data, and underlines show the maximum number of characters; you can press the space bar to 
move past a separator. A format affects only how data appears in a view and not how it is stored in the database. 
If "Show data entry format" is on for a text field, you see the data in its capitalization style as you type, and the data is
stored in the database in its format.

Setting a standard date format         
A standard date format can display the day of a week, a month, a date, and a year. You identify which of these 
elements you want to include and in what order you want the month, date, and year to appear.
The format can spell out the day or use an abbreviation; spell out the month, use an abbreviation, or use a numeral; 
use a fixed two-digit date or a flexible one- or two-digit date; and use a four-digit year or a two-digit year.

Setting a special date format for periods of a year         
A special date format can display a quarter, a trimester, or a semiannual period, along with a year. You can use a 
predefined format or create a custom format of your own.

Setting a time format         
A time format can display hours and minutes (HH:MM); hours, minutes, and seconds (HH:MM:SS); or hours, minutes,
seconds, and hundredths of a second (HH:MM:SS.00). Approach is preset to use a colon as the separator between 
hours, minutes, and seconds, but you can change the separator to another character.
You can use either a 12-hour system or a 24-hour system for numbering hours. If you use 12-hour numbering, 
Approach displays an AM or PM suffix with the time.

Setting a numeric format         
A numeric format specifies the number of digits, a thousands separator, and other numeric properties. You can use a 
predefined numeric format or create a custom numeric format of your own.

Setting a text format         
A text format can display all capital letters, all lowercase letters, or capital letters for the first letter in each word.

See also
InfoBox 



Setting a standard date format

A standard date format can display the day of a week, a month, a date, and a year. You identify which of these 
elements you want to include and can specify the display of the elements in several ways.
1. Select the field in Design.
2. Open the InfoBox.

3. Click the Format tab.
4. Select Date in the Format Type drop-down list.
5. Set the options in the Format panel.

See the Details topic for options.

See also
Setting a special date format for periods of a year 



Details: Setting a standard date format

To Do this
Change to another 
order for month, 
day, and year

Select an order in 
the Current Format 
drop-down list.

Change the spelling
of days (spelled out
or abbreviated) or 
turn off the display 
of days

Select an option in 
the Day drop-down 
list. Select the blank
option to turn off the
display.

Change the spelling
of months (spelled 
out, abbreviated, or
numeral) or turn off 
the display of 
months

Select an option in 
the Month drop-
down list. Select the
blank option to turn 
off the display.

Change the number
of digits for dates 
(fixed two digits or 
flexible one or two 
digits) or turn off the
display of dates

Select an option in 
the Date drop-down 
list. Select the blank
option to turn off the
display.

Change the number
of digits for years 
(four or two) or turn 
off the display of 
years

Select an option in 
the Year drop-down 
list. Select the blank
option to turn off the
display.

Change a separator
between days, 
months, and years

Edit the character in
a text box right after
the element

Show a data entry 
format in a field 
when you click in it 
in Browse

Turn on "Show data 
entry format."



Setting a special date format for periods of a year

A special date format can display a quarter, a trimester, or a semiannual period, along with a year. You can use a 
predefined format or create a custom format of your own.
1. Select the field in Design.
2. Open the InfoBox.

3. Click the Format tab.
4. Select Date in the Format Type drop-down list.
5. Select Other in the Custom Format drop-down list.
6. Set the options in the Format panel.

See the Details topic for options.

See also
Setting a standard date format 



Details: Setting a special date format for periods of a year

Options in the Format panel

To Do this
Change to another 
predefined format 
for a quarter, 
trimester, or 
semiannual period

Select a format in 
the Predefined 
Format Codes list.

Create a custom 
format

Edit the format's 
syntax in the Format
Code text box.

Show a data entry 
format in a field 
when you click in it 
in Browse

Turn on "Show data 
entry format."

Syntax for special date formats
A numeral in a special date format represents the period displayed: 4 means a quarter, 3 means a trimester, 2 means 
a semiannual period, and 1 means an entire year. 
The number of times the numeral appears in the format specifies how the numeral is displayed in the field: one 
numeral means a cardinal number (1, 2, and so on), two numerals means an ordinal number (1st, 2nd, and so on), 
and three numerals means spelled out (First, Second, and so on).
If a special date format includes the year, YYYY specifies all four digits of the year (such as 1994) and YY specifies 
the last two digits (such as 94).
A format can also include literal text (such as "Quarter"). If the literal text includes the character D, M, Y, 2, 3, or 4, 
enclose the text in double quotation marks.
These are some of the predefined special date formats:

Format With the date 
5/1/94

Q4 Q2
YYQ4 94Q2
44 Qtr. YY 2nd Qtr. 94
444 Quarter, 
YYYY

Second Quarter
1994



Setting a time format

A time format can display hours and minutes (HH:MM); hours, minutes, and seconds (HH:MM:SS); or hours, minutes,
seconds, and hundredths of a second (HH:MM:SS.00). You can use a 12-hour or 24-hour system.
1. Select the field in Design.
2. Open the InfoBox.

3. Click the Format tab.
4. Select Time in the Format Type drop-down list.
5. Set the options in the Format panel.

See the Details topic for options.



Details: Setting a time format

To Do this
Change to another
predefined format

Select a format in 
the Current Format 
drop-down list.

Change to 12-hour
or 24-hour 
numbering for 
hours

Select an option in 
the Time drop-
down list.

Change the AM or 
PM suffix that 
appears with 12-
hour numbering

Type a suffix in one
of the text boxes in 
the Time Suffix 
area.

Change the 
separator between
hours, minutes, 
and seconds

Edit the text in the 
Time Separator text
box.

Show a data entry 
format in a field 
when you click in it
in Browse

Turn on "Show data
entry format."



Setting a numeric format

A numeric format specifies the number of digits, a thousands separator, and other numeric properties. You can use a 
predefined numeric format or create a custom numeric format of your own.
1. Select the field in Design.
2. Open the InfoBox.

3. Click the Format tab.
4. Select Numeric in the Format Type drop-down list.
5. Set the options in the Format panel.

See the Details topic for options.



Details: Setting a numeric format

Options in the Format panel

To Do this
Change to 
another 
predefined format

Select a format in 
the Current Format 
drop-down list.

Create a custom 
format

Edit the format's 
syntax in the 
Format Code text 
box.

Show a data entry
format in a field 
when you click in 
it in Browse

Turn on "Show data
entry format."

Syntax for numeric formats
Zeroes (0) in a numeric format represent required digits, number signs (#) represent optional digits, and a period (.) 
specifies the position of the decimal point. If a comma is surrounded by zeroes or number signs, it acts as a 
thousands separator.
Dollar signs ($), minus signs (-), plus signs (+), colons (:), and parentheses are literal characters. Other literal 
characters must be enclosed in double quotation marks (") in the format.
A percentage sign (%) converts a number to a percentage. 
If a format has two parts divided by a semicolon (;), the part to the left of the semicolon is a format for positive 
numbers, and the part to the right is a format for negative numbers.
If a format begins with an integer and an equal sign (=), greater than sign (>), or less than sign (<), the format applies 
only to data that has the number of digits specified by the integer and sign. A format line can have more than one of 
these conditional formats together, with each format separated by a vertical or sign (|). For example, suppose a field 
has this format:

=7 000-0000|<7 "x"0000
If you enter 1234567, the data appears as 123-4567. If you enter 12345, the data appears as x1234.
These are some of the predefined numeric formats:

Format With 8000 With -8 With .8
Integer
#,##0;(#,##0)

8,000 (8) 1

General
#,##0.00;
(#,##0.00)

8,000.00 (8.00) 0.80

Currency
$#,##0;($#,##0)

$8,000 ($8) $1

Currency 
Decimal
$#,##0.00;
($#,##0.00)

$8,000.00 ($8.00) $0.80

Percent 800000% -800% 80%



0%
Percent Decimal
0.00%

800000.00% -800.00% 80.00%

Scientific
0.00e+00

8.00e+03 -8.00e+0 8.00e-01

The other predefined formats provide a required number of digits for several types of numeric information:

Telephone: >7 (###)" "000-0000|=7 000-0000
This format is for a U.S. telephone number. If a field has seven digits, no area code appears (###) and all the 
numerals appear in the 000-0000 part of the format. If a field has more than seven digits, the numerals begin 
with the area code.

Social Security: 000-00-0000
This format is for a U.S. social security number.

Zip Code: >5 00000-0000|=5 00000
This format is for a U.S. zip code. If a field has more than five digits, the code includes the -0000 extension.



Setting a text format

A text format can display all capital letters, all lowercase letters, or capital letters for the first letter in each word.
1. Select the field in Design.
2. Open the InfoBox.

3. Click the Format tab.
4. Select Text in the Format Type drop-down list.
5. To change to another predefined format, select a format in the Current Format drop-down list.
6. To show a data entry format when you click in the field in Browse, turn on "Show data entry format."

This also stores the formatted data in the database.



About editing fields
You can edit fields on views in several ways. You must be in Design to edit fields.
In addition to the changes described in this section, you can move, cut, copy, paste, and delete fields as you can 
other types of design objects. For more information, see About editing objects and text.

Changing the basic properties of a field         
A field's basic properties are the field definition, the data entry type, the named style, and whether the field is read-
only or non-printing.

Changing text attributes of data         
You can change the font, size, color, text style, text relief, and alignment of data in a field.

Changing line or color settings for a field         
You can set a fill color for a field's interior, a width and color for the borders, and a color for a drop shadow. You can 
also turn on only the borders you want and add a dotted line as a baseline for data.
A field can also have a raised or indented frame for a three-dimensional look. If you give a field a frame, all four 
borders are automatically turned on.

Changing the wording, text attributes, or position of a label         
A field label initially has the same wording as the field name, but you can edit the label to use any text you want. You 
can also change the text attributes of a label and move a label to any side of its field.

Sliding or resizing a field when you print         
Because data in fields can vary in length, you may end up with too much blank space in a view. You can slide fields 
and reduce their boundaries to eliminate some of the extra space.
Approach slides fields or resizes their boundaries when you preview or print, and in Design if you are showing data.

Changing the data entry orders for fields         
Approach initially sets the data entry order to be the order in which fields and macro buttons were added to a view, 
but you can change the order to whatever you want. You can either change the current data entry order or create a 
new order.
Radio buttons and checkboxes each have a separate position in the data entry order.

See also
InfoBox 
Attaching a macro to a field 



Changing the basic properties of a field

A field's basic properties are the field definition, the data entry type, the named style, and whether the field is read-
only or non-printing.
1. Select the field in Design.
2. Open the InfoBox.

3. Click the Basics tab.
4. Set the options in the Basics panel.

See the Details topic for options.

See also
Displaying a field as a drop-down list 
Displaying a field as a checkbox 
Displaying a field as radio buttons 



Details: Changing the basic properties of a field

To Do this
Change the 
definition of a 
database field

Click Field Definition 
and edit the 
definition in the 
dialog box.

Change to another 
data entry type, 
such as a drop-
down list or a set of
radio buttons

Select the data type 
in the Data Entry 
Type drop-down list. 
If a dialog box 
appears, specify the 
values.

Change the values 
used in a drop-
down list or a set of
checkboxes or 
radio buttons

Click Define List or 
Define Buttons and 
edit the values in the
dialog box.

Make a field read-
only in the current 
view

Turn on Read-only.

Make a field non-
printing in the 
current view

Turn on Non-
printing.

Show a non-
printing field in 
Preview

Turn on Show in 
Preview. (This is 
available only if Non-
printing is on.)

Apply a named 
style with width, 
color, and text 
properties already 
defined

Select a style in the 
Named Style drop-
down list.



Changing text attributes of data

You can change the font, size, color, text style, text relief, and alignment of data in a field.
1. Select the field in Design.
2. Open the InfoBox.

3. Click the Text tab.
4. Set the options in the Text panel.

See the Details topic for options.



Details: Changing text attributes of data

To Do this
Change the font of
data

Select a font in the 
Font Name drop-
down list.

Apply boldface, 
italics, underlining,
or strikethrough to 
data

Select one or more 
styles in the 
Style/Effect list.

Change the font 
size of data

Select a size in the 
Size drop-down list.

Apply a color to 
data

Select a color in the 
Text Color drop-down 
list.

Apply a raised or 
indented look to 
data

Select a relief in the 
Text Relief drop-down
list.

Change the 
alignment of data 
to left, center, or 
right 

Select an option in 
the Alignment area.



Changing line or color settings for a field

You can set a fill color for a field's interior, a width and color for the borders, and a color for a drop shadow. You can 
also turn on only the borders you want and give a field a raised or indented frame.
1. Select the field in Design.
2. Open the InfoBox.

3. Click the Lines and Colors tab.
4. Set the options in the Lines and Colors panel.

See the Details topic for options.



Details: Changing line or color settings for a field

To Do this
Change the width 
of the borders of a
field

Select a width in the 
Border Width drop-
down list.

Change the color 
of the borders of a
field

Select a color in the 
Border Color drop-
down palette. Select 
T for transparent.

Change the fill 
color of the interior
of a field

Select a color in the 
Fill Color drop-down 
palette. Select T for 
transparent.

Give a field a drop
shadow

Select a color in the 
Shadow Color drop-
down palette. Select 
T for no shadow.

Give a field a 
raised or indented 
frame

Select a frame style 
in the Frame drop-
down list.

Show borders or a
baseline for a field

Turn on options in the
Borders area.

Include the field 
label inside 
borders

Turn on "Borders 
enclose label."



Changing the wording, attributes, or position of a label

A field label initially has the same wording as the field name, but you can edit the label to use any text you want. You 
can also change the text attributes of a label and move a label to any side of its field.
1. Select the field in Design.
2. Open the InfoBox.

3. Click the Label tab.
4. Set the options in the Label panel.

See the Details topic for options.



Details: Changing the wording, attributes, or position of a label

To Do this
Change the font of
a label

Select a font in the 
Font Name drop-
down list.

Apply boldface, 
italics, underlining,
or strikethrough to 
a label

Select one or more 
styles in the 
Style/Effect list.

Change the font 
size of a label

Select a size in the 
Size drop-down list.

Change the 
alignment of a 
label to left, 
center, or right

Select an option in 
the Alignment area.

Change the 
wording of a label

Edit the text in the 
Label Text box.

Change the 
position of a label 
relative to the data

Select a position in 
the Label Position 
drop-down list.

Hide a label Select "No label" in 
the Label Position 
drop-down list.

Apply a color to a 
label

Select a color in the 
Text Color drop-down 
list.

Apply a raised or 
indented look to a 
label

Select a relief in the 
Text Relief drop-down
list.



Sliding or resizing a field when you print

Because data in fields can vary in length, you may end up with too much blank space in a view. You can slide fields 
and reduce their boundaries to eliminate some of the extra space.
1. Select the field in Design.
2. Open the InfoBox.

3. Click the Dimensions tab.
4. To slide the field to the left or up over a field with reduced boundaries, turn on Left or Up in the When Printing, 

Slide area.
5. To reduce or expand the field's boundaries to the size of the data, turn on Reduce or Expand in the When 

Printing, Boundaries area.

See also
Sliding an object when you print 



Details: Sliding or resizing a field when you print

Approach slides fields or resizes their boundaries when you preview or print, and in Design if you are showing data.

Sliding a field
If you have two fields next to each other and don't want a gap between the data in them, you can mark the fields to 
slide left. This moves one field to the left to fill the blank space in the other field. For sliding left to work, you must 
mark both fields to slide left, and the two fields must be aligned along their bottom sides.
When sliding a field left, you may want to turn off the two fields' borders or show only the bottom border.
You can also slide a field up to fill blank space left by a field above it. Usually, the field on the top is a memo field with 
a variable amount of data in it. You must mark both fields to slide up.

Resizing a field
Reducing a field's boundaries makes the field smaller so that is just large enough for the data in it. (When you slide 
fields left, Approach automatically reduces the boundaries of the field on the left.)
If a field has more data than it can display, you can also expand the field's boundaries just enough to show the data. 
If any other fields are below the expanded field, they slide down to make room.



Changing the data entry order for fields

Approach initially sets the data entry order to be the order in which fields and macro buttons were added to a view, 
but you can change the order. Radio buttons and checkboxes each have a separate position in the order.

To change the data entry order of a few items:
1. In Design, choose Show Data Entry Order from the View menu. 

Numbered squares show the tab position of each field, radio button, checkbox, and macro button.
2. Edit numbers in the squares to change the order. 

When you edit the number in one square, Approach renumbers the rest of the squares as soon as you click in 
another square.

To change the data entry order of all items:
1. In Design, choose Show Data Entry Order from the View menu.
2. Move the I-beam cursor over the border of a numbered square and double-click. 

The numbers are deleted from all of the squares.
3. Click in the squares in the order you want to tab through fields. 

Numbers appear in the squares as you click in them.



About working with PicturePlus fields
You can add a PicturePlus field to a form, report, form letter, or mailing label to hold a picture, an OLE object, or an 
image you draw with the mouse in Browse. The graphic appears only in the PicturePlus field in that record. It is part 
of the record's data, not part of the design of a view.
You must be in Design to add and edit a PicturePlus field.

Adding a PicturePlus field to a view         
You can add a PicturePlus field to a view using either the Add Field dialog box or the PicturePlus tool. If you use Add 
Field, the PicturePlus field is a predefined size and shape. If you use the PicturePlus tool, you drag to define the area 
for the field. You can resize a PicturePlus field as you can other types of objects.

Changing the basic properties of a PicturePlus field         
The basic properties of a PicturePlus field are the named style, whether the field is read-only or non-printing, and 
whether you can draw in the field.

Changing display options for a PicturePlus field         
A PicturePlus field is a fixed size. When you insert a graphic that is too large for the field, Approach can either crop 
the graphic or shrink it. When you insert a graphic that is too small, Approach can either leave the graphic as it is or 
stretch it to fill the field.

See also
About editing objects and text 
Pasting a picture 
InfoBox 



Adding a PicturePlus field to a view

You can add a PicturePlus field to a view using either the Add Field dialog box or the PicturePlus tool.

To add a PicturePlus field using the Add Field dialog box:
1. In Design, click the Add Field icon or choose Add Field from the Form, Report, Letter, or Mailing Label menu.

2. If you need to define a new PicturePlus field, click Field Definition in the Add Field dialog box and use the dialog 
box that appears.

3. If the PicturePlus field you want is in a different joined database, select the database in the drop-down list in Add 
Field.

4. Drag the PicturePlus field you want from Add Field to the view. 
The field appears in a predefined size.

5. If necessary, resize the PicturePlus field by dragging one of its handles.

To add a PicturePlus field using the PicturePlus tool:
1. In Design, click the PicturePlus icon or choose PicturePlus from the Create Drawing submenu. 

To draw more than one field, double-click the icon. It will stay selected until you select a different icon.

2. Drag diagonally to draw the PicturePlus field.
3. In the InfoBox, select the PicturePlus field you want in the field list.



Changing the basic properties of a PicturePlus field

The basic properties of a PicturePlus field are the named style, whether the field is read-only or non-printing, and 
whether you can draw in the field.
1. Select the PicturePlus field in Design.
2. Open the InfoBox.

3. Click the Basics tab.
4. Set the options in the Basics panel.

See the Details topic for options.



Details: Changing the basic properties of a PicturePlus field

To Do this
Make a field read-
only in the current 
view

Turn on Read-only.

Allow drawing with
the mouse in a 
field in Browse

Turn on "Allow 
drawing." (This is 
available only if 
Read-only is off.)

Make a field non-
printing in the 
current view

Turn on Non-printing.

Show a non-
printing field in 
Preview

Turn on Show in 
Preview. (This is 
available only if Non-
printing is on.)

Apply a named 
style with width, 
color, and 
PicturePlus 
properties already 
defined

Select a style in the 
Named Style drop-
down list.



Changing display options for a PicturePlus field

When you insert a graphic that is too large for a PicturePlus field, Approach can crop the graphic or shrink it. When 
you insert a graphic that is too small, Approach can leave the graphic as it is or stretch it.
1. Select the PicturePlus field in Design.
2. Open the InfoBox.

3. Click the Options tab.
4. Set the options in the Options panel.

See the Details topic for options.



Details: Changing display options for a PicturePlus field

To Do this
Change the 
position of a 
graphic in a field

Drag the image in the
PicturePlus Data 
Position area.

Crop or shrink a 
graphic that is too 
large for a field

Select "Crop it" or 
"Shrink it."

Stretch a graphic 
that is too small 
for a field

Turn on "Stretch if too
small."



Adding a field as a field box



Displaying a field as a drop-down list



Displaying a subset of data in a drop-down list



Displaying a field as a checkbox



Displaying a field as radio buttons



Setting a standard date format



Setting a special date format for periods of a year



Setting a time format



Setting a numeric format



Setting a text format



Changing the basic properties of a field



Changing text attributes of data



Changing line or color settings for a field



Changing the wording, text attributes, or position of a label



Sliding or resizing a field when you print



Changing the data entry order for fields



Adding a PicturePlus field to a view



Changing the basic properties of a PicturePlus field



Changing display options for a PicturePlus field



About joining and unjoining database files
An Approach file can have up to 50 joined databases (if the underlying database file type can support this capability). 
The forms, reports, and other views in an Approach file can use data from any of the databases joined in that file.
You need to save an Approach file after joining or unjoining database files in it or after setting join options. Approach 
does not save these changes automatically.

Joining database files        
You join two databases by establishing a link on one or more fields common to both databases. Often, a join field is 
an ID field used specifically for joining the databases.

Setting options for a join        
You can have Approach automatically insert or delete related records from a joined database.

Unjoining database files        
When you no longer need a relationship between data in two databases, you can unjoin the databases. If you unjoin 
and close a database in the Join dialog box, Approach deletes all the forms, reports, form letters, mailing labels, and 
repeating panels that are based on that database. 

See also
Joined databases 



Joining database files

You join two databases by establishing a link on one or more fields common to both databases.
1. Choose Join from the Create menu.
2. In the Join dialog box, click Open to open another database or click Alias to create an alias of the current 

database. 
If you click Open, the Open dialog box appears; use this to select a database to join. 

3. Link the two databases on one or more join fields. 
For each field you want to join on, click the field in the list for one database and then drag to the field in the other 
database.

4. To join more databases in the Approach file, continue opening files and joining them in the same manner.
5. To print a copy of the database fields and their join relationships, click Print and use the Print dialog box.
6. If you have opened a database you've decided not to join, click in its list of fields and click Close.
7. Click OK.

See also
Setting options for a join
Unjoining database files



Details: Joining database files

Join fields
A join field can be any field that is common to the two databases. Most often, you link databases on a single field with
ID numbers. If you do not have an ID field you can use for this, link the databases on other fields that together 
uniquely identify records in one of the databases, such as first name, last name, and phone extension.
A join field does not need to have the same name in the two databases, but it should usually be of the same type.
A single database can be joined to one or more other databases. You can use the same join field in all of its joins or 
different fields for different joins.

Valid joins
Every database you open in the Join dialog box must be joined to at least one other database in the dialog box. All 
the databases must be joined into a single set, and the join relationships cannot be circular.
The OK button is dimmed if any joins in the dialog box are invalid. When you correct the errors, you'll be able to click 
OK.

Alias databases
You can join a field to an alias "copy" of itself just as you can to any other database you open in the Join dialog box. 
An alias is not an actual copy of a database, but just another listing of it for the purposes of joining. For more 
information, see Alias joins.
If you click Alias, a copy of the current database appears in the Join dialog box. The name of the database is 
appended with a 1, and the copy has the same name as the original, plus a 2 (or a 3 and so on); for example, 
EMPLOYEE:1 and EMPLOYEE:2.

Joins on calculated fields
If "Show calculated fields in the Join dialog" is on in the General panel of Preferences, you can join databases on a 
calculated field. For information about setting this option, see Setting general working preferences.
The names of calculated fields appear italicized at the bottom of the field lists, after the database fields. A field list 
shows only the calculated fields that refer to fields in the listed database, and it does not include summary fields.
If you want calculated fields to appear in a field list for a secondary database (one you display in the Join dialog box 
using the Open button), first join the database using a database field. Then create a calculated field in the Field 
Definition dialog box, using a formula that refers to a field in the secondary database. When you open the Join dialog 
box again, you'll see the calculated field in the database's field list.



Setting options for a join

You can have Approach automatically insert or delete related records from a joined database.
1. Choose Join from the Create menu.
2. Double-click the join line.
3. To have Approach insert related records automatically for the selected join, turn on an Insert option.
4. To have Approach delete related records automatically for the selected join, turn on a Delete option.
5. Click OK in the Relational Options dialog box.
6. Click OK in the Join dialog box.



Details: Setting options for a join

The join options apply to a particular join, and you can set them differently for each join in an Approach file. The 
options at the top and the bottom of the Relational Options dialog box are the same. They just apply to different 
directions of the selected join.

Insert options
With an Insert option on, Approach inserts a new record in this case:

If: You type in a blank field for a detail database on a view, and the record for that field does not match a join
value in the main database.

Then: Approach inserts a new record in the detail database.
For example, suppose you turn on "Insert: If no records match the DEPARTMNT record, typing into a blank 
EMPLOYEE field inserts a new record." If you type on a new line in an employee repeating panel on a department 
form, Approach inserts a record for the new line in the employee database.

Delete options
With a Delete option on, Approach deletes records in this case:

If: You delete a record from the database listed first in the Delete option.

Then: In the database listed second in the Delete option, Approach deletes all records that have a join value
matching the record you deleted.
For example, suppose you turn on "Delete: Deleting a record from DEPARTMNT deletes matching records from 
EMPLOYEE." If you delete a department, Approach deletes all the employees for that department from the employee 
database.

Joins on calculated fields
If you have a one-to-many join on a calculated field and the calculated field is based on fields in a repeating panel, 
Approach cannot insert new records in the panel, even if you have the option on for inserting records automatically. 
But if a calculated field used in a one-to-many join is based on fields in the form's main database, Approach can 
insert records in the repeating panel.



Unjoining database files

If you unjoin and close a database in the Join dialog box, Approach deletes the views and repeating panels that are 
based on that database.
1. Choose Join from the Create menu.
2. Click the join line connecting the databases you want to unjoin.
3. Click Unjoin.
4. To unjoin more databases in the Approach file, continue unjoining in the same manner.
5. For each database left without a join, click in its list of fields and click Close.
6. If an alert box appears, click Yes to unjoin the database. 

Approach displays an alert box for each database you close that is the main database for any views or repeating 
panels.

7. Click OK.

See also
Joining database files



Joining database files



Setting options for a join



Unjoining database files



About setting up your network environment
You can store any Approach file and any database file supported by Approach on a network. Users who work on the 
network can create, open, and save files and work with data just as if the files were stored on their own local drives.
Before sharing dBASE and Paradox files on a network, you need to specify several network settings. (You can open 
FoxPro files on a network, but you cannot share them concurrently with other users in Approach.)
The network settings are saved in your APPROACH.INI file. Once you've made the settings, they'll stay in effect from 
one work session to another unless you change them.

Setting file-sharing options for dBASE files        
For dBASE files, you can specify whether other users can open network files you have open, whether your local files 
are available to other users, and whether to optimize performance for Approach-only files.

Specifying a locking protocol for shared dBASE files        
If you're sharing dBASE files with other users, you and the other users must all specify Approach, dBASE IV, or 
dBASE III+ as the locking protocol for the files. The default protocol is Approach.

Setting file-sharing options for Paradox files        
For Paradox files, you can specify 3.5 or 4.x networking and the location of the Paradox network control files.



Setting file-sharing options for dBASE files

For dBASE files, you can specify whether other users can open network files you have open, whether your local files 
are available to other users, and whether to optimize performance for Approach-only files.
1. Open the New, Open, Save Database As, Import Data, or Export Data dialog box, and select dBASE IV or 

dBASE III+ in the List Files of Type drop-down list.
2. Click Connect.
3. To allow other users to work with files you have open, turn on "Database sharing."
4. To make open files on your local drive available to other users, turn on "Local databases are shared."
5. To optimize performance for files used only with Approach, turn on "Sharing data only with other Approach 

users."
6. Click OK.
7. Click OK in the New, Open, or other file dialog box.
8. Close and reopen any dBASE files for the changes to affect them.



Details: Setting file-sharing options for dBASE files

You can have any Approach file active when you open the New, Open, or other file dialog box. The dBASE options 
affect all dBASE files you open.

Database sharing
This setting lets other users open and make changes to a network dBASE file you already have open. If the setting is 
off, no one else will be able to open the file until you close it.
If this setting is on, make sure everyone you work with on a network uses the same protocol for dBASE files. For 
more information about this, see Specifying a locking protocol for shared dBASE files.

Local databases are shared
If you're using a peer-to-peer network system such as LANtastic and the system is set up for sharing local files, this 
setting allows other users to open dBASE files on your local drive that you already have open. 
If this setting is off, other users will be able to open a dBASE file on your local drive only if you do not already have 
the file open. This is true even if "Database sharing" is on and your network software allows you to share local files.

Sharing data only with other Approach users
This setting optimizes performance for files that are used only in Approach. Turn this setting off if you or other network
users plan to use dBASE files with other applications.



Specifying a locking protocol for shared dBASE files

If you're sharing dBASE files with other users, you and the other users must all specify Approach, dBASE IV, or 
dBASE III+ as the locking protocol for the files. The default protocol is Approach.
1. Use a text editor to open the APPROACH.INI file in your Windows directory.
2. Set the sdBASEFileSharingMethod line to Approach, dBASE4, or dBASE3.

For example, sdBASEFileSharingMethod=dBASE4.
3. Save and close the APPROACH.INI file.
4. Restart Approach for the change to take effect.



Details: Specifying a locking protocol for shared dBASE files

To maintain the integrity of data, all users who share dBASE files should specify the same locking protocol.
If all users are working with the dBASE files only through Approach, leave the locking protocol as Approach. This will 
usually give you the best performance.
If any of the users are working through a dBASE IV application, change the protocol to dBASE4. If any users are 
working through a dBASE III+ application, change the protocol to dBASE3.



Setting file-sharing options for Paradox files

For Paradox files, you can specify 3.5 or 4.x networking and the location of the Paradox network control files.
1. Open the New, Open, Save Database As, Import Data, or Export Data dialog box, and select Paradox in the List 

Files of Type drop-down list.
2. Click Connect.
3. To change the type of networking, select "Use Paradox 3.5 networking" or "Use Paradox 4.x networking." 

Paradox 4.x networking includes Paradox for Windows.
4. Type your user name in the User Name text box.
5. Type the directory location for the control files in the Network Control File Path text box. 

Do not include a control file's name in the pathname. For example, if the files are in the SHARE directory on the f
drive, type f:\SHARE.

6. Click OK.
7. Click OK in the New, Open, or other file dialog box.
8. Close and reopen any Paradox files for the changes to affect them.



Details: Setting file-sharing options for Paradox files

You can have any Approach file active when you open the New, Open, or other file dialog box. The Paradox options 
affect all Paradox files you open.

Types of networking
If "Use Paradox 3.5 networking" is selected, you can open Paradox 3.5 files but not Paradox 4 files on a network. 
When you create or export a Paradox file (whether or not you are using a network), the file is in the 3.5 file type.
If "Use Paradox 4.x networking" is selected, you can open both Paradox 3.5 and Paradox 4 files on a network. When 
you create or export a Paradox file (whether or not you are using a network), the file is in the 4.x file type. Paradox 4.x
networking includes Paradox for Windows.
Users of Paradox 4 cannot share data concurrently with users of Paradox 3.5. 

Paradox control files
Paradox databases use network control files to monitor user count and to control database sharing on a network. If 
you want to share Paradox files with other users, you need to specify the location of the control files. Check with your 
network administrator for the location of these files.
In Paradox 4.x (including Paradox for Windows), the network control file is called PDOXUSRS.NET; in Paradox 3.5, 
the file is PARADOX.NET. The control files for Paradox 3.5 and Paradox 4.x should be in the same directory.
If you do not specify a location for the control files, you will open Paradox databases on a network as a single user.



About working on a network
In most ways, you can create, open, and save databases and import and export data on a network just as you can on
your local drive. Use the same dialog boxes you use with your local files, and provide the location of the network drive
and directory.
As you work with a database on a network, the original database remains in its network location. What you see on the
screen is a copy of those records in your computer's memory. If you have read/write access to the database, you can 
make changes to the data and the changes are saved in the original database on the network.

Changing your status to single user        
There may be times when you want to open a network database as a single user -- for example, to make structural 
changes to the database or to do a lot of previewing and printing. You can temporarily change your network 
environment to let you open databases as a single user.

Entering a password        
Files on a network often have one or more passwords so that only some users can read or edit the files. In Approach,
both database files and Approach files can have passwords.

Refreshing the network data on your screen        
Approach refreshes the data from a network database when you edit, find, or sort data, when you preview or print, 
and when you change what you see on the screen (such as move to another record or go to Design). You can also 
refresh the data yourself.

Saving changes to a shared record        
If you have optimistic record locking set for your network environment, other users will be able to edit a record at the 
same time you do. Approach helps you make careful use of this feature.



Changing the status to single-user

You can temporarily change your network environment to let you open network databases as a single user.

To change your status to single-user for a dBASE database:

Turn off "Database sharing" in the dBASE Network Connection dialog box. 

To change your status to single-user for a Paradox database:

Delete the text in the User Name and Network Control File Path text boxes in the Paradox Network 
Connection dialog box. 

See also
Setting file-sharing options for dBASE files
Setting file-sharing options for Paradox files



Entering a password

If you try to open a database file with a password or make design or join changes in an Approach file with a 
password, an Enter Password dialog box appears.
1. Type the password in the text box. 

You must spell a password exactly as it was defined, except that a password is case-insensitive.
2. Click OK.

See also
Defining a password for a file 



Details: Entering a password

Database file passwords
A database file can have two types of passwords: a read/write password that gives you complete access to the file, 
and a read-only password that allows you to read data but not modify it. A database can have a read/write password 
or both a read/write and a read-only password.
If a database file has passwords, the Enter Database Password dialog box appears when you try to open an 
Approach file that uses the database. 

Approach file passwords
An Approach file can have one password. In this case, the password gives you the ability to modify the design of the 
file.
If an Approach file has a password, the Enter Approach File Password dialog box appears when you try to change to 
Design, join database files, or create a view.



Refreshing the network data on your screen

Approach refreshes the data from a network database when you edit, find, or sort data, when you preview or print, 
and when you change what you see on the screen. You can also refresh the data yourself.

Choose Refresh from the Browse, PicturePlus, Worksheet, or Crosstab menu.



Details:Refreshing the network data on your screen

The Refresh command updates the data on your screen to match the database on the network. If you've made any 
changes you haven't entered, this command also enters those changes. If you're working with a found set or with 
sorted data, Refresh inserts any new records into the found set or the sort order as appropriate.

Why refresh data?
As you work in a network database, Approach places a copy of the data you see on the screen in your computer's 
memory. If other users are working in the database at the same time you are and make changes to its data, their 
changes do not always appear instantly in the image on your screen. Refresh data periodically to be sure you're 
seeing the current version of it.

Downloading data in Preview
When you print data from a network, Approach normally refreshes the data from the network database. If you preview
data before printing and other users make changes to the database after you preview, the data you print may not be 
the same as the data you previewed.
You can have Approach download a copy of the current set of network data to your hard disk whenever you change 
to Preview to "freeze" the data you see on the screen. This way, you can be sure you're looking at what will actually 
be printed. Downloading is especially helpful when you preview a report that uses a summary or any data set that 
many users are working on.
For information about setting this option, see Setting general working preferences.



Saving changes to a shared record

If you have optimistic record locking set for your network environment, other users will be able to edit a record at the 
same time you do. When you try to edit a shared record, an alert box appears

To save changes to a shared record:

Click Yes to save your changes and overwrite changes made by other users.
This overwrites all changes made to the record since your view of it was last refreshed.

To cancel your changes and refresh your copy:

Click No.
This lets you see changes made to the record by other users. You can then make your changes on top of theirs.

See also
Setting general working preferences



Details: Saving changes to a shared record

With optimistic record locking on, when two users edit the same record, the changes are saved in the database for 
the first user to enter the changes. When the second user tries to enter his or her changes, an alert box warns that 
the changes may overwrite those made by the first user.
If you don't want other users to edit a record at the same time as you, you can turn off optimistic record locking. This 
way, once you've clicked in a record, other network users can view the record but not make changes to it until you go 
to another record.



Setting file-sharing options for dBASE files



Specifying a locking protocol for shared dBASE files



Setting file-sharing options for Paradox files



Changing your status to single user



Entering a password



Refreshing the network data on your screen



Saving changes to a shared record



About previewing and printing
When you print a view in Approach, the data and design objects appear in the printed copy as they do on screen in 
Preview. If you have any objects you don't want to appear in printed copy (such as buttons to click to run a macro), 
you can define those objects as non-printing using their InfoBox in Design.

Specifying the printer, paper, and orientation        
Before printing a view, you need to select a printer and specify other print setup options. The printer, paper size, and 
page orientation together determine the printable area on a page.

Previewing a view        
The Preview environment shows what a view will look like when it's printed.

Printing a view        
When you're ready to print, you specify the view, the range of records, and the number of copies you want.

See also
Preview 



Specifying the printer, paper, and orientation

Before printing a view, you need to select a printer and specify other print setup options. The printer, paper size, and 
page orientation together determine the printable area on a page.
1. Choose Print Setup from the File menu.
2. Select a printer in the Printer area.
3. Select a page orientation in the Orientation area.
4. Select a paper size and a source in the drop-down lists in the Paper area.
5. Click OK.



Details: Specifying the printer, paper, and orientation

When you start Approach, the default printer is the one selected in the Windows Control Panel. If you are working on 
a network, you may also have other printers available.

Printer selections
Default Printer uses the printer selected in the Windows Control Panel.
If you want a different printer, select Specific Printer and select the name of the printer in the drop-down list. The list 
shows up to eight printers set up for use with your computer.

Orientation
Portrait places the view on the page vertically, and Landscape places the view on the page horizontally.

Additional settings
The Options button in Printer Setup displays an Options dialog box with more settings specific to your printer. For 
information about these settings, click the Help button in the Options dialog box.



Previewing a view

The Preview environment shows what a view will look like when it's printed.

Click the Preview icon or choose Preview from the File menu or from the environment pop-up menu in the 
status bar.



Details: Previewing a view

Before you preview...
Make sure you've already selected a printer, paper size, and orientation so that the preview will be accurate. For 
more information, see Specifying the printer, paper, and orientation.

Zooming in and out
When you first go to Preview, you see your current view reduced to 75 percent of its normal size. The pointer turns 
into a zoom cursor in Preview. 
You can change to another zoom setting in several ways: 

To zoom in or out one setting, click the left mouse button or right mouse button, click the Zoom In or Zoom 
Out icon, choose Zoom In or Zoom Out from the View menu, or press CONTROL and the up or down arrow key.

To change to a particular zoom setting, click the percentage in the status bar to open the zoom pop-up menu
and choose a setting.

To change to 100 percent in one step, choose Actual Size from the View menu or 100% from the zoom pop-
up menu.
The possible zoom settings in Preview are 25, 50, 75, 100, and 200 percent. 

Non-printing objects
You can make a non-printing object appear in Preview by setting the Non-printing option in the Basics panel of the 
object's InfoBox. If a macro button appears in Preview, the zoom cursor turns into a pointer when you move over the 
button so that you can click it to run a macro.

Summaries and objects
If a view has any fields that summarize data from multiple records, Approach calculates the summary in Preview and 
shows the results. If a view has fields or other objects that need to slide up or left, the fields slide into position in 
Preview.



Printing a view

When you're ready to print, you specify the view, the range of records, and the number of copies you want.
1. If necessary, specify the printer and print setup options.
2. Browse the records you want to print.
3. Change to the view you want to print.
4. If necessary, sort the records.
5. Preview the view and make any corrections you need.
6. Click the Print icon or choose Print from the File menu.

7. In the Print dialog box, specify a range of records in the Print Range area.
8. Select a print quality in the Print Quality drop-down list.
9. Type the number of copies you want in the Copies text box.
10. If necessary, turn on printing options.
11. Click OK.
To cancel a print job, press ESC or click Cancel in the print alert box.



Details: Printing a view

Before you print...
Approach prints from the set of records you're currently using with the current sort order. Before you print, either show
all the records in a database or use a find request to show only a found set of records.
Previewing shows how the view will look when printed. For more information, see Previewing a view.

Print range
All prints all the records you're currently browsing. Current form prints the current record (this is available only when 
you're using a form).
Pages prints a range of pages. Type the number of the first page of the range in From and the number of the last 
page in To.

Options
Print to file sends the print copies to a file rather than to a printer. If you turn this setting on, the Print to File dialog box
appears when you click OK in the Print dialog box. Specify a name and location for the print file.
Collate copies prints an entire copy before printing the next copy. Otherwise, Approach prints all copies of page 1, 
then all copies of page 2, and so on.

Printing reports, worksheets, and crosstabs
When you print a report, worksheet, or crosstab that has a header or footer, the header or footer appears on every 
printed page. The area between a header and footer is the body of the view. Approach prints as many records on a 
page as will fit in the body. 
If a report, worksheet, or crosstab has a title page, Approach prints a copy of the page at the beginning of the view. A 
title page can have its own header and footer.

Printing a view with summary calculations
If a view has any summary calculations that apply to a range of records, in most cases Approach calculates the 
summaries only when you preview or print. (The exception is a summary for line items in a repeating panel, which is 
summarized in Browse and in Design if you're showing data.) A summary panel in a report can appear before or after 
the records it summarizes.

Sliding objects when you print
If a views has fields or other objects that need to slide up or left, the objects slide when you preview or print. For more
information, see Sliding an object when you print.



Specifying the printer, paper, and orientation



Previewing a view



Printing a view



About charts
Approach gives you two ways to create a chart: using the Chart Assistant or directly from a crosstab.

Creating a bar, line, or area chart        
Bar, line, and area charts display information along the x-axis and y-axis. You use the Chart Assistant to name the 
chart, select a style and layout, and specify the data you want to chart.

Creating a pie chart        
Pie charts show the relationships of various parts to the whole. You use the Approach Chart Assistant to select the 
field for each pie wedge, a calculation, and the field to be calculated.

Creating an instant chart from a crosstab        
You can create a chart directly from a crosstab by clicking the Chart icon. Approach creates a vertical bar chart 
displaying the data in the crosstab. The values in the body of the crosstab are plotted as the chart bars. The crosstab 
rows are charted along the x-axis with crosstab groups (from columns) as the series. 

Charting a different data set        
Once you've created a chart, you can change the set of data it displays by specifying a new data source. If you use 
the Find command to create a found set of records, Approach automatically charts the found set. 

See also
Lotus Chart Help
Charts 



Creating a bar, line, or area chart

Bar, line, and area charts display information along the x-axis and y-axis. You use the Chart Assistant to name the 
chart, select a style and layout, and specify the data you want to chart.
1. Choose Chart from the Create menu.
2. Type a name for the chart in the Name text box.
3. Select a style for the chart in the SmartMaster Style drop-down list.
4. Select a layout (chart type) in the SmartMaster Layout list. 

See the Details topic for chart types.
5. Click the X-axis tab and select a field for the x-axis of the chart.
6. Click the Y-axis tab and define the calculation for the y-axis.
7. To include a series in the chart, click the Series tab and select a field for the series.
8. Click Done.
9. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the chart uses fields from more than one joined database. The first database you 
selected in the Fields panel is preselected as the main database.



Creating a pie chart

Pie charts show the relationships of various parts to the whole. You use the Approach Chart Assistant to select the 
field for each pie wedge, a calculation, and the field to be calculated.
1. Choose Chart form the Create menu.
2. Type a name for the chart in the View Name & Title text box.
3. Select a style for the chart in the SmartMaster Style drop-down list.
4. Select Pie Chart in the SmartMaster Layout list. 
5. Click the Pie Fields tab, select a field for each pie wedge, select a calculation, and select a field to be calculated.
6. Click Done.
7. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the chart uses fields from more than one joined database. The first database you 
selected in the Fields panel is preselected as the main database.



Creating an instant chart from a crosstab

When you create a chart directly from a crosstab, the values in the crosstab body are plotted as the chart bars. The 
crosstab rows are charted along the x-axis, and crosstab groups (from columns) are the series. 
1. Make sure that the crosstab contains the data you want to chart. 
2. Click the Chart icon.



Creating a bar, line, or area chart



Creating an instant chart from a crosstab



Creating a pie chart



Details: Creating a bar, line, or area chart

Chart types
The Chart Assistant lists four types of charts you can create:

Bar charts are the most common type of business chart. The SmartMaster bar chart layout is a standard 
vertical bar chart, where each bar represents a single value in a series. The height of each bar shows a value at a 
point in time. The left-to-right orientation gives the viewer a sense of movement with time.

Line charts trace the changes in sets of data over time. Each point along a line represents a value at a 
particular time period or point in time, and each line represents a category of data.

Area charts show trends in data over time by emphasizing the area under the curve created by each data 
series. Like line charts, area charts downplay individual values and emphasize trends and totals.

Y-axis calculations
To define the y-axis calculation, first select the calculation you want to use. Next, select the field you want to 
calculate. If you want to calculate a field from a different joined database, select the database in the drop-down list.



Charting a different data set

You can change the set of data a chart displays by specifying a new data source. If you use the Find command to 
create a found set of records, Approach automatically charts the found set.
1. Choose Chart Data Source from the Chart menu.
2. Select a field to appear on the x-axis.
3. Click the Y-axis tab and define the calculation for the y-axis.
4. Click the Series tab and select a field for the series.
5. Click Done.
6. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the chart uses fields from more than one joined database. The first database you 
selected in the Fields panel is preselected as the main database.



Charting a different data set



About setting Approach preferences
You can customize many aspects of your work area in Approach using the Preferences dialog box.
When you finish setting options, click OK or Save Default in the Preferences dialog box. If you click OK, the options 
are saved only for your current session with Approach. If you click Save Default, the options become the new 
defaults.

Setting display defaults        
The display defaults determine the window elements that appear in the Approach work area (such as icon bars, view 
tabs, and status bar), the default style available in Assistants (for creating views), the design elements that appear in 
Design, and settings for the design grid.

Setting a default order for records        
Approach stores records in a database in the order you add them. But for each Approach file, you can set a particular
order for the records and then move through them in that order in Browse. The order of records in an Approach file 
does not affect the order of records in the actual database. A database still stores records in their creation order.

Defining a password for a file         
You can define passwords for database files and Approach files. This allows you to share data and views with other 
users, without compromising the security of your data and the design of your views.

Setting dialing preferences        
The Approach dialing preferences let you define standard modem settings to be used whenever you have Approach 
dial a telephone number. Modem settings include the name of the serial port the modem is connected to, the 
modem's baud rate (speed), the type of dialing service to use. 

Setting database options for a dBASE or FoxPro file        
For a dBASE or FoxPro database file, you can make the file read-only in the current Approach file, change to another 
character set, and compress the file for more efficient storage.

Setting database options for a Paradox file         
For a Paradox database file, you can make the file read-only in the current Approach file, change to another character
set, and (for Paradox 4.0) change case sensitivity for searches.
Searches in Paradox 3.5 files are always case-sensitive. In Paradox 4.0 files searches are initially case-insensitive, 
but you can change them to case-sensitive in Approach.

Setting database options for SQL, Access, ODBC, and Lotus Notes tables        
For SQL, Microsoft Access, ODBC, and Lotus Notes tables, you can specify read-only access, display SQL system 
tables in the lists of filenames in dialog boxes, and cache the names of tables. The read-only setting also applies to 
Lotus Notes tables.
The options for SQL, Microsoft Access, ODBC, and Lotus Notes affect all of these tables you create or open in 
Approach, not just the table selected in the Preferences dialog box.

Maintaining external indexes for a dBASE or FoxPro database        
In dBASE and FoxPro database files, Approach uses and maintains its own indexes to keep track of records. If you 
have any indexes created in dBASE or FoxPro that you want Approach to maintain, you can associate those indexes 
with your database file. 
Approach does not use the external indexes but maintains them for the other applications.

Creating secondary indexes for a Paradox database         
In a Paradox database file, a primary index is built on the key field specified when the file is created. You can create 
additional, secondary indexes for the file in Approach.



Approach automatically uses and maintains all indexes for Paradox database files. 

Setting general working preferences        
Approach provides several options that make working with data as efficient as possible. You can make the ENTER key
work in Browse just like the TAB key, open the Add Field dialog box automatically right after you define a field, show a 
Cancel Macro dialog box whenever you run a macro, allow joins on calculated fields, download the current data set 
whenever you go to Preview, and allow two network users to edit a record at the same time using optimistic record 
locking.



Setting display defaults

The display defaults determine the window elements that appear in the Approach work area, the default style 
available in Assistants, the design elements that appear in Design, and settings for the design grid.
1. Choose Preferences from the Tools menu.
2. Click the Display tab.
3. Turn on the window elements you want to display in the Show area.

See the Details topic for options.
4. Click Edit Default Style and define a default style to be available in the Assistants when you create views.
5. Turn on the design elements you want to display in the Show in Design area.
6. Set the grid options in the Grid area.
7. Click OK or Save Default.

See also
Defining and saving a named style 



Details: Setting display defaults

Window elements

This option Displays
SmartIcons An icon bar (preset to 

appear at the top of the 
Approach window)

Status bar A status bar at the 
bottom of the Approach 
window

View tabs Tabs with view names 
at the top of the 
Approach window

Title bar help Command descriptions 
in the title bar, 
whenever you point on 
a menu command or 
right-click an icon

Welcome 
dialog 

A dialog box for opening
and creating files, 
whenever you start 
Approach or close a file

Find bar A bar with buttons for 
finding records, 
whenever you go to 
Find

Styles
A style specifies design properties such as colors and text attributes for all new objects and for the background of 
new views. When you create a new view, you can use the default style or select a predefined SmartMaster style in 
the Assistant.

Design elements

This 
option

Displays

Data Data from the first 
record or page of 
records in Design 
(Otherwise, field names
appear.)

Rulers Rulers along the top 
and left sides of the 
Design work area

Add Field 
dialog

Add Field dialog box in 
Design

Drawing 
tools

A floating palette of 
drawing tools in Design



Grid settings

This 
option

Does this

Show grid Show a design grid 
behind objects in the 
Design work area

Snap to 
grid

Make objects align with 
increments on the grid, 
when you draw, move, 
or resize the objects

Grid units Specify a unit of 
measure (inches or 
centimeters) for 
increments on the grid

Grid width Specify a width for the 
increments on the grid 
(First select a grid unit 
to see a list of widths 
here.)



Setting a default order for records

Approach stores records in a database in the order you add them. But for each Approach file, you can set a particular
order for the records and then move through them in that order in Browse.
1. Choose Preferences from the Tools menu.
2. Click the Order tab.
3. If necessary, change to another database by selecting from the Maintain Default Sort For drop-down list.
4. Add the primary sort field to the Fields to Sort On list.

To add a field to Fields to Sort On, select the field name in Database Fields and click Add, or double-click the 
field name. To move a field back to Database Fields, select the field name and click Remove, or double-click the 
field name. To move all the fields back, click Clear.

5. Select Ascending or Descending for the primary sort field.
6. If necessary, specify additional sort fields in the same way.
7. Click OK or Save Default.

See also
Specifying a sort order    



Details: Setting a default order for records

When you specify an order for records, this becomes the new default order in that Approach file (replacing the 
creation order). The order of records in an Approach file does not affect the order of records in the database file. A 
database file still stores records in their creation order.

Sort fields
You specify one or more sort fields for reordering records. The first field is the primary sort field. Approach sorts the 
records by the contents of that field. You can also specify other sort fields for Approach to use in case any records 
have the same value in the primary field. For example, you might use Last Name as the primary sort field and First 
Name as an additional sort field.

Ascending or descending sorts
Each sort field sorts in either ascending or descending order. 
Ascending sorts text from A to Z, numbers from lowest to highest, and dates and times from earliest to latest. If a text 
field has numbers and text, the sorting is 0 to 9 and then A to Z. Leading spaces are sorted before numbers and text.
Descending sorts data in the opposite direction. If a text field has numbers and text, the sorting is Z to A and then 9 to
0. Leading spaces are sorted at the end.



Defining a password for a file

You can define passwords for database files and Approach files. This allows you to share data and views with other 
users, without compromising the security of your data and the design of your views.
1. Choose Preferences from the Tools menu.
2. Click the Password tab.
3. To define a password for the current Approach file, type the password in the Password for This Approach File text

box.
When the Confirm Password dialog box appears, type the password a second time and click OK.

4. To define passwords for a database file, type the passwords in the Read/Write Password and Read-Only 
Password text boxes.
If necessary, change to another database by selecting from the Database Name drop-down list. When the 
Confirm Password dialog box appears, type the password a second time and click OK

5. Click OK or Save Default.

See also
Entering a password



Details: Defining a password for a file

Typing passwords
Passwords are case-insensitive and can have up to 16 characters. Asterisks appear in the text box as you type the 
characters of the password. 

Approach file passwords
An Approach file password protects the design of Approach files. If a user enters this password correctly, he or she 
will be able to join database create new views, redesign existing views, and join databases in the file.

Database passwords
A database file can have a read/write password or both a read/write and a read-only password. The file needs the 
read/write password because at least one user should have write access to it.



Setting dialing preferences

The Approach dialing preferences include the name of the serial port the modem is connected to, the modem's baud 
rate (speed), and the type of dialing service to use. 
1. Choose Preferences from the Tools menu.
2. Click the Dialer tab.
3. Set the options you want to be used whenever Approach dials a telephone number.
4. Click OK or Save Default.



Details: Setting dialing preferences

These are the options you can set. If you need more information, see your modem documentation. 

Use this 
setting

To set 

Modem Port The communications 
port where your modem
is connected

Baud Rate The speed of the 
modem

Dial 
Prefix/Suffix

The command string for
both before (Prefix) and
after (Suffix) you dial

Hangup The command string 
you use to hang up

Initialize The command string 
that initializes your 
modem

Access 
Code

Any numbers you might
need to dial to get 
access to an exchange 
or phone company 
system, and (if 
necessary) a comma 
for a pause (For 
example, to dial 9 for 
an outside line, type 9 
and a comma; the 
comma inserts a pause 
to wait for the outside 
line.)

Do Not Dial Any numbers to omit 
while dialing (Use this 
option to remove the 
area code or 
international dialing 
code from the 
beginning of a phone 
number.)

Dial Type Whether your modem 
line is tone or pulse 
(Most telephones use 
tone dialing.)



Setting database options for a dBASE or FoxPro file

For a dBASE or FoxPro database file, you can make the file read-only in the current Approach file, change to another 
character set, and compress the file for more efficient storage.
1. Choose Preferences from the Tools menu.
2. Click the Database tab.
3. If necessary, change to another database by selecting from the Database Name drop-down list.
4. To make the database read-only in the current Approach file, turn on "Make all fields in database read-only."
5. To change the character set for the database, select an option under Character Set.
6. To compress the database, click Compress.
7. Click OK or Save Default.



Setting database options for a Paradox file

For a Paradox database file, you can make the file read-only in the current Approach file, change to another character
set, and (for Paradox 4.0) change case sensitivity for searches.
1. Choose Preferences from the Tools menu.
2. Click the Database tab.
3. If necessary, change to another database by selecting from the Database Name drop-down list.
4. To make the database read-only in the current Approach file, turn on "Make all fields in database read-only."
5. To change the character set for the database, select an option under Character Set.
6. To change the case sensitivity for searches in the database, select an option under Paradox Case Sensitivity.

This is not available for Paradox 3.5 files; searches in Paradox 3.5 are always case-sensitive. In Paradox 4.0 
files searches are initially case-insensitive, but you can make them case-sensitive in Approach.

7. Click OK or Save Default.



Setting database options for SQL, Access, ODBC, and Lotus Notes tables

The database options for SQL, Microsoft Access, ODBC, and Lotus Notes affect all of these tables you create or 
open in Approach, not just the table selected in Preferences.
1. Choose Preferences from the Tools menu.
2. Click the Database tab.
3. If necessary, change to a SQL, Access, ODBC, or Notes table by selecting from the Database Name drop-down 

list.
4. To display SQL system tables in the list of filenames in Approach dialog boxes, turn on "Show system tables in 

Open dialog."
5. To cache a table name the first time you open a SQL, Access, or ODBC table, turn on "Cache table names for 

use in Open dialog."
6. To make SQL, Access, ODBC, and Notes tables read-only through Approach, turn on "Open all SQL tables as 

read-only."
7. Click OK or Save Default.



Maintaining external indexes for a dBASE or FoxPro database

If you have any indexes created in dBASE or FoxPro that you want Approach to maintain, you can associate those 
indexes with your database file. Approach does not use the external indexes but maintains them for the other 
applications.
1. Choose Preferences from the Tools menu.
2. Click the Index tab.
3. If necessary, change to another database by selecting from the Database Name drop-down list.
4. To add an external index to the database so that it will be maintained for other applications, click Add Index, 

select the index in the dialog box that appears, and click OK.
5. To close an external index so that it will no longer be maintained, select the index in the list of indexes and click 

Close Index.
6. Click OK or Save Default.



Creating secondary indexes for a Paradox database

In a Paradox database file, a primary index is built on the key field specified when the file is created. You can create 
additional, secondary indexes for the file in Approach. Approach automatically uses and maintains all indexes for 
Paradox database files. 
1. Choose Preferences from the Tools menu.
2. Click the Index tab.
3. If necessary, change to another database by selecting from the Database Name drop-down list.
4. To add a secondary index to the database, click Add Index, type the name in the Paradox Secondary Index text 

box, and add the index fields to the Fields to Index list.
5. To delete a secondary index from the database, select the index in the Paradox Secondary Index drop-down list 

and click Delete Index.
6. Click OK or Save Default.



Setting general working preferences

Approach provides several options that making working with data as efficient as possible.
1. Choose Preferences from the Tools menu.
2. Click the General tab.
3. To make the ENTER key work in Browse just like the TAB key, turn on "Use Enter key to move or tab between 

fields in Browse."
4. To open the Add Field dialog box automatically whenever you define new fields or edit existing ones, turn on 

"Show the Add Field dialog after creating new fields."
5. To show a Cancel Macro dialog box whenever you run a macro in Approach, turn on "Show the Cancel Macro 

dialog when running macros."
6. To allow joins on calculated fields in the current Approach file, turn on Show calculated fields in the Join dialog.
7. To have Approach download a copy of the current data set to your hard disk whenever you preview, turn on 

"Download data before previewing."
8. To allow two network users to edit a record at the same time, turn on "Lock records using optimistic record 

locking."
9. Click OK or Save Default.



Details: Setting general working preferences

Tabbing with the ENTER key
Whenever you press ENTER in Browse, any new data in the current field is entered and you move to the next field in 
the data entry order. 
If this setting is off, pressing ENTER enters the data but does not move you to the next field.

Showing the Add Field dialog box
When you close the Field Definition dialog box, Add Field appears in the work area so that you can easily add the 
fields to a view. In this case, Add Field shows only the fields you just defined or edited; it has an additional Show All 
Fields button that you can click to list all the fields. 
For information about using Add Field this way, see Adding a field as a field box.

Joining on calculated fields
If this setting is on, calculated fields appear italicized in field lists in the Join dialog box, after other fields in the 
database. You can join on calculated fields as you do with other types of fields. For more information, see Joining 
database files.

Downloading data before previewing
If you download data, the data set you print will be the version on your hard disk rather than the one in the network 
database. This way, when you preview you can be sure you're looking at what will actually be printed.

Optimistic record locking
With optimistic record locking, when two users edit the same record, the changes are saved in the database for the 
first user to enter them. Then when the second user tries to enter changes, Approach asks if he or she wants to save 
the changes and overwrite those of the first user, or cancel the changes. 
If this setting is off, two users can view a record at the same time, but only the first user to go to the record can edit it. 
This is sometimes called full record locking. 
For information about working with optimistic record locking, see Saving changes to a shared record.



About customizing SmartIcons and menus
You can customize the set of SmartIcons that appears in the Approach work area and the menus that appear with a 
particular view.

Customizing the SmartIcons        
Approach comes with a default set of SmartIcons for Browse, Find, and Preview. For Design, it provides three default 
sets of icons for the icon bar and a floating palette of icons that are used for drawing objects. 
You can add or remove icons in any of the default sets or create your own sets of icons. You can also change the 
location of the icon bar and change the size of icons in the icon bar.

Creating a custom menu bar        
When you create a menu bar, each menu can have as many or as few commands as you want. For a data entry 
form, for example, you might create a menu that contains only commands for entering data. 
You can base a custom menu bar on the default Approach menu bar, a default set of short menus, or any other menu
bar you've already created. In most cases, unless the menu you want to create is very short, creating a menu based 
on another is more efficient than creating a new one.
A custom menu bar can appear only in Browse.

Editing or deleting a custom menu bar         
Once you've created a custom menu bar, you can easily edit it or delete it. If you delete a menu bar that is attached to
a view, Approach substitutes the default menu bar for the view.



Customizing the SmartIcons

You can add or remove icons in any default set of SmartIcons or create your own sets of icons. You can also change 
the location of the icon bar and change the size of icons in the icon bar.
1. Go to Browse, Design, Find, or Preview, and choose SmartIcons from the Tools menu.
2. If you need to change to a different set of icons, select a set in the drop-down list at the top of the SmartIcons 

dialog box.
3. Add, remove, and arrange icons in the order you want them in the current set (the list on the right).

You can add icons by dragging them from the Available Icons list to the current set, remove icons by dragging 
them to the Available Icons list, or move icons by dragging them up or down in the current set.

4. To save changes you made to the current set as a new icon bar, click Save Set, specify a name and file location 
in the Save Set of SmartIcons dialog box, and click OK.

5. To remove a set of icons, click Delete Set, select the set of icons in the Delete Sets dialog box, and click OK.
6. To change the size of all icons in the icon bar, click Icon Size, select a different size in the Icon Size dialog box, 

and click OK.
7. To change the location of the icon bar, select an option in the Position drop-down list.
8. To see descriptions of icons when you move the pointer over them in the icon bar, turn on "Show icon 

descriptions."
If this setting is off, you can still see the descriptions by right-clicking the icons.

9. Click OK.



Creating a custom menu bar

You can base a custom menu bar on the default Approach menu bar, a default set of short menus, or any other menu
bar you've already created. A custom menu bar appears only in Browse.
1. In Design, choose Customize Menus from the Tools menu.
2. Click New or select an existing menu bar and click Copy.
3. Type a name for the menu bar.
4. For the first menu in the menu bar, select a type in the Menu Type drop-down list and enter a name in the Menu 

Name text box.
5. For each item in the menu, select an action in the Item Action drop-down list and enter a name in the Item Name 

text box.
For items after the first one, click Add Item to add a line. 
To remove an item, select the item by clicking in the cell to the left of it and click Delete Item. To move an item, 
select the item and drag it up or down. You can SHIFT-select more than one item to move.

6. For each additional menu, click Add Menu, specify a type and name, and define items.
To remove a menu, select the menu by clicking in the cell to the left of it and click Delete Menu. To move a menu,
select the menu and drag it up or down. You can SHIFT-select more than one menu to move.

7. Click OK.
8. Attach the menu bar to a view using the Basics panel of the view's InfoBox.



Details: Creating a custom menu bar

Copy vs. New
If you select a menu bar and click Copy, the Define Custom Menu Bar dialog box shows the menus and items for the 
menu bar. If you click New, the dialog box does not initially have any menu information. 

Menu bar names
The name of the menu bar appears in the list of menu bars in the Basics panel of the InfoBox for views. You use this 
list to attach a custom menu bar to a view.

Menu types

This type Displays
Standard A list of commands
Menu + 
Files

A list of commands, 
followed by the filenames
of the last four Approach 
files used

Window 
Menu

A list of commands, 
followed by the 
pathname of the current 
Approach file

Macro List A list of macros
View List A list of views

The type Context Menu in the Menu Type drop-down list is used by Approach for menus that appear only in certain 
environments or only with certain types of views. It is not an editable menu type for custom menu bars.

Menu names
To underline a letter in a menu name, type an ampersand (&) right before the letter in the name; for example, &File 
underlines the letter F. You can open the menu in Browse by pressing ALT and the underlined letter.

Menu items
The Item Action drop-down list shows all the commands you can use, the names of the main sections in the online 
Help, the names of all views and macros in the Approach file, a blank line, and a menu divider (with a line of 
hyphens). You can also type keyboard shortcuts for items along with their names.
To underline a letter in an item name, type an ampersand (&) right before the letter in the name; for example, Save 
&As underlines the letter A. You can choose the item in Browse by pressing ALT and the underlined letter for the 
menu and then pressing the underlined letter for the item.



Editing or deleting a custom menu bar

Once you've created a custom menu bar, you can easily edit it or delete it. If you delete a menu bar that is attached to
a view, Approach substitutes the default menu bar for the view.
1. In Design, choose Customize Menus from the Tools menu.
2. Select the name of the menu bar you want to edit or delete.
3. To redefine the menu bar, click Edit and change the menus or items in the Define Custom Menu Bar dialog box.
4. To remove the menu bar, click Delete.

When an alert box appears, click OK to confirm that you want to delete the menu bar.
5. Click Done.

See also
Creating a custom menu bar 



Setting display defaults



Setting a default order for records



Defining a password for a file
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Setting database options for a Paradox file



Setting database options for all SQL tables



Maintaining external indexes for a dBASE or FoxPro database



Creating secondary indexes for a Paradox database
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Creating a custom menu bar



Editing or deleting a custom menu bar



About form letters
A form letter is a view that displays a combination of the date, fields from a database, and text you type in any of 
several business and personal letter formats

Creating a form letter        
You use the Form Letter Assistant to give a new form letter a name and select a style and layout. You also select the 
fields that appear on the form letter, and add a return address, salutation, and closing if you want to use them. 

Typing text in a form letter        
The text you add around fields is the standard part of the form letter that changes only when you edit it. Because a 
form letter is a single large text object, you can easily add text or edit text just as you would in any other text object.

Adding a field to a form letter        
After you create a form letter, you can add fields to any part of the letter. One way to add a field is to simply type the 
database and field names in this format: <<DATABASE.FIELD>>. The other way is to use the Insert Field dialog box.

Moving or deleting a form letter field        
You can easily move or remove fields from a form letter. Because the fields you see in a form letter are just 
placeholders, you can use standard text editing commands (Cut and Paste) to move them. You can also add or 
delete text and space to position the fields where you want them. 

See also
Form letters 



Creating a form letter

You use the Form Letter Assistant to give a new form letter a name, select a style and layout, select the fields that 
appear on the form letter, and add other letter elements if you want. 
1. Choose Form Letter from the Create menu.
2. Type a name for the form letter in the Name text box.
3. Select a style for the form letter in the SmartMaster Style drop-down list.
4. Select a layout for the form letter in the SmartMaster Layout list.
5. Click the Return Address tab and type a return address if you want to use one.
6. Click the Inside Address tab, select an address layout in the Address Layout list, and add the fields for the 

address section of the letter. 
7. Click the Salutation tab and specify the salutation.
8. Click the Close tab and type a closing.
9. Click Done.
10. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the form letter uses fields from more than one joined database. The first database you 
selected in the Fields panel is preselected as the main database.



Typing text in a form letter

Because a form letter is a single large text object, you can easily add text or edit text just as you would in any other 
text object.
1. Double-click anywhere in the form letter to get the Text tool and click where you want to add text.
2. Type the text.

See also
Changing text attributes 



Adding a field to a form letter

One way to add a field is to simply type the database and field names in this format: <<DATABASE.FIELD>>. The 
other way is to use the Insert Field dialog box.
1. In Design, click where you want the field to appear.
2. Click the Insert Field icon or choose Field from the Letter Insert submenu.

3. Click a field in the list and click OK to add it to the form letter.



Moving or deleting a form letter field

You can easily move or remove fields from a form letter. Because the fields you see in a form letter are just 
placeholders, you can use standard text editing commands (Cut and Paste) to move them.    

To move a field in a form letter:
1. Select the field you want to move and choose Cut from the Edit menu.
2. Click where you want to place the field and choose Paste from the Edit menu.

You cannot move a field in a form letter by dragging it.

To delete a field in a form letter:

Select the field and choose Cut or press BACKSPACE or DELETE.



Details: Creating a form letter

Form letter name
A new form letter automatically has the name Form Letter and a number; you can edit this to any name you want up 
to 30 characters. The name you use will appear on the form letter's view tab.

SmartMaster layout
Approach displays a sample form letter in the lower-right corner of the dialog box so that you can see what the layout 
looks like.

This SmartMaster 
layout

Displays

Block The return address, 
date, inside address, 
salutation, closing, and 
body of the letter all in 
left-aligned blocks

Modified Block The inside address, 
salutation,and body of 
the letter in left-aligned 
blocks (The return 
address, date, and 
closing appear on the 
right.)

Personal The date, salutation, 
and body of the letter in 
left-aligned blocks (The 
closing appears on the 
right.)

SmartMaster Address layout
The SmartMaster Address layout determines the number of lines in the inside address area. To add a field to a box in 
the Fields for the Address layout, select a box, select the field name in the Database Fields list, and click Add, or 
double-click the name. If you want to add a field from a different joined database, select the database in the drop-
down list. 

Field names in a form letter
The form letter appears on your screen as a text object. The field names appear between angle brackets in this 
format: <<DATABASE.FIELD>>. 



About mailing labels
A mailing label is a view that displays database fields and text you type in a typical mailing address format.

Creating a mailing label        
Approach provides a Mailing Label Assistant to help you create either standard-sized or custom mailing labels. When 
you create a mailing label, you select the SmartMaster layout you want to use, the fields to be included on the mailing
label, and the mailing label format. You can use one of the predefined Avery label formats or create custom label 
formats of your own.

Creating a custom mailing label format        
If your mailing labels do not match any of the more than 50 standard Avery label formats, you can create your own 
custom mailing label format -- with a label size, margins, gaps between labels, and other options -- and use it 
whenever you want.

Moving or resizing mailing label fields        
Approach automatically slides fields over or up to eliminate any empty space between them. This works both for 
fields that don't contain any data and for fields where the data doesn't fill all of the space allocated to it. You can 
adjust the space between fields manually by dragging a field to a different location. You can also resize a field by 
dragging one of its handles.

Typing on a mailing label        
In addition to the database fields that appear on a mailing label, you can also add text, such as a comma between 
address fields or a general message, to each label. Working in Design, you create text objects and type your text in 
them. 

Setting a field to slide        
When you create mailing labels, Approach automatically slides fields up and to the left to remove any extra space. 
However, if you add a field to a mailing label after the labels have been created, you'll need to set the field to slide. 

Changing or deleting a mailing label layout        
When you create mailing labels, you can either select an Avery label layout or create a customized layout of your 
own. Thereafter, you can change the size and arrangement of labels on a page using the InfoBox.

Printing an envelope         
You can use Approach to print names and addresses directly onto an envelope. Use a form to lay out the fields in the 
size and shape you need.

See also
Mailing labels 



Creating a mailing label

When you create a mailing label, you select the SmartMaster layout you want to use, the fields to be included on the 
mailing label, and the mailing label format. 
1. Choose Mailing Labels from the Create menu.
2. Type a name for the mailing labels in the Mailing Label Name box.
3. Select a layout in the SmartMaster Layout list.
4. If necessary, select the main database in the Database Fields drop-down list. 
5. Move fields from the Database Fields list to the boxes in the Fields to Place on Label area. 
6. Select a label code in the Label Type drop-down list.
7. To create your own custom labels, click the Options tab and set options in the Options panel.
8. Click OK.
9. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the mailing label uses fields from more than one joined database. The first database 
you selected in the Fields panel is preselected as the main database.

See also
Creating a custom mailing label format



Creating a custom mailing label format

If your mailing labels do not match any of the more than 50 standard Avery label formats, you can create your own 
custom mailing label format and use it whenever you want. 
1. Choose Mailing Labels from the Create menu, type a name for the mailing labels, select a SmartMaster layout, 

and assign fields to the Fields to Place on Label boxes. 
2. Click the Options tab.
3. Type a name for the custom labels in the Custom Label text box.
4. Type new values for margin, label size, and gap dimensions.
5. Specify the number of labels on each page.
6. Select a printing order.
7. If you're using continuous feed labels, turn on Tractor feed.
8. Click Add to add a new custom label layout.
9. Click OK.
10. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the report uses fields from more than one joined database. The first database you 
selected in the Fields panel is preselected as the main database.

See also
Creating a mailing label



Moving or resizing mailing label fields

You can adjust the space between fields manually by dragging a field to a different location. You can also resize a 
field by dragging one of its handles.

To move a mailing label field:

Drag the field to the location you want. 
You can also use the arrow keys to move a field. Make sure the whole field fits inside the label boundaries so 
that all of its contents will be printed.

To resize a mailing label field:

Drag a field handle to the size you want.



Typing on a mailing label

In addition to the database fields that appear on a mailing label, you can also add text, such as a comma between 
address fields or a general message, to each label. 
1. In Design, create a text object on the label.
2. Type in the object.

See also
Entering text in a text object 



Setting a field to slide

Approach automatically slides mailing label fields up and to the left to remove any extra space. If you add a field to a 
mailing label after the labels have been created, you'll need to set the field to slide. 
1. In Design, select a field and open its InfoBox.

2. Click the Dimensions tab.
3. In the When Printing, Slide area, turn on Up and Left.



Changing or deleting a mailing label layout

You can change the size and arrangement of labels on a page using the InfoBox.

To change a mailing label layout:
1. In Design, click the Show Info icon to open the InfoBox for mailing labels.

2. Click Edit Label Settings in the Basics panel.
3. Select the label layout you want to change in the Custom Label drop-down list.
4. Change the settings for the label as necessary.
5. Click Add to add a new label definition, or click Change to apply your changes to the current label definition.
6. Click OK.

To delete a mailing label layout:

Select the layout in the Custom Label drop-down list and click DELETE.

See also
Creating a custom mailing label format



Details: Creating a mailing label

Mailing label name
A new mailing label automatically has the name Mailing Label and a number; you can edit this to any name you want 
up to 30 characters. The name you use will appear on the mailing label's view tab.

SmartMaster layout
The SmartMaster layout determines how many lines of text appear on the labels. You can select from 3-line, 4-line, or
5-line formats.

Moving fields
To add a field to a mailing label box, click the box to select it and then either double-click the field name or select the 
field name and click Add. The focus arrow automatically moves to the next box. 

Label Type list
The list includes more than 50 different label formats. If you've defined any custom label formats, they can also 
appear in the list.



Details: Creating a custom mailing label format

Approach automatically displays the names of all custom label formats in the Mailing Label Assistant Label Code list. 

Margin, label size, and gap dimensions

This setting Controls
Top Margin The space between 

the top of the page 
and the first label

Left Margin The space between 
the left edge of the 
page and the left 
column of labels

Height and Width The size of the 
mailing label

Vert. Gap The space between 
each label and the 
one below it

Horiz. Gap The space between 
each label and the 
one beside it

As you change these values, the Sample Preview shows how the labels will appear on a page. 

Number of labels
The Across value sets the number of columns and the Down number sets the number of rows.

Printing order
Left to right prints labels across the page. Top to bottom prints labels in columns.

Tractor feed
Approach disables the Top Margin and Down settings for continuous feed labels. You may also want to adjust printer 
settings for the correct paper size.



Printing an envelope

You can use Approach to print names and addresses directly onto an envelope. Use a form to lay out the fields in the 
size and shape you need.
1. Choose Form from the Create menu and use the Form Assistant to create a form for the envelope.
2. In Design, use the zoom pop-up menu in the status bar to change the zoom setting to 75 percent.

This will let you see the whole envelope layout.
3. SHIFT-click all the fields on the form to select them.
4. Click the Show Info icon to open the InfoBox for the selected fields.

5. In the Lines and Colors panel of the InfoBox, turn off the borders and colors for the fields.
6. In the Label panel, turn off the field labels.
7. In the Dimensions panel, mark the fields to slide left and up when printing.
8. Choose Print Setup from the File menu.
9. Choose an Envelope setting from the Paper Size drop-down list, select Landscape in the Orientation area, and 

click OK.
If no Envelope settings appear in the Paper Size drop-down list, the current printer does not support envelope 
printing.

10. In Browse, choose Print from the File menu and use the dialog box that appears to print the envelope.

See also
Creating a form 
About editing fields 
Printing a view 



Creating a form letter



Typing text in a form letter



Adding a field to a form letter



Moving or deleting a form letter field



Creating a mailing label



Creating a custom mailing label format



Moving or resizing mailing label fields



Typing on a mailing label



Setting a field to slide



Changing the mailing label layout



Printing an envelope



About customizing the Design work area
Approach provides several ways to customize your Design work area.

Showing the design grid         
You can show a design grid behind objects in the work area. The grid appears as dotted lines. The design grid is only 
for working with objects in Design; it disappears when you go to Browse, and it does not print.

Snapping objects to the grid         
When you draw, move, or resize objects, you can have the objects "snap" to the increments on the design grid. The 
objects snap to the grid whether or not the grid is showing. This makes it easier to align objects precisely.

Showing rulers         
Approach can display rulers along the top and left sides of the Design work area. Rulers are only for working with 
objects in Design; they disappear when you go to Browse.

Showing the Tools palette         
You can show a floating Tools palette in Design, with SmartIcons for drawing objects. The Tools palette appears only 
in Design; it disappears when you go to Browse. You can drag the palette by its title bar to move it around in the work 
area.

Showing data or field names         
You can show either actual data or field names in field objects in Design. Work with data showing if you prefer to see 
how a view will look in Browse or when printed.

Zooming in and out         
As you work in Design, you can zoom in for a closer look at your view or zoom out for the big picture. The possible 
zoom settings are 25, 50, 75, 100, and 200 percent. Zoom settings affect only how a view appears on the screen and 
not how it is printed.

See also
Design 



Showing the design grid

You can show a design grid behind objects in the work area. The grid appears as dotted lines. The design grid is only 
for working with objects in Design; it disappears when you go to Browse, and it does not print.

Click the Show Grid icon or choose Show Grid from the View menu. To hide the grid, click the icon or choose
Show Grid again.

See also
Snapping objects to the grid 



Snapping objects to the grid

When you draw, move, or resize objects, you can have the objects "snap" to the increments on the design grid. The 
objects snap to the grid whether or not the grid is showing.

Click the Snap to Grid icon or choose Snap to Grid from the View menu. To remove the snap, click the icon 
or choose Snap to Grid again.

See also
Showing the design grid 
Setting display defaults 



Showing rulers

Approach can display rulers along the top and left sides of the Design work area. Rulers are only for working with 
objects in Design; they disappear when you go to Browse.

Click the Show Ruler icon or choose Show Ruler from the View menu. To hide the rulers, click the icon or 
choose Show Ruler again.

See also
Setting display defaults 



Details: Showing rulers

The Approach rulers are not drawn to scale on the screen, but 1 inch or 1 centimeter on a ruler is equal to 1 inch or 1 
centimeter on a printed page.
As you move the pointer in the work area, lines in the rulers identify the pointers position. If an object is selected, the 
lines show the dimensions of the object.
If you have the insertion point in a text object (including the main part of a form letter), the top ruler also shows the left
and right margins and any tab stops in the object.



Showing the Tools palette

You can show a floating Tools palette in Design, with SmartIcons for drawing objects. The Tools palette appears only 
in Design; it disappears when you go to Browse.

Click the Show Tools icon or choose Show Drawing Tools from the View menu. To hide the palette, click the 
icon or choose Show Drawing Tools again.

See also
Tools palette 



Showing data or field names

You can show either actual data or field names in field objects in Design. Work with data showing if you prefer to see 
how a view will look in Browse or when printed.

Click the Show Data icon or choose Show Data from the View menu. 
This toggles back and forth between showing data and field names.



Details: Showing data or field names

Data
When you show data in field objects in Design, in a form or form letter the data you see is from the first record in the 
current sort order of the found set. In other types of views, you see data from the records at the beginning of the 
found set that can fit on one page.

Field names
When you show field names in Design, the object borders also appear in the work area. If the Approach file has 
joined databases, the database names appear along with the field names; for example, EMPLOYEE.ADDRESS.



Zooming in and out

As you work in Design, you can zoom in for a closer look at your view or zoom out for the big picture. The possible 
zoom settings are 25, 50, 75, 100, and 200 percent.

To change to a particular zoom setting:

Click the percentage in the status bar to open the zoom pop-up menu and choose a setting.

To zoom in or out one setting:

Click the Zoom In or Zoom Out icon, choose Zoom In or Zoom Out from the View menu, or press CONTROL 
and the up arrow or down arrow key.

        

To return to 100 percent in one step:

Choose Actual Size from the View menu or 100% from the zoom pop-up menu in the status bar.



About adding objects to the background of a view
You can add geometric objects, pictures, text objects, and macro buttons to the "background" of a view in Design. 
When you go to Browse, the objects will look exactly the same on every page of the view. (By contrast, data in fields 
changes from record to record in Browse.)
Approach gives a new object the pen width, fill color, text attributes, and other properties of the default named style 
for the view. You can change any of these properties after creating the object.

Drawing a geometric object         
You can draw straight lines, rectangles and squares, rounded rectangles and squares, and ellipses and circles on a 
view. You can use these shapes to emphasize, separate, or "tie together" data, or just to enhance the appearance of 
the view. 

Pasting a picture         
You can paste a picture created in a graphics application, either directly from the picture file or through the Clipboard. 
For example, you may want to show a graphic of an icon the user needs to click or have a company logo appear on a
view in every record.

Entering text in a text object         
You can include text in a view, such as a name for the view or instructions for entering data. You first draw a text 
object and then type in the object. If you need to edit the text, click where you want to add text or select text you want 
to replace or delete.

Adding a macro button         
You can add a button to a view and attach a macro to the button. In Browse, Approach will run the macro whenever 
you click, tab into, or tab out of the button (depending on how you set up the macro).

See also
About editing objects and text 



Drawing a geometric object

You can draw straight lines, rectangles and squares, rounded rectangles and squares, and ellipses and circles on a 
view.
1. In Design, click the Line, Rectangle, Rounded Rectangle, or Ellipse icon, or choose Line, Rectangle, Rounded 

Rectangle, or Ellipse from the Create Drawing submenu. 
To draw more than one object of a type, double-click the icon. It will stay selected until you select a different icon.

        

        

        

2. Drag to draw the object. 
You can press SHIFT while dragging to constrain a line to 0, 45, or 90 degrees; a rectangle to a square; a 
rounded rectangle to a rounded square; or an ellipse to a circle.



Pasting a picture

You can paste a picture created in a graphics application, either directly from the picture file or through the Clipboard. 
For example, you may want to have a company logo appear on a view in every record.

To paste a picture from a file:
1. In Design, click where you want the upper-left corner of the picture. 

If you dont click anywhere, the picture will be pasted in the upper-left corner of the view.
2. Choose Paste from File from the Edit menu.
3. Select the file you want in the File Name list. 

If you dont know the file type, or want to display all the filenames, select All Files in the drop-down list.
4. Click OK.

To paste a picture from the Clipboard:
1. Select the picture in the picture's source application.
2. Choose Copy from the Edit menu.
3. In Approach, go to Design and click where you want the upper-left corner of the picture. 

If you don't click anywhere, the picture will be pasted in the upper-left corner of the view.
4. Click the Paste icon or choose Paste from the Edit menu.

See also
About embedding OLE objects 
About linking OLE objects from other applications 



Details: Pasting a picture

These are the graphic file types you can paste in Approach:

Graphic file type Filename 
extension

Encapsulated 
Postscript

.EPS

Graphics 
interchange

.GIF

Targa .TGA
TIFF (Tagged 
Image File 
Format)

.TIF

Windows bitmap .BMP
Windows metafile .WMF
Windows 
Paintbrush

.PCX



Entering text in a text object

You can include text in a view, such as a name for the view or instructions for entering data. You first draw a text 
object and then type in the object. 
1. In Design, click the Text icon or choose Text from the Create Drawing submenu.

To draw more than one text object, double-click the icon. It will stay selected until you select a different icon.

2. Click where you want the text to begin or drag to define an area for the text object.
3. Enter the text. 

To paste text from the Clipboard, click the Paste icon or choose Paste from the Edit menu. To insert a date or 
time, click the Date or Time icon or choose Date or Time from the Insert submenu in the context-sensitive view 
menu (such as Form or Report).

        

        

See also
Changing text attributes 



Details: Entering text in a text object

Typing text
The text you type appears at the insertion point. You dont need to press RETURN as you type; the text wraps 
automatically from line to line to fit in the text object.

Inserting a date or time
If you insert a date or time, Approach will update it to the current date or time whenever you open, preview, or print 
the Approach file.



Adding a macro button

You can add a button to a view and attach a macro to the button. In Browse, Approach will run the macro whenever 
you click, tab into, or tab out of the button (depending on how you set up the macro).
1. In Design, click the Macro Button icon or choose Macro Button from the Create Drawing submenu. 

To draw more than one macro button, double-click the icon. It will stay selected until you select a different icon.

2. Drag to draw the button.
3. In the Macros panel of the button's InfoBox, select one or more macros for the button in the drop-down lists in the

Attached Macros area.
4. If you need to define a macro, click Define Macro and use the dialog box that appears.
5. Click the Basics tab in the InfoBox.
6. Type a label for the button in the Button Text box.
7. If youre working with data showing, turn on Show in Preview to see the macro button in Design.

See also
Defining a macro 



About selecting in Design
Before making design changes to a view, you need to select the object or text youre editing.
The Pointer and Text icons are in the Tools palette.

Selecting objects         
A selected object has handles around it. You can drag one of these handles to resize the object. If you select more 
than one object, you can move, cut, copy, delete, and apply properties (such as a fill color) to the selected objects all 
at once.

Selecting text         
You can select particular text in a text object or the entire object. If you select an entire text object, any attribute you 
use applies to all text in the object. Text is highlighted when it is selected.



Selecting objects in Design

A selected object has handles around it. You can drag one of these handles to resize the object. 

To select an object:

Click the Pointer icon and then click inside the object or on its border. 

To select more than one object:

Click the Pointer icon and then SHIFT-click the objects. Or drag diagonally to draw a selection rectangle 
around the objects.

To select all the objects on a view:

Choose Select All from the Edit menu.

To deselect an object from several selected objects:

Click the Pointer icon and then SHIFT-click the object.

To cancel a selection:

Click in another part of the view. 



Selecting text in Design

You can select particular text in a text object or the entire object. If you select an entire text object, any attribute you 
use applies to all text in the object. Text is highlighted when it is selected.

To select a range of text:

Click the Text icon or double-click the text object. Then drag through the text.

To select a word:

Click the Text icon or double-click the text object. Then double-click the word.

To select a text object:

Click the Pointer icon and then click the object. 

To enter an insertion point in text:

Click the Text icon and click in the text, or click the Pointer icon and double-click a selected text object.

To cancel a selection:

Click in another part of the view.



About editing objects and text
You can edit objects and text in several ways. You must be in Design to make these changes.

Changing the basic properties of an object         
An object's basic properties are its named style and whether the object is non-printing and appears in Preview.

Changing line or color settings for an object         
You can set a line width, color, and frame for an object's border, a fill color for an object's interior, and a color for a 
drop shadow.

Resizing an object         
You can change the size and shape of any existing design object, either with the mouse or with the InfoBox. You can 
also reshape ellipses into circles, circles into ellipses, rectangles into squares, and squares into rectangles without 
redrawing.

Moving an object         
You can move any object to another part of a view using the mouse, the keyboard, or the InfoBox.

Sliding an object when you print         
The data in a field can vary in length, so the distance between field data and an object to the right of it or below it can 
also vary from record to record. If you want an object to be a consistent distance from a fields data in every record, 
you can have Approach slide the object to the left or up to fill blank space.

Changing text attributes         
You can change the font, size, color, and text style of all text in a text object or of text in a selected range. You can 
also change the alignment and line spacing of all text in a text object. 

Cutting or copying an object or text         
You can cut or copy an object or a range of text and paste it elsewhere on the view or on another view.

Deleting an object or text         
You can permanently delete any object or range of text from a view. If you delete a field, the field is not deleted from 
the database but only from the current view.

Applying properties from another object         
You can copy the line and color settings and text attributes from one object and apply them to another object with a 
click of the mouse.

See also
InfoBox 
About selecting in Design 
About editing views
Attaching a macro to a button or object 



Changing the basic properties of an object

An object's basic properties are its named style and whether the object is non-printing and appears in Preview.
1. Select the object in Design.
2. Open the InfoBox.

3. Click the Basics tab.
4. Set the options in the Basics panel.

See the Details topic for options.



Details: Changing the basic properties of an object

To Do this
Make an object 
non-printing

Turn on Non-printing.

Show a non-
printing object in 
Preview

Turn on Show in 
Preview. (This is 
available only if Non-
printing is on.)

Apply a named 
style with line, 
color, and text 
properties already
defined

Select a style in the 
Named Style drop-
down list.



Changing line or color settings for an object

You can set a line width, color, and frame for an object's border, a fill color for an object's interior, and a color for a 
drop shadow.
1. Select the object in Design.
2. Open the InfoBox.

3. Click the Lines and Colors tab.
4. Set the options in the Lines and Colors panel.

See the Details topic for options.



Details:Changing line or color settings for an object

To Do this
Change the 
width of a line or
of the border of 
another object

Select a width in the 
Border Width drop-
down list.

Change the 
color of a line or
of the border of 
another object

Select a color in the 
Border Color drop-
down palette. Select T
for transparent.

Change the fill 
color of the 
interior of an 
object

Select a color in the 
Fill Color drop-down 
palette. Select T for 
transparent. (This is 
not available for lines.)

Give an object a
drop shadow

Select a color in the 
Shadow Color drop-
down palette. Select T
for no shadow.

Give an object a
raised or 
indented frame

Select a frame style in
the Frame drop-down 
list.



Resizing an object

You can change the size and shape of any existing design object, either with the mouse or with the InfoBox.

To resize an object using the mouse:

In Design, select the object and drag one of its handles. 
You can press SHIFT while dragging to resize a rectangle, rounded rectangle, or ellipse to the shape of a square, 
rounded square, or circle.

To resize an object using the InfoBox:
1. Select the object in Design.
2. Open the InfoBox.

3. Click the Dimensions tab.
4. Type values in the Width and Height text boxes.

See also
Moving an object 



Moving an object

You can move any object to another part of a view using the mouse, the keyboard, or the InfoBox.

To move an object using the mouse:

In Design, select the object and drag it by the border.

To "nudge" an object using the keyboard:

In Design, select the object and press an arrow key. 
At the 100-percent zoom setting, the object moves 1 pixel each time you press the key. (Nudging an object takes 
the object off the snap grid.)

To move an object using the InfoBox:
1. Select the object in Design.
2. Open the InfoBox.

3. Click the Dimensions tab.
4. Type values in the Top and Left text boxes.

See also
Resizing an object 



Sliding an object when you print

If you want an object to be a consistent distance from a fields data in every record, you can have Approach slide the 
object to the left or up to fill blank space.
1. Select the object in Design.
2. Open the InfoBox.

3. Click the Dimensions tab.
4. Turn on Left or Up in the When Printing, Slide area.

See also
Sliding or resizing a field when you print 



Details: Sliding an object when you print

For sliding to work, you must have Reduce on (in the Dimensions panel of the InfoBox) for the field with the variable 
data. Approach resizes the field so that it is just large enough for the data in it, and then it slides the object to fill the 
space left by the reduced boundaries.
For example, if you have a memo field with a variable amount of data in it and a line beneath the memo field, you can
slide the line up to be just below the data in every record. (The memo field must have Reduce on.)
Approach slides an object when you preview or print, and in Design if youre showing data.



Changing text attributes

You can change the font, size, color, and text style of all text in a text object or of text in a selected range. You can 
also change the alignment and line spacing of all text in a text object. 
1. Select the text or text object in Design.
2. Open the InfoBox.

3. Click the Text tab.
4. Set the options in the Text panel.

See the Details topic for options.



Details: Changing text attributes

To Do this
Change the font of 
text

Select a font in the 
Font Name drop-
down list.

Apply boldface, 
italics, underlining, 
or strikethrough to 
text

Select one or more 
styles in the 
Style/Effect list.

Change the font 
size of text

Select a size in the 
Size drop-down list.

Apply a color to text Select a color in the
Text Color drop-
down list.

Change line 
spacing to single 
space, one and a 
half space, or 
double space

Select an option in 
the Line Spacing 
area.

Change alignment 
to left, center, right, 
or justified 

Select an option in 
the Alignment area.



Cutting or copying an object or text

You can cut or copy an object or a range of text and paste it elsewhere on the view or on another view.
1. Select the object or text in Design.
2. Click the Cut or Copy icon or choose Cut or Copy from the Edit menu.

        

3. Click where you want to paste the selection.
4. Click the Paste icon or choose Paste from the Edit menu.

See also
Deleting an object or text 



Details: Cutting or copying an object or text

Cut and Copy commands
The Cut command removes the selection from the view and puts it on the Clipboard. Copy leaves the selection in 
place and puts a copy of it on the Clipboard.
The Clipboard stores only one item at a time. When you cut or copy, you erase the current contents of the Clipboard.

Location of pasted objects
If youre pasting an object, you can click where you want the object to go. If you dont specify a location, the object will 
be pasted on top of the original object. If you paste into another view, the object will be pasted at the same location as
in the original view.
If youre pasting text, you must click in a text object. The text will be pasted at the insertion point.



Deleting an object or text

You can permanently delete any object or range of text from a view. If you delete a field, the field is not deleted from 
the database but only from the current view.
1. Select the object or text in Design.
2. Choose Clear from the Edit menu or press DELETE or BACKSPACE.

See also
Cutting or copying an object or text 



Applying properties from another object

You can copy the line and color settings and text attributes from one object and apply them to another object with a 
click of the mouse.
1.  In Design, select the object with the properties you want to use.
2. Click the Fast Format icon or choose Fast Format from the context-sensitive view menu.

3. Click the objects you want to apply properties to. 
Each object you click takes the line and color settings and text attributes of the selected object.

4. When youre finished, click the Fast Format icon, choose Fast Format, or press ESC.



About working with named styles
You can apply a named style to any object and define a style to be the default for new views. A named style can 
include these properties:

Line and color settings for all objects, and border and baseline settings for fields

Text attributes for field data and for text in text objects

Text attributes for field labels

Picture settings such as cropping and shrinking for PicturePlus fields

Width and color settings for the background of a view
The properties in a named style are the same as they are in the InfoBox, but by saving properties in a style you can 
easily apply them to more than one object. If you change any properties of a named style, all objects that use the 
style are updated to match the changes automatically.
When you create a view using an Assistant, you can apply your default style to the view or apply one of the 
SmartMaster styles. Approach uses the style properties for the background of the view and for all objects you add to 
the view. You can change the style of a view or object using the Named Style drop-down list in the Basics panel of the
InfoBox.
When you apply a named style to an object, only the appropriate properties apply. For example, if you apply a style to
a rectangle, only the width, color, and frame settings apply even though the style may also have text attributes and 
picture settings.

Defining and saving a named style         
When you define a named style, you can either create a new style from scratch or make a copy of an existing style 
and then modify it.

Editing or deleting a named style         
If you edit a style, in general any existing objects that use the style are updated automatically. But if you have 
changed any properties for an object using its InfoBox, those particular properties are not updated for that object.
Deleting a style does not affect the properties of any existing objects that use the style. You can delete styles youve 
created but not the predefined styles that come with Approach.

See also
Setting display defaults



Defining and saving a named style

When you define a named style, you can either create a new style from scratch or make a copy of an existing style 
and then modify it.
1. Choose Named Styles from the Tools menu.
2. In the Named Styles dialog box, click New or select an existing style and click Copy.
3. In the Define Style dialog box, type a name for the new style in the Style Name text box.
4. If you want to base the style on an existing one, select the existing style in the Based On drop-down list.
5. To define text attributes for data in fields and for text in text objects, click the Font tab and set options in the Font 

panel.
6. To define properties for widths, colors, frames, and field borders, click Lines & Colors and set options in the Lines

and Colors panel.
7. To define text attributes for field labels, click the Label tab and set options in the Label panel.
8. To define properties for PicturePlus fields, click the Picture tab and set options in the Picture panel.
9. To define properties for the background of views, click the Background tab and set options in the Background 

panel.
10. Click OK.
11. To apply the new style to the current selection, click Apply. 

This is available only if at least one object is selected in a view.
12. Click Done.

See also
Changing text attributes 
Changing line or color settings for an object 
Changing display options for a PicturePlus field 
Changing line or color settings for a view 



Details: Defining and saving a named style

New vs. Copy
If you click New, the Define Style dialog box shows properties in their default neutral settings.
If you select a style and click Copy, the selected styles properties appear in the panels of the dialog box. The Style 
Name text box shows the name of the copied style, plus a number (for example, Corporate2). You can edit this name 
and the settings in the panels.

Based On drop-down list
If you select an existing style in the Based On drop-down list, the base styles properties appear in the panels of the 
dialog box. You can edit any of these settings.
The new style maintains a relationship with the base style. For any property you keep from the base style, if you later 
change that property in the base style, the change is also made in the new style.



Editing or deleting a named style

You can edit any named style, and you can delete the named styles you've created.
1. Choose Named Styles from the Tools menu.
2. Select the name of the style you want to edit or delete. 

You can delete only styles youve created.
3. To redefine the style, click Edit and change the settings in the Define Style dialog box. 

Objects that use the style are updated automatically, except for any properties you've changed in their InfoBox.
4. To remove the style, click Delete and click OK in the alert box. 

This does not affect the properties of existing objects that use the style.
5. Click Done.

See also
Changing text attributes 
Changing line or color settings for an object 
Changing display options for a PicturePlus field 
Changing line or color settings for a view 



About working with more than one object at a time
Approach makes it easy to quickly change more than one object at a time. After you select the objects you want to 
change, you can cut, copy, paste, or move the objects or change their properties just as you can with an individual 
object. 
A few commands work only with multiple objects.

Grouping and ungrouping objects         
You can combine two or more objects so that they act as a single object. When you select a grouped object, one set 
of handles appears around the entire group, and the object name in the InfoBox is Grouped Object.
You cannot edit text in a text object that is part of a group. You must first ungroup the text object from the other 
objects.

Changing the stacking order of an object         
Each time you create a new object, it is placed "in front of" any other objects already on the view. You can change this
stacking order, moving any object closer to the front or farther to the back.

Aligning and distributing objects         
Approach lets you align objects along their tops, bottoms, sides, or centers. The objects can align to the position of 
one object or to the nearest point on the grid.
You can also distribute objects vertically or horizontally. This places an equal amount of space between the objects.

See also
About editing objects and text 



Grouping and ungrouping objects

You can combine two or more objects so that they act as a single object. One set of handles appears around the 
entire group, and the object name in the InfoBox is Grouped Object.

To group objects:
1. Select the objects in Design.
2. Click the Group icon or choose Group from the Object menu.

To ungroup a grouped object:
1. Select the object in Design.
2. Click the Ungroup icon or choose Ungroup from the Object menu.

See also
Selecting objects in Design 



Changing the stacking order of an object

Each time you create a new object, it is placed "in front of" any other objects already on the view. You can change this
stacking order, moving any object closer to the front or farther to the back.
1. Select the object in Design.
2. Click the Bring to Front, Send to Back, Bring Forward, or Send Backward icon or choose one of these commands

from the Object Arrange submenu.

        

        

        

See also
Selecting objects in Design 



Aligning and distributing objects

Approach lets you align objects along their tops, bottoms, sides, or centers. You can also distribute objects    vertically
or horizontally to place an equal amount of space between them.
1. Select two or more objects in Design.
2. Click the Align icon or choose Align from the Object menu.

3. Select whether to align the objects to each other or to the grid in the Align Objects area.
4. Select the alignment and distribution setting you want in the Vertical Alignment and Horizontal Alignment areas.
5. Click OK.

See also
Selecting objects in Design 



About editing views
In addition to editing individual objects on a view, you can make changes that affect the view as a whole. You must be
in Design to make these changes.

Changing the basic properties of a view         
A views basic properties are its name, the main database if the view uses joined data, the named style for its 
background, the set of menus, and whether the view appears in Browse.
A report does not have named styles in its basic properties. Instead, the panels in the report each have a named 
style.

Adding a date or time to a view         
You can put a date or time on the background of a view. Approach will update it to the current date or time whenever 
you open, preview, or print the Approach file. 
When you first insert a date or time, Approach places it in a new text object in the upper-left corner of the view. You 
can move, resize, and otherwise edit the text object.

Resizing page margins         
When you create a new view, Approach automatically sets page margins appropriate for the current printer. You can 
change any of the margins to make the printable area larger or smaller, up to the maximum area allowed by the 
printer.

Changing line or color settings for a view         
In a form, form letter, or mailing label, you can change the color or width of the page margins and the fill color of the 
page background. Objects such as fields and rectangles on the view are not affected by the views background color 
(unless the objects are transparent).
In a report, you change the line and color settings in InfoBoxes for the individual panels.

Duplicating a view         
If you want to create a form, report, form letter, mailing label, worksheet, crosstab, or chart that is similar to one you 
already have, you can make a duplicate and then modify it. Approach names a duplicate view Form 2, Report 2, and 
so on; you can rename the view in the Basics panel of its InfoBox.

Deleting a view         
You can delete a form, report, form letter, mailing label, worksheet, crosstab, or chart. 

See also
InfoBox 
About editing objects and text 
Attaching a macro to a view 



Changing the basic properties of a view

A views basic properties are its name, the main database if the view uses joined data, the named style for its 
background, the set of menus, and whether the view appears in Browse.
1. Click in the background of the view in Design.
2. Open the InfoBox.

3. Click the Basics tab.
4. Set the options in the Basics panel.

See the Details topic for options.



Details: Changing the basic properties of a view

Options in the Basics panel

To Do this
Change the 
name of a view

Edit the name in the 
View Name text box.

Change to a 
different main 
database

Select a database in
the Main Database 
drop-down list.

Apply a named 
style with line 
and color 
properties 
already defined

Select a style in the 
Named Style drop-
down list. (This is not
available for 
reports.)

Change the 
menus for a view

Select a set of 
menus in the 
Attached Menu Bar 
drop-down list.

Hide a view in 
Browse

Turn on "Hide view."

Hide a views 
page margins in 
Browse

Turn on "Hide page 
margins." (This is 
available for forms 
and form letters, and
only if "Hide view" is 
off.)

Another way to rename a view
You can also rename a view in Design by double-clicking a view tab and then typing in the tab.

Menu bars for a view
If you attach a set of menus to a view, the menus are available whenever you go to the view in Browse. You can 
attach the default menus, the Approach short menus, or any custom menus of your own.
The short menus are a subset of the default menus; they do not include commands for modifying the file. For 
example, the short menus do not have the Create Form and Define Macro commands. 
For information about setting up custom menus, see Customizing menus.



Adding a date or time to a view

You can put a date or time on the background of a view. Approach will update it to the current date or time whenever 
you open, preview, or print the Approach file. 
1. In Design, click the Date or Time icon or choose Date or Time from the Insert submenu in the context-sensitive 

menu.

        

2. Drag the date or time to move it where you want it on the view.
Approach initially places the date or time in the upper-left corner of the view.

See also
Adding a header or footer 



Resizing page margins

When you create a new view, Approach automatically sets page margins appropriate for the current printer. You can 
change any of the margins, up to the maximum area allowed by the printer.
1. In Design, click the border of the view. 

The border is highlighted when you click it.
2. Drag a border to resize the margin.



Changing line or color settings for a view

In a form, form letter, or mailing label, you can change the color or width of the page margins and the fill color of the 
page background.
1. Click in the background of the form, form letter, or mailing label in Design.
2. Open the InfoBox.

3. Click the Lines and Colors tab.
4. Set the options in the Lines and Colors panel.

See the Details topic for options.

See also
Changing line or color settings for a report panel 



Details: Changing line or color settings for a view

To Do this
Change the width
of the page 
margins of a view

Select a width in 
the Border Width 
drop-down list.

Change the color
of the page 
margins of a view

Select a color in the
Border Color drop-
down palette. 
Select T for 
transparent.

Change the fill 
color of the 
background of a 
view

Select a color in the
Fill Color drop-
down palette. 
Select T for 
transparent.



Duplicating a view

If you want to create a form, report, form letter, mailing label, worksheet, crosstab, or chart that is similar to one you 
already have, you can make a duplicate and then modify it.
1. In Design, change to the view you want to duplicate.
2. Choose the Duplicate command from the Edit menu. 

The name of the command changes depending on the type of the current view; for example, Duplicate Form.



Deleting a view

You can delete a form, report, form letter, mailing label, worksheet, crosstab, or chart. 
1. In Design, change to the view you want to delete.
2. Choose the Delete command from the Edit menu. 

The name of the command changes depending on the type of the current view; for example, Delete Form.
3. Click Yes in the alert box to delete the view.



Showing a design grid



Snapping objects to the grid



Showing rulers



Showing the Tools palette



Showing data or field names



Zooming in and out



Drawing a geometric object



Pasting a picture



Entering text in a text object



Adding a macro button



Selecting objects in Design



Selecting text in Design



Changing the basic properties of an object



Changing line or color settings for an object



Resizing an object



Moving an object



Sliding an object when you print



Changing text attributes



Cutting or copying an object or text



Deleting an object or text



Applying properties from another object



Defining and saving a named style



Editing or deleting a named style



Grouping and ungrouping objects



Changing the stacking order of an object



Aligning and distributing objects



Changing the basic properties of a view



Adding a date or time to a view



Resizing page margins



Changing line or color settings for a view



Duplicating a view



Deleting a view



About forms and repeating panels
A form is a view that shows one record at a time. If an Approach file uses data from joined databases, you can put a 
repeating panel on a form to show data from detail records related to the form's main record.

Creating a form        
The Approach Form Assistant guides you as you create new forms. You use the Assistant to apply styles and layouts 
called SmartMasters to a new form and to specify which fields go on the form. If the form has a repeating panel, you 
also use the Assistant to add fields for the panel.

Adding a repeating panel to an existing form        
In addition to creating a repeating panel with the Form Assistant, you can add a panel to a form after creating the 
form. When you add a panel to an existing form, you can specify the number of lines in the panel, an alternating 
background color for lines, and a sort order for records in the panel.

See also
Forms 
Repeating panels 
About modifying repeating panels 



Creating a form

You use the Form Assistant to apply SmartMasters to a new form and to specify which fields go on the form. If the 
form has a repeating panel, you also use the Assistant to add fields for the panel.
1. Choose Form from the Create menu.
2. In the Form Assistant, type a name for the form in the Name text box.
3. Select a style for the form in the SmartMaster Style drop-down list.
4. Select a field layout for the form in the SmartMaster Layout list.
5. Click the Fields tab and add the fields you want to show in the form.
6. If you're creating a form with a repeating panel, click the Panel tab and add the fields you want for the panel.
7. Click Done.
8. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the form uses fields from more than one joined database. The first database you 
selected in the Fields panel is preselected as the main database.



Details: Creating a form

Form name
A new form automatically has the name Form and a number; you can edit this to any name you want up to 30 
characters. The name you use will appear at the top of the form and on the form's view tab.

Styles
The styles set properties such as background color for the form and text attributes for data and field labels.
You can select your default style or one of the predefined SmartMaster styles. The default style is specified in the 
Display panel of the Preferences dialog box.

Field layouts
A new form can have a standard or columnar layout, or it can be blank. If the Approach file uses joined databases, a 
form can also be standard with a repeating panel.

Adding fields to a form or repeating panel
To add a field to the Fields to Place on View or Fields to Place in Panel list, select the field name in the Database 
Fields list and click Add, or double-click the name. If you want to add a field from a different joined database, select 
the database in the drop-down list. Approach will display the fields in the form or panel in the order they appear in the 
Assistant.
To remove a field from the Fields to Place on View or Fields to Place in Panel list, select the field name in the list and 
click Remove, or double-click the name.



Adding a repeating panel to an existing form

When you add a repeating panel to an existing form, you can specify the number of lines in the panel, an alternating 
background color for lines, and a sort order for records in the panel.
1. In Design, click where you want to place the upper-left corner of the repeating panel on the form.
2. Choose Repeating Panel from the Create menu.
3. Add the fields you want in the repeating panel to the Fields to Place in Panel list.
4. To use a background color in every other line of the panel, turn on "Alternate color with" and select a color in the 

drop-down palette.
5. To set a sort order for the records in the panel, turn on "Sort the values in the panel," click Define Sort, specify 

the order in the dialog box that appears, and click OK.
6. Type the number of lines for the panel in the Number of Lines text box.
7. Click OK.

See also
About modifying repeating panels 
About sorting records by data in fields 



Details: Adding a repeating panel to an existing form

Adding fields to a repeating panel
To add a field to the Fields to Place in Panel list, select the field name in the Database Fields list and click Add, or 
double-click the name. If you want to add a field from a different joined database, select the database in the drop-
down list. Approach will display the fields in the panel in the order they appear in the Assistant.
To remove a field from the Fields to Place in Panel list, select the field name in the list and click Remove, or double-
click the name.
The first database you add a field from will be the default main database for the repeating.panel. The panel cannot 
have the same main database as the form.

Number of lines
Type the number of matching records you want displayed at one time, up to 30 lines. You don't need to show as 
many lines as you have records; Approach adds a scroll bar if necessary.

Alternating colors
Alternating colors can make it easier to distinguish lines in a repeating panel. The lines without the color are 
transparent and appear in the background color of the form.



About modifying a repeating panel
You can change the appearance of repeating panels in several ways. You must be in Design to modify a repeating 
panel.
In addition to the changes described in this section, you can move, cut, copy, paste, and delete both panels and the 
fields in them as you can other types of design objects. For more information, see About editing objects and text.

Selecting a repeating panel        
Before modifying a repeating panel, you sometimes need to select the panel in Design. A repeating panel has a dark 
border around it when it is selected.

Adding labels to a repeating panel        
When you create a repeating panel, the new panel does not have any field labels. You may want to add labels to 
make it easier to enter and identify data in the panel in Browse.

Changing the basic properties of a repeating panel        
The basic properties of a repeating panel are its main database, a sort order for records, the named style, and the 
number of lines that display.

Changing line or color settings for a repeating panel        
You can set a line width and color for the borders between lines and around the outside of a repeating panel, and a fill
color for the background of the interior. You can also apply a three-dimensional frame to each line and a drop shadow
to the entire panel. The sets of colors include several patterns for each color. 

Resizing a repeating panel        
You can resize a repeating panel horizontally or vertically. When resizing a panel, you select and drag only the top 
line of the panel. (The line has a border around it when selected.) Dragging the entire panel moves the panel rather 
than resizing it.

Adding a field to a repeating panel        
You can add more fields to a repeating panel. A new field must be entirely inside the borders of the panel and in the 
top line along with the other fields.
A new field takes the field style properties associated with the repeating panel. For example, a field is usually 
transparent, with its label and borders hidden.

Rearranging fields in a repeating panel        
A repeating panel is initially laid out with the fields for each record all in a row. You can rearrange the fields to stack or
stagger them any way you want inside their line in the panel. This sometimes makes each line look like a small 
record.

Summarizing data for records in a repeating panel        
You can add a calculated field to a form to show a total, average, count, or other summary on data in a repeating 
panel. A summary on data in a repeating panel is calculated in Browse and Preview, and in Design if you're showing 
data.



Selecting a repeating panel

Before modifying a repeating panel, you sometimes need to select the panel in Design. A repeating panel has a dark 
border around it when it is selected.

In Design, click in any part of the panel except for the top line. 
If you click in the top line, you select a field rather than the entire panel.



Adding labels to a repeating panel

When you create a repeating panel, the new panel does not have any field labels. You may want to add labels to 
make it easier to enter and identify data in the panel in Browse.
1. In Design, use the Text tool to type the labels above the fields and outside the borders of the panel.

2. Select the labels and align them along the bottoms.

3. Group the labels.

See also
About working with more than one object at a time 



Changing the basic properties of a repeating panel

The basic properties of a repeating panel are its main database, a sort order for records, the named style, and the 
number of lines that display.
1. Select the repeating panel in Design.
2. Open the InfoBox.

3. Click the Basics tab.
4. Set the options in the Basics panel.

See the Details topic for options.



Details: Changing the basic properties of a repeating panel

To Do this
Change to a 
different main 
database

Select a database in 
the Main Database 
drop-down list.

Apply a sort order 
to records in a 
panel

Turn on "Sort panel 
values," click Define 
Sort, and specify the 
sort order in the 
dialog box.

Apply a named 
style with line and 
color properties 
already defined

Select a style in the 
Named Style drop-
down list.

Change the number
of visible lines in a 
panel

Edit the number in the
Number of Lines text 
box.



Changing line or color settings for a repeating panel

You can set a line width and color for the borders in a repeating panel, and a fill color for the interior. You can also 
apply a three-dimensional frame to each line and a drop shadow to the panel.
1. Select the repeating panel in Design.
2. Open the InfoBox.

3. Click the Lines and Colors tab.
4. Set the options in the Lines and Colors panel.

See the Details topic for options.



Details: Changing line or color settings for a repeating panel

To Do this
Change the width 
of borders in a 
panel

Select a width in the 
Border Width drop-
down list.

Change the color of
borders in a panel

Select a color in the 
Border Color drop-
down palette. Select 
T for transparent.

Change the fill color
of the interior of a 
panel

Select a color in the 
Fill Color drop-down 
palette. Select T for 
transparent.

Give a panel a drop
shadow

Select a color in the 
Shadow Color drop-
down palette. Select 
T for transparent.

Give the lines in a 
panel a raised or 
indented frame

Select a frame style 
in the Frame drop-
down list.

Show outside 
borders around a 
panel

Turn on options in the
Borders area.

Show the current fill
color in every other 
line of a panel

Turn on "Alternating 
color."



Resizing a repeating panel

You can resize a repeating panel horizontally or vertically. When resizing a panel, you select and drag only the top 
line of the panel.
1. In Design, select the panel by clicking in any part of it except for the top line.
2. Drag the gray border of the top line in the panel.

If you drag the black border of the main part of the panel rather than the gray line border, you move the panel 
rather than resizing it.



Details: Resizing a repeating panel

Horizontal resizing
Resizing a repeating panel horizontally changes the width of only the panel and not the fields in it. If you're making a 
panel more narrow, be sure that the fields are still inside the borders of the panel.

Vertical resizing
Resizing a panel vertically changes the height of lines in the panel. This does not change the number of lines and 
does not affect the size of the fields or the data in them. If you want to change the number of lines, use the Basics 
panel in the InfoBox.



Adding a field to a repeating panel

You can add more fields to a repeating panel. A new field must be entirely inside the borders of the panel and in the 
top line along with the other fields.
1. In Design, click the Add Field icon or choose Add Field from the Panel or Form menu.

2. Drag the database field you want from the Add Field dialog box to the repeating panel.
3. If necessary, move and resize the new field or the repeating panel. 

The field should fit inside the borders of the repeating panel and in the top row of the panel. 

See also
Moving an object 
Resizing an object 
Resizing a repeating panel 



Rearranging fields in a repeating panel

A repeating panel is initially laid out with the fields for each record all in a row. You can rearrange the fields to stack or
stagger them any way you want inside their line in the panel.
1. In Design, resize the panel to make the lines tall enough and wide enough to accommodate the fields.
2. If you want field labels to appear inside the lines of the panel, use the Label panel in the InfoBox to show the 

label for each field.
3. Drag the fields to the layout you want.

See also
Resizing a repeating panel



Summarizing data for records in a repeating panel

You can add a calculated field to a form to show a summary on data in a repeating panel. A summary for a repeating 
panel is calculated in Browse and Preview, and in Design if you're showing data.
1. Define a calculated field with a summary function for the repeating panel.
2. Add the calculated field to the form with the repeating panel. 

Place the field outside the panel, on the form.

See also
Setting up a formula for a calculated field 
Adding a field as a field box 



Details: Summarizing data for records in a repeating panel

Define Formula panel
In the Define Formula panel of the Field Definition dialog box, enter a summary function and use a field from the 
repeating panel as the parameter; for example, SSum(Invoice_Number).

Define Summary panel
In the Define Summary panel, select "Summary of all records in database," where database is the name of the main 
database for the panel; for example, "Summary of all records in CUSTOMER."



Creating a form



Adding a repeating panel to an existing form



Adding labels to a repeating panel



Selecting a repeating panel



Changing the basic properties of a repeating panel



Changing line or color settings for a repeating panel



Resizing a repeating panel



Adding a field to a repeating panel



Rearranging fields in a repeating panel



Summarizing data for records in a repeating panel



About reports
A report is a view that shows data from multiple records on a single page. Reports can display field data, summary 
information, or a combination of the two. You can include fields from single database or from joined databases.

Creating a standard or columnar report        
A standard or columnar report contains database field information only. When you create one, you give it a name and 
select a style and layout. You also select the fields that appear on the report.

Creating a report with summaries        
A report with summaries can contain a combination of field data and summaries. When you create one, you select the
fields that appear on the report and define the summaries.

Creating a repeating panel report        
A repeating panel report is the report equivalent to a form with a repeating panel. It contains a combination of 
database fields from joined databases. When you create this type of report, you select the databases and fields that 
appear on the report and define the summaries.

See also
Reports 



About modifying reports
You can modify reports in a number of ways to change their appearance and their arrangement of data.

Selecting a report panel        
A report can be composed of several different panels, including a body panel, a header, a footer, and one or more 
summary panels. 

Changing line or color settings for a report panel        
Each type of report panel has its own InfoBox that you can use for changing the appearance of the panel. The 
settings in the InfoBox apply to all panels of a type. 

Changing the alignment or position of a summary panel         
You can align a summary panel to the main body of a report and position the panel above or below its group of 
records.

Adding a header or footer        
Approach automatically adds a header and footer when you create a report. If you're working with a report that 
doesn't already contain a header or footer, you can easily add one. 

Adding a date, time, or page number to a report...  
You can add the date, time, or a page number to the header or footer of a report. Approach inserts the placeholder 
<<DATE>>, <<TIME>>, or <<#>>. 

Adding a title page        
A title page is a special first page that you can add to a report. It contains all of the information that appears on the 
rest of the report, as well as a unique header and footer. In Preview, the window's title bar displays "Title Page."

Changing the number of columns in a report        
Approach is preset to place fields in a single column that runs the length on each page. If it's appropriate for your 
report, you can increase the number of columns and reduce the number of pages. 

Keeping records together        
If your data spans more than one page in a standard report, you might want to keep records together and prevent 
them from starting on one page and ending on another. You might also want to keep the fields in a record together in 
one column if you have multiple columns on a page. 

Working with whole report columns        
Approach lets you work in Design with whole report columns or with individual fields. When you work with whole 
columns, you can move or resize both the column and its header at the same time. Otherwise, the column fields and 
the column header behave like separate objects that you can resize or move independently. 



Creating a standard or columnar report

A standard or columnar report contains field data only. When you create one, you give it a name and select a style 
and layout. You also select the fields that appear on the report.
1. Choose Report from the Create menu.
2. Type a name for the report in the Name text box.
3. Select a style for the report in the SmartMaster Style drop-down list.
4. Select Standard or Columnar in the SmartMaster Layout list. 

See the Details topic for descriptions of the layouts.
5. Click the Fields tab and add the fields you want to show in the report. 
6. Click Done.
7. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the report uses fields from more than one joined database. The first database you 
selected in the Fields panel is preselected as the main database.



Creating a report with summaries

A report with summaries can contain a combination of field data and summaries. When you create one, you select the
fields that appear on the report and define the summaries.
1. Choose Report from the Create menu.
2. Type a name for the report in the Name text box.
3. Select a style for the report in the SmartMaster Style drop-down list.
4. Select one of the summary report layouts in the SmartMaster Layout list. 

See the Details topic for descriptions of the layouts.
5. Click the Fields tab and add the fields you want to show in the report. 
6. Click the Summary tab and define the summary.
7. Click Done.
8. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the report uses fields from more than one joined database. The first database you 
selected in the Fields panel is preselected as the main database.

See also
About PowerClick reporting 



Creating a repeating panel report

A repeating panel report is the report equivalent to a form with a repeating panel. It contains a combination of 
database fields from joined databases. When you create this type of report, you select the databases and fields that 
appear on the report and define the summaries.
1. Choose Report from the Create menu.
2. Type a name for the report in the Name text box.
3. Select a style for the report in the SmartMaster Style drop-down list.
4. Select Repeating Panel Report in the SmartMaster Layout list. 

See the Details topic for descriptions of the layouts.
5. Click the Fields tab, select a database, and add the field you want to show in the main section of the report (the 

"one" side of the "one-to-many" relationship). 
6. Click the Repeating Fields tab, select a database, and add the fields you want for the repeating section of the 

report (the "many" side of a "one-to-many" relationship).
7. Click the Trailing Summary tab and define the summary.
8. Click Done.



Details: Creating a report

Report name
A new report automatically has the name Report and a number; you can edit this to any name you want up to 30 
characters. The name you use will appear on the report's view tab and as a default on printed reports.

Styles
A style gives a report a set of InfoBox properties, such as background color, text attributes, and specifications for field
borders and frames. You can apply a default style defined in Preferences or use one of the predefined SmartMaster 
styles.

SmartMaster layouts

This layout Displays
Standard Database fields you select in 

one continuous column, with 
each field in its own row

Columnar Database fields you select in 
columns, with each record in 
its own row

Leading 
Grouped 
Summary

A columnar report sorted and 
summarized by the field you 
select with the sort field in a 
leading summary panel and 
the summary in a trailing 
summary panel

Trailing 
Grouped 
Summary

A columnar report sorted and 
summarized by the field you 
select with the sort field and 
the summary in a trailing 
summary panel

Columnar with 
Grand 
Summary

A columnar report with a 
summary at the end

Summary Only Summaries of records 
grouped by the field you 
select, with a grand summary

Repeating 
Panel Report

Database fields from joined 
databases grouped and 
summarized by the field you 
select.

The new report can also be blank.

Adding fields to a report
To add a field to the Fields to Place on View list, select the field name in the Database Fields list and click Add, or 
double-click the name. If you want to add a field from a different joined database, select the database in the drop-
down list. Approach will display the fields in the report in the order the appear in the Assistant.

Defining a summary



To define a summary, first select the field you want to group records in the summary by. Next, select the calculation 
you want to use. Finally, select the field you want to calculate. 
Be sure to select different fields for grouping and calculating. For example, if you want to see a subtotal of amounts 
by product, select Product as the field to group by, Amount as the field to calculate, and SSum as the calculation.
If you want to group on or calculate a field from a different joined database, select the database in the drop-down list.



Selecting a report panel

A report can be composed of several different panels, including a body panel, a header, a footer, and one or more 
summary panels. 

Click a border of the panel, CONTROL-click anywhere in the panel, or click the panel label. 



Changing line or color settings for a report panel

Each type of report panel has its own InfoBox that you can use for changing the appearance of the panel. The 
settings in the InfoBox apply to all panels of a type. 
1. Select the panel in Design.
2. Click the Show Info icon to open the panel's InfoBox.

3. Click the Lines and Colors tab.
4. Set the options in the Lines and Colors panel.

See the Details topic for options.



Changing the alignment or location of a summary panel

You can align a summary panel to the main body of a report and position the panel above or below its group of 
records.
1. Select the summary panel in Design.
2. Click the Show Info icon to open the panel's InfoBox.

3. Click the Display tab.
4. Set the alignment and location options in the Display panel.



Details: Changing line or color settings for a report panel

To Do this
Change the 
width of 
borders in a
panel

Select a width in the 
Border Width drop-
down list.

Change the 
color of 
borders in a
panel

Select a color in the 
Border Color drop-
down palette. Select 
T for transparent.

Change the 
fill color of 
the interior 
of a panel

Select a color in the 
Fill Color drop-down 
palette. Select T for 
transparent.

Give the 
lines in a 
panel a 
raised or 
indented 
frame

Select a frame style 
in the Frame drop-
down list.

Show 
outside 
borders 
around a 
panel

Turn on options in the
Borders area.

Adding a header or footer

Approach automatically adds a header and footer when you create a report. If you're working with a report that 
doesn't already contain a header or footer, you can easily add one. 

Choose Insert Header or Insert Footer from the Report menu.



Adding a date, time, or page number to a report

You can add the date, time, or a page number to the header or footer of a report. Approach inserts the placeholder 
<<DATE>>, <<TIME>>, or <<#>>. 

Draw a text block and then, with the cursor still active in the text block, choose Date, Time, or Page# from 
the Report Insert submenu.



Adding a title page

A title page is a special first page that you can add to a report. It contains all of the information that appears on the 
rest of the report, as well as a unique header and footer. 

To add a title page:

Choose Add Title Page from the Report menu.

To remove a title page:

Choose Add Title Page from the Report menu again.

To view the title page of a report:

Choose Show Title Page from the Report menu.

To return to the standard page of your report:

Choose Show Title Page from the Report menu again.



Changing the number of columns in a report

If it's appropriate for your report, you can increase the number of columns and reduce the number of pages.
1. Click the Show Info icon to open the InfoBox for the report.

2. Click the Basics tab. 
3. Change the number in the Number of Columns text box.



Keeping records together

Keeping records together prevents them from being split across two pages or columns. 
1. Click the Show Info icon to open the InfoBox for the report.

2. Click the Basics tab. 
3. Turn on "Keep records together" in the Basics panel.



Working with whole report columns

When you work in Design with whole columns, you can move or resize both the column and its header at the same 
time. 

To turn on columns:

Choose Turn On Columns from the Report menu or click the Column Mode icon (if it appears in an icon bar).

To resize a column:

Click the column to select it and drag its right edge to a new position with the column sizer.

To move a column:

Click the column to select it and drag it to another position.



About summarizing data in a report
When you summarize data in a report, you can include subtotals, grand totals, and running totals, averages, counts, 
and many other types of calculations. You can summarize data from records in a single database or data from 
records in joined databases.

Adding a summary panel to a report        
You use the Summary dialog box to specify how you want records to be summarized, the location and alignment of 
the summary panel, and whether you want a page break after the summary panel. 

Moving or deleting a summary panel        
You can easily move a summary panel elsewhere on a report or delete it.

Adding a calculated field to a summary panel          
A summary calculated field in a summary panel can show a subtotal, total, average, count, or other summary on data.
You can define a new summary calculated field for each summary panel, or you can use a field that has already been
defined. 



Adding a summary panel to a report

You use the Summary dialog box to specify how you want records to be summarized, the location and alignment of 
the summary panel, and whether you want a page break after the summary panel. 
1. Choose Summary from the Create menu.
2. Select a summarize option. 

See the Details topic for options.
3. Specify an alignment for the summary panel. 
4. Specify a location for the summary panel.
5. To display one summary per page, turn on "Insert page break after each summary group."
6. Click OK.

See also
Adding a calculated field to a summary panel  



Details: Adding a summary panel to a report

Summarize options
The summarize option affects the way Approach sorts records and summarizes data in the summary panel. For 
example, if you define a summary panel that summarizes groups of records grouped by product, Approach sorts 
records by product -- even if you don't actually calculate a summary for the records. 

To insert a 
summary

Do this

After a 
specified 
number of 
records

Select "Every n records" 
and type the number of 
records you want 
summarized.

For an entire 
group of 
records

Select "All records."

After unique 
values in a 
sorted group 
of records

Select "Records grouped 
by" and select a field to use
when sorting for the 
summary. Select the 
database carefully to be 
sure you are sorting on the 
correct field in the 
database you want.

Summary panel alignment 
You can place the summary panel to the left of the report body, to the right of the report body, or centered above or 
below the report body.

Summary panel location
The Leading Location setting places the summary panel before its group of records. The Trailing Location setting 
places the summary after its group of records. 



Moving or deleting a summary panel

You can easily move a summary panel elsewhere on a report or delete it.

To move a summary panel:

CONTROL-click the panel and drag it into position. 

To delete a summary panel:

CONTROL-click the panel and press DELETE.



Adding a calculated field to a summary panel

A calculated field in a summary panel is calculated when you preview the report or when you view the report in 
Design with data showing.

If you're using a field that has already been defined, choose Add Field from the Panel menu and drag the 
field entirely within the borders of the summary panel.

If you're creating a new field, use the Field Definition dialog box to name the field, define the formula the 
field uses, and specify how the field summarizes records.

See also
Setting up a formula for a calculated field



About PowerClick reporting
PowerClick reporting lets you organize data and summarize it in reports with just a few clicks. 

Adding a grand total to a report        
You can add a grand summary to any columnar report. Approach places a summary panel at the end of the report 
and adds a calculated field that sums the values in the field you select. 

Grouping records and adding subtotals to a report        
You can group and subtotal records on any field that appears in a report with just a few clicks. Approach adds a 
calculated field, in either a leading or a trailing summary, that sums values in the field you select .



Adding a grand total to a report

You can add a grand summary to any columnar report. Approach places a summary panel at the end of the report 
and adds a calculated field that sums the values in the field you select. 
1. Use the Report Assistant to create a columnar report.
2. In Design, with Show Data turned on, click the column that contains the values you want to total.

3. Click the Sum, Count, or Average icon.

        

        

See also
Adding a calculated field to a summary panel
Adding a summary panel to a report
Creating a report



Grouping records and adding subtotals to a report

You can group and subtotal records on any field that appears in a report with just a few clicks. Approach adds a 
calculated field, in either a leading or a trailing summary, that sums values in the field you select .
1. Starting with a columnar report in Design with Show Data turned on, click the column you want to group on.

2. Click the Trailing Summary icon. 

3. Click the column that contains the values you want to summarize.
4. Click the Sum, Count, or Average icon.

        

        

5. To display the grouping field only once per group, click the column you first used for sorting and click the Leading
Summary icon.

6. Choose Turn on Columns from the Object menu to turn columns off.
7. Select the first group item and move it into the leading summary panel you just created.

See also
Adding a calculated field to a summary panel



Creating a standard or columnar report



Selecting a report panel



Changing line or color settings for a report panel



Adding a header or footer



Adding a title page



Changing the number of columns in a report



Keeping records together



Working with whole report columns



Adding a summary panel to a report 



Moving or deleting a summary panel



Adding a grand total to a report



Grouping records and adding subtotals to a report 



Adding a date, time, or page number to a report



Changing the alignment or location of a summary panel



Creating a report with summaries



Creating a repeating panel report



About crosstabs
An Approach crosstab allows you to categorize and summarize database records. Crosstab cells summarize 
underlying records grouped or categoized by any fields you select. You can create a simple crosstab that either 
counts or summarizes data for groups of records, or a multiple-level crosstab that summarizes data for different 
groups of records by categories.

Creating a crosstab        
The Crosstab Assistant lets you select the fields displayed in the crosstab rows, the fields displayed in the crosstab 
columns, the field summarized in the body of the crosstab, and the formula used to calculate body cells.

Turning a worksheet into a crosstab        
Because worksheets and crosstabs are so similar, you can easily convert a worksheet into a simple crosstab by 
dragging a worksheet field into a summarizing position in the row gutter at the left side of the worksheet. Approach 
displays counts for text fields and sums for numeric fields. Then, you can turn a simple crosstab into a multiple-level 
one by dragging other fields into grouping positions in the row gutter or in the column gutter at the top of the 
worksheet. 

Adding a summary column or row to a crosstab        
Approach lets you add special summary columns or rows to a crosstab. A summary row can use any formula you 
choose. A summary column uses the same formula as the other body cells in the crosstab. When you have nested 
fields in a crosstab, Approach adds a summary column or row to each group.

Editing a crosstab formula        
Approach uses a single summary formula to calculate summary columns and the body cells in a crosstab. In addition,
Approach can use a different summary formula to calculate summary rows. If you want to perform a different set of 
calculations, either for all body cells and summary columns or for a summary row, you can change the formula at any 
time.

Working with crosstabs        
You can work with crosstabs in much the same way as with worksheets -- by adding database fields, moving 
columns, removing columns, resizing columns or rows, editing and formatting column header text, or adding 
background color to columns or rows. When you assign color to a column or row header, all columns or rows nested 
within that column or row also take the new color.

See also
Worksheets and crosstabs 



Creating a crosstab

The Crosstab Assistant lets you select fields for the crosstab columns and rows, and define the summary that 
appears in the body of the crosstab.
1. Choose Crosstab from the Create menu.
2. Select a different main database if necessary.
3. Add the fields you want to show as crosstab rows to the Fields to Place on View list.
4. Click the Columns tab and add the fields you want to show as crosstab columns to the Fields to Place on View 

list. 
Add the fields in the order you want them nested, with the first field at the highest level.

5. Click the Values tab.
6. Select a formula in the Calculate list and a field in the Of Field list.
7. Click Done.
8. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the crosstab uses fields from more than one joined database. The first database you 
selected in the Fields panel is preselected as the main database.



Details: Creating a crosstab

Summary columns and rows in crosstabs
In addition to columns and rows for the fields that you select in the Crosstab Assistant, Approach adds a summary 
row at the bottom of the crosstab, summary subtotals for each group of columns, and a summary total column at the 
far right. You can remove these summaries if you don't want them.

Nesting fields in a crosstab
When you select more than one field for either columns or rows, Approach nests the fields in the order you list them, 
with the first field listed at the highest or outermost level. For example, if you list Country first and then City, Approach 
groups the cities within the countries.

Simple crosstabs
If you want to create a simple crosstab (one without any categories), select a field for rows and one for body cell 
values, but don't select a field for columns. Approach creates a simple crosstab with counts if the Value field is text 
and summaries if the Value field is numeric.
When you create a simple crosstab, you can drag fields from the Add Field dialog box to create additional columns or 
to convert the simple crosstab into a multiple-level crosstab.

Adding and removing fields
To add a field to the Fields to Place on View list, select the field in the Database Fields list and click Add. You can also
double-click a field to add it. Approach nests the fields in the order listed, with the first field at the highest level. 
To remove a field in the Fields to Place on View list, select the field and click Remove.

Crosstab formula 
This is the formula Approach will use to calculate the values that appear in body cells. The same formula applies to all
crosstab cells except for extra summary rows that you add.



Adding a summary column or row to a crosstab

A summary row can use any formula you choose. A summary column uses the same formula as the other body cells 
in the crosstab. 

To add a summary column or row using SmartIcons:

Click the Add Row icon (to add a summary row) or the Add Column icon (to add a summary column).

        

To add a summary column or row to a crosstab using the wedge tool:
1. Position the pointer at the right edge of a column group or at the bottom of a row group.
2. When the pointer turns into the wedge tool, click.

To add a summary column or row to a crosstab using Crosstab commands:

Choose Summarize Columns (to add a summary row) or Summarize Rows (to add a summary column) from
the Crosstab menu.

To remove a summary from a crosstab:

Select the column or row and press DELETE.

See also
Editing a crosstab formula



Editing a crosstab formula

You can use the InfoBox to edit the formulas that Approach uses to calculate summary rows or summary columns 
and body cells.
1. Select a a value header or the header for a summary row that contains the formula you want to change.
2. Click the Show Info icon to open the InfoBox for the worksheet.

3. Click the Formula tab.
4. Select a formula in the Formula list in the Formula panel. 



Working with crosstabs

You can work with crosstabs by adding a database field, moving or removing columns, resizing columns or rows, 
editing and formatting column header text, or adding background color to columns or rows. 

To open the InfoBox for the current crosstab:

Click the Show Info icon.

To open the InfoBox for a column or row:

Click the column or row header to select the column and click the Show Info icon.

See also
Adding a database field to a worksheet or crosstab 
Changing line or color settings for an object
Dividing a worksheet or crosstab into panes 
Editing worksheet or crosstab column header text
Moving worksheet or crosstab columns
Navigating in a worksheet or crosstab 
Removing a database field from a worksheet or crosstab 
Resizing worksheet or crosstab columns and rows



Turning a worksheet into a crosstab

You can convert a worksheet into a simple crosstab, or a simple crosstab into a multiple-level one, by dragging 
worksheet fields into summarizing positions in the row or column gutters. 

To turn a worksheet into a simple crosstab:

Drag a field from the column gutter at the top of the worksheet or from the Add Field dialog box to the row 
gutter on the left side of the worksheet.

To turn a simple crosstab into a multiple-level one

Drag a field from the Add Field dialog box or from the column or row gutter to a grouping position (in the row 
gutter or the column gutter).



Creating a crosstab



Adding summaries to a crosstab



Editing a crosstab formula



Working with crosstabs



Turning a worksheet into a crosstab



About worksheets
An Approach worksheet is composed of columns that show database fields and rows that show individual records.

Creating a worksheet        
Using the Worksheet Assistant, you select the fields that will initially appear on a worksheet. You can easily add or 
remove fields after the worksheet has been created.

Selecting in a worksheet or crosstab        
You can select individual cells, a range of cells, one or more contiguous columns, one or more contiguous rows, or 
one or more column headers. You can also select all column headers and row markers or the entire worksheet. 

Copying a selection to the Clipboard        
Once you've selected all or part of a worksheet or crosstab, you can copy the selection to the Clipboard for pasting, 
linking, or embedding in a document created by another application. 

Navigating in a worksheet or crosstab        
When you select a range of cells in a worksheet or crosstab, you can use either the TAB key or the ENTER key to 
move from one cell to the next.

Dividing a worksheet or crosstab into panes        
If a worksheet or crosstab contains a great deal of data, you might not be able to see all of the columns or rows on 
the screen at the same time. When data you want to view is out of sight, you can divide a worksheet or crosstab 
horizontally or vertically into independently scrolling panes. 

Formatting a worksheet or crosstab for printing        
When you print a worksheet or a crosstab, you can print the view title in a header, the page number (in the lower-right
corner), and the current date (in the lower-left corner).

See also
Worksheets and crosstabs 



Creating a worksheet

Using the Worksheet Assistant, you select the fields that will initially appear on a worksheet.
1. Choose Worksheet from the Create menu.
2. Select a different main database if necessary.
3. Add the fields you want to show on the worksheet to the Fields to Place on View list.
4. Click Done.
5. If the Define Main Database dialog box appears, select the database you want to be the main database for the 

report and click OK.
This dialog box appears if the worksheet uses fields from more than one joined database. The first database you 
selected in the Fields panel is preselected as the main database.



Details: Creating a worksheet

Adding or removing fields
To add fields to the Fields to Place on View list, select the fields in the Database Fields list and click Add. You can 
also double-click a field to add it. Approach displays the fields in the order listed.
To remove a field in the Fields to Place on View list, select the field and click Remove.



Selecting in a worksheet or crosstab

In an Approach worksheet or crosstab, you can select individual cells, columns, rows, or column headers; a range of 
cells; or contiguous columns, rows, or column headers. 

To select Do this
A single cell Click in the cell. Double-

click to select the text in
the cell for editing.

A range of 
cells

Click in a cell and drag 
in any direction.

A column Click the column 
header. Drag to select 
multiple columns.

Just the 
column 
header

Select the column and 
click the Column 
Header icon.

The column
header text 
for editing

Triple-click the column 
header.

Just the 
column 
cells (and 
not the 
column 
header)

Click the column header
to select the column 
and click the Column 
icon. 

A 
worksheet 
row

Click to the left of the 
row.

A crosstab 
row

Click the row header.

The entire 
worksheet 
or crosstab

Click in the upper-left 
corner of the worksheet 
or crosstab.

All of the 
worksheet 
column 
headers 
and all rows
(but not the 
data)

Click the upper-left 
corner of the worksheet 
a second time.



Copying a selection to the Clipboard

Once you've selected all or part of a worksheet or crosstab, you can copy the selection to the Clipboard for pasting, 
linking, or embedding in a document created by another application. 

To copy a selection to the Clipboard:

Select the portion of the worksheet or crosstab you want to copy and choose Copy from the Edit menu.

See also
Creating an Approach OLE object from another application
Creating an Approach OLE object in Approach



Details: Copying a selection to the Clipboard

When you select an entire worksheet or crosstab, Approach places it on the Clipboard as an object that you can 
embed, as a Windows Metafile format (WMF) object that you can paste as a graphic, and as tab-delimited text (to 
paste into a spreadsheet, for example).
When you select a range of cells in a worksheet or crosstab, Approach places the range on the Clipboard as a 
pastable WMF object and as tab-delimited text.



Navigating in a worksheet or crosstab

When you select a range of cells in a worksheet or crosstab, you can use either the TAB key or the ENTER key to 
move from one cell to the next.

To move from left to right in a row before wrapping around to the next row:

Press TAB.

To move down in a column before wrapping around to the next column:

Press ENTER.



Dividing a worksheet or crosstab into panes

If a worksheet or crosstab doesn't fit on the screen, you can divide it horizontally or vertically into independently 
scrolling panes. 

To divide a worksheet or crosstab into panes:

Drag the divider boxes (in the upper-right and lower-left corners) to the location you want. 

To adjust the position of the pane divider bars:

Drag the divider bars to a new position. 
You can adjust both divider bars at the same time by dragging the point where they intersect.



Formatting a worksheet or crosstab for printing

When you print a worksheet or a crosstab, you can print the view title, the page number, and the current date.
1. Open the InfoBox for the worksheet or crosstab.

2. Click the Printing tab.
3. Change the settings as necessary.



About changing the appearance of a worksheet or crosstab
Approach gives you many different ways to change the appearance of a worksheet or crosstab without affecting the 
data that's displayed. You can work in Browse to alter the appearance of a worksheet or crosstab. However, if there's 
a password associated with the Approach file, you must work in Design to change the worksheet or crosstab.

Adding a database field to a worksheet or crosstab        
When you first create a worksheet or crosstab, Approach displays the fields you select in the Worksheet or Crosstab 
Assistant. If you want to display additional fields, you can add them from the Add Field dialog box. 

Removing a field from a worksheet or crosstab        
If you no longer want to see a particular database field displayed on a worksheet or crosstab, you can easily remove 
it from the view. 

Moving worksheet or crosstab columns        
When you create a worksheet or crosstab, Approach arranges fields in the order you list them in the Assistant. You 
can easily move a column from one location to another without affecting your data. 

Resizing worksheet or crosstab columns and rows        
Approach initially sizes worksheet or crosstab columns so that they are just large enough to display the field data. 
Rows are also just large enough to display their data. You can resize columns or rows to improve the appearance of 
your worksheet or crosstab or to show additional information. You can resize a single column or change multiple 
columns to the same size.

Inserting a blank or formula column in a worksheet        
In addition to columns that display data from database fields, you can add a blank column to a worksheet and use it 
for spacing or to display the results of a formula. You might, for example, add a column that summarizes data, one 
that averages data, or one that shows the variance between two columns of data. 

Changing worksheet or crosstab settings        
You can use the InfoBox to change the name of a worksheet or crosstab, attach a macro or custom menu, add colors
and borders to headers and cells, and change the appearance of text.

Editing column header text        
Approach is preset to use field names as column headers in worksheets and crosstabs. You can change the header 
text to be anything you want.



Adding a database field to a worksheet or crosstab

If you want to display additional fields to a worksheet or crosstab, you can add them from the Add Field dialog box. 
1. Click the Add Field icon or choose Add Field from the Worksheet or Crosstab menu.

2. Drag a field from the Add Field dialog box to the worksheet column gutter or to a grouping position on the 
crosstab.

3. Release the field name where you want the field to appear. 
A dark vertical placement line shows where the field will be located.



Removing a database field from a worksheet or crosstab

If you no longer want to see a particular database field displayed on a worksheet or crosstab, you can easily remove 
it from the view. 

Click the column header to select the column, and drag the header above the column gutter until the pointer 
changes to the delete tool (it looks like the header is going into a trashcan).

This removes the entire column.



Moving worksheet or crosstab columns

You can move one or more columns from one location to another without affecting your data. Approach moves 
multiple selected columns as a block.
1. Select one or more columns.
2. Drag the columns to the position you want, using the vertical guide to position the columns correctly.

The vertical guide shows where the column will be placed when you release it.



Resizing worksheet or crosstab columns and rows

You can easily resize columns or rows to improve the appearance of your worksheet or crosstab, or to show 
additional information. If you select more than one column, Approach will make them all the same size.

To resize columns:
1. Select the columns you want to resize.
2. Place the pointer between column headers to the right of the column you want to resize, and when the pointer 

becomes a column sizer, drag the column to the size you want.

To resize a row:

Place the pointer in the row gutter at the bottom border of a row, and when the pointer becomes a row sizer, 
drag the row to the size you want.



Inserting a blank or formula column in a worksheet

You can add a blank column to a worksheet and use it for spacing or to display the results of a formula. 

To add a formula column to a worksheet:
1. Position the pointer between the tops of column headers where you want the blank column to appear, and click 

when the pointer changes to a wedge.

2. In the Formula dialog box, define the formula and click OK.
You can use any of the Approach functions or define your own formula.

To add a blank column to a worksheet:
1. Position the pointer between the tops of column headers where you want the blank column to appear, and click 

when the pointer changes to a wedge.

2. Click Cancel in the Formula dialog box.

See also
Setting up a formula for a calculated field



Changing worksheet settings

You can use the InfoBox to change the name of a worksheet or crosstab, attach a macro or custom menu, add colors
and borders to headers and cells, and change the appearance of text.

To open the InfoBox for the current worksheet:

Click the Show Info icon.

To open the InfoBox for a column:

Click the column header to select the column and click the Show Info icon.

See also
Changing line or color settings for an object
Formatting a worksheet for printing



Editing column header text

Approach is preset to use field names as column headers in worksheets and crosstabs. You can change the column 
header text to be anything you want.
1. Triple-click the column header, or select the column and choose Edit Column Label from the Worksheet or 

Crosstab menu.
2. Edit the text.



Creating a worksheet



Selecting in a worksheet or crosstab



Copying a selection to the Clipboard



Navigating in a worksheet or crosstab



Dividing a worksheet or crosstab into panes



Formatting a worksheet or crosstab for printing



Adding a database field to a worksheet or crosstab 



Removing a database field from a worksheet or crosstab 



Moving worksheet or crosstab columns



Resizing worksheet or crosstab columns and rows



Inserting a blank or formula column in a worksheet



Changing worksheet settings



Editing column header text



About macros
You can use Approach macros to perform many different types of tasks, from finding a set of records to fully 
automating your data entry or invoicing process. Your only limit is your imagination.

Defining a macro        
You define a macro using the Define Macro dialog box, in which you list the tasks you want the macro to do in the 
order you want them performed. Depending on the commands, you can also set appropriate options. For example, if 
a macro definition includes the Find command, you can specify the search criteria. 

Adding and removing commands in a macro        
If you need to add or remove commands in a macro, you can use the Insert and Delete buttons to add a new row in 
the middle of the Command grid or to remove a selected row. 

Moving a command in a macro        
If you need to change the order of the commands you've listed in a macro, you can easily drag a command to a new 
location.

Editing a macro        
After you define a macro, you can edit it to change any aspect of the macro, including the macro name and the 
commands it contains. You edit a macro definition the same way you create it, using the Macros and Define Macro 
dialog boxes.

Deleting a macro        
You can use the Macros dialog box to delete a macro you no longer need. If the macro is attached to a macro button, 
the button no longer does anything. You may want to delete the button or attach another macro to it.

Running a macro        
Approach gives you many ways to run a macro (depending on the macro definition): from a function key, from a menu
command, from the Macros dialog box, or from a button (or other object). If a macro is attached to a field or a view, 
Approach automatically runs the macro at an appropriate time.

Saving a find request as part of a macro        
Approach lets you save the current find request as part of the definition of a macro.



Defining a macro

In the Define Macro dialog box, you list the tasks you want the macro to do in the order you want them performed. 
You can also set appropriate options for the commands you select.
1. Choose Macros from the Tools menu.
2. Click New.
3. Type a name for the macro in the Macro Name box. 
4. If you want to execute the macro using a function key, select a key in the Function Key drop-down list.
5. Define the actions you want the macro to perform by adding commands to the Command grid and specifying the 

appropriate options.
6. When your macro definition is complete, click OK.
7. To display the new macro in the Run Macro menu, select the macro name and click "Show in menu" in the 

Macros dialog box.
8. Click Done to close the Macros dialog box.

See also
About macro commands



Details: Defining a macro

Macros and function keys
Defining a function key allows you to run the macro directly from the keyboard. Therefore, the drop-down list shows 
only the function keys you haven't already used. Leave the Function Key list set to None if you don't want to use a 
function key.

Adding commands to the Command grid
To add a command, click in any cell in the Command grid and click the down arrow to display a list of available 
commands. Click a command to select it.
Each time you add a command, Approach displays the options for that command in the bottom half of the Define 
Macro dialog box and adds a blank line at the end of the Command grid. To add another command, click in the next 
blank Command cell and select a command. 
Be sure to list commands in the order you want them carried out. For example, if you want Approach to go to the next
record before printing, make sure that Records appears before Print in the Command grid.
You can click the Insert button to add a line within the Command grid, or select a command line and click Delete to 
delete it.



Adding and removing commands in a macro

If you need to add or remove commands in a macro, you can use the Insert and Delete buttons to add a new row in 
the middle of the Command grid or to remove a selected row. 

To add a command row to a macro:

Select the row where you want the new command to be inserted (click to the left of the command to select 
the row) and click Insert.

To remove a command row from a macro:

Select the command row (click to the left of the command) and click Delete.



Moving a command in a macro

If you need to change the order of the commands you've listed in a macro, you can easily drag a command to a new 
location.
1. Select the row that holds the command you want to move.
2. Position the pointer over the selected command.
3. When the pointer changes to a move cursor, drag the command to the new position.



Editing a macro

After you define a macro, you can edit it to change any aspect of the macro, including the macro name and the 
commands it contains.
1. Choose Macros from the Tools menu.
2. Select the macro you want to edit and click Edit.
3. Make your changes.
4. Click OK to close the Define Macro dialog box.
5. Click Done.



Deleting a macro

You can use the Macros dialog box to delete a macro you no longer need. If the macro is attached to a macro button, 
the button no longer does anything. You may want to delete the button or attach another macro to it.
1. Choose Macros from the Tools menu.
2. Select the macro you want to delete and click Delete.
3. Click Done.



Running a macro

Approach gives you many ways to run a macro (depending on the macro definition): from a function key, from a menu
command, from the Macros dialog box, or from a button (or other object). If a macro is attached to a field or a view, 
Approach automatically runs the macro at an appropriate time.

To run a macro from the menu:

Choose Run Macro from the Tools menu and choose the macro you want from the submenu.
If you have more macros than fit in the submenu, choose More Macros. Approach opens a dialog box that lists 
your macros.

To run a macro using an assigned function key:

Press the function key.

To run a macro that's attached to a button or other object:

Click the button or object.

To run a macro that's attached to a field:

Tab to or from the field or change data in the field.

To run a macro that's attached to a view:

Switch to or from the view.

To run any macro:

Choose Macros from the Tools menu, select the macro in the Macros dialog box, and click Run.



About attaching macros
Approach lets you attach a macro to a macro button or to an object (text or graphic) so that you can run the macro 
simply by clicking the button or object. 

Attaching a macro to a macro button or an object        
You can attach a macro to an Approach macro button or to any other object so that clicking the button or object 
triggers the macro. 

Creating a button and defining a macro        
You can create a button and define the macro it triggers at the same time. Approach creates the macro and adds it to 
the list of available macros. 

Attaching a macro to a field        
You can attach a macro to a field in a view so that tabbing into or out of the field or changing the data in the field 
triggers the macro. 

Attaching a macro to a view        
You can attach a macro to a view so that switching to or from the view triggers the macro.



Attaching a macro to a macro button or an object

You can attach a macro to an Approach macro button or to any other object so that clicking the button or object 
triggers the macro. 
1. In Design, select the button or object and click the Show Info icon to open the InfoBox.

2. Click the Macros tab.
3. Select a macro name in a list in the Attached Macros area.

See also
Adding a macro button



Details: Attaching a macro to a button or an object

To attach a macro
that runs

Select a macro 
name in

When you tab to 
the button

On tab into

When you tab out 
of the button

On tab out of

When you click the 
button

On clicked

If you include a macro button in a view's data entry order, you can have a macro activated when you tab into the 
button or out of it. In Design, use the Show Data Entry Order command in the View menu to view or change the order
for fields and buttons on a view. 

See also
Changing the data entry order for fields 



Creating a button and defining a macro

You can create a button and define the macro it triggers at the same time. Approach creates the macro and adds it to 
the list of available macros. 
1. In Design, click the Button icon and draw a button.

2. Click the Show Info icon to open the InfoBox.

3. Click the Macros tab in the InfoBox.
4. Click Define Macro and use the Macros and Define Macro dialog boxes to name and define the macro.
5. Click the Basics tab in the InfoBox, type a label for the buttons, and change its appearance if you want.



Attaching a macro to a field

You can attach a macro to a field in a view so that tabbing into or out of the field or changing the data in the field 
triggers the macro. 
1. In Design, select the field and click the Show Info icon to open the InfoBox.

2. Click the Macros tab.
3. Select the macros you want to run.
4. If you want to define a new macro, click Define Macro and use the Define Macro dialog box to name and define 

the macro.



Details: Attaching a macro to a field

To attach a macro 
that runs

Select a macro
name in

When you tab or 
click into the field

On tab into

When you tab out 
of the field or click 
in another field

On tab out of

When the value in 
the field changes

On data change



Attaching a macro to a view

You can attach a macro to a view so that switching to or from the view triggers the macro.
1. In Design, click in the background of the view and click the Show Info icon to open the InfoBox.

2. To attach a macro that runs when you switch to the view, select a macro name in the "On switch to" list.
3. To attach a macro that runs when you switch to another view, select a macro name in the "On switch out" list.
4. If you want to define a new macro, click Define Macro and use the Define Macro dialog box to name and define 

the macro.



About sample macros
A good way to learn about macros (and to get ideas for ways to use them) is to look at some sample macros.

Creating a looping macro        
You can create a macro that loops through all the records in a found set and either ends when it encounters the last 
record in the found set or continues running. Looping macros use the Records command to go to the next record and 
the Run command to repeat the same macro. 

Switching to another view with a macro        
You can create a macro that simply takes you from the starting view to another view in the same Approach file. You 
might use a macro like this any time you need to switch from one view to another.

Finding a set of records with a macro        
Approach gives you several ways to find a set of records using a macro. You can restore an existing find (one that 
was in effect when you created the macro), edit an existing find request, create a new find request, or create a macro 
that goes to a blank find request and waits for you to supply the criteria while the macro is running. You can also use 
the Find command to show all records or to refresh the database.

Saving a find request as part of a macro        
Approach lets you save a find request in a macro.

Setting a value in a field with a macro        
You can create a macro that changes the value in a field for all records in a database file, automatically going from 
one macro to the next and repeating itself until all records are updated. The macro stops running when it reaches the 
last record in the database file. A macro that repeats itself is called a macro loop. In order to have a macro run itself, 
you must first create the macro and then edit it to include the self-repeating element.

Using an If calculation in a macro        
You can create a macro that has a conditional formula so that it performs other tasks only if the condition is met. You 
define the condition by defining a formula in the Formula dialog box.

Defining a conditional macro        
You can create a conditional macro to verify that a certain condition exists in the current record before it either 
continues with the current macro or runs a second macro. If the condition is not met, you can instruct Approach to run
a second macro instead of continuing with the current one. You set up a conditional macro using the Run command, 
and you define the condition by selecting a field and typing a value or defining a formula. 



Creating a looping macro

You can create a macro that loops through all the records in a found set and either ends when it encounters the last 
record in the found set or continues running. 

To create a looping macro that ends when it reaches the last record:
1. Choose Macros from the Tools menu.
2. Click New.
3. Type a name for the macro and assign a function key if you want.
4. Add commands to the macro to be performed within the loop.
5. In the Command grid, make Records the first command in the list and use the Next Record setting.
6. In the Command grid, add Run to the list and select the current macro.
7. Click OK to save the new macro and click Done in the Macros dialog box.

To create a looping macro that continues to run after it reaches the last record:
1. Choose Macros from the Tools menu.
2. Click New.
3. Type a name for the macro and assign a function key if you want.
4. In the Command grid, make Records the first command and use the next record.
5. Select the Run command, click If, and type IsLastRecord() in the If formula box.
6. Select "run macro" in the Is True drop-down list and select the macro to be run when the last record is 

encountered in the drop-down list to the right.
7. In the Command grid, add Run to the list and select the current macro.
8. Click OK to save the new macro and click Done in the Macros dialog box.



Switching to another view with a macro

You can create a macro that simply takes you from the starting view to another view in the same Approach file. You 
might use a macro like this any time you need to switch from one view to another.
1. Choose Macros from the Tools menu.
2. Click New.
3. Type a name for the macro and assign a function key if you want.
4. In the Options area, click "Switch the current view to" and select a view in the View list.
5. Click OK to create the macro.
6. Click Done to close the Macros dialog box.



Finding a set of records with a macro

Approach gives you several different ways to find a set of records using a macro. See the Details topic for a list of the
ways.
1. Choose Macros from the Tools menu.
2. Click New.
3. Type a name for the macro and assign a function key if you want.
4. In the Command grid, select Find in the list of commands.
5. In the Options area, select "Perform stored find when macro is run" and click New Find.
6. Complete the find request and click Done.
7. Click OK to create the macro.
8. Click Done to close the Macros dialog box.



Saving a find request as part of a macro

Approach lets you save a find request in a macro.
1. Choose Macros from the Tools menu.
2. Click New.
3. Type a name for the macro and assign a function key if you want.
4. In the Command grid, select Find in the list of commands.
5. In the Options area, select "Perform stored find when macro is run."
6. Click OK to create the macro.
7. Click Done to close the Macros dialog box.



Details: Finding a set of records with a macro

To Select
Edit an existing find 
request for the macro

"Perform stored Find 
when macro is run" 
and click Edit Find

Go to a blank find 
request while the 
macro runs and wait 
for criteria to be 
entered

Go to Find and wait 
for input

Go to a partially filled
in find request while 
the macro runs and 
wait for additional 
criteria to be entered

Find Again and wait 
for input

Show all records in 
the database

Show All records

Update the database 
with regard to the 
found set

Refresh the found set



Setting a value in a field with a macro

You can create a macro that changes the value in a field for all records in a database file, automatically going from 
one macro to the next and repeating itself until all records are updated. 
1. Choose Macros from the Tools menu.
2. Click New.
3. Type a name for the macro and assign a function key if you want.
4. In the Command grid, make Set the first command in the list, select a field, and type a value in the To this Value 

box.
5. In the Command grid, add Records to the list and click Next Record.
6. In the Command grid, add Run to the list and select the current macro.
7. Click OK to save the new macro and click Done in the Macros dialog box.



Using an If calculation in a macro

You can create a macro that has a conditional formula so that it performs other tasks only if the condition is met. You 
define the condition with a formula.
1. Choose Macros from the Tools menu.
2. Click New.
3. Type a name for the macro and assign a function key if you want.
4. In the Command grid, make the command you want to perform the first command in the list, select a field, click 

Formula, and type a value in the formula box.
5. Click OK to save the new macro and click Done in the Macros dialog box. 

To loop through all the records in the database, add these steps to the macro:
1. In the Command grid, add Records to the list and click Next Record.
2. In the Command grid, add Run to the list and select the current macro to continue running it until you reach the 

last record in the found set.



Defining a conditional macro

You can create a conditional macro to verify that a certain condition exists in the current record before either 
continuing with the current macro or running a second macro. 
1. Choose Macros from the Tools menu.
2. Click New.
3. Type a name for the macro and assign a function key if you want.
4. In the Command grid, make Run the first command in the list of commands. In the Run a Macro area, click If, 

click Formula, and type the formula in the Formula dialog box.
5. To specify the action to take when the condition is true, select "continue this macro" in the Is True drop-down list.
6. To run a different macro when the condition is false, turn on "else," select "run macro" in the Else drop-down list, 

and select the macro you want to run.
7. Add the other actions you want Approach to perform if the condition is true.
8. In the Command grid, add Records to the list and click Next Record.
9. In the Command grid, add Run to the list and select the current macro.
10. Click OK to save the new macro and click Done in the Macros dialog box. 



Details: Defining a conditional macro

The Is True drop-down list specifies the action Approach takes when the condition is true. The Else drop-down list 
specifies the action Approach takes when the condition is false.

To Select
Run a different 
macro

Run macro

Run a different 
macro and return to 
the current macro

Run & return 
from macro

Continue running 
the current macro

Continue this 
macro

End the macro End this macro
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Creating a button and defining a macro
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Running a macro
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Setting a value in a field with a macro



Using an IF calculation in a macro



Defining a conditional macro



About macro commands

There are 27 commands that you can include in an Approach macro, many of which have options you can set. The 
options affect the way Approach carries out the command. 
These are the commands you can select and the options you can set:

Use this 
command

To

Browse Go to Browse.
Close Close the current 

Approach file. You 
can set Approach to 
automatically 
disconnect from the 
server while the 
macro runs.

Delete Delete the current 
record, found set, or 
Approach file. The 
"Show warning" 
option opens alert 
boxes that need to 
be OK'd while the 
macro runs. 

Dial Dial the telephone 
number in the field 
you select. Approach
uses the modem 
settings you specify 
in dialer preferences.
See Setting dialing 
preferences. 

Edit Use these 
commands from the 
Edit menu: Cut, 
Copy, Paste, or 
Select All. You can 
also have the macro 
open the Paste 
Special dialog box 
and wait for input 
while the macro 
runs. The Edit 
command is used 
mostly for putting 
data on the 
Clipboard or pasting 
it.

Enter Accept the current 
record (this is the 



same as pressing 
the ENTER key or 
clicking the Enter 
icon).

Exit Exit Approach.
Export Set export options 

now (click Edit 
Export to select the 
records and fields to 
be exported as well 
as the filename) or 
set Approach to 
open the Export 
Data dialog box and 
wait for input while 
the macro runs. See 
Exporting data from 
Approach.

Find Perform a stored find
request, show all 
records in the 
database file, or 
refresh the found 
set. You can also set
Approach to open a 
find request or the 
Find Again dialog 
box and wait for 
input while the 
macro runs. The 
stored find request 
can be one that you 
define now (click 
New Find) or one 
that has already 
been defined. You 
can also edit a 
stored find by 
clicking Edit Find. If 
no records are 
found, you can 
select another macro
for Approach to run. 
See Finding a set of 
records with a macro
and Creating a find 
request.

Find 
Special

Set Find Special 
options now (click 
Edit Find Special) or 
set Approach to 
open the Find 
Special dialog box 
and wait for input 
while the macro 
runs. See Finding 
duplicate values and
Finding unique 



values.
Import Set import options 

now or set Approach
to open the Import 
Data dialog box and 
wait for input while 
the macro runs. You 
can set up a new 
import (click New 
Import) or edit an 
existing import set 
up (click Edit 
Import). See 
Importing a 
database file.

Mail Set mailing options 
now (click Edit Send 
Mail) or set 
Approach to open 
the Send Mail dialog 
box and wait for 
input while the 
macro runs. See 
Sending e-mail from 
Approach.

Menu 
Switch

Switch to the menu 
bar you specify. You 
can also create a 
custom menu now 
(click Customize 
Menus). See 
Customizing menus.

Message Display a message 
box that contains the
title and the text you 
enter. 

Open Set file-opening 
options now (click 
Files) or set 
Approach to open 
the File Open dialog 
box and wait for 
input while the 
macro runs. The file 
can be another 
Approach file, a 
different database 
file, or another 
application, such as 
Lotus 1-2-3. You 
could even open a 
communication 
application that uses
a script to upload 
your data to another 
computer. See 
Opening an 
Approach file.



Preview Go to Preview.
Print Set printing options 

now (click Edit Print) 
or set Approach to 
open the Print dialog
box and wait for 
input while the 
macro runs. See 
Printing a view.

Records Go to a record, hide 
a record, duplicate a 
record, or create a 
new record.

Replicate Set replication 
options now (click 
Edit Replicate) or set
Approach to open 
the Replicate Notes 
Database dialog box
and wait for input 
while the macro 
runs. See 
Replicating a new 
Notes database.    

Run Run another macro 
you select (or 
continue running the 
current macro) under
the conditions you 
specify in a formula 
(click Define 
Formula). You can 
also select a macro 
to be run when the 
condition is false and
can return to the 
current macro after 
running that macro. 
See Defining a 
conditional macro.

Save Set file-saving 
options now (click 
Files) or set 
Approach to open 
the Save As dialog 
box and wait for 
input while the 
macro runs. See 
Saving a copy of an 
Approach file and a 
database file.

Set Set the field you 
specify to the value 
you enter or the 
formula you define 
(click the Formula 
button). You can use



Set for any 
uncalculated field. 
See Setting up a 
formula for a 
calculated field.

Sort Set sort criteria now 
or set Approach to 
open the Sort dialog 
box and wait for 
input while the 
macro runs. See 
Specifying a sort 
order.

Spell 
check

Check the spelling of
data in records and 
text in memo fields 
(in Browse) or text in
text objects (in 
Design). See 
Running the spelling 
checker.

Tab Tab forward or 
backward the 
number of times you 
specify. Use the 
Show Data Entry 
Order command in 
Design to view or 
change the data 
entry order for fields 
and buttons in a 
form. See Changing 
the data entry order 
for fields.

View Go to another view 
in the Approach file, 
show a view, or hide 
a view.

Zoom Scale the current 
window by zooming 
in or out.



About moving to another record
When entering and editing data, you work with one record at a time (the current record). In a form or form letter, the 
current record is the one showing; in a report or mailing label, the current record is the one with a solid border; in a 
worksheet, the current record is the line with the active field.
You can use commands to move through the records of a found set, in their current order in the Approach file. In a 
report, mailing label, or worksheet, you can also click in a visible record to move to it or tab to the next record from 
the last field of the current one.
If you have a field selected before you move to another record, the same field is selected in the other record.

Moving one record at a time        
You can move forward or backward through a view one record at a time.

Moving to the first or last record        
You can also move quickly to the first record or the last record in the current order of records.

Moving to a specific record         
Each record has a number in the current order of records in an Approach file (from front to back). If you know the 
number of the record you want to go to, you can give Approach the number to move directly to that record. This is 
especially helpful in a large database.

See also
Setting a default order for records 



Moving one record at a time

You can move forward or backward through a view one record at a time.

To move forward one record:

Click the Next Record icon, click the right arrow in the status bar, or press PAGE DOWN. 
You can hold down the mouse button on the Next Record icon to "fast forward" through the records.

To move backward one record:

Click the Previous Record icon, click the left arrow in the status bar, or press PAGE UP. 
You can hold down the mouse button on the Previous Record icon to "rewind" through the records.



Moving to the first or last record

You can move quickly to the first record or the last record in the current order of records.

To move to the first record in the current order of records:

Click the First Record icon or press CONTROL-HOME.

To move to the last record in the current order of records:

Click the Last Record icon or press CONTROL-END.



Moving to a specific record

Each record has a number in the current order of records in an Approach file. If you know the number of the record 
you want to go to, you can give Approach the number to move directly to that record.
1. Click the record number in the status bar.
2. Type the number of the record you want to move to.
3. Click OK.



About adding, deleting, and hiding records
You can put another record in a database by either adding a new record or making a duplicate of an existing one. If 
you have set a default order for the records, after you add data to a new record the record is placed in its proper 
position in the order. If you have not set an order for the records, a new record remains at the end of the database.
You can delete individual records or a set of records from a database. The records are permanently removed from the
database, not just from the Approach file youre browsing. Deleting records also removes them from other Approach 
files that use the database.
You can also hide records from view to make them unavailable. This does not delete the records from the database, 
but just temporarily hides them from the group of records youre browsing.

Adding a new record         
When you add a new record to a database, the record is initially blank (except for fields that are defined to have data 
entered automatically).

Duplicating a record         
You can make a duplicate of any existing record. Approach copies each field from the original record and places them
in the duplicate.

Deleting specific records        
You can delete one record at a time in a form and more than one record at a time in a report or a worksheet.

Deleting a found set of records        
If you want to delete records that have certain criteria in common, you first fill out a find request that specifies the 
criteria. You can delete all records in a database by first finding all the records.

Hiding records        
You can hide one record at a time in a form and more than one record at a time in a report or a worksheet. When a 
record is hidden, it is not included in sorts and calculations, and it is not printed or exported along with other records.

Showing hidden records        
When youre ready to use hidden records, you can show them again. You can show either all the records in the 
database or only the records in the found set you used most recently.

See also
Setting a default order for records 



Adding a new record

When you add a new record to a database, the record is initially blank (except for fields that are defined to have data 
entered automatically).

Click the New Record icon or choose New Record from the Browse, PicturePlus, or Worksheet menu.



Duplicating a record

You can make a duplicate of any existing record. Approach copies each field from the original record and places them
in the duplicate.
1. If youre using a form, show the record. In a report, worksheet, repeating panel, or mailing label, click in a field in 

the record.
2. Click the Duplicate Record icon or choose Duplicate Record from the Browse, PicturePlus, or Worksheet menu.



Deleting specific records

You can delete one record at a time in a form and more than one record at a time in a report or a worksheet.
1. If youre using a form, show the record. In a report, worksheet, repeating panel, or mailing label, click in a field in 

the record. 
To select more than one record, SHIFT-click or CONTROL-click in the records.

2. Click the Delete Record icon or choose Delete Record from the Browse, PicturePlus, or Worksheet menu.

3. Click Yes in the alert box to delete the records.



Deleting a found set of records

If you want to delete records that have certain criteria in common, you first fill out a find request that specifies the 
criteria. You can delete all records in a database by first finding all the records.
1. Use the Find command to isolate the records you want to delete.

If you want to delete all the records in a database, type an asterisk (*) in one field of the find request.
2. Choose Delete Found Set from the Browse, PicturePlus, or Worksheet menu.
3. Click Yes in the alert box to delete the records.

See also
About finding records 



Hiding records

You can hide one record in a form and more than one record in a report or a worksheet. When a record is hidden, it is
not included in sorts and calculations, and it is not printed or exported along with other records.
1. If youre using a form, show the record. In a report, worksheet, repeating panel, or mailing label, click in a field in 

the record. 
To select more than one record, SHIFT-click or CONTROL-click in the records.

2. Choose Hide Record from the Browse, PicturePlus, or Worksheet menu.



Showing hidden records

When youre ready to use hidden records, you can show them again. You can show either all the records in the 
database or only the records in the found set you used most recently.

To show all the records in the database:

Click the Show All icon or choose Show All from the Browse or PicturePlus menu or the Worksheet Find or 
Crosstab Find submenu.

To show the records in the found set you were using before you hid the records:

Choose Find Again from the Browse or PicturePlus menu or the Worksheet Find or Crosstab Find submenu 
and then press ENTER.



About entering data in fields
Any data you enter in a field appears at the insertion point or replaces the current selection. Approach saves the data 
you enter or edit as soon as you click in or tab to another field, move to another record, change to another view, click 
the Enter icon, or press ENTER. You do not need to save data yourself.
Approach may enter data automatically in a field because of how the field was defined; for example, a date or serial 
number is often entered this way. You can edit data that was entered automatically (unless the field is read-only or the
Approach file has a password). You cannot edit data in a calculated field, however.
In a form, report, worksheet, or other view with specified field boundaries, you see only as much data as fits in a 
field's boundaries even though the field may contain more data than is visible.

Selecting a field         
You need to select a field before you can enter or edit data in it. You cannot select a calculated field.

Changing the insertion point or selection         
Once a field is selected, you can move the insertion point or select other data in the field.

Entering text in a text or memo field         
You can type letters, numbers, and symbols in a text or memo field. 

Entering a value in a numeric field         
You can type numeric data in a numeric field. Approach does not save any text or non-numeric characters (such as * 
and ") in a numeric field.

Entering a value in a Boolean field         
A Boolean field holds a value of True or False. If you refer to a Boolean field in a formula, Approach uses 1 for a True 
value and 0 for a False value to calculate the result.

Entering a date in a date field         
You can type up to 10 characters in a date field to represent one date, or you can use shortcuts to have Approach 
enter a date for you. Do not mix the date with other kinds of information.

Entering a time in a time field        
You can type up to 12 characters in a time field to represent one time, or you can use shortcuts to have Approach 
provide a time for you. Do not mix the time with other kinds of information.

Duplicating a value from the last record modified        
You can duplicate a value from the same field in the last record you modified in your current session with Approach. 
This is quick way to enter repeating data in a field. You can duplicate data in any type of field and with any type of 
value.

Selecting from a drop-down list        
A drop-down list shows the possible values for a field. When you move to a field with a drop-down list, the list opens 
so that you can select a value. In some cases, a list is combined with a field box so that you can either select from the
list or type a value.

Turning on a radio button or a checkbox        
A radio button or checkbox assigns an on or off value to a field. You can enter a value in a field by turning on one of 
its radio buttons or checkboxes.

Filling a field with a new value        



You can have Approach enter the same value in a particular field in every record in the current found set.

See also
Browse 
Types of fields 



Selecting a field

You need to select a field before you can enter or edit data in it. You cannot select a calculated field.

Click in a field, or press TAB to go to the next field in the data entry order or SHIFT-TAB to go to the previous 
field in the order. 

If your preferences are set this way, you can also press ENTER or SHIFT-ENTER to tab to the next or previous 
field.

See also
Changing the insertion point or selection 
Setting general working preferences 



Details: Selecting a field

Clicking in a field
Clicking in a field selects the field and places an insertion point in it. Any data you enter will appear at the insertion 
point.

Tabbing to a field
Tabbing to a field selects the field and its entire contents. Any data you enter will replace the selected contents. If you 
tab out of the last field in the last record, Approach asks if you want to create a new record. Click OK to create the 
record.



Changing the insertion point or selection

Once a field is selected, you can move the insertion point or select other data in the field.

To change the insertion point:

Click where you want the insertion point to go, or press the left arrow key or right arrow key to move the 
insertion point one character at a time.

To change the selection:

Drag to select a range, double-click to select a word, or press SHIFT and the left arrow key or right arrow key
to extend a selection by one character.

See also
Selecting a field 



Entering text in a text or memo field

You can type letters, numbers, and symbols in a text or memo field. 

Type any letters, numbers, or symbols, up to the limit of the text field length or the memo file size.

See also
Setting a text format 
About database files 



Details: Entering text in a text or memo field

Field lengths
In a text field, the text must fit in the length specified in the fields definition. Approach alerts you if you try to type 
characters beyond the length allowed.
You can type more text in a memo field because the text is stored in a separate memo file. The maximum size of a 
memo file depends on the file type of the database.

Dates and times
You can enter todays date or the current time in a text or memo field, but you will not be able to sort the field 
chronologically on the date or time. Click the Date or Time icon or choose Todays Date or Current Time from the 
Insert submenu in the Browse or Worksheet menu.

        

Text formats
A text format can specify all capitals, all lowercase, or first-letter capitals. If a field has a text format, the text changes 
to the format when you move out of the field.
If a field has a text format and "Show data entry format" is on for the field, the text is formatted as you type and the 
formatted text is stored in the database.



Entering a value in a numeric field

You can type numeric data in a numeric field. Approach does not save any text or non-numeric characters (such as * 
and ") in a numeric field.

Type numeric data up to the length specified in the fields definition.

See also
Setting a numeric format 



Details: Entering a value in a numeric field

A numeric format can specify currency signs, separators, a fixed number of digits, and other properties. If a field has 
a numeric format, the data is formatted when you move out of the field. Type a decimal point if the data needs one, 
but dont type other characters such as currency signs and commas; let the format provide them.
If a field has a numeric format and "Show data entry format" is on, the fixed characters of the format appear in the 
field and underlines show the maximum number of characters. You can press the space bar to move the insertion 
point past the next separator.



Entering a value in a Boolean field

A Boolean field holds a value of True or False. If you refer to a Boolean field in a formula, Approach uses 1 for a True 
value and 0 for a False value to calculate the result.

Type Yes, Y, yes, y, or 1 for True. Type No, N, no, n, or 0 for False.



Entering a date in a date field

You can type up to 10 characters in a date field to represent one date, or you can use shortcuts to have Approach 
enter a date for you. Do not mix the date with other kinds of information.

To type a date in a date field:

Type the month, day, and year as numbers separated by non-numeric characters. 

To enter the current date:

Click the Date icon or choose Todays Date from the Insert submenu in the Browse or Worksheet menu.

To enter another day for the current month and year:

Type a single number. 
For example, in June 1994 you can type 15 to enter June 15, 1994.

See also
Setting a standard date format 
Setting a special date format for periods of a year 



Details: Entering a date in a date field

Number of digits in a year
When typing a date, you can type one, two, three, or four digits for the year. One-digit and two-digit years are 
assumed to mean the twentieth century. If you dont type a year, Approach assumes the current year (based on your 
system settings) and enters it for you.

Date formats
A date format can specify the order of the month, day, and year as they appear in views, whether the month appears 
as a word or a number, and other properties. If a field has a date format, the date changes to the format when you 
move out of the field. Type the separators along with the numbers for the month, day, and year.
If a field has a date format and "Show data entry format" is on, slashes appear in the field as separators and 
underlines show the maximum number of characters. You can press the space bar to enter the current month, day, or
year and move past the next slash.

International formats
Your system may require a different order for entering dates (such as day, month, year or month, day, year). Enter the
date numbers in the order specified in your Windows International Control Panel.



Entering a time in a time field

You can type up to 12 characters in a time field to represent one time, or you can use shortcuts to have Approach 
provide a time for you. Do not mix the time with other kinds of information.

To type a time in a time field:

Type the time as hours and minutes separated by colons (HH:MM); as hours, minutes, and seconds 
separated by colons (HH:MM:SS); or as hours, minutes, seconds, and hundredths of a second separated by colons 
and a decimal (HH:MM:SS.00).

To enter the current time:

Click the Time icon or choose Current Time from the Insert submenu in the Browse or Worksheet menu.

To enter only an hour:

Type a single number. 
For example, type 8 to enter 8:00.

See also
Setting a time format 



Details: Entering a time in a time field

12-hour or 24-hour
When typing a time, you can use either a 12-hour or a 24-hour format. If you enter an hour less than 12 without a 
suffix of AM or PM, Approach assumes AM.

Time formats
A time format can specify which separators appear in views, whether seconds and hundredths appear, and other 
properties. If a field has a time format, the time changes to the format when you move out of the field. Type the 
separators along with the numbers for the parts of the time.
If a field has a time format and "Show data entry format" is on, colons appear in the field as separators and 
underlines show the maximum number of characters. You can press the space bar to enter the current hour, minute, 
or second and move past the next colon.

International formats
Your system may require a different time separator than the colon for entering times. Use whatever separator is 
specified in your Windows International Control Panel.



Duplicating a value from the last record modified

You can duplicate a value from the same field in the last record you modified in your current session with Approach. 
This is quick way to enter repeating data in a field.

Click the Previous Value icon or choose Previous Value from the Insert submenu in the Browse or 
Worksheet menu.

If you have not entered or edited any data in the current session, this command does not enter a value.



Selecting from a drop-down list

When you move to a field with a drop-down list, the list opens so that you can select a value. In some cases, a list is 
combined with a field box so that you can either select from the list or type a value.

Click the value you want. Or begin typing the value or press the up arrow key or down arrow key until the 
value is selected and then press TAB or ENTER.

See also
Displaying field as a drop-down list 



Turning on a radio button or a checkbox

A radio button or checkbox assigns an on or off value to a field. You can enter a value in a field by turning on one of 
its radio buttons or checkboxes.

Click the radio button or checkbox. Or tab to the set of radio buttons or the checkbox and then press the 
space bar.

See also
Displaying field as radio buttons 
Displaying field as a checkbox 



Details: Turning on a radio button or a checkbox

Radio buttons
Radio buttons identify a set of possible values for a field. When you click a radio button, you enter its value in the 
field.
Only one radio button in a set can be on at a time. When you turn on a radio button, if another button in the set is on it
is automatically turned off. (Once you have turned on a radio button, the only way to turn it off is by turning on another
button in its set.)
The value in a field with radio buttons is null until you click a button.

Checkboxes
A checkbox is normally used by itself to define a checked value and an unchecked value for a field. When you click a 
checkbox for the first time, you enter its checked value in the field; if you click the checkbox a second time, you enter 
its unchecked value.
The value in a field with a checkbox is null until you click the checkbox.



Filling a field with a new value

You can have Approach enter the same value in a particular field in every record in the current found set.
1. If you want to fill the field only in a set of records, use the Find command to isolate the records. 
2. In one of the records, click in the field you want to fill. 

If a record already has the value you want to use for the fill, click in the field in that record. The value will appear 
in the Fill Field dialog box.

3. Choose Fill Field from the Browse or Worksheet menu.
4. If necessary, edit the fill value.
5. Click OK.

See also
About finding records



About putting a picture in a field
To use a graphic in a PicturePlus field, you can paste a picture from another application or draw in the field to create 
your own image. The graphic appears only in the PicturePlus field in the current record. It is part of the records data, 
not part of the design of a view. 
When a pasted picture is too large for a field, the picture is either cropped or reduced, depending on how this option 
is set for the field. Approach can also enlarge a picture to fit a field.

Pasting a picture         
You can paste a picture directly from its file into a PicturePlus field. You can also paste a picture by copying it to the 
Clipboard in its source application. The Clipboard stores one item at a time.

Drawing lines with the pointer        
If a PicturePlus field is defined to allow drawing, you can draw freehand lines in it.



Pasting a picture

You can paste a picture directly from its file into a PicturePlus field. You can also paste a picture by copying it to the 
Clipboard in its source application. The Clipboard stores one item at a time.

To paste a picture from a file:
1. In Browse, select the PicturePlus field.
2. Choose Paste from File from the Edit menu.
3. Select a graphic file type or *.* in the List Files of Type drop-down list. 
4. Select the name of the graphic file you want in the File Name list. 

You can change the directory and disk if you need to look for the file.
5. Click OK.

To paste a picture from the Clipboard:
1. In the pictures source application, select the picture and choose Copy from the Edit menu.
2. In Approach, select the PicturePlus field in Browse and click the Paste icon or choose Paste from the Edit menu.



Details: Pasting a picture

Graphic file types
These are the graphic file types for pictures you can paste in Approach:

File type Filename 
extension

Encapsulated 
Postscript

.EPS

Graphics 
interchange

.GIF

Targa .TGA
TIFF (Tagged 
Image File 
Format)

.TIF

Windows bitmap .BMP
Windows 
metafile

.WMF

Windows 
Paintbrush

.PCX

Paste Special
If a picture is stored on the Clipboard in more than one format, the Paste Special command is available in the Edit 
menu. You can choose Paste Special rather than Paste and select the format you want for the pasted picture in the 
dialog box.



Drawing lines with the pointer

If a PicturePlus field is defined to allow drawing, you can draw freehand lines in it.
1. In Browse, select the PicturePlus field.
2. While holding down the left mouse button, drag to draw the lines.

See also
Changing display options for a PicturePlus field 



About checking spelling
Approach can check the spelling of text in your databases and Approach files. The text it checks depends on which 
environment youre in:

In Browse, Approach checks the spelling of data in records, including text in memo fields.

In Design, Approach checks the spelling of text in field labels and text objects, including text in the body of 
form letters.
The spelling checker is not available in Find and Preview.
When you check spelling, Approach compares the text with entries in a main dictionary and a user dictionary. Lotus 
provides the main dictionary for your language; you cannot edit this dictionary. The user dictionary is for words that 
are not in the main dictionary, such as proper nouns and technical terms; you can add and delete words in this 
dictionary at any time.

Running the spelling checker         
You must be in Browse or Design to run the spelling checker.

Editing the user dictionary         
If you click Add To Dictionary for a questioned word when you run the spelling checker, the word is added to your user
dictionary. You can also add words directly to the user dictionary, and you can delete words from the dictionary.

Changing to another main dictionary         
Approach comes with a main dictionary for your language. If you have another dictionary you want to use as the main
dictionary, you can change to it within Approach.

Setting options for checking spelling         
You can specify options for checking spelling, such as whether you want Approach to find repeated words. The 
options become a new default for the spelling checker and remain in effect until you change them.



Running the spelling checker

You must be in Browse or Design to run the spelling checker.
1. If you want to check the spelling in only some text, select the text to check. 

In Browse, you can select any text in a record. In Design, you can select text or an entire text object.
2. Click the Spell Check icon or choose Spell Check from the Tools menu.

3. In the first Spell Check dialog box, select the scope of the text you want to check.
4. Click OK.
5. In the second Spell Check dialog box, specify what to do for each questioned word. 

This dialog box appears only if Approach finds one or more words that are not in its dictionaries.
6. Click OK in the alert box.

See also
Setting options for checking spelling 



Details: Running the spelling checker

Selecting the scope
The Selection option checks the spelling only in the selected text or text object.
"Current record" (in Browse) checks the spelling in all fields of the current record. "Current view" (in Design) checks 
the text in all text objects in the active view.
"Found set" (in Browse) checks the spelling of all text in all records in the current found set; if a field is selected, it 
checks only that field in each record. "Selection across found set" (in Browse) checks the selected text or text object 
in all records in the found set.

Responding to a questioned word
To replace the word, either edit the text in the Replace With text box or select another word in the Alternatives list, 
and then click Replace All or Replace. Replace All changes the word wherever it occurs in the text youre checking, 
and Replace changes only this occurrence of it.
To accept the word, click Skip All or Skip. Skip All accepts the word wherever it occurs in the text youre checking, and
Skip accepts only this occurrence of it.
To accept the word and add it to the user dictionary, click Add To Dictionary. Approach will not question the word in 
future spell checks.



Editing the user dictionary

If you click Add To Dictionary when you run the spelling checker, the word is added to your user dictionary. You can 
also add words directly to the user dictionary, and you can delete words from the dictionary.
1. Click the Spell Check icon or choose Spell Check from the Tools menu.

2. Click Edit Dictionary.
3. To add a word to the dictionary, type the word in the New Word text box and click Add.
4. To delete a word from the dictionary, select the word in the Current Words list and click Delete. 

The list shows symbols first, then numbers, and then words in alphabetical order.
5. Click OK to return to the Spell Check dialog box.
6. Click OK to run the spelling checker or click Cancel to close the Spell Check dialog box.



Changing to another main dictionary

Approach comes with a main dictionary for your language. If you have another dictionary you want to use as the main
dictionary, you can change to it within Approach.
1. Click the Spell Check icon or choose Spell Check from the Tools menu.

2. Click Language Options.
3. Type the pathname of the new main dictionary in the Directory Path text box.
4. If a single dictionary file has more than one language in it, select the language you want in the Language drop-

down list.
5. Click OK to return to the Spell Check dialog box.
6. Click OK to run the spelling checker or click Cancel to close the Spell Check dialog box.



Setting options for checking spelling

You can specify options for checking spelling, such as whether you want Approach to find repeated words. The 
options become a new default for the spelling checker and remain in effect until you change them.
1. Click the Spell Check icon or choose Spell Check from the Tools menu.

2. Click Options.
3. Turn on the options you want.
4. Click OK to return to the Spell Check dialog box.
5. Click OK to run the spelling checker or click Cancel to close the Spell Check dialog box.



Details: Setting options for checking spelling

To Turn on
Find words that 
appear twice in a 
row, such as "the 
the"

Check for 
repeated words

Check the spelling 
of words with 
numerals, such as 
Invoice2

Check words 
with numbers

Check the spelling 
of words that begin
with a capital letter,
such as London

Check words 
with initial caps

Show words from 
the user dictionary 
in the Alternatives 
list during a spell 
check

Include user 
dictionary 
alternatives



Moving one record at a time



Moving to the first or last record



Moving to a specific record



Adding a new record



Duplicating a record



Deleting specific records



Deleting a found set of records



Hiding records



Showing hidden records



Selecting a field



Changing the insertion point or selection



Entering text in a text or memo field



Entering a value in a numeric field



Entering a value in a Boolean field



Entering a date in a date field



Entering a time in a time field



Duplicating a value from the last record modified



Selecting from a drop-down list



Turning on a radio button or a checkbox



Filling a field with a new value



Pasting a picture



Drawing lines with the pointer



Running the spelling checker



Editing the user dictionary



Changing to another main dictionary



Setting options for checking spelling



What's new in Approach 3.0
Approach 3.0 has a new look, new power, and dozens of new features that help you work more efficiently and 
effectively than ever before. 

New usability features

Approach Assistants make creating views a breeze

SmartMaster layouts give you an instant palette of form and report layouts

SmartMaster styles let you create visually appealing views 

PowerClick reporting puts sophisticated reports at your fingertips

WYSIWYG report design means you can see reports as you design them

Lotus InfoBox design technology makes formatting simple

Ground-breaking integration with other products

Lotus 1-2-3 and Lotus Notes users get instant access to Approach reporting and analysis capabilities

You can now send mail directly from Approach using your e-mail system

Increased horsepower

New speed technology, enhanced database joins, and alias joins give you much more power

New, easy-to-use graphics tools

Fast Format helps you format objects instantly

Named styles let you collect a library of your favorite looks

The Tools palette lets you keep all the drawing tools together when you work in Design 

Three new views for working with your data

Worksheets, crosstabs, and charts give you new ways to look at your data

Customization features and macros for making Approach work your way

Customization features let you create the custom menus and SmartIcon bars you need

Easy to use advanced macro technology helps you automate your work

New look and new online Help

SmartIcons, view tabs, and context-senstive menus change the look of the Approach work area

New context-sensitive help makes it easy to locate the information you need



SmartIcons
The SmartIcons are a subset of the menu commands; they appear in an icon bar (initially set to appear just below the
menu bar). To apply a SmartIcon command, click the icon.



View tabs
View tabs show the name of the view and appear at the top of the Approach window. They make it easy to navigate 
from one view to another. To go another view, click its view tab.



Context-sensitive menus
Context-sensitive menus change depending on the current selection or the current view. 



InfoBox
Lotus InfoBox design technology gives you an easy-to-use palette of choices for modifying objects.    
Every design object has a set of properties, such as dimensions, text attributes, line and fill colors, and attached 
macros. The settings for an object are stored in an InfoBox. You can keep the InfoBox open on the screen as you 
work and use it to edit objects.



WYSIWYG
WYSIWYG report design lets you see how your printed reports will look while you're designing them.
When you're in Design, you can show data in fields as it appears in Browse or show the names of fields and 
databases. To toggle between the two settings, click the Show Data icon.

    
This 
report 
with 
Show 
Data 
turned on
lets you 
see what 
the 
printed 
report will
look like. 
This is 
the same 
report 
with 
Show 
Data 
turned off
for fast 
formattin
g.

Working with Lotus Notes
Lotus Notes users can extend their reporting, analysis, and advanced forms capabilities.
You can use Approach to open views or forms in a Lotus Notes database and to replicate a Notes database. You can 
also use the powerful Notes F/X 1.1 feature to share key information between Notes and Approach.



Working with Lotus 1-2-3
Lotus 1-2-3 users get instant access to Approach reporting and analysis capabilities from within a 1-2-3 spreadsheet.
Approach and Lotus 1-2-3 can share data in a number of ways. You can open Lotus 1-2-3 spreadsheets in Approach 
and have Approach create a database file from the spreadsheet. Or you can work with "live" 1-2-3 data in Approach, 
starting either from 1-2-3 or from Approach.



Custom menus
Approach lets you create your own custom menu bars that you can attach to selected views in an Approach file. For 
example, if you design a data entry form, you might also create a custom menu bar that contains only the commands 
that people entering data will need.



Macros
You can use Approach macros to perform many different types of tasks -- from finding a set of records to saving a find
request to fully automating your data entry or invoicing process. Your only limit is your imagination.



Charts
Charts give your data an attractive graphical presentation.



Worksheets
Worksheets present database records in a spreadsheet-like view for easy manipulation.



Crosstabs
Crosstabs let you categorize and summarize database records in new ways.



Assistants
Approach Assistants help you to quickly and easily create customized forms, reports, form letters, mailing labels, 
charts, worksheets, and crosstabs.
Everything you need to select a style, a layout, and the fields that appear in a view are all in one convenient dialog 
box.



PowerClick reporting
PowerClick reporting lets you quickly and easily organize data and summarize it in sophisticated reports. You use 
SmartIcons to sort and summarize (or count or average) report data instantly.

For 
exa
mpl
e, 
you
can
turn
this 
rep
ort..
.
...in
to 
this 
rep
ort..
.
...wi
th 
just 
a 
few 
clic
ks.

SmartMaster styles
SmartMaster styles give you a variety of different looks for your new views. They let you create visually appealing 
views without -- a graphic artist.



SmartMaster layouts
SmartMaster layouts provide an instant palette of layouts for Approach views.



Help on Help
The new drill-down Approach online Help shows you layers of information. Introductory and detail information 
appears in the Main window, where you're reading this now. The steps for performing tasks appear in the Steps 
window, which appears on the right side of the screen. You can leave the Steps window open as you work in 
Approach. 
Icons in both windows make it easy for you to move between windows.

Click this 
icon

In this 
window

To

Main Display more 
specific 
reference 
information or 
the steps for a 
specific task

Steps View the 
details 
associated 
with a task

Main or 
Steps

Go to the next 
higher topic or 
return to the 
About 
overview topic

Main or 
Steps

Print a topic

Fast Format
The new Fast Format feature lets you copy the line and color settings and text attributes from one object and apply 
them to another object with a click of the mouse.



Named styles
Named styles are sets of InfoBox properties that you can save and apply whenever you want a consistent look. A 
named style can include these properties:

Line and color settings for all objects, and border and baseline settings for fields

Text attributes for field data and for text in text objects

Text attributes for field labels

Picture settings such as cropping and shrinking for PicturePlus fields

Width and color settings for the background of a view



Tools palette
The new Tools palette puts all of the tools you need for drawing Design objects in a special floating palette. The Tools 
palette appears automatically whenever you might possibly need it.. 



Send mail
The new Approach mail features let you send an Approach view (with or without data) to anyone on your e-mail 
system. You can even route messages to multiple recipients in the sequence you want.



Speed technology
X10 speed technology provides superb standalone and client/server database performance. Imagine performing 
database tasks at 10 times the speed of other leading PC end-user database products.



Database joins
You can now join up to 50 database files in a single Approach file (depending on the database file type). You can also
ensure data accuracy by using two or more fields as join criteria, including joins on calculated fields.



Alias joins
Approach now lets you create aliases to join a database to itself. Alias joins help optimize disk space and give you 
greater flexibility in using your data.
MY_END_OF_FILE_FLAG



Working Together
Click one of these topics for more information:
Working together with Lotus Notes
Working together with Lotus 1-2-3



Working together with Lotus Notes
About working together with Lotus Notes
Opening a view or form from a local Notes database 
Opening a view or form from a server Notes database 
"Quick connecting" to a server Notes database 
Replicating a new Notes database 
Replicating a Notes database with a server
Enabling a variable field for Notes F/X 1.1



Working together with Lotus 1-2-3
About working together with Lotus 1-2-3
Creating a database from a Lotus 1-2-3 spreadsheet
Opening a named range from a Lotus 1-2-3 spreadsheet
Creating an Approach view in Lotus 1-2-3



About working together with Lotus Notes
You can use Approach to open views or forms in a Lotus Notes database and to replicate a Notes database. You can 
also use the powerful Notes F/X 1.1 feature to share key information between Notes and Approach.

Opening a view or form from a local Notes database        
You can open a view or form from a Notes database stored on your local drive. The data from the view or form 
appears in a standard Approach form.

Opening a view or form from a server Notes database        
You can open a view or form from a database stored on a Notes file server. The data from the view or form appears in
a standard Approach form.

"Quick connecting" to a server Notes database        
Once you specify the name of a Notes server and database in the Open dialog box, Approach keeps track of that 
connection for your current work session. The next time you open the dialog box and select Lotus Notes - Server, the 
name of the connection you used before will appear in the Server drop-down list.

Replicating a new Notes database        
Replicating a new Notes database creates a new copy of an existing database on your local hard drive.

Replicating a Notes database with a server        
Replicating a Notes database with a server updates both your replica and the server's replica with changes made to 
either one.

Enabling a variable field for Notes F/X 1.1        
Notes F/X 1.1 is a powerful feature that allows Notes and Approach to share information. From the Approach end, the
sharing is accomplished with variable fields that have been enabled for Notes F/X 1.1. When a variable field is 
enabled, Notes can write to the field and can read its contents without having to open an Approach view.



Opening a view or form from a local Notes database

You can open a view or form from a Notes database stored on your local drive. The data from the view or form 
appears in a standard Approach form.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.
2. Select Lotus Notes - Local in the List Files of Type drop-down list.
3. Double-click a Notes database in the Directories list.
4. Select the name of the view or form you want to open in the File Name list and click OK.
5. If an alert box appears, click OK.



Opening a view or form from a server Notes database

You can open a view or form from a database stored on a Notes file server. The data from the view or form appears in
a standard Approach form.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.
2. Select Lotus Notes - Server in the List Files of Type drop-down list.
3. Select a server in the Server drop-down list.
4. If a Setup dialog box appears, fill in the information and click OK.

The dialog box appears if you are not already connected to the server. 
5. Double-click a Notes database in the Directories list, or double-click a Notes subdirectory to see its contents and 

then double-click a database.
6. Select the name of the view or form you want to open in the File Name list and click OK.
7. If an alert box appears, click OK.



"Quick connecting" to a server Notes database

Once you specify the name of a Notes server and database in the Open dialog box, Approach keeps track of that 
connection for your current work session. The next time you open the dialog box and select Lotus Notes - Server, the 
name of the connection you used before will appear in the Server drop-down list; for example, Acccounts Payable @ 
Accounting.
If you select the connection name in the Server drop-down list, the File Name list shows the views and forms in the 
Notes database you used before on that server. This way, you don't need to establish a connection and select in the 
Directories list.



Replicating a new Notes database

Replicating a new Notes database creates a new copy of an existing database on your local hard drive.
1. Choose the Notes New Replica command from its custom menu.
2. In the New Notes Replica dialog box, select the server where the database you want to copy is stored in the 

Server drop-down list.
3. Select the database file in the list of files or type the filename in the Filename text box.
4. Type a filename for the new replica in the Filename text box in the New Local Replica area.
5. If you want to replicate only those documents replicated in a specific period of time, turn on "Only replicate 

documents saved in the last nn days" and type the number of days.
6. Click New to replicate the database.

If you want to close the New Notes Replica dialog box without replicating a database, click Done instead.

See also
Customizing menus 



Replicating a Notes database with a server

Replicating a Notes database with a server updates both your replica and the server's replica with changes made to 
either one.
1. Choose the Notes Replicate with Server command from its custom menu.
2. In the Replicate with Notes Server dialog box, type the database replica filename in the Filename text box.
3. Select the server where the database you want to copy is stored in the Server drop-down list.
4. Turn on replication options as appropriate.
5. Click OK.

See also
Customizing menus 



Enabling a variable field for Notes F/X 1.1

When an Approach variable field is enabled, Notes can write to the field and can read its contents without having to 
open an Approach view.
1. Choose Approach File Info from the File menu.
2. In the Approach File Info dialog box, click a variable field to enable it.
3. Click OK.



Details: Replicating a Notes database

Replication commands
The two Approach replication commands are available only when you create a custom menu or a macro that includes
them. For more information about creating a custom menu, see Customizing menus.

Replication with server options

Turn on 
this option

To

Exchange 
document 
read marks

Update both the local 
replica and the server 
replica with read marks
on documents (Read 
marks tell whether a 
document has been 
read.)

Receive 
documents 
from server

Update the local replica
with documents from 
the server replica

Send 
documents 
to server

Update the server 
replica with documents 
from the local replica

Replicate 
database 
templates

Replicate database 
templates associated 
with the database



About working together with Lotus 1-2-3
Approach and Lotus 1-2-3 can share data in a number of ways. You can open Lotus 1-2-3 spreadsheets in Approach 
and have Approach create a database file from the spreadsheet. Or, you can work with "live" 1-2-3 data in Approach, 
starting either from 1-2-3 or from Approach.

Creating a database from a Lotus 1-2-3 spreadsheet        
You can open a Lotus 1-2-3 spreadsheet, and Approach will create a database file with a copy of the spreadsheet's 
data. Approach also creates a new Approach file for the database. 

Opening a named range from a Lotus 1-2-3 spreadsheet        
You can open a "live" named range from a Lotus 1-2-3 spreadsheet in Approach and view or edit the range in an 
Approach file. This does not convert the range to a database file. If you make any changes to data in the range, the 
changes are saved in the spreadsheet. Lotus 1-2-3 must be running and the spreadsheet with the range must be 
open.

Creating an Approach view in Lotus 1-2-3        
When you work in Lotus 1-2-3 (any version later than 4.0), you can create four types of Approach views to display 
selected worksheet data: reports, forms, dynamic crosstabs, and mailing labels. The Approach views appear as icons
embedded in the 1-2-3 worksheet.



Creating a database from a Lotus 1-2-3 spreadsheet

You can open a Lotus 1-2-3 spreadsheet, and Approach will create a database file with a copy of the spreadsheet's 
data. Approach also creates a new Approach file for the database. 
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.
2. Select Lotus 1-2-3 (*.WK*) in the List Files of Type drop-down list.
3. Select the name of the spreadsheet in the File Name list and click OK.
4. In the Select Range dialog box, select a sheet or named range with the data you want to use in the new 

database.
5. To use the text in the first row of the spreadsheet as field names, turn on "First row contains field names."
6. Click OK.
7. In the Convert To dialog box, type a name for the database file in the File Name text box.
8. Select a database file type in the List Files of Type drop-down list.
9. Click OK.



Opening a named range from a Lotus 1-2-3 spreadsheet

You can open a "live" named range from a Lotus 1-2-3 spreadsheet in Approach and view or edit the range in an 
Approach file. Lotus 1-2-3 must be running and the spreadsheet with the range must be open.
1. Click the Open File icon or choose Open from the File menu. Or if the Welcome dialog box is on the screen, 

select "Open an existing file" and click OK.
2. Select 1-2-3 Ranges in the List Files of Type drop-down list.
3. Select the name of the spreadsheet with the range you want in the Directories list.
4. Select the named range in the File Name list.
5. Click OK.



Creating an Approach view in Lotus 1-2-3

When you work in Lotus 1-2-3 (any version later than 4.0), you can create reports, forms, dynamic crosstabs, or 
mailing labels to display selected worksheet data.
1. Select the 1-2-3 database table range you want to view in the Approach form. Be sure to include column 

headings when you select the database table range.
2. Choose Form, Report, Dynamic Crosstab, or Mailing Label from the Tools Database submenu.
3. Click OK. Use the Assistant to create the view.
4. Modify the view if you want.
5. Return to 1-2-3. Choose Exit and Return from the File menu to close Approach, or choose Close and Return 

from the File menu to leave Approach running in the background.

See also
Creating a crosstab
Creating a form
Creating a mailing label
Creating a report



Opening a view or form from a local Notes database



Opening a view or form from a server Notes database



"Quick connecting" to a server Notes database



Creating a database from a Lotus 1-2-3 spreadsheet



Opening a named range from a Lotus 1-2-3 spreadsheet



Creating an Approach view in Lotus 1-2-3



Replicating a new Notes database



Replicating a Notes database with a server



Enabling a variable field for Notes F/X 1.1



About importing data
You can import data into an existing database file in Browse or you can transfer the views from one Approach file to 
another in Design. Importing data allows you to add to or update the records in your database without changing the 
appearance of any of the views in your Approach file. Importing views lets you add the views from another Approach 
file without affecting your data.

Importing data into a database        
When you import into a database, Approach can:

Update existing records with the data you're importing 

Add the data from the import file as new records at the end of the current database file

Do a combination of the two: update existing records using the imported data and add new records for data 
that doesn't matching existing ones 
Because this is essentially a data function, you must be in Browse to import data.

Importing an Approach file         
If you have views in an Approach file that you want to reuse with other databases, you can easily import the Approach
file (including all of its forms, reports, worksheets, crosstabs, charts, letters, and mailing labels) and add it to an 
existing Approach file. Because this is essentially a design function, you must be in Design to import an Approach file.



Importing data into a database

In Browse, you can update existing records with the data you're importing, add the data from the import file in new 
records at the end of the current database file, or do a combination of the two.
1. Open the database file you want to import into.
2. In Browse, choose Import Data from the File menu.
3. Select the file type of the import file if necessary in the Import Data dialog box and enter any information that's 

required for the type of field you select.
4. Type the filename in the File Name text box or select the file to import in the File Name list.
5. Click OK.
6. In the Import Setup dialog box, arrange the fields in the Fields In list so that they align with the corresponding 

data in the Data From list.
7. Click between the two field names to map the fields in the import file's Data From list with the fields you want to 

update in the current database file's Fields In list.
8. Select an import option in the Import Options drop-down list.

See the Details topic for the options.
9. If you're updating matching records, click in the checkmark column to the right of the Fields In column to select 

the fields you want to match on. 
10. Click OK.



Details: Importing data into a database

Because you're adding data to a database file, you must be in Browse. If you're working with a found set rather than 
the entire database, Approach updates only the found set.

Delimited text files
If you select the Text - Delimited file type, Approach opens the Text File Options dialog box. A delimited ASCII text file 
uses separators (special characters in the text file) to show where one field ends and the next one begins. You may 
want to refer to the manual for the application that was used to create the delimited text file to see what field 
separator it uses.
You can also specify which character set is used in the import file. If you're importing DOS text with international 
characters, change the character set of the current database before importing into it. DOS text with international 
characters uses the DOS or OS/2 (PC-8) character set.

Fixed-length text files
If you select the Text - Fixed-Length file type, Approach opens the Fixed-Length Text File Setup dialog box. In a fixed-
length text file, a specific field is always the same length in each record, regardless of how much data it contains. 
When you import a fixed-length text file, you provide the names, data types, and widths of each field. You enter the 
starting position for only the first field; Approach automatically calculates the starting position for all fields after the first
one. 

Oracle, SQL Server, DB2, or server-based ODBC files
If you select Oracle, SQL Server, DB2, or a server-based ODBC application, Approach opens the appropriate 
Connect dialog box. Use this dialog box to connect to the server. See Opening a server database through ODBC.

Arranging the fields in the Fields In list
To move a field, click the field and drag it to a new position. When you release the mouse button, the field you 
dragged exchanges positions with the field you dropped it on. 

Field mapping
Field mapping tells Approach which imported data matches fields in the current database. To map two fields, click in 
the mapping column between them to turn on an arrow. To unmap specific fields, click the mapping arrow beside the 
field name to turn it off. To unmap all fields, click Clear. To remap any fields with matching names, click Map Fields.
If you want to map the import fields to those in a joined database, select the database file in the Fields In drop-down 
list.
If a field in the import file is not mapped to a field in the current database file, Approach ignores the field. Approach 
also ignores any fields in the current database that are not mapped. Therefore, if you want to update only specific 
fields when you import data, be sure that those fields are the only ones mapped (a mapped field has an arrow 
connecting it to a field in the import file).

Import options

This option Does this
Add imported 
records as new 
records

Adds the 
imported data 
as new records 
at the end of 
the database; 
the new 
records have 



data only in the 
fields you 
mapped

Use imported 
data to update 
existing records

Updates the 
data in existing 
records (only 
for the fields 
you map) when
the records 
contain data in 
the fields you 
specify that 
matches the 
data in the 
import file

Use imported 
data to update 
& add to 
existing records

Updates the 
data in records 
that match the 
import file and 
adds new 
records for the 
data that does 
not match 
existing records

If you select one of the update options, a new column appears on the right side of the Import Setup dialog box. You 
use this column to select the fields that must have matching data before their records can be updated.



Importing an Approach file

If you have views in an Approach file that you want to reuse with other databases, you can easily import the Approach
file in Design and add it to an existing Approach file. 
1. Open the Approach file you want to import into.
2. In Design, choose Import Approach File from the File menu.
3. Select the Approach file you want to import and click OK.
4. Arrange the fields in the current file's Fields In list so that they align with the corresponding fields in the import 

file's Fields In list.
5. Map the fields in the import file's Fields In list with the fields you want to update in the current Approach file.
6. Click OK.



Details: Importing an Approach file

Arranging the fields in the Fields In list
To move a field, click the field and drag it to a new position. When you release the mouse button, the field you 
dragged exchanges positions with the field you dropped it on. 

Field mapping
Field mapping tells Approach which imported fields match fields in the current Approach file. To map two fields, click 
in the mapping column between them to turn on an arrow. To unmap specific fields, click the mapping arrow beside 
the field name to turn it off. To unmap all fields, click Clear. To remap any fields with matching names, click Map 
Fields.
If you want to map the import fields to those in a joined database, select the database file in the Fields In drop-down 
list.
If a field in the imported Approach file is not mapped to a field in the current Approach file, Approach displays the 
message NO_FIELD_REFERENCE in Design instead of a name for the field. In Browse, you get an error telling you 
that you cannot edit the field and must assign a database field to the current field.



About exporting and sending data
You can export data from an Approach database file, copy a PicturePlus picture to a file, or send data or views from 
an Approach file via e-mail.

Exporting data from Approach        
When you export an Approach database file, you take selected data and save it in a format that can be used by other 
applications. You can export all the records in a database or use Find to select a subset to export. You can also 
export all of the fields in a record or just some of them. 

Copying a PicturePlus picture to a file        
You can easily copy a picture in a PicturePlus field to a new file in whatever graphics file type you specify. You can 
then edit the picture if you want, or use it for another purpose. You must be in Browse to copy a PicturePlus picture to
a file.

Sending e-mail from Approach        
If you are connected to a network and have access to an e-mail package (such as Lotus Notes or cc:Mail), you can 
include Approach views and data in your e-mail messages. Approach lets you e-mail an image of the current view, or 
save and attach all or part of the current Approach file. 



Exporting data from Approach

Exporting saves selected data in a format that can be used by other applications. Approach creates a new database 
file that can include all types of fields except variable fields and summary calculated fields.
1. In Browse, open the database file you want to export and select the records to be exported.
2. Choose Export Data from the File menu.
3. Type a name for the file you're exporting to and specify where you want the file to be saved.
4. Select a database file type in the List Files of Type drop-down list.
5. Select "Found set only" or "All records" in the Records to Export area.
6. Move the fields you want to export to the Fields to Export list.
7. Click OK.



Details: Exporting data from Approach

Exporting different file types
If you select the Text file type, Approach opens the Text File Options dialog box. You can specify the character used 
to separate fields in the export file.
If you select Oracle, SQL Server, DB2, or a server-based ODBC application, Approach opens the appropriate 
Connect dialog box. Use this dialog box to connect to the server. See Opening a server database through ODBC.

Selecting records to export
"Found set only" exports only the records you've located with the most recent find request. "All records" exports all 
records in the database.

Moving fields to the Fields to Export list
To move a field to the Fields to Export list, select the field name in Database Fields and click Add, or double-click the 
field name. Approach exports fields in the order you list them.
To move a field back to the Database Fields list, select the field name in Fields to Export and click Remove.



Copying a PicturePlus picture to a file

In Browse, you can easily copy a picture in a PicturePlus field to a new file in whatever graphics file type you specify. 
You can then edit the picture if you want, or use it for another purpose. 
1. In Browse, select the PicturePlus field that contains the image you want to copy.
2. Choose Copy to File from the Edit menu.
3. Type a filename for the file you're creating in the File Name text box.
4. Select the file type you want in the Save File as Type drop-down list.
5. Click OK.



Sending e-mail from Approach

If you are connected to a network and have access to an e-mail package, you can include Approach views and data 
in your e-mail messages. First you select the data, and then you specify the recipient.
1. Open an Approach file and use the Find command to locate the set of records you want to mail.
2. Choose Send Mail from the File menu.
3. Select the amount of information you want to send.

See the Details topic for the options.
4. Click OK.
5. In the Send dialog box, select "Route to addressees in sequence in the drop-down list.
6. Type the names of the addressees in the order you want them to receive the message in the To text box.
7. Type a subject in the Subject text box and a message in the Message text box if you want.
8. Click Options to set return notification and delivery priority options.
9. Click Send.



Details: Sending e-mail from Approach

You can select either or both of these options.

This option Sends
Send snapshot of 
the current view

A Windows 
Metafile (.WMF) 
image of the 
current Approach
file view

Attach Approach 
file with

The current 
Approach file 
with either all 
views or the 
current view only

If you attach an Approach file, you can include copies of all databases displayed in the Approach file, a blank copy of 
each database displayed in the Approach file, or no databases. 
Use the No Databases option when the person you're sending the Approach file to has access on the same network 
as you do to the database files that are displayed in the Approach file.



About creating Approach OLE objects
Object Linking and Embedding (OLE) is a system that allows different Windows applications to share live data freely. 
You can create Approach objects that consist of either an individual view (such as a report or form) or an entire 
Approach file. When you insert an Approach OLE object into another application, it generally appears as an Approach
icon. 

Creating an Approach OLE object in Approach        
When you create an Approach OLE object from within Approach, it becomes available to any other application for 
linking. You can create two types of Approach objects: a data object or a view object. A data object is a worksheet or 
crosstab that you CONTROL-drag and drop in a OLE 2 drop target application. A view object can be either a single 
view, such as a worksheet or chart, or the entire Approach file.

Creating an Approach OLE object from another application        
When you create a new Approach object from within another application, it can contain the entire Approach 
application or a single view. You begin by selecting the type of object: the Approach application or a view. Next, you 
select the database you want to use. And finally, you create the view using the appropriate Approach Assistant dialog 
box.



Creating an Approach OLE object in Approach

When you create an Approach OLE object from within Approach, it becomes available to any other application for 
linking. You can create two types of Approach objects: a data object or a view object. 
1. Open the Approach file in Browse or Preview and go to a view you want to include in the OLE object. 
2. Make sure nothing is selected in the view.
3. Choose Copy VIew from the Edit menu.
4. Select "Copy current view only" to create an object that consists of only the current view, or select "Copy all 

views to create an object that includes all of the views in the current Approach file.
5. To include data in the object, turn on "Include data" and select the amount of data. 



Details: Creating an Approach OLE object in Approach

You can choose whether to include data in a view object and the amount of data to be included.
If you include data in a view object, the object and its data are a self-contained unit. This format is convenient for 
sending an Approach form to someone via e-mail. The recipient can then enter data into the form and send it back to 
you.
If you choose not to include data in the object, Approach still adds references to the data so that you can see data in 
the OLE object as long as the object and the database file it points to are on the same network or local hard drive.



Creating an Approach OLE object from another application

When you create a new Approach object from within another application, it can contain the Approach application or 
just a single view that you create using an Approach Assistant.
1. Embed a new OLE object following the instructions provided for the container application.
2. Select the database you want to use.
3. To include a view, select the type of Approach view you want to use in the object, use the Assistant to create the 

view, and click Done.
4. Close Approach.

See also
Creating a form
Creating a standard or columnar report
Creating a mailing label
Creating a form letter
Creating a worksheet
Creating a crosstab



About linking OLE objects from other applications
OLE lets you include different kinds of information in your database -- including graphics, charts, sounds, and text -- 
limited only by the server applications installed on your computer.You can place a linked object as a design element 
in every record or in a PicturePlus field on a single record. Depending on the server application, the object appears 
right in the record or as an icon. Any changes you make to the linked object from within Approach update the original 
object. 

Inserting a linked object        
When you insert a linked object, you begin by creating the object in the server application. You can then either copy 
the object to the Clipboard and paste it into Approach or create a link to the object's file.    

Editing a linked object        
You can easily edit a linked object by double-clicking it. 

Modifying a link        
Once a link is inserted, you can specify when the object is updated, manually update an object, activate a linked 
object, link the object to another source (when you change the name of the source file, for example), or break the link 
altogether.



Inserting a linked object

You create the object in the server application and either copy it to the Clipboard and use the Paste Special 
command or create a link to the object's file. 

To insert a linked object from the Clipboard:
1. In the server application, create the object you want to link to and then use the Copy command to copy it to the 

Clipboard.
2. Prepare the Approach file to receive the linked object by opening the Approach file and going to the view you 

want to use.
3. If you plan to paste the OLE object as a design element, go to Design and click where you want the object to 

appear. Or, if you're placing the linked object in a PicturePlus field, go to Browse, go to the record, and select the 
field.

4. Choose Paste Special from the Edit menu.
5. In the Paste Special dialog box, click Paste Link and turn on Display As Icon if you want the OLE object to 

appear as an icon.
6. Click OK.

To link to an object's file:
1. Prepare the Approach file to receive the linked object by opening the Approach file and going to the view you 

want to use.
2. If you plan to paste the OLE object as a design element, go to Design and click where you want the object to 

appear. Or, if you're placing the linked object in a PicturePlus field, go to Browse, go to the record, and select the 
field.

3. Choose Object from the Create menu.
4. In the Insert Object dialog box, click Create from File.
5. Type the name of the file you want to link to or click Browse and select a file in the Browse dialog box.
6. If you want the OLE object to appear as an icon, turn on Display As Icon.
7. Click OK.

To delete a linked object:

Select the object and choose Cut or Clear from the Edit menu.



Editing a linked object

You can easily edit a linked object by double-clicking it. 
1. Double-click the object to open the source document.
2. Make your changes to the object.
3. Choose Update from the File menu of the server application.
4. Choose Exit or Exit & Return from the File menu of the server application.



Modifying a link

Once a link is inserted, you can modify it in a number of ways. 
1. Open the Approach file that contains the linked object. 
2. If the object is a design element, go to Design. If the object is in a PicturePlus field, go to the record that contains

the object and select the PicturePlus field.
3. Choose Links from the Edit menu.
4. In the Links dialog box, select the link you want to modify and make the necessary changes.



Details: Modifying a link

You can update an linked object either automatically or manually. Automatic updating means that the object is 
updated whenever the source object changes. Manual updating means that the object is updated only when you 
specifically update it. If you're making frequent changes to an object, you might want to wait until you're finished 
before manually updating it.
When Approach is the container application, it updates linked objects only if the source application is running. If you 
have a linked object in a PicturePlus field, Approach updates the object only when you manually update it. 

To Click
Change when the 
link is updated

Automatic or 
Manual in the 
Update area

Manually update 
the link

Update Now

Activate a linked 
object

Open Source

Change the link to 
another source file 
(if, for example, you
change the name or
location of the 
source file)

Change Source 
and select a new
file or path for 
the link in the 
Change Link 
dialog box

Break a link and 
convert the object 
into a graphic 
element

Break Link



About embedding OLE objects
Embedding an OLE object in an Approach file creates a link to the server application the same way linking to an 
object does. The main difference between linking and embedding is that an embedded object is the only version of 
the object, whereas a linked object refers back to and can update the original source object.

Embedding an existing OLE object        
When you embed an object, you simply paste it into an Approach view. You can embed an object as a design 
element, or in a PicturePlus field on a single record. 

Embedding a new OLE object        
You can embed an OLE object without actually creating the object first. Instead, you create and embed an object at 
the same time.

Editing an embedded object        
Once you've embedded an object, you can easily edit the object by double-clicking it. 



Embedding an existing OLE object

When you embed an object, you simply paste it into an Approach view. You can embed an object as a design 
element, or in a PicturePlus field on a single record. 

To embed an existing object:
1. In the server application, create the object you want to link to and then use the Copy command to copy it to the 

Clipboard.
2. Prepare the Approach file to receive the embedded object by opening the file and going to the view you want to 

use.
3. If you plan to paste the OLE object as a design element, go to Design and click where you want the object to 

appear. If you're placing the linked object in a PicturePlus field, go to Browse, go to the record, and select the 
field.

4. Choose Paste Special from the Edit menu.
5. In the Paste Special dialog box, click Paste.

To delete an embedded object:

Select the object and choose Cut or Clear from the Edit menu.



Embedding a new OLE object

You can embed an OLE object without actually creating the object first. Instead, you create and embed an object at 
the same time.
1. Prepare the Approach file to receive the embedded object by opening the file and going to the view you want to 

use.
2. If you plan to paste the OLE object as a design element, go to Design and click where you want the object to 

appear. If you're placing the linked object in a PicturePlus field, go to Browse, go to the record, and select the 
field.

3. Choose Object from the Create menu.
4. To create an object from a specific file, click Create from File in the Insert Object dialog box and select a file.
5. To create a completely new object, click Create New and select the type of object you want to create.
6. Click OK.
7. Create the object in the server application window and choose Update from that application's File menu.
8. Close the server application window and return to Approach.



Editing an embedded object

Once you've embedded an object, you can easily edit the object by double-clicking it. 
1. In Design, double-click the object you want to edit.
2. Make the changes you want in the embedded object and choose Update from the server application's File menu.
3. Close the server application window and return to the Approach window.



Importing data into a database
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Help on Help
Approach online Help information is divided into several types of topics to make it easy to find just the right amount of
information.

This type of 
topic

Displays 

About A brief overview for a 
group of related tasks

Steps The steps for each task 
in a secondary window 
on the right side of your 
screen. You can keep a 
Steps topic open while 
you work in Approach

Details Additional information 
you might need in order 
to complete a task

Reference Descriptive information 
about SmartIcons, 
functions, the work 
area, and other 
elements of Approach 

Moving around in Help
Approach online Help information appears in one of two windows: the Main window, where you're reading this now, 
and the Steps window, which appears on the right side of the screen. You can leave the Steps window open as you 
work in Approach. 
Icons in both windows make it easy for you to move between windows.

Click this 
icon

In this 
window

To

Main Display more specific 
reference information or
the steps for a specific 
task

Steps View the details 
associated with a task

Main or 
Steps

Go to the next higher 
topic or return to the 
About overview topic

Main or 
Steps

Print a topic



File types
A database in Approach can be a dBASE, Paradox, or FoxPro file, a Microsoft Access table, a SQL table, or an 
ODBC data source. This allows you to share data with people who use other applications. With any type of database,
you work with the data through an Approach file, which is always in the same Approach file type.
Click one of these topics for more information:
Database files
SQL tables
ODBC data sources



Database files
About database files
dBASE III+ and DBASE IV
Paradox 3.5 and Paradox 4.0
FoxPro 2.1
Microsoft Access
Filename extensions



SQL tables
About SQL tables
Oracle SQL
SQL Server
IBM DB2
Troubleshooting Oracle SQL on a server 
Troubleshooting Oracle SQL on your local drive 
Troubleshooting Microsoft SQL Server 
Troubleshooting Sybase SQL Server 
Troubleshooting IBM DB2-MDI 
Query files 



Database files

You can work with database files in a dBASE, Paradox, or FoxPro format. When you create a new database in 
Approach, the default file type for it is dBASE IV.

dBASE III+ and dBASE IV         
Approach lets you create and use dBASE III+ and dBASE IV files. The filename extension for dBASE files is.DBF.

Paradox 3.5 and Paradox 4.0         
You can create and use Paradox 3.5 and Paradox 4.0 (including Paradox for Windows) database files in Approach. 
The filename extension for Paradox database files is .DB.

FoxPro 2.1         
You can create and use FoxPro 2.1 database files in Approach. The filename extension for all FoxPro files is .DBF. 
The FoxPro file type is similar to dBASE IV but uses a different format for memo files.

Microsoft Access         
You can create and use Microsoft Access database tables in Approach. The filename extension for Access databases
is .MDB.

Filename extensions         
The filename extensions you'll probably see most often in Approach are .DBF for dBASE and FoxPro files, .DB for 
Paradox files, .APR for Approach files, and .MDB for Access files. But you may see additional extensions in the file 
dialog boxes if you select a different file type or All Files in the List Files of Type drop-down list.

See also
About creating and opening files 
About SQL tables 
ODBC data sources 



dBASE III+ and dBASE IV

Approach lets you create and use dBASE III+ and dBASE IV files. The filename extension for dBASE files is.DBF.
You can share Approach dBASE files on a network.

Viewing dBASE files in Approach
These are the main differences between viewing dBASE files in Approach and in other dBASE applications:

In a dBASE file created in Approach, you can use field names with any characters, up to 32 characters long. 
If you view the file in other dBASE applications, you may see a modified version of your field names.

Memo fields greater than 5000 characters cannot be viewed in the internal memo editor for dBASE III+.

Memo fields greater than 64,000 character cannot be viewed in the internal memo editor for dBASE IV.

Approach PicturePlus fields cannot be viewed in other dBASE applications.

Field names
The names of fields in Approach dBASE files can be up to 32 characters long. You can use any characters in a field 
name, including letters, whole numbers, spaces, commas, periods, and arithmetic signs.
Other dBASE applications have more restrictions on the length of field names and on the characters you can use. For
field names that do not satisfy other applications, Approach saves both the name you give the field and a modified 
name that other applications can read. If you open the database in another dBASE application, you'll see the 
modified field names.

Field lengths
You must specify a field length for text and numeric fields. The length for a text field can be from 1 to 254. The length 
for a numeric field can be from 1 to 19. If you want to display numbers with high precision, you can also specify up to 
15 decimal places for a numeric field.
The other fields are fixed in length or do not require a specified length.

Index files
Approach uses its own indexes for keeping track of records in a dBASE file. 
If you have any other dBASE-type index files you want Approach to maintain, you can associate those indexes with a 
dBASE file in Approach. Approach does not use the external indexes but maintains them for other dBASE 
applications. For more information, see Maintaining external indexes for a dBASE or FoxPro database.

Files, records, and fields
These are the limits on files, records, and fields for the dBASE file types:

Item Limit
File size 2GB
Database files 
open

Up to 255 
(depending on 
memory)

Records per 
database

1,000,000,000

Record size 4KB
Fields per record 128 (dBASE III+) or

255 (dBASE IV)
Fields used in a 
sort

255



Size of a memo 
file

5KB (dBASE III+) or
64KB (dBASE IV)

Indexes per 
database

255

See also
Creating a new database file 
Opening a database created in another application 
Setting database options for a dBASE or FoxPro file 



Paradox 3.5 and Paradox 4.0

You can create and use Paradox 3.5 and Paradox 4.0 database files in Approach. The filename extension for 
Paradox database files is .DB. All of the characteristics of Paradox 4.0 described in this topic also apply to Paradox 
for Windows.
The Paradox file types require a key field -- a field or group of fields that uniquely identifies each record in the 
database. When you create a Paradox database in Approach or try to use one that does not have a key field, a dialog
box appears so that you can assign one. For more information, see Specifying a key field for a Paradox database.
You can share Approach Paradox files on a network.

Viewing Paradox files in Approach
This is the main difference between viewing Paradox files in Approach and in other Paradox applications:

Memo and PicturePlus fields cannot be viewed in Paradox 3.5. You can view memo and PicturePlus fields in
Paradox 4.0, unless the database was created in the Paradox 3.5 file type.

Field names
The names of text, numeric, and date fields in Approach Paradox files can be up to 25 characters long. The names of
time, memo, Boolean, and PicturePlus fields can be up to 18 characters long. These characters can include letters, 
whole numbers, spaces, commas, periods, and arithmetic signs. 
A field name in Paradox cannot begin with a space and cannot contain these characters anywhere in the name:

[, ], {, }, (, ), ", ->
You cannot use a number sign (#) by itself in a field name, but you can combine it with other characters, such as 
Invoice #.
When using a Paradox field name in a formula, you must enclose it in double quotation marks if it contains a space, a
period, a comma, or any of the following characters:

/, *, +, -, <, >

Field lengths
You must specify a field length for text fields. The length for a text field can be from 1 to 255. 
The other fields are fixed in length or do not require a specified length.

Index files
A primary index for a Paradox file is built on the key field specified when the file is created. If you want to create 
additional, secondary indexes for the file in Approach, see Creating secondary indexes for a Paradox database.
Approach automatically uses and maintains all indexes for Paradox database files. 
Indexes in Paradox 3.5 are case-sensitive and in Paradox 4.0 are case-insensitive. If you want to change a Paradox 
4.0 search to case-sensitive, see Setting database options for a Paradox file.

Files, records, and fields
These are the limits on files, records, and fields for the Paradox file types:

Item Limit
File size 4GB
Database files 
open

2 to 10 (depending
on the number of 
secondary index 
files open)

Records per 
database

2,000,000,000



Record size 1350 bytes
Fields per record 255
Fields used in a 
sort

255

Indexes per 
database

255

See also
Creating a new database file 
Opening a database created in another application 



FoxPro 2.1

You can create and use FoxPro 2.1 database files in Approach. The filename extension for all FoxPro files is .DBF. 
The FoxPro file type is similar to dBASE IV but uses a different format for memo files.
Unlike dBASE and Paradox database files, FoxPro files cannot be shared on a network in Approach. (You can open a
FoxPro file on a network, but other users will not be able to open it at the same time.)

Viewing FoxPro files in Approach
These are the main differences between viewing FoxPro files in Approach and in other FoxPro applications:

In a FoxPro file created in Approach, you can use field names with any characters, up to 32 characters long. 
If you view the file in other FoxPro applications, you may see a modified version of your field names.

Approach PicturePlus fields cannot be viewed in other FoxPro applications.

Field names
The names of fields in Approach FoxPro files be can up to 32 characters long. You can use any characters in a field 
name, including letters, whole numbers, spaces, commas, periods, and arithmetic signs.
Other FoxPro applications have more restrictions on the length of field names and on the characters you can use. For
field names that do not satisfy other applications, Approach saves both the name you give the field and a modified 
name that other applications can read. If you open the database in another FoxPro application, you'll see the 
modified field names.

Field lengths
You must specify a field length for text and numeric fields. The length for a text field can be from 1 to 254. The length 
for a numeric field can be from 1 to 19. If you want to display numbers with high precision, you can also specify up to 
15 decimal places.
The other fields are fixed in length or do not require a specified length.

Index files
Approach uses its own indexes for keeping track of records in a FoxPro file. 
If you have any other FoxPro-type index files you want Approach to maintain, you can associate those indexes with a 
FoxPro file in Approach. Approach does not use the external indexes but maintains them for other FoxPro 
applications. For more information, see Maintaining external indexes for a dBASE or FoxPro database.

Files, records, and fields
These are the limits on files, records, and fields for the FoxPro file type:

Item Limit
File size 2GB
Database files 
open

Up to 255 
(depending on 
memory)

Records per 
database

1,000,000,000

Record size 4KB
Fields per 
record

255

Fields used in a 
sort

255

Size of a memo 64KB



file
Indexes per 
database

255

See also
Creating a new database file 
Opening a database created in another application 
Setting database options for a dBASE or FoxPro file 



Microsoft Access

You can create and use Microsoft Access database tables in Approach. The filename extension for Access databases
is .MDB.
To be able to create an Access table in Approach, you need to have an Access database already set up. You add the 
table to this database using the Approach New dialog box. The table is in the Access file type version 1.0, 1.1, or 2.0, 
depending on the version of the database.
You can share Access tables on a network in Approach. To set up an Access database for multiple users, see the 
Access documentation.

Viewing Access tables in Approach
These are the main differences between viewing Access tables in Approach and in the Microsoft Access application:

Approach PicturePlus fields cannot be viewed in Access.

In Approach, fields in the Access currency field type are converted to numeric fields.

Timestamp fields in Access include both a date and a time. In Approach, these fields appear as two fields: a 
date field and a time field. The extension "_Time" is added to the time field.

For example, suppose an Access timestamp field Shipped has the value "5/10/94 10:35PM". Approach 
displays a date field Shipped with the value "5/10/94" and a time field Shipped_Time with the value "10:35PM".
If you read an Access table without a unique index, Approach opens a read-only copy of the file.

Field names
In an Access table in Approach, the first character in a field name must be a letter. After that, the name can have 
letters and whole numbers. Spaces and ODBC keywords are not allowed.
The names of text, numeric (numeric/currency), memo, and Boolean (bit) fields can be up to 32 characters long. The 
names of date, time, and PicturePlus (OLE object) fields can be up to 26 characters long.

Field lengths
You must specify a field length for text fields, from 1 to 255.
The other fields are fixed in length or do not require a specified length.

Tables, records, and fields
These are the limits on tables, records, and fields for Access tables in Approach:

Item Limit
Table size 1GB (1.1/2.0), 

128MB (1.0)
Tables open at 
a time

Up to 255 
(depending on 
memory)

Records per 
database

Limited by the size 
of the database

Record size Limited by the 
number of fields

Fields per 
record

255

Fields used in a 
sort

10

Size of a memo 32KB



file
Size of a 
PicturePlus file

1 GB (1.1, 2.0), 
128 MB (1.0)

Indexes per 
database

32

See also
Creating a new database file 
Opening a table created in Microsoft Access 
Setting database options for SQL, Access, ODBC, and Lotus Notes tables    



Filename extensions

The filename extensions you'll probably see most often in Approach are .DBF for dBASE and FoxPro files, .DB for 
Paradox files, .APR for Approach files, and .MDB for Access files. But you may see additional extensions in the file 
dialog boxes if you select a different file type or All Files in the List Files of Type drop-down list. 

Files created or used by Approach
These are the extensions for Approach files and data-related files that Approach creates or uses. The n's in some of 
the extensions are wildcards for individual numbers; for example, the extension .Xnn might appear in a filename 
as .X24.
You may see other extensions for files that another database application has created for its own purposes. For 
information about those extensions, see the documentation that came with the application.

Extension File type
.ADX Approach dBASE 

index
.APR Approach file (for 

storing views)
.APT Approach data and 

views (created 
when you attach an
.APR file to Notes)

.APX Approach-specific 
Paradox 
information file

.CDX FoxPro compound 
index

.DB Paradox database 
file

.DBF dBASE or FoxPro 
database file

.DBQ Paradox memo file

.DBT dBASE memo file

.FPT FoxPro memo file

.IDX FoxPro 2.0 index

.LCK Paradox lock file

.MB Paradox 
4.0/Windows memo
file

.MDB Microsoft Access 
database file

.MDX Maintained dBASE 
index

.NDX Non-maintained 
dBASE index

.NSF Notes database file

.OYZ Approach alternate 
dBASE index



.QRY Approach query file
(for SQL tables)

.SMI Lotus SmartIcon 
file

.VEW Approach file (for 
storing views; 
versions earlier 
than 3.0)

.Xnn Paradox single 
secondary index

.Ynn Paradox single 
secondary index

.XGn Paradox composite
secondary index

.YGn Paradox composite
secondary index

Approach creates an .OYZ file only if it needs to create an index and an .ADX file already exists for another 
application.

Text and spreadsheet files
You can use text and spreadsheet files for creating database files and for importing and exporting data. These are the
filename extensions for supported file types:

Extension File type
.TXT Delimited or fixed-

length text
.WKS Lotus 1-2-3 release

1A
.WK1 Lotus 1-2-3 release

2
.WK3 Lotus 1-2-3 release

3
.WK4 Lotus 1-2-3 release

4
.WRK Symphony release 

1 or 1.01
.WR1 Symphony release 

1.1, 1.2, or 2
.XLS Excel 3.0 or 4.0

Graphic files
You can use graphic files for importing images into a PicturePlus field and for putting an object on a view as a design 
element. These are the filename extensions for supported file types:

Extension File type
.BMP Windows bitmap
.EPS Encapsulated 

Postscript
.GIF Graphics 

interchange
.PCX Windows 

Paintbrush
.TGA Targa



.TIF TIFF (Tagged 
Image File Format)

.WMF Windows metafile



About SQL tables

Approach allows you to view and work with SQL data right at your desktop. The data can be stored in Oracle SQL, 
Microsoft/Sybase SQL Server, or IBM DB2 tables. If you have other SQL tables that can be opened through an 
ODBC driver, you also have access to those tables in Approach.

Oracle SQL         
You can use Approach to work with tables in Oracle SQL, versions 6 and 7. You can work with an Oracle table on a 
server or on your local drive.

SQL Server         
You can use Approach to work with tables in Microsoft/Sybase SQL Server, in any version under 5.0.

IBM DB2         
You can use Approach to work with tables in IBM DB2 (Database 2) through ODBC support or through the Micro 
Decisionware Database Gateway (MDI), version 2.0 or above. 

Query files         
Query files allow you to quickly connect to a server and get access to specific information in a SQL table. The 
filename extension for query files is .QRY.

Troubleshooting Oracle SQL on a server         

Troubleshooting Oracle SQL on your local drive         

Troubleshooting Microsoft SQL Server         

Troubleshooting Sybase SQL Server         

Troubleshooting IBM DB2-MDI         
See also

ODBC data sources 
About working with SQL tables 
Setting database options for SQL, Access, ODBC, and Lotus Notes tables 



Oracle SQL

You can use Approach to work with tables in Oracle SQL, versions 6 and 7. You can work with an Oracle table on a 
server or on your local drive.

Viewing Oracle SQL tables in Approach
These are the main differences between viewing tables in Approach and in other Oracle SQL applications:

Approach PicturePlus fields cannot be viewed in other Oracle SQL applications.

In Oracle SQL, null and blank field values sort greater than nonblank field values.

Date fields in Oracle SQL include both a date and a time. In Approach, these fields appear as two fields: a 
date field and a time field. The extension "_Time" is added to the time field.

For example, suppose an Oracle SQL date field Shipped has the value "5/10/94 10:35PM". Approach 
displays a date field Shipped with the value "5/10/94" and a time field Shipped_Time with the value "10:35PM".

When reading Oracle SQL 7 tables, Approach treats varchar2 fields with more than 255 characters as memo
fields.
If you read an Oracle view file based on more than one Oracle table, Approach opens a read-only copy of the view 
file.
In Oracle, each table is assigned a user as its owner. When Oracle tables are showing in file dialog boxes, the names
of tables appear in the File Name list, the names of table owners appear in the Directories list, and the names of 
servers you're connected to appear in the Drives drop-down list.

Field names
The names of text, numeric, and memo fields in Oracle SQL tables can be up to 30 characters long. The names of 
date, time, Boolean, and PicturePlus fields can be up to 23 characters long. An Oracle field name can include any 
character except for the double quotation mark (").
When using an Oracle field name in a formula, you must enclose it in double quotation marks if it contains a space, a 
period, a comma, or any of the following characters:

/, *, +, -, <, >, (, )
Field names in Oracle are not case-sensitive.

Field lengths
You must specify a field length for text fields. The length for a text field can be from 1 to 255. (In Oracle SQL 7, a text 
field can be up to 2000 characters. If you create a text field that is longer than 255 characters, Approach treats it as a 
memo field.)
The other fields are fixed in length or do not require a specified length.

Tables, records, and fields
These are the limits on tables, records, and fields for Oracle SQL in Approach:

Item Limit
Table size Limited only by disk

space
Tables open at a 
time

255

Records per 
table

Limited only by disk
space

Record size Limited by the 
number of fields 
and the size of the 



field type
Fields per record 254
Fields used in a 
sort

As many fields as 
are in the table

Size of a memo 
or picture field

64KB (Oracle 6) or 
2GB (Oracle 7)

Memo and 
picture fields per 
table

1 memo field or 1 
picture field 
(but varchar2 fields 
already in an 
Oracle 7 table are 
treated as memo 
fields in Approach)

See also
Connecting to an Oracle server 
Connecting to Oracle on your local drive 



Troubleshooting Oracle SQL on a server

If you are having problems getting access to Oracle SQL tables on a server through Approach, check for these 
requirements:

The server and workstation utilities must be for Oracle version 6 or 7.

You must be running the SQL*Net drivers specific for the type of client and server on the network. Novell 
networks might run SQLSPX.EXE, whereas a UNIX-based network might run SQLTCP.EXE. The drivers themselves 
must also be the version 6 or 7 release.

If you get the message "SQL*Net driver not loaded," it probably means that the DOS SQLSPX driver is not 
loaded or that it needs to be loaded into another part of memory because it is conflicting with something else. 
Sometimes when a driver is loaded, it is put into a part of memory that is later overwritten or buried by another 
product or driver. 

Experiment with the load order of the drivers in AUTOEXEC.BAT or the .DLL file. Always try to load the Oracle 
SQL*Net drivers as the absolute last resident program. Do not load SQL*Net drivers high.

Check for the presence of a CONFIG.ORA file or an ORACLE.INI file, and examine the file using a text 
editor or the DOS TYPE command. A CONFIG.ORA or ORACLE.INI file might look like this:

ORACLE_HOME=C:\ORA6
MACHINE_TYPE=2
ORACLE_TIO=VIDEO
DBA_AUTHORIZATION=approach
LOCAL=X:ORASRV
SQLPATH=C:\ORA6

You can determine your network type from the CONFIG.ORA or ORACLE.INI file by looking for the "login 
string" usually located on the "LOCAL=" or "REMOTE=" line. In the example above, the X signifies Novell's SPX. 
Right after the login string is the database server name, such as ORASRV. This is the default database on the 
network.

If this configuration is present, you should have to enter only your user name and password in the Connect 
dialog box. Approach will translate the remaining information by first looking at the DOS environment to find out 
where the CONFIG environment variable is set and then at the CONFIG.ORA or ORACLE.INI file to determine 
the default information. To reduce the risk of typing errors, enter only your user name and password and let 
Approach fill in the other text boxes.

If you get the message "invalid server name," check with the database administrator to find out what the 
actual server name is. Sometimes the server name is cryptic and will have an alias so that you can log into a server 
named "Sales" rather than the actual "W45GG16X." Approach currently requires you to enter the actual server name 
and will not honor an alias.

If your configuration appears to be correct in CONFIG.ORA or ORACLE.INI and you still can't get access to 
Oracle tables on your drive, check the available DOS conventional memory using MEM/C|More in DOS. If you have 
less than 450KB of memory, remark out drivers and Terminate Stay Residents to make more memory available.
For more information about troubleshooting Oracle SQL, see your Oracle documentation.

See also
Connecting to an Oracle server 



Troubleshooting Oracle SQL on your local drive

If you are having problems getting access to Oracle SQL tables on a local drive through Approach, check for these 
requirements:

Windows must be running in Standard mode. Choose the About command from the Program Manager Help 
menu to verify this. You may get errors if Windows is running in Enhanced mode.

You must be running version 6 or 7 of Local PC-Oracle.

When logging in, you need to enter only your user name and password. Approach gets the rest of the 
information from the CONFIG.ORA or ORACLE.INI file. 

If you get messages like "invalid server name" or "SQL*Net driver not loaded," check the CONFIG.ORA or 
ORACLE.INI file. Add a line to the file that says "LOC=S:" if there isn't one already. This tells Approach to look for a 
local Oracle database rather than a remote database server.

If your configuration appears to be correct in CONFIG.ORA or ORACLE.INI and you still can't get access to 
Oracle tables on your drive, check the available DOS conventional memory using MEM/C|More in DOS. If you have 
less than 450KB of memory, remark out drivers and Terminate Stay Residents to make more memory available.
For more information about troubleshooting Oracle SQL, see your Oracle documentation.

See also
Connecting to Oracle on your local drive 



SQL Server

You can use Approach to work with tables in Microsoft/Sybase SQL Server, in any version under 5.0.

Viewing SQL Server tables in Approach
These are the main differences between viewing tables in Approach and in other SQL Server applications:

Approach PicturePlus fields cannot be viewed in other SQL Server applications.

SQL Server has a field type for money. In Approach, this is converted to a numeric field.

Date fields in SQL Server include both a date and a time. In Approach, these fields appear as two fields: a 
date field and a time field. The extension "_Time" is added to the time field.

For example, suppose an SQL Server date field Shipped has the value "5/10/94 10:35PM". Approach 
displays a date field Shipped with the value "5/10/94" and a time field Shipped_Time with the value "10:35PM".
If you read a SQL Server view file or a SQL Server table without a unique index or timestamp, Approach opens a 
read-only copy of the view file or table.
When SQL Server tables are showing in file dialog boxes, the names of tables appear in the File Name list, the 
names of databases (groups of tables) appear in the Directories list, and the names of servers you're connected to 
appear in the Drives drop-down list.

Field names
The names of text, numeric, memo, and Boolean fields in SQL Server tables can be up to 30 characters long. The 
names of date, time, and PicturePlus fields can be up to 24 characters long. 
The first character in a field name must be a letter, the number sign (#), or the underscore character (_). After that, 
the name can have letters, whole numbers, and the symbols #, _, and $. Spaces are not allowed.

Field lengths
You must specify a field length for text fields. The length for a text field can be from 1 to 255. 
The other fields are fixed in length or do not require a specified length.

Table names
A table name that begins with a number sign (#) is for a temporary table. Other object names cannot begin with a #.
Table names have the same restrictions as field names.

Tables, records, and fields
These are the limits on tables, records, and fields for SQL Server in Approach:

Item Limit
Table size Limited only by disk 

space
Tables open at 
a time

255

Records per 
table

Limited only by disk 
space

Record size 1962 bytes, not 
including picture 
and memo fields

Fields per 
record

250

Fields used in a 
sort

16



Size of a memo 
or picture field

2GB

Memo and 
picture fields 
per table

Limited only by disk 
space

See also
Connecting to a server in SQL Server 



Troubleshooting Microsoft SQL Server

Opening SQL Server tables
If you are having problems getting access to Microsoft SQL Server tables through Approach, check for these 
requirements:

Check the spelling of the server name and user name/password combination. SQL Server is case-sensitive, 
so the server name "SERVER" is not the same as "Server," and both are different from "SeRvEr".

If you are accessing data through a Novell network, make sure the Named Pipes (DOSNP.EXE) and related 
NETAPI.DLL files are from the updated OS/2 Requester Utilities disk from Novell. The file dates on the updated files 
should be no earlier than 6/24/91 for NETAPI.DLL and 4/2/92 for DOSNP.EXE. You can obtain these files from Novell 
directly or via Netwire (Novell's CompuServe file connection). The files must be installed both on the client 
workstation running Approach and on the OS/2 machine running SQL Server.

Abnormal behavior in SQL tables
Sometimes when you open a SQL Server table in Approach, you may notice abnormal behavior, such as no data 
even though the status bar might say "Found 300 of 300." This is usually because you do not have the most recent 
version of the W3DBLIB.DLL and DBNMP3.DLL files. These .DLL files are installed by other products in the 
Windows/System directory and may be older than the versions installed by Approach; the files can also appear in 
other directories. Approach may not overwrite existing .DLL files during installation. If the correct versions of 
these .DLL files are not installed, you may get erratic behavior in a table. 
Use a File Find utility to locate the W3DBLIB.DLL and DBNMP3.DL files, and rename or delete all occurrences of 
these files on your hard drive or path. After verifying that the files no longer exist, re-install Approach. This will install 
all the correct versions of the .DLL files. Older products will still work with the newer .DLL files because the files are 
made to be downward-compatible.
For more information about troubleshooting SQL Server, see your SQL Server documentation.

See also
Connecting to a server in SQL Server 



Troubleshooting Sybase SQL Server

Opening SQL Server tables
If you are having problems getting access to Sybase SQL Server tables through Approach, check for these 
requirements:

Check the spelling of the server name and user name/password combination. SQL Server is case-sensitive, 
so the server name "SERVER" is not the same as "Server," and both are different from "SeRvEr".

Confirm that the Netlib .DLL file from Sybase is in your Windows\System directory or somewhere in the path.

Sybase SQL Server and IPC connections
Sybase SQL Server uses the same client application API and the same SQL dialect as Microsoft SQL Server, but it 
uses different IPC mechanisms to talk to the server application. Microsoft SQL Server requires the Named Pipes 
transport, whereas Sybase SQL Server can use minicomputer protocols like TCP/IP and DECnet. 
Currently, a client using a single transportation IPC stack will not have access to Microsoft and Sybase SQL Server at
the same time. Some users have set up dual-transport protocol stacks in order to achieve the connection. Although 
Named Pipes is not necessary, you do need to have an additional .DLL file from Sybase in your Windows/System 
directory that is specific to the type of network you are running in order to communicate with the database server. 
This file is included in the Netlib client utilities from Sybase. 
Make sure you have the correct Netlib utilities for your particular client environment; for example, TCP/IP. You can get
the most recent version from Sybase. Typically, the utilities that ship with version 4.x or newer of Sybase are 
sufficient.

Abnormal behavior in SQL tables
Sometimes when you open a SQL Server table in Approach, you may notice abnormal behavior, such as no data 
even though the status bar might say "Found 300 of 300." This is usually because you do not have the most recent 
version of the W3DBLIB.DLL and DBNMP3.DLL files. These .DLL files are installed by other products in the 
Windows/System directory and may be older than the versions installed by Approach; the files can also appear in 
other directories. Approach may not overwrite existing .DLL files during installation. If the correct versions of 
these .DLL files are not installed, you may get erratic behavior in a table. 
Use a File Find utility to locate the W3DBLIB.DLL and DBNMP3.DL files, and rename or delete all occurrences of 
these files on your hard drive or path. After verifying that the files no longer exist, re-install Approach. This will install 
all the correct versions of the .DLL files. Older products will still work with the newer .DLL files because the files are 
made to be downward-compatible.
For more information about troubleshooting SQL Server, see your SQL Server documentation.

See also
Connecting to a server in SQL Server 



IBM DB2

You can use Approach to open IBM DB2/2, DB2/6000, and DB2/HP-UX tables directly in Approach through ODBC 
support; IBM DB2, DB2/400, and SQL/DS tables via the IBM Distributed Database Connection Services (DDCS) 
through ODBC support; and IBM DB2 tables through the Micro Decisionware Database Gateway (MDI), version 2.0 
or later. 

Viewing DB2 tables in Approach
These are the main differences between viewing DB2 tables in Approach and in other DB2 applications:

Date fields in DB2 include both a date and a time. In Approach, these fields appear as two fields: a date field
and a time field. The extension "_Time" is added to the time field.

For example, suppose a DB2 date field Shipped has the value "5/10/94 10:35PM". Approach displays a date
field Shipped with the value "5/10/94" and a time field Shipped_Time with the value "10:35PM".

You can create memo and PicturePlus fields in a DB2 table you open through ODBC, but not in a DB2 table 
you open through MDI. Approach PicturePlus fields cannot be viewed in other DB2 applications.
If you read a DB2 table without a unique index, Approach opens a read-only copy of the table.
In DB2, each table is assigned a user as its owner. When DB2 tables are showing in file dialog boxes, the names of 
tables appear in the File Name list, the names of table owners appear in the Directories list, and the names of servers
you're connected to appear in the Drives drop-down list.

Field names
In a DB2 table you open through ODBC, the names of PicturePlus fields can be up to 12 characters long and of 
Boolean fields can be up to 11 characters long. The names of other types of fields can be up to 18 characters long. 
The first character in a field name must be a letter. After that, the name can have letters and whole numbers. Spaces 
and ODBC keywords are not allowed.
In a DB2 table you open through MDI, the names of Boolean fields can be up to 11 characters long. The names of 
other types of fields can be up to 18 characters long. These characters can include letters, whole numbers, and the 
underscore character (_). The first character in a field name must be a letter.

Field lengths
You must specify a field length for text fields. The length for a text field can be from 1 to 254. 
The other fields are fixed in length or do not require a specified length.

Tables, records, and fields
These are the limits on tables, records, and fields for DB2 in Approach:

Item Limit
Table size Limited only by disk

space
Tables open at a 
time

255

Records per 
table

Limited only by disk
space

Record size 2KB or 4KB
Fields per record 300
Fields used in a 
sort

As many fields as 
are in the table

Memo and 
picture fields per 

Limited only by disk
space



table (available only for 
DB2 tables you 
open through 
ODBC)

See also
Connecting to an IBM DB2 or SQL/DS server through ODBC 
Connecting to an IBM DB2 server through MDI 



Troubleshooting IBM DB2-MDI

Setting up the Micro Decisionware (MDI) Gateway
The Micro Decisionware (MDI) Gateway makes DB2, an IBM mini or mainframe database, look like SQL Server to 
client applications. You need these three elements to set up an MDI system for DB2: 

A client application (Approach) that makes calls that are nearly identical to SQL Server 

A dedicated OS/2 machine to run the part of the gateway software that talks to a CICS process on the IBM 
mini or mainframe computer (via L.U. 6.2, an IBM SNA communication standard) 

Micro Decisionware's product, running as a CICS process, which communicates directly with the DB2 
database
Named Pipes is used as the transport mechanism between the client application and the MDI gateway on the OS/2 
machine. All issues for SQL Server also apply to DB2.
The MDI gateway must be version 2.0 or later.

Getting access to the system table
Make sure that you have access permission to the Catalog Stored Procedures (CSP). Following MDI specifications, 
Approach uses CSP to determine which table access you have. (Older products try to get access to the system table 
directly. ) For example, if you are not using CSP you will be able to see the table names in Q+E but not in Approach. 
This is often evidence that you do not have Select access to CSP.
If you have access to the system table directly, you may view files that you shouldn't and may modify or delete files 
that should not be altered. The CSP is something like a "view" or an alias of the system table, allowing a database 
administrator to grant selective access to tables and items you need to see and restrict other items that are not 
necessary for you to view or modify. 
The system table is also subject to change, which can sometimes cause a product to work improperly. The CSP 
eliminates these problems and is the standard method of access that MDI recommends in versions 2.0 and later of 
their DB2 gateway.
Using the CSP method is somewhat slower than using the system table directly because of the processing required.
For more information about troubleshooting IBM DB2-MDI, see your DB2 and MDI documentation.

See also
Connecting to an IBM DB2-MDI server 



Query files

Query files allow you to quickly connect to a server and get access to specific information in a SQL table. The 
filename extension for query files is .QRY.
You can create or edit a query file using any text editor. These are the commands you can use:
Type=Oracle or SQLServer or DB2-MDI or Notes or ODBC type
Network=protocol letter (for Oracle only)
Path=name of the database server
User=your name
Password=your password
Database=name of the database (for SQL Server only)
Select valid Select statement
The commands for a query file are case-insensitive. They can be in any order except that the Select statement must 
be last. 
All of the commands except for Type and Select are optional. If the query file does not contain enough log-on 
information, a Connect dialog box appears when you open the file so that you can fill in the remaining information.
If you include spaces or non-alphanumeric characters in a parameter, the parameter must be enclosed in double 
quotation marks ("). 
This is an example of an Oracle query file:
Type=Oracle
Network=X
Path=ORASRV
User=Rich
Password=sequoia
Select Name,Address,City From Employee

See also
Creating a query file in Approach 
Opening a query file in Approach 
Saving or exporting data from a query 



ODBC data sources

Approach is fully compatible with the Open Database Connectivity standard (ODBC). You can use a Level 1 Tier 1 
ODBC drive engine or a Level 1 Tier2 ODBC driver to get access to ODBC data sources in Approach. 

Viewing ODBC data sources in Approach
These are the main differences between viewing ODBC data in Approach and in other applications:

You can add PicturePlus fields to an ODBC data source in Approach only if the driver supports the Long Var 
Binary field type. You can add memo fields only if the driver supports the Long Var Char field type.

You cannot view Approach PicturePlus fields in other ODBC applications. 

In Approach, fields in the ODBC field types Big Int, Tiny Int, Small Int, Real, Numeric, Decimal, Integer, 
Double, and Float are converted to numeric fields.

Timestamp fields in ODBC include both a date and a time. In Approach, these fields appear as two fields: a 
date field and a time field. The extension "_Time" is added to the time field.

For example, suppose an ODBC Timestamp field Shipped has the value "5/10/94 10:35PM". Approach 
displays a date field Shipped with the value "5/10/94" and a time field Shipped_Time with the value "10:35PM".
If you read an ODBC data source without a unique index or timestamp, Approach opens a read-only copy of the view 
file or table.

Field names
The first character in a field name must be a letter. After that, the name can have letters and whole numbers. Spaces 
and ODBC keywords are not allowed.
The limits on the length of a field name depend on whether the ODBC driver supports the field's data type:

Text (Char or Var Char)
30 characters or limit of driver (always supported)

Numeric (Bit Int, Tiny Int, Small Int, Real, Numeric, Decimal, Integer, Double, or Float)
If driver supports data type: 30 or limit of driver

If driver does not support data type: 30 or limit of driver; stored as text

Memo (Long Var Char)
If driver supports data type: 30 or limit of driver

If driver does not support data type: Field is disabled

Boolean (Bit)
If driver supports data type: 30 or limit of driver

If driver does not support data type: (30 or limit of driver) minus 7; stored as text

Date (Date)
If driver supports data type: 30 or limit of driver

If driver does not support data type: (30 or limit of driver) minus 6; stored as timestamp (if supported) or as text

Time (Time)
If driver supports data type: 30 or limit of driver

If driver does not support data type: (30 or limit of driver) minus 6; stored as timestamp (if supported) or as text

PicturePlus (Long Var Binary)
If driver supports data type: (30 or limit of driver) minus 6
If driver does not support data type: Field is disabled

If two lengths are given for a field name (such as "30 or limit of driver"), the field name can be the shorter of the two 
lengths.

Field lengths



You must specify a field length for text fields, from 1 to the limit of the ODBC driver. Most drivers have a limit of 255.
The other fields are fixed in length or do not require a specified length.

Tables, records, and fields
In an ODBC data source, the size of the table and the number of records in it are limited only by disk space. You can 
have up to 255 tables open at a time.
The limits on record size, fields per record, fields in a sort, and memo and picture fields are determined by the 
database application for the ODBC data source. For more information, consult the documentation for the ODBC 
driver or for the database application.

See also
About working with ODBC data sources 



Find request
In Find, you create a find request that tells Approach what to search for. A new find request is a blank copy of the view
you're currently using. You enter the search criteria in fields of the find request. If the view contains a summary field, 
you see the summary field along with the other fields in the find request. 

See also
Repeating a search 
Showing all records 
Creating a find request 



Find Special
You use the Find Special dialog box to find duplicate or unique records. You can find all records that have either the 
same value in a field (duplicate records) or a unique value. 
When you find duplicate records, Approach searches in the current found set for duplicates of any value you specify. 
You can find all duplicate records or just the extra duplicates.
When you find unique records, Approach searches in the current found set for each occurrence of a unique value. 

See also
Finding duplicate values
Finding unique values



Sort
You use the Sort dialog box to select the fields that Approach uses to sort records in a database. For each field, you 
can specify ascending or descending order.

See also
Changing the sort order 
Showing records in their original order    
Sorting records by a field in a view



Align
You use the Align dialog box to align selected objects along their tops, bottoms, sides, or centers. You can also 
distribute objects vertically or horizontally to place an equal amount of space between them.

See also
Aligning and distributing objects 



Approach File Info
You use the Approach File Info dialog box to provide a description of an Approach file and to enable a variable field 
for Notes F/X 1.1. This dialog box also displays information about the Approach file, including size, number of views, 
and date and time the file was created.

See also
Enabling a variable field for Notes F/X 1.1 



Define Checkboxes
You use the Define Checkboxes dialog box to specify values for a field's checkboxes.

See also
Displaying a field as a checkbox



Define Radio Buttons
You use the Define Radio Buttons dialog box to specify values for a field's radio buttons.

See also
Displaying a field as radio buttons



Macros
You use the Macros dialog box to create a new macro or to select an existing macro for editing or deleting.

See also
Defining a macro 
Editing a macro
Deleting a macro



Define Macros: Browse
You use the Browse command to switch to Browse. This command has no options.

See also
Defining a macro 
About macro commands
Adding and removing commands in a macro



Define Macros: Close
You use the Close command to close the current Approach file. You can also automatically disconnect from the 
server while the macro runs.

See also
Defining a macro 
About macro commands
Adding and removing commands in a macro



Define Macros: Delete
You use the Delete command to delete the current record, found set, or Approach file. The "Don't show warning" 
option deletes the item you've selected without opening alert boxes while the macro runs. 

See also
Defining a macro 
About macro commands
Adding and removing commands in a macro



Define Macros: Dial
You use the Dial command to dial the telephone number in the field you select. Approach uses the modem settings 
you specify in Dialer preferences. This command has no options.

See also
Defining a macro 
Setting dialing preferences
About macro commands
Adding and removing commands in a macro



Define Macros: Edit
You use this panel of the Define Macros dialog box to select the Cut, Copy, Paste, or Select All command. You can 
also have the macro open the Paste Special dialog box and wait for input while the macro runs. The Edit command is
used mostly for putting data on the Clipboard or for pasting it.

See also
Defining a macro 
About macro commands
Adding and removing commands in a macro



Define Macros: Enter
You use the Enter command to accept the current record (this is the same as pressing the ENTER key or clicking the 
Enter icon). This command has no options.

See also
Defining a macro 
About macro commands
Adding and removing commands in a macro



Define Macros: Exit
You use the Exit command to exit Approach. This command has no options.

See also
Defining a macro
About macro commands
Adding and removing commands in a macro



Define Macros: Export
You use the Export command to export data from Approach. You can set export options now (click Edit Export), or set
Approach to open the Export Data dialog box and wait for input while the macro runs.

See also
Defining a macro
Exporting data from Approach
About macro commands
Adding and removing commands in a macro



Define Macros: Find
You use the Find command to perform a stored find request, to show all records in the database file, or to refresh the 
found set. You can set Approach to open a find request or to open the Find Again dialog box and wait for input while 
the macro runs. The stored find request can be a new one you define now (click New Find) or one that has already 
been defined. You can also edit a stored find by clicking Edit Find. If no records are found, you can select another 
macro for Approach to run.

See also
Defining a macro 
Finding a set of records with a macro
Creating a find request
About macro commands
Adding and removing commands in a macro



Define Macros: Find Special
You use the Find Special command to find duplicate or unique records. You can set Find Special options now (click 
Edit Find Special), or set Approach to open the Find Special dialog box and wait for input while the macro runs.

See also
Defining a macro    
Finding duplicate values
Finding unique values
About macro commands
Adding and removing commands in a macro



Define Macros: Records
You use the Records command to go to a record, hide a record, duplicate a record, or create a new record.

See also
Defining a macro 
Moving to another record
About macro commands
Adding and removing commands in a macro



Define Macros: Import
You use the Import command to import data or views into Approach. You can set import options now, or set Approach 
to open the Import Data dialog box and wait for input while the macro runs. You can set up a new import (click Define 
Import File) or edit an existing import setup (click Edit Import Setup).

See also
Defining a macro 
Importing a database file
About macro commands
Adding and removing commands in a macro



Define Macros: Mail
You use the Mail command to e-mail a view. You can set mailing options now (click Edit Send Mail), or set Approach 
to open the Send Mail dialog box and wait for input while the macro runs. 

See also
Defining a macro 
Sending e-mail from Approach
About macro commands
Adding and removing commands in a macro



Define Macros: Menu Switch
You use the Menu Switch command to switch to another menu. You use this panel to select the menu you want to 
switch to. You can also create a custom menu now (click Customize Menus).

See also
Defining a macro 
Customizing menus
About macro commands
Adding and removing commands in a macro



Define Macros: Message
You use the Message command to create a boxed message that appears while the macro runs.

See also
Defining a macro 
About macro commands
Adding and removing commands in a macro



Define Macros: Open
You use the Open command to open a file while the macro runs. You can set file-opening options now (click Files), or 
set Approach to open the Open dialog box and wait for input while the macro runs. The file can be another Approach 
file, a different database file, or another application, such as Lotus 1-2-3. You can even open a communication 
application that uses a script to upload your data to another computer.

See also
Defining a macro 
Opening an Approach file
About macro commands
Adding and removing commands in a macro



Define Macros: Preview
You use the Preview command to switch to Preview. There are no options for this command.

See also
Defining a macro 
About macro commands
Adding and removing commands in a macro



Define Macros: Print
You use the Print command to print a view. You can set printing options now (click Edit Print), or set Approach to open
the Print dialog box and wait for input while the macro runs.

See also
Defining a macro 
Printing a view
About macro commands
Adding and removing commands in a macro



Define Macros: Replicate
You use the Replicate command to replicate a Notes database. You can set replication options now (click Edit 
Replicate), or set Approach to open the Replicate Notes Database dialog box and wait for input while the macro runs.

See also
Defining a macro 
Replicating a new Notes database 
Replicating a Notes database with a server 
About macro commands
Adding and removing commands in a macro



Define Macros: Run
You use the Run command to set a condition and either run another macro or continue with the current macro 
depending on whether the condition is met. You set the condition in a formula (click Define Formula), and specify a 
macro to run when the result of the condition is true and a macro to run when the result is false. You can also set 
Approach to return to the current macro after running another macro. 

See also
Defining a macro 
Defining a conditional macro
Using an If calculation in a macro
About macro commands
Adding and removing commands in a macro



Define Macros: Save
You use the Save command to save the current Approach file. You can either save the current Approach file, or you 
can set Approach to open the Save As dialog box and wait for input while the macro runs.

See also
Defining a macro 
Saving a copy of an Approach file and a database file
About macro commands
Adding and removing commands in a macro



Define Macros: Zoom
You use this panel of the Define Macros dialog box to set the options for the Zoom command. The Zoom command 
scales the current window by zooming in or out.

See also
Defining a macro 
About macro commands
Adding and removing commands in a macro



Define Macros: Set
You use the Set command to set a value in any uncalculated field. You specify the field to be set and the value to use.
You can type a value or define a formula (click Formula).

See also
Defining a macro 
Setting up a formula for a calculated field
Setting a value in a field with a macro
About macro commands
Adding and removing commands in a macro



Define Macros: Sort
You use the Sort command to sort database records. You can set sort criteria when you define the macro, or set 
Approach to open the Sort dialog box and wait for input while the macro runs. 

See also
Defining a macro 
Specifying a sort order
About macro commands
Adding and removing commands in a macro



Define Macros: Spell Check
You use the Spell Check command to check the spelling of data in records and text in memo fields (in Browse) or the 
spelling of text in text objects (in Design).

See also
Defining a macro 
Running the spelling checker
About macro commands
Adding and removing commands in a macro



Define Macros: Tab
You use the Tab command to tab forward or backward among the fields in a record. You can specify the number of 
times to tab.
To view or change the data entry order for fields and buttons on a form, use the Show Data Entry Order command in 
the View menu in Design.

See also
Defining a macro 
Changing the data entry order for fields
About macro commands
Adding and removing commands in a macro



Define Macros: View
You use the View command to go to another view, show a view, or hide a view. You can select the view to go to, or 
show or hide the current view. 

See also
Defining a macro 
Switching to another view with a macro
About macro commands
Adding and removing commands in a macro



Preferences: Display 
You use the Preferences Display panel to determine the window elements that appear in the Approach work area, the
default named style for Assistants, the elements that appear in Design, and the settings for the design grid.

See also
Setting display defaults 



Preferences: Dialer
You use the Preferences Dialer panel to define a standard modem setting to be used whenever you have Approach 
dial a telephone number. Modem settings include the name of the serial port the modem is connected to, the 
modem's baud rate (speed), and the type of dialing service to use.

See also
Setting dialing preferences 



Preferences: Database 
You use the Preferences Database panel for a dBASE or FoxPro database to make the file read-only in the current 
Approach file, to change to another character set, or to compress the file for more efficient storage. You can use 
either the DOS character set or the Windows character set.
You use the Preferences Database panel for a Paradox database to make the file read-only in the current Approach 
file, to change to another character set, and (for Paradox 4.0) to change case sensitivity for searches. You can use 
either the DOS character set or the Windows character set.
You use the Preferences Database panel for SQL to make all SQL and ODBC tables you work with in Approach read-
only, to display SQL system tables in file dialog boxes, and to cache the names of SQL tables. These options are 
saved in your APPROACH.INI file and affect all SQL tables you open or create in Approach.

See also
Setting database options for a dBASE or FoxPro file 
Setting database options for a Paradox file 
Setting database options for all SQL tables 



Preferences: General 
You use the Preferences General panel to make the ENTER key work the same way in Browse as the TAB key, to 
open the Add Field dialog box right after you define a field, to show a Cancel Macro dialog box whenever you run a 
macro, to download the current data set whenever you go to Preview, and to allow two network users to edit a record 
at the same time using optimistic record locking.

See also
Setting general working preferences 



Preferences: Index 
You use the Preferences Index panel for a dBASE or FoxPro database to create an association between a database 
file and any indexes you may have created in dBASE or FoxPro. Associating an index and a database field allows 
Approach to maintain an index even though Approach doesn't use the index. You can also close an external index so 
that it will no longer be maintained.
You use the Preferences Index panel for a Paradox database to create additional, secondary indexes in Approach for 
the database file. Approach automatically uses and maintains all indexes for Paradox database files.

See also
Maintaining external indexes for a dBASE or FoxPro database 
Creating secondary indexes for a Paradox database 



Preferences: Password 
You use the Preferences Password panel to define passwords for database files and Approach files. You can give a 
database file a read/write password or a read-only password. 

See also
Defining a password for a file 



Preferences: Order
You use the Preferences Order panel to set a new default order for records to appear in Browse. When you show all 
records after sorting them, the records return to the order you specify here.

See also
Setting a default order for records 



Form Assistant: Layout
You use the Form Assistant Layout panel to name a form, select a SmartMaster style, and select a SmartMaster 
layout.

See also
Creating a form 



Form Assistant: Fields
You use the Form Assistant Fields panel to select the fields that appear on a form.

See also
Creating a form 



Form Assistant: Panel
You use the Form Assistant Panel panel to select the fields that appear in a repeating panel.

See also
Creating a form 



Report Assistant: Layout
You use the Report Assistant Layout panel to name a report, select a SmartMaster style, and select a SmartMaster 
layout.

See also
Creating a standard or columnar report 
Creating a report with summaries 
Creating a repeating panel report 



Report Assistant: Fields
You use the Report Assistant Fields panel to select the fields that appear on a report.

See also
Creating a standard or columnar report 
Creating a report with summaries 
Creating a repeating panel report 



Report Assistant: Trailing Summary
You use the Report Assistant Trailing Summary panel to select the field used to group records for a trailing summary 
and the calculation used in the trailing summary.

See also
Creating a report with summaries 
Creating a repeating panel report 



Report Assistant: Leading Summary
You use the Report Assistant Leading Summary panel to select the field used to group records for a leading summary
and the calculation used in the leading summary.

See also
Creating a report with summaries 



Report Assistant: Grand Summary
You use the Report Assistant Grand Summary panel to select the field used to group records for a grand summary 
and the calculation used in the grand summary.

See also
Creating a report with summaries 



Report Assistant: Repeating Fields
You use the Report Assistant Repeating Fields panel to select the database and fields you want for the repeating 
portion of a repeating panel report.

See also
Creating a repeating panel report 



Mailing Label Assistant: Basics
You use the Mailing Label Assistant Basics panel to select a SmartMaster layout for mailing labels, select and 
position the mailing label's fields, and select a label code.

See also
Creating a mailing label 



Mailing Label Assistant: Options
You use the Mailing Label Assistant Options panel to give custom mailing labels a name; to set the labels' size, page 
margins, and space between labels; to specify the number of labels that appear on a page and their arrangement; 
and to set printing options if necessary. 

See also
Creating a mailing label 
Creating a custom mailing label format 



Mailing Label Options 
You use the Mailing Label Options dialog box to change the current custom mailing label definition, select a different 
label definition, or create a new one. You can also delete a custom label definition.

See also
Creating a custom mailing label format 
Creating a mailing label 



Form Letter Assistant: Layout
You use the Form Letter Assistant Layout panel to name a form letter, select a SmartMaster style, and select a 
SmartMaster layout.

See also
Creating a form letter 



Form Letter Assistant: Return Address
You use the Form Letter Assistant Return Address panel to type the return address that appears in a form letter.

See also
Creating a form letter 



Form Letter Assistant: Inside Address
You use the Form Letter Assistant Inside Address panel to select a SmartMaster Address layout and the fields that 
appear in a form letter's address. 

See also
Creating a form letter 



Form Letter Assistant: Salutation
You use the Form Letter Assistant Salutation panel to select the fields that appear in a form letter's salutation. You 
can also change the wording and punctuation of the salutation.

See also
Creating a form letter 



Form Letter Assistant: Close
You use the Form Letter Assistant Close panel to type the closing that appears in a form letter. 

See also
Creating a form letter 



Worksheet Assistant
You use the Worksheet Assistant to select the fields that appear on a worksheet.

See also
Creating a worksheet 



Crosstab Assistant: Rows
You use the Crosstab Assistant Rows panel to select the fields that appear in a crosstab's rows.

See also
Creating a crosstab 



Crosstab Assistant: Columns
You use the Crosstab Assistant Columns panel to select the fields that appear in a crosstab's columns.

See also
Creating a crosstab 



Crosstab Assistant: Values
You use the Crosstab Assistant Values panel to select a formula to be used in calculating the values in a crosstab's 
body cells and to select the field to be calculated. 

See also
Creating a crosstab 



Chart Assistant: Layout
You use the Chart Assistant Layout panel to name a chart, select a SmartMaster style, and select a SmartMaster 
layout.

See also
Creating a chart using the Chart Assistant 



Chart Assistant: X Axis
You use the Chart Assistant X Axis panel to select the field that appears in a chart's x-axis.

See also
Creating a chart using the Chart Assistant 



Chart Assistant: Y Axis
You use the Chart Assistant Y Axis panel to select the field that appears in a chart's y-axis.

See also
Creating a chart using the Chart Assistant 



Chart Assistant: Series
You use the Chart Assistant Series panel to select the field used for grouping a chart's series.

See also
Creating a chart using the Chart Assistant 



Chart Assistant: Pie Fields
You use the Chart Assistant Pie Fields panel to select the field that appears in a chart's pie wedges.

See also
Creating a chart using the Chart Assistant 



Links
You use the Link dialog box to change when a link is updated, manually update a link, activate a linked object, 
change the link to another source file, or break the link and convert the object into a graphic element.

See also
Modifying a link 



Choose Key Field
You use the Choose Key Field dialog box to specify a key field when you save or create a Paradox database.

See also
Specifying a key field for a Paradox database 



Confirm Password
You use the Confirm Password dialog box to confirm a new password being assigned to a database file.

See also
Defining a password for a file 
Entering a password 



Confirm Approach File Password
You use the Confirm Approach File Password dialog box to confirm a new password being assigned to an Approach 
file.

See also
Defining a password for a file 
Entering a password 



dBASE Network Connection
You use the dBASE Network Connection dialog box to specify file-sharing options for dBASE and FoxPro database 
files on a network.

See also
Setting file-sharing options for dBASE files 



Connect to DB2-MDI
You use the Connect to DB2-MDI dialog box to connect to an IBM DB2-MDI server.

See also
Connecting to an IBM DB2-MDI server 



Paradox Network Connection
You use the Paradox Network Connection dialog box to specify file-sharing options for Paradox database files on a 
network.

See also
Setting file-sharing options for Paradox files 



Connect to ORACLE
You use the Connect to ORACLE dialog box to connect to an ORACLE server.

See also
Connecting to an Oracle server 



Connect to SQL Server
You use the Connect to SQL Server dialog box to connect to a server in SQL Server. 

See also
Connecting to a server in SQL Server 



Copy View to Clipboard
You use the Copy View to Clipboard dialog box to copy the current view or all views to the Clipboard. You can copy 
the view with or without data.

See also
Creating an Approach OLE object in Approach 



Connect Options
You use the Connect Options dialog box to set system catalog and tablespace options when connecting to an IBM 
DB2-MDI server.

See also
Connecting to an IBM DB2-MDI server 



Enter Password
You use the Enter Password dialog box to type a password associated with a database file.

See also
Entering a password 
Defining a password for a file 



Named Styles
You use the Named Styles dialog box to create a new named style, or to select a named style for editing, copying, or 
deleting.

See also
Defining and saving a named style



Define Style: Font
You use the Define Style Font panel to define text attributes for data in fields and for text in text objects.

See also
Defining and saving a named style
Changing text attributes 



Define Style: Label
You use the Define Style Label panel to define the position and text attributes for field labels.

See also
Defining and saving a named style
Changing text attributes 



Define Style: Lines and Colors
You use the Define Style Lines and Colors panel to define properties for widths, colors, frames, and field borders.

See also
Defining and saving a named style
Changing line or color settings for an object 



Define Style: Picture
You use the Define Style Picture panel to define properties for PicturePlus fields.

See also
Defining and saving a named style
Changing display options for a PicturePlus field



Define Style: Background
You use the Define Style Background panel to define properties for the background of views.

See also
Defining and saving a named style
Changing line or color settings for a view 



Field Definition
You use the Field Definition dialog box to add, modify, or delete fields in a database.

See also
Adding fields to a database 



Field Definition: Default Value
You use the Field Definition Default Value panel to specify a default value for a field.

See also
Entering data automatically 



Field Definition: Define Formula
You use the Field Definition Define Formula panel to define a formula for a calculated field.

See also
Setting up a formula for a calculated field 
Setting up a formula for a summary calculated field 



Field Definition: PicturePlus Options
You use the Field Definition PicturePlus Options panel to set OLE options for a PicturePlus field.

See also
Setting OLE options for a PicturePlus field 



Field Definition: Validation
You use the Field Definition Validation panel to define validation options for data in a field.

See also
Verifying the accuracy of entered data 



Field Definition: Define Summary
You use the Field Definition Define Summary panel to define a calculation for a summary field.

See also
Setting up a formula for a calculated field 
Setting up a formula for a summary calculated field 



Field Definition: Variable Options
You use the Field Definition Variable Options panel to set data options for a variable field.

See also
Setting data options for a variable field 



Import Approach File
You use the Import Approach File dialog box to select an Approach file to import.

See also
Importing an Approach file 



Import Setup
You use the Import Setup and Import Approach File Setup dialog boxes to align fields in the file you're importing with 
fields in the current database and to select a field to import. If you're importing a database, you also select the import 
method and the fields you want to match if the method includes matching.

See also
Importing an Approach file 
Importing data into a database 



Select Range
You use the Select Range dialog box to select a Lotus 1-2-3 range to open as a database file.

See also
Opening a named range from a Lotus 1-2-3 spreadsheet 



Edit Dictionary
You use the Edit Dictionary dialog box to add, change, or delete words in your personal dictionary.

See also
Editing the user dictionary 
Running the spelling checker 



Summary
You use the Summary dialog box to add a summary panel to a report. You select the way you want to summarize 
records, the field to summarize on, and the alignment and location of the summary panel.

See also
Adding a summary panel to a report 



Change Icon
You use the Change Icon dialog box to change the icon used to represent an OLE object.

See also
Embedding a new OLE object 
Embedding an existing OLE object 



Copy to File
You use the Copy to File dialog box to specify the name of a file to which you're copying the contents of a PicturePlus
field.

See also
Copying a PicturePlus picture to a file 



Export Data
You use the Export Data dialog box to type the name for a file you're exporting to, to specify where you want the file 
to be saved, to select a database file type, and to select the amount of data to export.

See also
Exporting data from Approach 



Formula
You use the Formula dialog box to edit a formula that is part of a field definition or to build a formula for a macro.

See also
Setting up a formula for a calculated field 
Using an IF calculation in a macro 



Fixed-Length Text File Setup
You use the Fixed-Length Text File Setup dialog box to select the character set used in a fixed-length text file and to 
define the fields in the file.

See also
Creating a database from a fixed-length text file 



Fill Field
You use the Fill Field dialog box to enter or edit text used to fill a field.

See also
Filling a field with a new value 



Define Filter
You use the Define Filter dialog box to define a set of conditions for displaying a subset of field data in a drop-down 
list.

See also
Displaying a field as a drop-down list 



Open
You use the Open dialog box to select a file to open.

See also
Opening an Approach file
Opening a database created in another application 



Go To Record
You use the Go To Record dialog box to type the record number of a record you want to go to.

See also
Moving to a specific record 



Add Field
You use the Add Field dialog box to add a field to a view.

See also
Adding a field as a field box 
Adding a field to a repeating panel 
Adding a field to a form letter 
Adding a database field to a worksheet 



Join
You use the Join dilaog box to establish a link between two or more databases. You can also use the dialog box to 
unjoin joined databases.

See also
Joining database files 
Unjoining database files 



Relational Options
You use the Relational Options dialog box to set options for inserting or deleting records automatically in joined 
databases.

See also
Setting options for a join 



Language Options
You use the Language Options dialog box to switch to another dictionary when you check spelling.

See also
Changing to another main dictionary 
Running the spelling checker 



Define Main Database
You use the Define Main Database dialog box to select the main database for a view that contains fields from two or 
more joined databases.

See also
Creating a chart using the Chart Assistant 
Creating a crosstab 
Creating a form 
Creating a form 
Creating a mailing label 
Creating a standard report    
Creating a worksheet 



Customize Menus
You use the Customize Menus dialog box to create, edit, or delete custom menu bars.

See also
Customizing menus 



Define Custom Menu Bar
You use the Define Custom Menu Bar dialog box to create a custom menu bar by specifying its menus and 
commands.

See also
Customizing menus 



More Macros
You use the More Macros dialog box to select a macro to be run when you have more macros than will fit in the Run 
Macro submenu.

See also
Running a macro 



Paste from File
Use the Paste From File dialog box to paste a picture into the background of a view or into a PicturePluss field.

See also
Pasting a picture (Design) 
Pasting a picture (Browse) 



Paste Special
You use the Paste Special dialog box to embed OLE objects in an Approach file.

See also
Embedding an existing OLE object 



Print
You use the Print dialog box to print a view.

See also
Printing a view 



New Notes Replica
You use the New Notes Replica dialog box to replicate a new Lotus Notes database.

See also
Replicating a new Notes database 



Replicate with Notes Server
You use the Replicate with Notes Server dialog box to replicate a Notes database with the server.

See also
Replicating a Notes database with a server 



Save Approach File
You use the Save Approach File dialog box to specify a name and location for a new Approach file.

See also
Saving an Approach file 



Save Database As
You use the Save Database As dialog box to specify a name and location for a database file when you save a copy of
an Approach file.

See also
Saving a copy of an Approach file and a database file 



Save Approach File As
You use the Save Approach File As dialog box to specify a name and location when you save a copy of an Approach 
file.

See also
Saving a copy of an Approach file and a database file 



Send Mail
You use the Send Mail dialog box to specify the views and data to include when you send e-mail from Approach. 

See also
Sending e-mail from Approach 



Spell Check
You use the Spell Check dialog box to check the spelling in database records and Approach files. In Browse, you 
check the spelling of data in records, including text in memo fields. In Design, you check the spelling of text in field 
labels and text objects, including text in the body of form letters.

See also
Running the spelling checker 



Speller Options
You use the Speller Options dialog box to tell Approach the type of errors to find or ignore when checking spelling.

See also
Setting options for checking spelling 
Running the spelling checker 



Welcome
You use the Welcome dialog box to create a new database file or to select a file to open. If you're creating a file, you 
can select a template in the Welcome dialog box.

See also
Creating a new database file 



Text File Options
You use the Text File Options dialog box to select the character set used in a delimited text file and to specify the field
separators in the file.

See also
Creating a database from a delimited text file 



Drop-Down List
You use the Drop-Down List dialog box to specify values for a field's drop-down list.

See also
Displaying a field as a drop-down list 



Enter Approach File Password
You use the Enter Approach File Password to type a password when you create views, join databases, or go to 
Design in an Approach file that has a password.

See also
Entering a password 



InfoBox: Basics
You use the InfoBox Basics panel to set basic properties for an object, field, repeating panel, summary panel, or view.

See also
Changing the basic properties of an object 
Changing the basic properties of a field 
Changing the basic properties of a PicturePlus field 
Changing the basic properties of a repeating panel 
Changing the number of columns in a report 
Keeping records together 
Changing the basic properties of a view 



InfoBox: Macros
You use the InfoBox Macros panel to attach macros to a macro button, field, object, or view.

See also
Attaching a macro to a macro button 
Attaching a macro to a field 
Attaching a macro to a view 
Attaching a macro to a button or object 



InfoBox: Printing
You use the InfoBox Printing panel to set printing properties for a worksheet or crosstab.

See also
Formatting a worksheet for printing 



InfoBox: Text
You use the InfoBox Text panel to set text attributes for a fields or text object (including the body text of a form letter).

See also
Changing text attributes of data 
Changing text attributes 



InfoBox: Lines and Colors
You use the InfoBox Lines and Colors panel to change the appearance of lines and colors for a field, object, 
repeating panel, summary panel, or view.

See also
Changing line or color settings for a field 
Changing line or color settings for an object 
Changing line or color settings for a repeating panel 
Changing line or color settings for a report panel 
Changing worksheet settings 
Changing line or color settings for a view 



InfoBox: Dimensions
You use the InfoBox Dimensions panel to slide or resize an object or field.

See also
Sliding an object when you print 
Sliding or resizing a field when you print 



InfoBox: Format
You use the InfoBox Format panel to set a data format for a field.

See also
Setting a numeric format 
Setting a standard date format 
Setting a special date format for periods of a year 
Setting a time format 
Setting a text format 



InfoBox: Label
You use the InfoBox Label panel to set properties for a field label.

See also
Changing the wording, attributes, or position of a label 



InfoBox: Display
You use the InfoBox Display panel to specify the alignment and position of a summary panel.

See also
Changing the alignment or position of a summary panel 



InfoBox: Options
You use the InfoBox Options panel to set display options for a PicturePlus field when the graphic in the field is either 
larger or smaller than the field.

See also
Changing display options for a PicturePlus field 



InfoBox: Formula
You use the InfoBox Formula panel to edit the crosstab formula used in summary columns and body cells or in 
summary rows. 

See also
Editing a crosstab formula 



New
You use the New dialog box to create a new database file.

See also
_Creating a new database file 



SmartIcons
Use the SmartIcons dialog box to add, modify, or delete an icon bar.

See also
Customizing the SmartIcon bar 



Delete File
Use the Delete File dialog box to delete a database file or an Approach file.

See also
Deleting a file 



Insert Object
Use the Insert Object dialog box to insert an OLE object into a view.    You can either create a new object or link to an 
existing object.

See also
Embedding a new OLE object 
Inserting a linked object 



Add Repeating Panel
Use the Add Repeating Panel dialog box to add a repeating panel to a form.

See also
Adding a repeating panel to an existing form 



Print Setup
Use the Print Setup dialog box to change printer settings, such as orientation, paper size, and paper source.

See also
Specifying the printer, paper, and orientation 



Options
Use the (Print Setup) Options dialog box to set printer options, such as those for grayscale printing and duplex 
printing.

See also
Printing a view 



About
Use the (Print Setup Options) About dialog box to see which printer driver is currently being used by your computer.

See also
Printing a view 



Insert Field
Use the Insert Field dialog box to add a field to a text block (such as in a form letter).

See also
Adding a field to a form letter



Add Index
Use the Add Index dialog box to add an external index to a dBASE or FoxPro database or to add a secondary index 
to a Paradox database.

See also
Maintaining external indexes for a dBASE or FoxPro database 
Creating secondary indexes for a Paradox database 



<<Fieldname>> must be filled in
This field must be filled in.

See also
Verifying the accuracy of entered data 



The entry in <<Fieldname>> must be unique
The entry in this field must be unique.

See also
Verifying the accuracy of entered data 



The entry in <<Fieldname>> must be in the range...
The entry in this field must be with a certain range.

See also
Verifying the accuracy of entered data 



The entry in <<Fieldname>> is not one of the items...
The entry in this field must be one of the items in the data validation list.

See also
Verifying the accuracy of entered data 



The entry in <<Fieldname>> is invalid
The entry is\n this field is not valid for some reason.

See also
Verifying the accuracy of entered data 



The find rule is not valid
There's an error in the find request you've created.

See also
Creating a find request 




